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About this Guide

This guide describes how you can use programming interfaces to access and modify
the CentraSite Registry Repository. Additionally, it describes how you can customize
the CentraSite graphical user interfaces to suit the requirements or standards of your
organization.

Document Conventions

Convention Description

Bold Identifies elements on a screen.

Narrowfont Identifies storage locations for services on webMethods
Integration Server, using the convention folder.subfolder:service .

UPPERCASE Identifies keyboard keys. Keys you must press simultaneously
are joined with a plus sign (+).

Italic Identifies variables for which you must supply values specific to
your own situation or environment. Identifies new terms the first
time they occur in the text.

Monospace
font

Identifies text you must type or messages displayed by the
system.

{ } Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

| Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[ ] Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

... Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).
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Online Information
Software AG Documentation Website

You can find documentation on the Software AG Documentation website at “hp://
documentation.softwareag.com”. The site requires Empower credentials. If you do not
have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

You can find product information on the Software AG Empower Product Support
website at “hps://empower.softwareag.com”.

To submit feature/enhancement requests, get information about product availability,
and download products, go to “Products”.

To get information about fixes and to read early warnings, technical papers, and
knowledge base articles, go to the “Knowledge Center”.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG
TECHcommunity website at “hp://techcommunity.softwareag.com”. You can:

Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.

Link to external websites that discuss open standards and web technology.

http://documentation.softwareag.com
http://documentation.softwareag.com
https://empower.softwareag.com
https://empower.softwareag.com/Products/default.asp
https://empower.softwareag.com/KnowledgeCenter/default.asp
http://techcommunity.softwareag.com
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Introduction to the CentraSite API for JAXR
The CentraSite API for JAXR (Java Application Program Interface for eXtensible Markup
Language Repositories) is based on the Java API for XML Registries (JAXR) standard.
CentraSite supports JAXR capability level 1. In addition, it has some extensions
that enable you to exploit specific functions of CentraSite. The reader should be an
experienced Java programmer, with knowledge of XML and the concepts of enterprise
repositories.

CentraSite extends the JAXR standard with the following:

Ability to create user-defined object types.

CentraSite extends the JAXR object model by user-defined types, which may have
triggers and operations aached. Correspondingly, the CentraSite JAXR-based
extensions interface extends the JAXR query interface and allows you to search user-
defined objects.

Ability to use XQuery to access to the stored data.

CentraSite allows a client to access the stored data directly using XQuery through
the XQJ-based (XQuery API for Java) interface.

Creating a JAXR-based Connection

To create a JAXR-based connection

1. Ensure that the CLASSPATH includes directories that contain all JAR files in the
CentraSite redist folder.

Note: If you have activated an e-mail policy, the CLASSPATH must additionally
include the file mail.jar, which you can find in the rts/bin folder.

2. Do one of the following:

Start your client program with the parameter:
-Djavax.xml.registry.ConnectionFactoryClass=com.centrasite.jaxr.
ConnectionFactoryImpl

Set this property during program startup:
System.setProperty("javax.xml.registry.ConnectionFactoryClass", 
    "com.centrasite.jaxr.ConnectionFactoryImpl");

3. Create a factory by running the command connFactory, along with the appropriate
code snippet:
ConnectionFactory connFactory = ConnectionFactory.newInstance();

4. Supply the queryManagerURL to the connection.
Properties p = new Properties(); 
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p.setProperty("javax.xml.registry.queryManagerURL", 
      "http://localhost:53307/CentraSite/CentraSite");

Note: In CentraSite, the lifeCycleManagerURL is always the same as the
queryManagerURL, hence it need not be specified.

The port number, in the example above specified as 53307, may need to
be changed to suit your local configuration.

5. Set the BrowserBehaviour option.
p.setProperty("com.centrasite.jaxr.BrowserBehaviour", "yes"); 
connFactory.setProperties(p);

Enabling BrowserBehaviour mode is the preferred way of creating a JAXR-based
connection. This is beneficial for several reasons. The BrowserBehaviour mode uses
a less strict locking paern, and this can result in an increased number of parallel
read and update operations. For example in CentraSite Control, while one user is
looking at some asset, another user can update the same asset in parallel. In the same
scenario without BrowserBehaviour, the update would fail as the necessary lock
cannot not be granted.

Moreover, with BrowserBehaviour mode, the assets cached on the client side are
refreshed often. After an asset is read, it is refreshed in the cache if it is returned as
the result of a subsequent query with a newer timestamp.

6. Create the connection and set the user credentials. The setCredentials() method expects
a Set containing a java.net.PasswordAuthentication object.
Connection connection = connFactory.createConnection(); 
  
HashSet credentials = new HashSet(1); 
credentials.add(new PasswordAuthentication("userid",
                                           "password".toCharArray())); 
  
connection.setCredentials(credentials);

7. Construct the other objects once the connection is created.
RegistryService regService = connection.getRegistryService(); 
BusinessLifeCycleManager lcManager = 
         regService.getBusinessLifeCycleManager(); 
BusinessQueryManager bqManager = regService.getBusinessQueryManager();

Closing a JAXR-based Connection
A JAXR-based connection uses some resources in the CentraSite XML Server.

Software AG recommends that you ensure the connection is closed after the client
program has been processed successfully or failed due to a JAXR-based client failure.
Otherwise the resources are released only after a non-activity timeout, which might
hinder parallel users.

To close a JAXR-based connection

Call the method:
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connection.close()

Defining a Service
A service is provided by an organization. It should have a name and a description, and
the details are specified by service bindings, which are further detailed by specification
links. The following code snippet, which assumes that the providing organization is
known, shows how to create a new service:
Organization providingOrganization = ...; 
  
Service service = m_lcManager.createService("service name"); 
service.setProvidingOrganization(providingOrganization); 
InternationalString description = 
       lcManager.createInternationalString("service description"); 
service.setDescription(description); 
  
ServiceBinding serviceBinding = ...;  
// create service binding with specification links 
  
service.addServiceBinding(serviceBinding); 
  
ArrayList serviceList = new ArrayList(); 
serviceList.add(service); 
lcManager.saveServices(serviceList);  
// save service and related modified objects

Service that Uses Another Service
If a service calls another service, this should be modeled with the pre-defined Uses
association.
Service callingService = ...; 
Service calledService = ...; 
  
// find the "Uses" concept 
ClassificationScheme associationType = bqManager.findClassificationSchemeByNam 
e(Collections.singleton(FindQualifier.EXACT_NAME_MATCH), "AssociationType"); 
Concept usesConcept  = 
  bqManager.findConceptByPath("/" + associationType.getKey().getId() + "/Uses"); 
  
// create association of type "Uses" 
Association usesAssociation = 
    lcManager.createAssociation(calledService, usesConcept); 
  
// callingService is now the source object of the association 
callingService.addAssociation(usesAssociation);  
  
ArrayList associationList = new ArrayList(); 
associationList.add(usesAssociation); 
  
// save association and related modified objects 
lcManager.saveAssociations(associationList, false);
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Service with Additional Information
Each JAXR-based object instance may be supplied with arbitrary additional information.
JAXR uses the slot mechanism to provide this kind of extensibility.

Note: JAXR allows arbitrary strings as slot names. The CentraSite implementation
stores a slot by creating an XML element whose tag name is the slot name.
Consequently, a slot name should be a valid XML QName. If a QName has a
non-null URI, the lexical representation of the slotname is the URI enclosed in
curly braces, followed by the local-name, for example {myUri}mySlotname.

The following code snippet shows how to add a slot to a service object:
Service service = ...; 
  
Slot slot = lcManager.createSlot("{myUri}mySlotName", "slotValue", null); 
service.addSlot(slot); 
  
ArrayList serviceList = new ArrayList(); 
serviceList.add(service); 
lcManager.saveServices(serviceList);

Pre-defined Classification Schemes (Taxonomies)
The CentraSite registry has several pre-defined classification schemes:

All the classification schemes that are defined in the JAXR standard.

A classification scheme for the products using CentraSite. Thus, each registry object
can be classified with its product. This makes it easy to find all registry objects
originating from a particular product.

The name of this classification scheme is Products and its member concepts are
CentraSite and products that use CentraSite.

A classification scheme for database management systems: This can be used to
classify data sources by the type of the database management system they represent.

The name of this classification scheme is Databases and its member concepts are:
Adabas
Tamino
DB2
Enabler
MSSQL
Oracle

A classification scheme for content types: This can be used to classify external links
with their content type/MIME type.

The name of this classification scheme is Content Type.
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A classification scheme for the types of objects in the CentraSite repository: This can
be used to classify external links with their repository object type.

The name of this classification scheme is RepositoryObjectType and its member
concepts are:

BPEL
BPELObject
CustomComponent
Documentation
DTD
E-mailEvent
Emerger
FileEvent
HTML
Icon
JAR
JMSEvent
Layout
Ontology
Payload
ProjectFolder
ReportDefinition
ScheduledTask
Sequence
SOAP
Template
TypeIcon
WSDD
WSDL
XML
XSD
XSLT

Some external classification schemes used for UDDI mapping:
ClassificationGroup
Object
UseType
uddi-org:protocol:hp
uddi-org:protocol:soap
uddi-org:wsdl:address
uddi-org:wsdl:categorization:protocol
uddi-org:wsdl:categorization:transport
uddi-org:wsdl:portTypeReference
uddi-org:wsdl:types
uddi-org:xml:localName
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uddi-org:xml:namespace

CentraSite API for JAXR Reference Information
This section explains the differences between the JAXR standard and our APIs,
particularly, the CentraSite-specific extensions to the JAXR standard.

Creating User-Defined Objects
In addition to the pre-defined object types such as organizations, services, and
associations, CentraSite allows you to define your own object types. Once such a type
has been created using the CentraSite Control, a corresponding concept exists in the
ObjectType classification scheme.

To create an instance of a user-defined object type

1. Create a RegistryEntry object.

2. Classify it with the type concept.

The following code example assumes that a user-defined type {User-Uri}UserType
exists:
RegistryEntry userTypeObject 
   = (RegistryEntry)lcManager.createObject(LifeCycleManager.REGISTRY_ENTRY); 
  
// find the "{User-Uri}UserType" concept 
ClassificationScheme objectType 
   = bqManager.findClassificationSchemeByName(null, "ObjectType"); 
Concept userTypeConcept 
   = bqManager.findConceptByPath("/" + objectType.getKey().getId() 
            + "/{User-Uri}UserType"); 
  
// create classification 
Classification userTypeClassification 
   = lcManager.createClassification(userTypeConcept); 
userTypeObject.addClassification(userTypeClassification); 
  
/* 
 * from now on the userTypeObject is of type "UserType", and 
 * userTypeObject.getObjectType() will return a concept equal to 
 * userTypeConcept 
 */ 
  
// save object 
ArrayList objectList = new ArrayList(); 
objectList.add(userTypeObject); 
lcManager.saveObjects(objectList);

Direct XQuery Access to the Stored Data
A CentraSite JAXR client can call XQJ (XQuery API for Java technology) functionality
directly in order to access the registry data. JAXR also uses XQJ to access the registry.
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The CentraSiteCentraSiteConnection maintains an XQConnection object, which it uses for its
own purposes as well as for direct client access. The client can get this object as follows,
assuming JAXR-based connection is already present:
Connection jaxrCon = ...; 
XQConnection xqjCon = ((CentraSiteConnection)jaxrCon).getXQConnection();

As both the client and JAXR use the same XQJ connection, the following restrictions
apply (assuming the client uses JAXR and XQJ in parallel):

The client must not call any JAXR-based save... method if there is an open
transaction, because JAXR performs the save... methods as one atomic operation
based on an XQJ transaction.

The client should never close the XQJ connection; instead, close the JAXR-based
connection. This action cleans up anything else.

Unique Keys
This implementation does not support client supplied keys. The method
RegistryObject.setKey() displays an UnsupportedCapabilityException. CentraSite rejects client-
supplied keys.

Simultaneous Database Access and Locking
The CentraSite implementation stores all RegistryObjects in a common repository, which
is a database. If multiple JAXR-based clients (or, to be more precise, multiple JAXR-
based connections) are active simultaneously, it is possible that they might read and
update the data in the common database concurrently.

Multiple clients that update a RegistryObject must be synchronized in order to prevent
update losses. Usually, this is handled by the underlying database's locking mechanism.
However, since it is likely that many JAXR-based clients would be browsing or
searching the repository and only a few JAXR-based clients would be modifying data,
the CentraSite implementation has been optimized to allow maximum concurrent
access. In particular, if one or more JAXR-based clients are reading a RegistryObject,
another JAXR-based client may update it concurrently.

For example, if a user has opened CentraSite Control to look for a particular object
and then keeps the UI open for a protracted period (maybe even for several days), this
should not prevent other users from updating that object.

Locks for read access are therefore relatively permissive, but of course it must be
ensured that two JAXR-based clients cannot modify the same object at the same time.
This is achieved as follows:

When a JAXR-based client starts to modify a RegistryObject, JAXR acquires an exclusive
lock for this object from the database management system. This prevents any other client
from updating the same object at the same time. When the JAXR-based client saves the
modified object, the lock is released as a side-effect of calling LifeCyclemanager.saveObjects().
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Alternatively, if the JAXR-based client decides to discard the changes, it should release
the lock by calling CentraSiteConnection.rollback().

With this locking behavior, there are two principal scenarios when two JAXR-based
clients aempt to modify the same object at the same time. In order to modify an object,
the JAXR-based client always has to read it first, modify the Java instance, and then call
saveObjects() to write the modified object back to the database.

Scenario A

JAXR-based Client A JAXR-based Client B

1. Read a RegistryObject.  

 2. Read the same RegistryObject.

3. Start to modify the object. This
automatically locks the object.

 

 4. Start to modify the object. The
aempt to lock the object fails and a
LockNotAvailableException occurs.

As long as client A holds the exclusive lock for the object, client B is unable to modify it.

Scenario B

JAXR-based Client A JAXR-based Client B

1. Read a RegistryObject.  

 2. Read the same RegistryObject.

3. Start to modify the object. This
automatically locks the object.

 

4. Save the object. This releases the
lock.

 

 5. Start to modify the object. The
aempt to lock the object fails and an
ObjectOutdatedException occurs.

In scenario B, client A has finished making its changes and has released the lock, so the
lock is now available for acquisition by another client, for example client B. However,
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client B's local copy of the object does not reflect the current database status of the object,
which has been modified in the meantime by client A. If client B were allowed to save
the object, client A's modifications would be overwrien.

To avoid this, each RegistryObject has a last-modification date. When a lock is acquired,
the API checks whether the last-modification date of the object in the database is the
same as the last-modification date of the client's local copy of the object. If the dates are
not the same, an ObjectOutdatedException occurs. This ensures that updates are not lost and
that all modifications are based on the latest state of the object.

Immediately before the ObjectOutdatedException occurs, the API cleans up its internal
structures. When the client encounters the exception, it should release all references to
the RegistryObject and then re-read it. This should return the latest copy of the object
from the database; the client can now continue to make the necessary modifications to
this clean copy.

Caller
The caller identifies himself by issuing Connection.setCredentials(). The corresponding user
object is retrieved from the registry using the name given in the credentials. If the user
record does not yet exist, CentraSite returns an error message.

Note: Each user must be registered in the CentraSite registry before being used as
the caller.

Here, the user name is the name aribute as inherited from the RegistryObject interface. It
should not be confused with the user's PersonName.

The caller must be known before a connection can be used. In other words, setCredentials()
is required, otherwise a security error occurs.

Note: The user name must be unique in the CentraSite registry.

Semantics of Remove Operations
There are several methods that allow an object to be removed from its parent.
Depending on the kind of object, the remove operation has different effects.

Associations, Classifications, External Identifiers, Service Bindings, Specification Links. If
such an object is removed from its parent and the parent is then saved, the object is
automatically deleted as it cannot exist as a standalone object. Remove these objects
using the following methods:

RegistryObject.removeClassification()
RegistryObject.setClassifications()
RegistryObject.removeAssociation()
RegistryObject.setAssociations()
RegistryObject.removeExternalIdentifier()
RegistryObject.setExternalIdentifiers()
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ServiceBinding.removeSpecificationLink()
Service.removeServiceBinding()

Other Objects. Other objects are de-linked from their parents during the remove
operation. They continue to exist as separate objects. If the parent object is saved, the
removed objects are also automatically saved.

The remove operations for these objects are:
ClassificationScheme.removeChildConcept()
Concept.removeChildConcept()
Organization.removeUser()
Organization.removeService()
Organization.removeChildOrganization()
RegistryObject.removeExternalLink()
RegistryObject.setExternalLinks()
RegistryPackage.removeRegistryObject()

Delete Operation
Deleting an object means deleting it from the persistent store. Optionally, the delete
operation can be called with an objectType parameter, which is one of the pre-defined
LifeCycleManager interface names. If this parameter is specified, only objects of that type
are accepted for delete. The interface names shown in the following list are allowed for a
deletion; all others are rejected with an InvalidRequestException.

LifeCycleManager.ASSOCIATION
LifeCycleManager.CLASSIFICATION
LifeCycleManager.CLASSIFICATION_SCHEME
LifeCycleManager.CONCEPT
LifeCycleManager.EXTERNAL_IDENTIFIER
LifeCycleManager.EXTERNAL_LINK
LifeCycleManager.ORGANIZATION
LifeCycleManager.REGISTRY_ENTRY
LifeCycleManager.REGISTRY_PACKAGE
LifeCycleManager.SERVICE
LifeCycleManager.SERVICE_BINDING
LifeCycleManager.SPECIFICATION_LINK
LifeCycleManager.USER

Objects have relationships to each other: some relationships prohibit object deletion,
while other relationships are automatically cleaned up during deletion.

RegistryObject

In general, an aempt to delete a registry object is rejected if:

it is a new object, that is, it has not yet been saved, or

it is the target of an association.
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Deleting a registry object has the following side-effects:

Removes the object from all its packages; update the packages.

De-links the object from all its external links; update the external links.

Deletes all associations whose source object is the object to be deleted.

Deletes all classifications whose classified object is the object to be deleted.

Deletes all external identifiers whose registry object is the object to be deleted.

Association

1. Remove the association from its source object.

2. Update the source object. This automatically deletes the association.

AuditableEvent

It is not possible to delete an auditable event explicitly.

Classification

1. Remove the classification from its classified object.

2. Update the classified object. This automatically deletes the classification.

ClassificationScheme

1. Reject deletion if there are child concepts; else

2. Delete the classification scheme.

Concept

1. Reject deletion if there are child concepts; else,

2. Remove the concept from its parent object.

3. Update the parent object.

4. Delete the concept.

ExternalIdentifier

1. Remove the external identifier from its registry object.

2. Update the registry object. This automatically deletes the external identifier.

ExternalLink

1. Reject deletion if there are linked objects; else,

2. Delete the external link.
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Organization

1. Reject deletion if there are child organizations, services, or users; else,

2. Remove the organization from its parent organization.

3. Update the parent organization.

4. Delete the organization.

RegistryEntry

1. Delete the registry entry.

RegistryPackage

1. Reject deletion if there are member objects; else,

2. Delete the registry package.

Service

1. Remove the service from its organization.

2. Update the organization.

3. Delete all service bindings whose service is the service to be deleted.

4. Delete the service.

ServiceBinding

1. Remove the service binding from its service.

2. Delete all specification links whose service binding is the service binding to be
deleted.

3. Update the service. This automatically deletes the service binding.

SpecificationLink

1. Remove the specification link from its service binding.

2. Update the service binding's enclosing service. This automatically deletes the
specification link.

User

1. Remove the user from its organization.

2. Update the organization.

3. Delete the user.
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Unsupported Methods
The following methods are not supported and an UnsupportedCapabilityException occurs:

RegistryService.getDeclarativeQueryManager()

RegistryService.makeRegistrySpecificRequest()

Unsupported FindQualifiers
The following FindQualifiers are not supported:

COMBINE_CLASSIFICATIONS

SERVICE_SUBSET

SOUNDEX

Using Wildcards
The wildcard character, which is the percent (%) character, represents zero or more
characters. Thus, for example, the search string ABC%DEF finds all strings that begin
with ABC and end with DEF, with any number of characters in between. The search
string ABC%DEF% finds all strings that begin with ABC and include DEF anywhere
else. If you do not include a wildcard character in the search string, the search assumes
that there is a wildcard character at the end of the search string, unless the find qualifier
EXACT_NAME_MATCH is specified. Thus, for example, if you specify ABC as the search
string, the search in fact looks for and finds strings that match the paern ABC%, that is,
all strings that begin with the characters ABC.

Using Namespaces
Some names, for example type names and slot names, comprise a namespace and a
name. When programming a JAXR-based client, these names must be represented in the
following format:
{namespace}name

In other words, the namespace is enclosed in curly braces and is used as a prefix for the
name.

Strings in this format are used in the following methods:

for objectType in CentraSiteQueryManager.findObjects()

for typeName in CentraSiteQueryManager.getTypeDescription()

for name in LifeCycleManager.createSlot()

for slotName in ExtensibleObject.getSlot()
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Method createSlot
The method createSlot in the interface LifeCycleManager takes 3 parameters; its signatures
are as follows:
Slot createSlot (String name, String value, String slotType) 
Slot createSlot (String name, Collection values, String slotType)

The CentraSite implementation accepts any value of type String, or a null reference,
for the third parameter, slotType. This parameter is stored with the slot, but it is not
interpreted in any way. Note, however, that the JAXR standard does not indicate how
this parameter should be interpreted; it might, for example, be interpreted as indicating
the data type of the slot in some future implementation. Software AG recommends
specifying the slotType as an xs:string.

Caching Considerations
This section describes various aspects of caching behavior as it affects the API.

JAXR-based Caching Strategy

Objects that are retrieved from the registry by means of the CentraSite API for JAXR
are stored in a cache by the JAXR-based connection. All objects stored in the cache are
inspected from time to time by the Java garbage collector, which may delete them if
there are no references to them from the application.

Any object reference that results from a call to getRegistryObject(), getRegistryObjects() or any
of the find methods is, if possible, resolved from the cache. If an application already holds
a reference to an object that resulted from any of these calls, the reference is present in
the cache, and the call returns the same Java reference.

There are situations, however, where the cache is cleared completely. This occurs, for
example, after executing saveObjects or deleteObjects. Any Java reference that is retrieved
after the cache is cleared is different from a reference that was retrieved before the cache
is cleared.

Note: This does not affect data integrity, since objects read cannot be concurrently
updated.

Caching in User Interfaces

The CentraSite user interfaces, that is, Control, Business UI, and Eclipse, browse JAXR-
based data. This means that they make use of the JAXR-based caching mechanism, but
they do not block concurrent updates. Control, Business UI, and Eclipse users should
be aware that, in general, the data display does not immediately reflect changes that
another user may make.

Note: This does not affect data integrity in the sense that outdated data may be the
source of any updates.
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You can see the current data at any time by clicking the Refresh buon.

Dynamically Loaded JAR Files

CentraSite locally caches dynamically-loaded JAR files. You should be aware that the
date and time of the cached files are compared with the date and time of the library files
whenever a new connection is created, the JAR files in the cache are refreshed if they are
found to be out of date. This could mean that processing continues with a newer version
of a JAR file after a connection has been created.

Note: Problems may arise if a custom security manager has been implemented,
because the connection to the database is refused.

Cache Location

CentraSite uses the following strategy to determine the location of the cache store:

If the system property com.softwareag.centrasite.dynloader.cache-dir is
defined, then its value is used as the location of the cache store.

Otherwise, the location of the cache store is derived from:

1. A directory whose name is taken from the system property java.io.tmpdir.

2. A sub-directory whose name is constructed from the string CentraSite, a
package name, and the string Jars.
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Introduction to the Web Service Interfaces
This chapter describes some of the web services that CentraSite provides. You can obtain
a complete list of services at:

http://server:port/wsstack/services/listServices

Where server  is the machine on which the Software AG Runtime is running and port
is the port on which Software AG Runtime is listening (use port 53307 if CentraSite is
configured to use the default Software AG Runtime port number). For example:

http://myServer:53307/wsstack/services/listServices

The information in this chapter is intended for developers who want to integrate custom
applications or third-party tools with CentraSite using web services.

CentraSite provides the following web services for each of the predefined importers:
ImportWsdlService
ImportXsdService
ImportXPDLService
ApprovalService

As an example, this chapter describes the ApprovalService in detail.

Approval Service
The Approval service provides a set of operations that enables you to programmatically
interact with CentraSite's approval system. Using the Approval service, you can develop
client applications that let users view requests that they have submied for approval and
let approvers accept or reject these requests.

The WSDL for the Approval service is located here:

hp://server:port /wsstack/services/ApprovalService?wsdl

Where server  is the machine on which the Software AG Runtime is running and port
is the port on which Software AG Runtime is listening (port 53307 if CentraSite is
configured to use the default Software AG Runtime port number).

The following lists the operations that the Approval service provides:
getPendingApprovals
getApprovalRequests
getApprovalActions
approve
reject
getApprovalHistory
revertPendingStateChange
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Invoking Operations from the Approval Service
You can perform the invoking operations from the approval service by specifying the
authenticated user or by specifying the location of the approval log.

Specifying the Authenticated User

The Approval service returns results that are specific to the authenticated user (that is,
the user who invokes the operation). For example, when a client application invokes the
getPendingApprovals operation, the operation returns the set of approval requests that
require the authenticated user's approval.

The authenticated user is identified by the basic hp authentication credentials that the
client application provides when it invokes an operation in the Approval service. The
supplied credentials must identify an active user account on the instance of CentraSite
to which the client application is connecting. If the client application submits invalid
credentials, the Approval service returns a SOAP fault.

Specifying the Location of the Approval Log

All of the operations provided by the Approval service have an input parameter called
locationCentraSite. This parameter identifies the address of the CentraSite registry
or repository whose approval log is to be queried. A client application must specify the
locationCentraSite parameter if the registry or repository is running anywhere other
than its default location (that is, port 53307 on the machine where the Approval service
is running).

If the registry or repository is running at its default location, a client does not have to
specify the locationCentraSite parameter.

Retrieving the List of Approval Requests that a User Has Submitted
You can use the getApprovalRequests operation to retrieve the list of approval requests
that the authenticated user has submied to CentraSite. By default, this operation
returns all the approval requests that a user has submied. However, you can optionally
set the objectType, submittedAfter, submittedBefore, and status parameters to
filter the list by the following criteria:

The type of object on which the request was submied

The time period during which the request was submied

The status of the request (for example, retrieve only those requests that have not yet
been approved)

You would use this operation, for example, to show users a list of their requests that are
pending approval.

Tip: This operation provides functionality like that of the Approval Requests list in
CentraSite Control.
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ApprovalRequestList Message

The getApprovalRequests operation (and other operations provided by the Approval
service) returns an ApprovalRequestList message. This message contains an array of
ApprovalRequest elements. Each ApprovalRequest element in the array represents a
single approval request and contains the following information:

The key of the approval request object (this key is required to perform operations
that act directly on a specific approval request)

The key of the user who submied the approval request

The date on which the approval request was submied

The key of registry object for which the approval request was submied

The type of object for which the approval request was submied

The status of the request

Remarks, if any, that were submied with the approval request

The approval requests in the array are not sorted.

The ApprovalRequestList message also returns an aribute called count that indicates
the total number of approval requests in the result set. If the operation does not find any
approval requests that satisfied the operation's criteria, then no element is returned in
ApprovalRequest[] and the count value is zero.

If you want to receive the result, set a few entries at a time instead of all at once, you can
use the scroll parameter in the request message to specify which block of entries you
want the operation to return. For more information about using the scroll parameter,
see Scrolling Through the List of Returned Approval Requests.

Getting Details about the Actions of the Approvers Associated with a Request

Once you have an ApprovalRequestList, you can use the getApprovalActions operation
to obtain detailed information about the approvers associated with any request in the
list.

The getApprovalsActions operation takes an approval request key as input (which you
can get from the ApprovalRequestList) and returns the set of approvers associated with
the specified request. (You can specify multiple keys if you want to get the details for
multiple approval requests.)

The getApprovalsActions operation returns an ApprovalActionResult message. The
ApprovalAction[] array in this message identifies the set of approvers associated with
a particular approval request. Each ApprovalAction element in this array contains the
following information:

The key for the approver (that is, the key to the User object that represents the
approver)

The status of the approver's action on this request is as follows:
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If the request has not yet been processed to completion (that is, it has not yet
been approved or rejected) and the approver has not taken any action on the
request, then the status is Pending.

If the approver has approved the request, then the status is Approved.

If the approver has rejected the request, then the status is Rejected.

If the request has been processed to completion (that is, it has been approved or
rejected), approvers who did not make the approval decision have the status as
No Action. (If the approval request was auto-approved, all of the approvers have
the status as No Action.)

Tip: This operation provides functionality like that of the Approval Requests list
when you use CentraSite Control to display the details for an approval
request.

Approving or Rejecting Approval Requests
To enable a user to approve or reject a request

1. Use the getPendingApprovals operation to obtain the list of requests that require the
user's approval.

2. Apply the approve or reject operation to the requests in the list according to the
approval decisions that the user makes.

When you invoke the approve or reject operation, you must specify the key of the
approval request on which the operation is to act. You can obtain this key from
the ApprovalRequestList message that was returned by the getPendingApprovals
operation.

Note: You can apply the approve or reject operation to a single approval request
or to multiple requests.

The approve and reject operations return an ApprovalRequestList message. This
message contains the approval requests that were approved or rejected by the
operation.

Tip: This operation provides functionality like that of the Pending Approvals list
in CentraSite Control.

Scrolling Through the List of Returned Approval Requests
The getPendingApprovals, getApprovalRequests, and getApprovalHistory
operations each return an array of approval requests (that is, their result set) in an
ApprovalRequestList message. In certain cases, the result set can be quite large (for
example, if you were to retrieve the entire Approval History log). Instead of receiving
the entire result set in a single message, you can use the scroll parameter to retrieve
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the results in blocks of a specified size (for example, 15 entries at a time). For example,
you might use this feature to display when an approval requests a page at a time in your
client application.

To receive a specified block of results, set the following elements in the scroll
parameter when you invoke the getPendingApprovals, getApprovalRequests, and
getApprovalHistory operation.

In this element... Specify...

start The first element in the block that you want to retrieve
(where 1 represents the first element in the entire set of
results).

number The total number of elements that you want to retrieve in
that block (that is, the size of the block).

For example, let's say you are using the getApprovalHistory operation, and you want to
retrieve the contents of the log 20 entries at a time. To do this you would:

Invoke... Set... Set...

getApprovalHistory scroll.start = 1 scroll.number = 20

getApprovalHistory again scroll.start = 21 scroll.number = 20

getApprovalHistory again scroll.start = 41 scroll.number = 20

You would continue until you reach the end of the result set.

To determine that you have reached the end of the result set, you can check the value
in the count parameter in the ApprovalRequestList. This parameter reports the total
number of entries in the entire result set.

Note: If the last block in the set contains fewer entries than what you specify in
scroll.number, the operation returns the remaining entries in that last block.
If the element that you specify in scroll.start does not exist in the result
set, the operation returns an empty list.

Reverting a Pending Approval Request
There might be times when you need to retract a pending request from the approval
system. For example, if a request that is awaiting approval requires the approval of a
user who has left the company, the request can be stuck in pending mode. To resolve
this condition, you must remove that request from the approval system and resubmit it
(after updating the approver group).
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When you have an approval request that is stuck in the pending mode, you can use the
revertPendingStateChange operation to remove the request from the approval system.
This operation also reverts the object that was pending approval to its previous state so
that a user can submit the object for approval again.

Note: When you invoke this operation, you must specify the key of the registry
object whose state you want to revert. You can obtain this key from the
approval request that is stuck in pending mode. (You would need to retrieve
that request and the object's key, using one of the operations that returns an
ApprovalRequestList.)

This operation returns a revertPendingStateChangeResponse message. The value of
the revertedState parameter in this message reports the lifecycle state of the object
on which the revertPendingStateChange operation was executed. For example, if you
execute this operation on an object whose lifecycle state is pending a change from
state A to state B, the operation reverts the object to state A and returns state A in the
revertedState parameter.

Note: Only users in the CentraSite Administrator role are permied to execute
the revertPendingStateChange operation. If the authenticated user is not a
member of this role, the operation returns a SOAP fault.

Approval Service Operations
This secon describes the various operaons that the Approval service provides.

getPendingApprovals

This operation returns a list of the approval requests that are awaiting the authenticated
user's approval (where the authenticated user is the user who invoked the
getPendingApprovals service). You can optionally filter the list by object type and
submission date.

Input Message

Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite registry
or repository from which you want to retrieve the approval
requests. The registry or repository runs at the following
URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CentraSite
registry or repository is running and port  is the port on
which Apache is configured to listen for requests (port
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Parameter Name Description
53307 if CentraSite is configured to use the default Apache
port number).

If you do not specify locationCentraSite, the Approval
service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

objectType (Optional). (String). (Array). If you want to retrieve
approval requests for only certain object types, use this
element to specify the types by name.

Note: You must specify the type's schema name, not its
display name. You can find the schema name on the
type's Asset Type Details page in CentraSite Control.

submittedAfter (Optional). (DateTime). If you want to retrieve requests
after a particular date, specify that date in this element.

submittedBefore (Optional). (DateTime). If you want to retrieve requests
before a particular date, specify that date in this element.

locale (Optional). (String). The locale in which you want the
results to be returned.

(Optional). (Scroll). If you want to return a particular block
of entries from the result set, specify the following values
in the scroll element.

start (Integer). The first entry that you want to
include in the block (where 1 represents the first
entry in the entire result set).

scroll

number (Optional). (Integer). The number of entries to be
returned in the block of approval requests.

If you specify a start value, but no number
value, then the remainder of the result set is
returned.

Output Message

ApprovalRequestList
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getApprovalRequests

This operation returns the list of requests that the authenticated user has
submied for approval (where the authenticated user is the user who invoked
the getApprovalRequests service). You can optionally filter the list by object type,
submission date, and approval status.

Input Message

Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite registry
or repository from which you want to retrieve the
approval requests. The registry or repository runs at the
following URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CentraSite
registry or repository is running and port  is the port on
which Apache is configured to listen for requests (port
53307 if CentraSite is configured to use the default Apache
port number).

If you do not specify locationCentraSite, the Approval
service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

(Optional). (String). If you want to retrieve only requests
with a specified approval status, specify one of the
following values:

Specify... To retrieve...

In
Progress

Approval requests that are pending
(awaiting approval).

Approved Approval request that have been approved
(excluding requests that were auto-
approved).

Rejected Approval requests that have been rejected.

status

No
Action

Approval requests that were auto-approved.
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Parameter Name Description

objectType (Optional). (String). (Array). If you want to retrieve
approval requests for only certain object types, specify the
types by name in this element.

Note: You must specify the type's schema name, not its
display name. You can find the schema name on the
type's Asset Type Details page in CentraSite Control.

submittedAfter (Optional). (DateTime). If you want to retrieve requests
after a particular date, specify that date in this element.

submittedBefore (Optional). (DateTime). If you want to retrieve requests
before a particular date, specify that date in this element.

locale (Optional). (String). The locale in which you want the
results returned.

(Optional). (Scroll). If you want to return a particular
block of entries from the result set, specify the following
values in the scroll element:

start (Integer). The first entry that you want to
include in the returned block of approval
requests (where 1 represents the first entry
in the entire result set).

scroll

number (Optional). (Integer). The number of entries
to be returned in the block of approval
requests.

If you specify a start value, but no number
value, then the remainder of the result set is
returned.

Output Message

ApprovalRequestList

getApprovalActions

This operation returns detailed information about specified approval requests.

Input Message
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Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite
registry or repository from which you want to retrieve
the approval requests. The registry or repository runs at
the following URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CentraSite
registry or repository is running and port  is the port
on which Apache is configured to listen for requests
(port 53307 if CentraSite is configured to use the default
Apache port number).

If you do not specify locationCentraSite, the
Approval service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

approvalRequestKeys (String). (Array). he keys for the approval requests
whose details you want to retrieve.

locale (Optional). (String). The locale in which you want the
results returned.

Output Message

ApprovalActionResult

approve

This operation approves specified approval requests.

Input Message

Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite
registry or repository on which the approval requests
reside. The registry or repository runs at the following
URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CentraSite
registry or repository is running and port  is the port
on which Apache is configured to listen for requests
(port 53307 if CentraSite is configured to use the default
Apache port number).
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Parameter Name Description

If you do not specify locationCentraSite, the
Approval service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

approvalRequestKeys (String). (Array). The keys for the requests that are to be
approved.

comment (Optional). (String). A comment from the approver.

locale (Optional). (String). The locale in which you want the
results returned.

Output Message

ApprovalRequestList (contains the requests that were approved)

reject

This operation rejects the specified approval requests.

Input Message

Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite
registry or repository on which the approval requests
reside. The registry or repository runs at the following
URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CentraSite
registry or repository is running and port  is the port
on which Apache is configured to listen for requests
(port 53307 if CentraSite is configured to use the default
Apache port number).

If you do not specify locationCentraSite, the
Approval service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

approvalRequestKeys (String). (Array). The keys for the requests that are to be
rejected.

comment (Optional). (String). A comment from the approver.
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Parameter Name Description

locale (Optional). (String). The locale in which you want the
requests returned.

Output Message

ApprovalRequestList (contains the requests that were rejected)

getApprovalHistory

This operation returns entries from the approval history log based on specified search
criteria. If the user belongs to the CentraSite Administrator role, he or she receives all
entries in the log. If the user belongs to the Organization Administrator role, he or she
receives all log entries for his or her organization. Otherwise, the user receives only
those approval requests that he or she has submied.

Input Message

Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite registry
or repository on which the approval history log resides.
The registry or repository runs at the following URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CentraSite
registry or repository is running and port  is the port on
which Apache is configured to listen for requests (port
53307 if CentraSite is configured to use the default Apache
port number).

If you do not specify locationCentraSite, the Approval
service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

(Optional). (String). If you want to retrieve only requests
with a specified approval status, specify one of the values
shown here:

Specify... To retrieve...

status

In
Progress

Approval requests that are pending (that is,
awaiting approval).
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Parameter Name Description

Approved Approval requests that have been approved
(excluding requests that were auto-
approved).

Rejected Approval request that have been rejected.

No
Action

Approval requests that were auto-approved.

objectType (Optional). (String). (Array). If you want to retrieve
approval requests for only certain object types, specify the
types by name in this element.

Note: You must specify the type's schema name, not its
display name. You can find the schema name on the
type's Asset Type Details page in CentraSite Control.

submittedAfter (Optional). (DateTime). If you want to retrieve requests
after a particular date, specify that date in this element.

submittedBefore (Optional). (DateTime). If you want to retrieve requests
before a particular date, specify that date in this element.

locale (Optional). (String). The locale in which you want the
results returned.

(Optional). (Scroll). If you want to return a specified block
of entries from the result set, specify the following values
in the scroll element.

start (Integer). The first entry that you want to
include in the block (where 1 represents the
first entry in the entire result set).

scroll

number (Optional). (Integer). The number of entries
to be returned in the block.

If you specify a start value, but no number
value, the remainder of the result set is
returned.

Output Message

ApprovalRequestList
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revertPendingStateChange

This operation removes an object that is pending approval from the approval system,
and returns the object to its prior lifecycle state. Only users that belong to the CentraSite
Administrator role can execute this operation.

Input Message

Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite
registry or repository on which the object resides. The
registry or repository runs at the following URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CentraSite
registry or repository is running and port  is the port
on which Apache is configured to listen for requests
(port 53307 if CentraSite is configured to use the default
Apache port number).

If you do not specify locationCentraSite, the
Approval service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

key (String). The key of the object whose state you want to
revert.

Output Message

revertPendingStateChangeResponse

Parameter Name Description

revertedState (String). The lifecycle state to which the object was reverted by
the revertPendingStateChange operation. For example, if you
executed this operation on an object whose state was pending a
change from state A to state B, the operation would return state
A in the revertedState parameter.

ApprovalRequestList

This data structure holds a list of approval requests.
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Parameter Name Description

An array of ApprovalRequest elements. Each
ApprovalRequest entry in the array represents one
approval request and has the following structure:

name (Optional). (String). The name of the
approval request (as specified by the
Approval Flow Name parameter in
the approval policy action).

ApprovalRequest[]

requestor (String). The key that identifies the
user who submied the approval
request.

 registryObject (String). The key of the registry object
on which the user is requesting
approval.

 requestType (String). The type of event that
triggered the approval request (for
example, Pre-State Change).

 reasonForRequest (Optional). (String). The remark (if
any) that was assigned to the request
by the approval policy action.

 key (String). The approval request's key.

 (String). The state of the approval
request. The value of this element will
be one of the following:

 Value Description

 

status

In
Progress

The approval request
is pending (that is,
awaiting approval).

  Approved The approval request
has been approved.

  Rejected The approval request
has been rejected.
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Parameter Name Description

  No
Action

The approval request
was auto-approved.

 submittedDate (DateTime). The date on which the
request was submied for approval.

(Optional). (String). The scroll values, if any, that were
submied when the operation that produced this
ApprovalRequestList was invoked.

start (Integer). The start value that was
specified in the input message when
the operation was invoked.

scroll

number (Integer). (Optional). The number
value that was specified in the input
message when the operation was
invoked.

count (Number). The number of approval requests in the entire
result set.

ApprovalActionResult

This data structure holds the details for a specified set of approval requests.

Parameter Name and Description

ApprovalActionList[]  

An array of ApprovalActionList elements. Each ApprovalActionList entry in the
array holds the details for one approval request and has the following structure:

ApprovalAction[]
ApprovalRequestKey

(String). The key to the approval request.

An array of ApprovalAction elements. Each
ApprovalAction element in the array holds the approval
details for one approver. This array contains one
entry for each approver in the approver group. Each
ApprovalAction element has the following structure:

 approver (String). The key that identifies the user
who is the approver.
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Parameter Name and Description

 statuscomment (Optional). (String). A remark from
the approver (typically indicating why
he or she approved or rejected the
request).

  (String). The approver's decision on
the request. Possible values are shown
below:

Pending

The approver has not taken action on
the request.

Approved

The approver approved the request.

Rejected

The approver rejected the request.

No Action

The request has been approved or
rejected, however, this approver did
not make the approval decision on the
request. This can also indicate that the
request was auto-approved.

Search Service Operations
The Search service provides a set of operations that supplies various information about
registered services inside CentraSite.

The WSDL for the Search service is located here:
http://server:port/wsstack/services/SearchService?wsdl

where server is the machine in which the Software AG Runtime is running and port
is the port on which the Software AG Runtime is listening (port 53307 if CentraSite is
configured to use the default Software AG Runtime port number).

The following lists the operations that the Search service provides:

findAllServices

findServices

findOrganizations

getAllServiceDetails
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getServiceDetails

getAllAssociatedServices

getAssociatedServices

findServices and findAllServices

The findServices operation returns a list of services in CentraSite. You can optionally
filter the list by specific criteria.

The findAllServices operation, in addition, returns a list of registered services in
Integration Server.

Input Message

Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite registry
repository (CRR) from which you want to retrieve the
search requests. The registry or repository runs at the
following URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CRR is running
and port  is the port on which CentraSite is listening to
requests.

If you do not specify locationCentraSite, the Search
service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

keyword (Mandatory). (String). The paern for matching an exact
service name or %, or * for matching all services.

organizationKey (Optional). (String). (Array). The UDDI key or the
organization name where the services belong to.

owner Optional). (String). (Array). The first and last name of the
owner of services to be selected. The first and last name
must be separated with a ,.

lifeCycleStateName (Optional). (String). The name of a valid lifecycle state
currently active with the service type. Only the services
matching that lifecycle state will be selected. You may
specify multiple lifecycle state name elements to match
more states.
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Parameter Name Description

product (Optional). (String). A product name the service is
classified with. If specified it must be a valid name among
the Products taxonomy of CentraSite, for example, ARIS.
You may specify multiple product name elements to match
more product classifications.

locale (Optional). (String). The locale in which you want the
results to be returned.

sortCriteria Sort criteria for returning the result in a sorted order.
Possible values are:

SortByNameAsc

SortByNameDesc

SortByDateAsc

SortByDateDesc

Organization

(Optional). (Scroll). If you want to return a particular block
of entries from the result set, specify the following values
in the scroll element.

start (Integer). The first entry that you want to
include in the block (where 1 represents the first
entry in the entire result set).

scroll

number (Optional). (Integer). The number of entries to be
returned in the block of approval requests.

If you specify a start value, but no number
value, then the remainder of the result set is
returned.

Output Message

ServiceInfo[]

Parameter Name Description

ServiceInfo - An array of ServiceInfo elements. Each ServiceInfo entry
represents one registered service. The ServiceInfo message has the following
details:
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Parameter Name Description

key The UDDI key of the service.

name The display name of the service.

wsdlURL The URL of the service’s WSDL in the CentraSite
repository.

lifeCycleState The name of the current lifecycle state

owner The user who created the service.

organizationKey The UDDI key of the organization which owns the service.

organizationName The organization which owns the service.

version The user-assigned version identifier for the service.

Example SOAP Request

Returns the first 10 services for a particular organization, sorted by name in ascending
order:
<soapenv:Body>
  <findAllServices>
    <locationCentraSite></locationCentraSite>
    <keyword>*<keyword>
    <organizationKey>uddi:207ff1cc-25c5-544c-415c-5d98ea91060c
                                            </organizationKey>
    <owner></owner>
    <product></product>
    <locale>EN</locale>
    <sortCriteria>SortByNameAsc</sortCriteria>
    <scroll>
     <start>1</start>
     <number>10</number>
    </scroll>
  </findAllServices>
</soapenv:Body>

findOrganizations

The findOrganizations operation returns a list of organizations in CentraSite. You can
optionally filter the list by specific criteria.

Input Message
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Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite registry
repository (CRR) from which you want to retrieve the
search requests. The registry or repository runs at the
following URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CRR is running
and port  is the port on which CentraSite is listening to
requests.

If you do not specify locationCentraSite, the Search
service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

keyword (Mandatory). (String). The paern for matching an
exact organization name or %, or * for matching all
organizations.

locale (Optional). (String). The locale in which you want the
results to be returned.

sortCriteria Sort criteria for returning the result in a sorted order.
Possible values are:

SortByNameAsc

SortByNameDesc

SortByDateAsc

SortByDateDesc

Organization

(Optional). (Scroll). If you want to return a particular block
of entries from the result set, specify the following values
in the scroll element.

start (Integer). The first entry that you want to
include in the block (where 1 represents the first
entry in the entire result set).

scroll

number (Optional). (Integer). The number of entries to be
returned in the block of approval requests.
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Parameter Name Description

If you specify a start value, but no number
value, then the remainder of the result set is
returned.

Output Message

OrganizationInfo[]

Parameter Name Description

OrganizationInfo - An array of OrganizationInfo elements. Each
OrganizationInfo entry represents one organization. The OrganizationInfo
message has the following details:

key The UDDI key of the organization.

name The display name of the organization.

description The description for the organization.

Example SOAP Request

Returns information for the organization myorg :
<soapenv:Body>
  <findOrganizations>
    <locationCentraSite>
      http://localhost:53305/CentraSite/CentraSite
    </locationCentraSite>
    <keyword>myorg</keyword>
    <locale>DE</locale>
    <sortCriteria></sortCriteria>
  </findOrganizations>
</soapenv:Body>

getServiceDetails and getAllServiceDetails

The getServiceDetails operation returns a detailed information about a particular
service in CentraSite. You can optionally filter the list of service information by specific
criteria.

The getAllServiceDetails operation, in addition, returns a list of additional
properties for the service.

Input Message
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Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite registry
repository (CRR) from which you want to retrieve the
search requests. The registry or repository runs at the
following URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CRR is running
and port  is the port on which CentraSite is listening to
requests.

If you do not specify locationCentraSite, the Search
service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

serviceKey (Optional). (String). (Array). The UDDI key of the service.

locale (Optional). (String). The locale in which you want the
results to be returned.

Output Message

ServiceDetail[]

Parameter Name Description

ServiceDetail - An array of ServiceDetail elements for each of the service. The
ServiceDetail message has the following details:

key The UDDI key of the service.

name The display name of the service.

wsdlURL The URL of the service’s WSDL in the CentraSite
repository.

lifeCycleState The name of the current lifecycle state

owner The user who created the service.

organizationKey The UDDI key of the organization which owns the service.

organizationName The organization which owns the service.
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Parameter Name Description

version The user-assigned version identifier for the service.

property service namespace - The target namespace of the service.

OperationInfo[] - An array of OperationInfo for the service.

key The UDDI key of the service.

name The display name of the service.

description The description for the service.

property input - The input message.

output - The output message.

Example SOAP Request

Returns detailed information for two particular services:
<soapenv:Body>
  <getServiceDetails>
    <locationCentraSite></locationCentraSite>
    <serviceKey>uddi:372ad925-d207-11e4-8844-ad99cc9211e8</serviceKey>
    <serviceKey>uddi:65f11014-c8b8-11e4-9dd8-c736d339af26</serviceKey>
    <locale></locale>
  </getServiceDetails>
</soapenv:Body>

getAssociatedServices and getAllAssociatedServices

The getAssociatedServices operation returns information about services that are
associated to a particular service in CentraSite. You can optionally filter the list of service
information by specific criteria.

Input Message

Parameter Name Description

locationCentraSite (Optional). (String). The address of the CentraSite registry
repository (CRR) from which you want to retrieve the
search requests. The registry or repository runs at the
following URL:

hp://server:port /CentraSite/CentraSite

Where server  is the machine on which the CRR is running
and port  is the port on which CentraSite is listening to
requests.
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Parameter Name Description

If you do not specify locationCentraSite, the Search
service uses the following default URL:

hp://localhost:53307/CentraSite/CentraSite

assetKey (Optional). (String). (Array). The UDDI key of the service.

associationType (Optional). (String). The name of the association type,
for example, Uses, through which the asset references a
service.

Output Message

ServiceDetail[]

Parameter Name Description

ServiceDetail - An array of ServiceDetail elements for each of the service. The
ServiceDetail message has the following details:

key The UDDI key of the service.

name The display name of the service.

wsdlURL The URL of the service’s WSDL in the CentraSite
repository.

lifeCycleState The name of the current lifecycle state

owner The user who created the service.

organizationKey The UDDI key of the organization which owns the service.

organizationName The organization which owns the service.

version The user-assigned version identifier for the service.

property service namespace - The target namespace of the service.

OperationInfo[] - An array of OperationInfo for the service.

key The UDDI key of the service.
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Parameter Name Description

name The display name of the service.

description The description for the service.

property input - The input message.

output - The output message.
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Introduction to Java Management Interface
Use the CentraSite Java Management Interface to manage the CentraSite Registry or
Repository. With the CentraSite Java Management Interface, you can:

Monitor certain parameters of the CentraSite Registry or Repository.

Change certain parameters of the CentraSite Registry or Repository. CentraSite
parameters are known here as aributes.

Perform operations such as starting and stopping the CentraSite Registry or
Repository.

The JMX-based CentraSite Java management Interface is provided as an open MBean
(managed bean) that interfaces to CentraSite.

To activate the CentraSite Java Management Interface, the MBean must be registered
in an MBeanServer, which must run on the same host as the CentraSite Registry or
Repository.

The CentraSite Java management interface is based on the Java Management Extensions
(JMX) standard and the Java Management Extensions so that it can be used with JMX
MBeanServers that are based on this standard.

Recent version of Java contains a JMX MBeanServer that can be requested by the
ManagementFactory class.

If no other MBeanServer is running, you can have a look at the CentraSite Java
Management Interface by registering the MBean by the MBeanServer of a Java process.
Add the following three lines to the Java code:
MBeanServer mbs = ManagementFactory.getPlatformMBeanServer(); 
ObjectName csAdmin = new ObjectName("CentraSite:id=CentraSiteAdminImp"); 
mbs.createMBean("com.centrasite.jmx.admin.CentraSiteAdminImpl", csAdmin);

For correct operation of the MBean, the following points must be fulfilled:

The name of the MBean must be an ObjectName. In our case, it is
CentraSite:id=CentraSiteAdminImp

The CLASSPATH must include the following JAR files:

<CentraSiteInstall_Directory> /rts/jmx/CentraSiteJMXAdmin.jar

<CentraSiteInstall_Directory> /rts/jmx/CentraSiteJMXAdmin-L10N.jar

<CentraSiteInstall_Directory> /rts/jmx/CentraSiteAdminAPI.jar

<CentraSiteInstall_Directory> /rts/bin/inmUtil.jar

<CentraSiteInstall_Directory> /rts/bin/inmUtilConf.jar

<CentraSiteInstall_Directory> /rts/bin/log4j.jar

The PATH must include the <CentraSiteInstall_Directory> /bin directory.
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Other system properties may be required, depending on the environment. For
example, to use JConsole, the Java process must be started with the following Java
system property:
-Dcom.sun.management.jmxremote

Note: The above example shows how the CentraSite Java Management Interface
works for the default MBean server of a JVM. In a production environment
the integration in a MBean server may be different.

The CentraSite Java Management Interface works with Java version 5.0.

Attributes and Operations
The following sections describe the aributes and operations used in the Java
Management Interface.

Attributes

Each aribute corresponds to a CentraSite parameter. The name, type, access mode (R =
read-only; RW = read and write), current value, and description of each of the following
aributes are output, for example, through the CentraSite Java Management console.

cache size
The size of the cache, in megabytes. If you change this aribute, the CentraSite Registry
or Repository is automatically restarted to activate the new value.

max threads
The maximum number of threads used. If you change this aribute, the CentraSite
Registry or Repository is automatically restarted to activate the new value.

max users
The maximum number of users that can be active concurrently. If you change this
aribute, the CentraSite Registry or Repository is automatically restarted to activate the
new value.

non-activity timeout
The session timeout period, in seconds. If no activity has occurred in a session for this
period of time, the changes are rolled back and the session is terminated. If you change
this aribute, the change takes effect immediately.

state
The current state of the CentraSite Registry or Repository. You cannot change this value.

transaction timeout
The maximum transaction duration, in seconds. If you change this aribute, the change
takes effect immediately.
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Registry or Repository Start and Stop Operations

The CentraSite Java Management Interface provides access to the following operations.
For each operation that has one or more parameters, the name, type, and description of
each parameter are output and the value of each parameter can be input. If you access
the CentraSite Java Management Interface using console software (for example, a web
browser), the operation is initiated when you select Invoke.

Start the CentraSite Registry or Repository

Stop the CentraSite Registry or Repository in normal mode

Stop the CentraSite Registry or Repository in the specified mode

Possible termination modes are:

Code Meaning

0 (normal) Terminates the server session normally and waits for the current
active processing to finish. The maximum waiting time (in
seconds) can be set with the aribute transaction timeout.

1 (rollback) Terminates the server immediately. User transactions that have
not finished are rolled back.

2 (abort) Terminates the server session immediately. The processing is
immediately stopped. Crash dump files are wrien. Using this
option initiates an automatic repair (autorepair) the next time the
server is started.

Back up the contents of the CentraSite Registry or Repository. Write the backup file
to the default location.

Back up the contents of the CentraSite Registry or Repository. Write the backup file
to the specified location.

Back up the CentraSite Registry or Repository, writing the backup file to the
default location or to the specified location. In either case, the backup identification
is returned. Also, the backup is listed in the output of the list all backups
operation. A backup is done to freeze the current state of the CentraSite Registry or
Repository.

Restore the contents of the CentraSite Registry or Repository from the latest backup
with or without recovery.

Restore the contents of the CentraSite Registry or Repository from the specified
backup with or without recovery.

The restore operation can only be used when the CentraSite Registry or Repository
is not active. It is used to restore the CentraSite Registry or Repository to the state
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that was stored in a previous backup. If you want to restore the most recent backup,
you do not have to specify the identification of the backup.

Repository changes that occur between one backup and the next are stored in session
logs. When restoring from a backup, you can optionally include (with recovery) or
omit (without recovery) the session log data.

Delete the specified backup file.

A backup that is no longer required can be deleted. Deleting a backup removes the
backup spaces but the associated session log data is not removed, since it may be
needed if the database has to be recovered. The backup file to be deleted is specified
by means of the backup identification.

List all backups.

Creates a list of CentraSite Registry or Repository backups. Each entry contains the
corresponding backup identifier.

Show more information about the last operation.

Shows additional information about the most recently processed command.
Additional information can be displayed for the following operations: start, stop,
back-up, restore, delete backup. If an operation fails, this command can be used
to find the reason for the failure.
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Customization of CentraSite Business UI
This section describes the CentraSite Business UI's pluggable architecture. You can
extend CentraSite Business UI's functionality by adding your own features with
appropriate widgets and JavaScripts. The CentraSite Business UI extension framework
is a plug-in to a core infrastructure, in other words, the core infrastructure provides
extension points where CentraSite Business UI extension framework is plugged in. The
core infrastructure comprises of the CentraSite Business UI built on top of the Google
Web Toolkit (GWT), which provides the widget classes for CentraSite.

The following figure illustrates the pluggable architecture:

Extensions are implemented as widgets. The points in the code at which extensions can
be added are called extension points. CentraSite Business UI offers extension points that
allow you to implement or extend the following features:

Provide an alternative login screen.

Provide an alternative screen for requesting an account.

Extend the search dialog by additional search conditions.

Replace the standard asset details view.

Extend the set of available actions in the asset's details page.
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CentraSite Business UI Configuration Files
When you start Software AG Runtime, property seings in the centrasite.xml files
determine the features of the CentraSite Business UI

Configuration File Location Description

<CentraSiteInstall_Directory> \cast
\cswebapps\BusinessUI
\system\conf

Contains property seings that are installed
for the CentraSite Business UI. Throughout
this document, we use the term system
configuration file when referring to this
standard system file.

Important: Do not modify the contents of this file
unless asked to do so by Software AG.

<CentraSiteInstall_Directory> \cast
\cswebapps\BusinessUI
\custom\conf

Contains properties that modify the installed
seings in the system configuration file.
Throughout this document, we use the term
custom configuration file when referring to this
customizable file.

Modify this file, if you want to modify the
property seings for the CentraSite Business
UI.

Customizing CentraSite Login Page
The Login page used to access CentraSite Business UI can be customized to suit your
requirements. You can change the logos used, colors, text, time formats, and layouts. You
can also define links that navigate you to the Welcome page or guest access page, the
user registration, and Take a Tour link of the CentraSite Business UI.

The standard Login page contains a header section, a login section, and a footer section.
The following figure depicts the schematic layout of the Login page:
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The header section displays the company logo. You can change the company logo and
colors used to display the logo or hide the logo as part of the page customization. You
can change the product name and the individual field labels and change the font and
color used to display them. You can optionally choose to hide the product name as part
of the page customization.

The footer section shows the copyright information. You can hide the copyright
information as part of the page customization.

To customize and install the customized login page

1. Stop Software AG Runtime.

2. Customize the Login page configuration.

The standard configuration file centrasite.xml delivered with the CentraSite kit
contains all of the names of the CentraSite Business UI extension points, including
the extension point for the Login page configuration. You must create a copy of
the extension point for the Login page configurations in the customization file,
centrasite.xml, in order to define a customized Login page. For more information, see
“CentraSite Login Page Configuration” on page 65.

You can find the customization file, centrasite.xml, on
<CentraSiteInstall_Directory> \cast\cswebapps\BusinessUI\custom\conf.
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3. Start Software AG Runtime.

The changes incorporated are now visible in the Login page.

CentraSite Login Page Configuration
The element <GUIConfiguration> in the centrasite.xml file contains the properties
for customization of CentraSite Business UI. The Login page configuration includes
configuring the header, content panel, and the footer.

Note: Make sure that you specify an image file using its relative path in the
<CentraSiteInstall_Directory> \cast\cswebapps\BusinessUI\custom\images
directory. In a Windows environment, use forward slashes instead of
backward slashes in the path name.

Header Configuration

Layout
Component

Configuration Property Description

CENTRASITE
BY SOFTWARE
AG

BlueFlagCompanyLogo Contains property seings that are
used to modify the company logo in
the Login page of CentraSite Business
UI.

To modify the company logo,
configure the property statement:
<BlueFlagCompanyLogo
tooltip="CS_MSG_INMBX_LBL_PAGE_TITLE">
images/custom/
centrasite_by_sag_stacked.png
</BlueFlagCompanyLogo>

Content Panel Configuration

Layout
Component

Configuration
Property

Description

Welcome
Please Log in

LoginProductLogo Contains property seings that are
used to modify the CentraSite login
information in the Login page of
CentraSite Business UI.

To modify the CentraSite login
information, configure the property
statement:
<LoginProductLogo
tooltip="CS_MSG_INMBX_LBL_PAGE_TITLE">
images/custom/
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Layout
Component

Configuration
Property

Description

img_CentraSite_loginscreen.png
</LoginProductLogo>

loginAsGuest Contains property seings that are used
to modify the Access as Guest link.

If the aribute loginAsGuest is set to
true, then the Login page is skipped
and the Welcome page appears to users
when accessing CentraSite Business UI.
This allows anonymous users to skip
the Login screen and access the registry
anonymously. You can perform a login by
clicking the Log in link in the masthead of
CentraSite Business UI.

If the aribute loginAsGuest is set to
false, then the Login page appears to
users when accessing the CentraSite
Business UI.

Access as
Guest (link)

Guest
visibility

Contains property seings that are used
to modify the Access as Guest link.

If the aribute visibility is set to true,
then the Access as Guest link will appear
in the Login page of CentraSite Business
UI.

If the aribute visibility is set to
false, then the Access as Guest link will
not appear in the user interface. This
prevents anonymous users from skipping
the Login page and accessing the registry
anonymously.

To enable or disable the Access as Guest
link, configure the property statement:
<Guest visiblity="true" />

Remember me
(check box)

RememberMe Contains property seings that are used
to modify the Remember me check box.

If the aribute visiblity is set to true,
then the Remember Me check box will
appear in the Login page of CentraSite
Business UI. This helps users to store the
specified login credentials as a cookie and
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Layout
Component

Configuration
Property

Description

automatically use it the next time they
access CentraSite Business UI.

If the aribute visiblity is set to false,
then the Remember Me check box will
not appear in the user interface. This
enforces users to manually specify their
login credentials every time they access
CentraSite Business UI.

To enable or disable the Remember
me check box, configure the property
statement:
<RememberMe visiblity="true" />

RequestAnAccount Contains property seings that are used
to modify the Request an Account link.

If the aribute visiblity is set to true,
then the Request an Account link will
appear in the Login page of CentraSite
Business UI. This enables anonymous
users to create or register a new user
account in CentraSite registry.

If the aribute visiblity is set to false,
then the Request an Account link will not
appear in the user interface.

To modify the Request an Account link,
configure the property statement:
<RequestAnAccount
                visiblity="true">

Request an
Account (link)

ReasonForRequest Contains property seings that are used
to modify the Request an Account link.

If the aribute visiblity is set to true,
then the Reason for Request text box will
appear in the Create an Account page
of CentraSite Business UI. This allows
users to enter the specific reason why
they require this account in CentraSite.

If the aribute visiblity is set to true,
then the Reason for Request text box will
not appear in the user interface.
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Layout
Component

Configuration
Property

Description

To enable or disable the Reason for
Request text box, configure the property
statement:
<ReasonForRequest visiblity="true"/>

Take a Tour
(buon)

TakeATour Contains property seings that are used
to modify the Take a Tour buon.

If the aribute visiblity is set to true,
then the Take a Tour buon will appear
in the Login page of CentraSite Business
UI. This allows users to enter the specific
reason why they require this account in
CentraSite.

If the aribute visiblity is set to false,
then the Take a Tour buon will not appear
in the user interface.

To modify the Take a Tour buon,
configure the property statement:
<TakeATour visiblity="true"
url="http://www.softwareag.com">
CS_MSG_INMBX_BTN_TOUR</TakeATour>

Take a Tour
(image)

TakeATour Contains property seings that are used
to modify the Take a Tour image.

If the aribute visiblity is set to true,
then the Take a Tour image will appear in
the Login page of CentraSite Business
UI. This allows users to enter the specific
reason why they require this account in
CentraSite.

If the aribute visiblity is set to false,
then the Take a Tour image will not appear
in the user interface.

To modify the Take a Tour image,
configure the property statement:
<TakeATourImage>
images/custom/ico_up_TakeATour_50x43.png
</TakeATourImage>
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Footer Configuration

Layout
Component

Configuration Property Description

Copyright CopyRight Contains property seings that are used
to modify the Copyright information.

If the aribute visiblity is set to true,
then the Copyright information will appear
in the Login page of CentraSite Business
UI.

If the aribute visiblity is set to false,
then the copyright information will not
appear in the user interface.

To enable or disable the Copyright text,
configure the property statement:
<CopyRight
visiblity="true">
CS_MSG_INMBX_LBL_COPYRIGHT
</CopyRight>

Powered by
Software AG

PoweredBy Contains property seings that are used
to modify the Software AG  logo.

If the aribute visiblity is set to true,
then the Software AG  logo will appear in
the Login page of CentraSite Business UI.

If the aribute visiblity is set to false,
then the Software AG  logo will not appear
in the user interface.

To enable or disable the Powered by
Software AG  logo, configure the property
statement:
<PoweredBy
tooltip="CS_MSG_INMBX_LBL_FOOTER_TEXT"
visiblity="true">images/system/
webfooter_powered_by.png
</PoweredBy>

Customizing CentraSite Welcome Page
The Welcome page that is visible when you access CentraSite Business UI can be
customized to suit your requirements. You can change the search widget, search
scopes, activity menus, the main navigation links, and the Welcome page. The standard
Welcome page gives you quick links to the pages of CentraSite Business UI that you
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use frequently during your day-to-day work with CentraSite. It also provides links to
external web sites that provide useful information related to CentraSite. A search box
allows you perform a keyword search for registry assets whose name or description
contains the given keyword. The figure depicts the schematic layout of the welcome
page.

The header section displays the company logo and the product logo. You can change
the logos and colors used to display them or hide the logos as part of the page
customization. You can change the background color for the whole header section.

The navigation bar contains a search widget that allows you to perform a keyword
search for an asset. You can have a user-defined search widget or the default search
widget as part of the page customization. You can change the background color of the
search widget. Additionally, a browse link is displayed by default that allows you to
perform an advanced search for an asset. You can customize the browse link to contain
a custom URL that either opens an Advanced Search page or an external page of your
choice. You can rename or hide the browse link as part of the page customization.

The Activities menu includes options that enable you to access the various functions,
such as Create Assets, Import Assets, and so on. You can rearrange the order of these
menu options, customize the activities menu to include or exclude one or more functions
as part of the customization process.

The Welcome page can contain one or more portlets. Each portlet contains a header and
content. The header includes a title, with an icon adjacent to the text, some selectable



M
Odd Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 71

markers (for example, set user configuration of an individual portlet, expand and
collapse a portlet) and a close buon. Under the header, you can have a list of entries,
either representing the result set of a search query, any external HTML page or a
graphical image. The rendering of the portlets in the welcome page depends on how you
configure them.

CentraSite Business UI supports the following portlets:

Text portlet – Represents the result set of a saved search query as executable actions.
An action contains the URL of a search result (for example, the name of an asset) that
renders the appropriate details page (in this case, the asset details page). The names
of the search results are displayed as a table consisting of single or multiple columns.
Each table cell contains one executable action and may have an icon beside it.

IFrame portlet – Represents an arbitrary URL that points to the corresponding external
HTML page inside the HTML IFrame component.

Graphical portlet – Represents the saved search queries in graphical representation.

The footer section displays the current date and time, copyright information, and
subtitle text. You can change the background color of the footer section, and hide the
copyright information and the subtitle text as part of the page customization.

To customize and install the customized welcome page

1. Stop Software AG Runtime

2. Customize the Welcome page configuration.

The standard configuration file centrasite.xml delivered with the CentraSite kit
contains all of the names of the CentraSite Business UI extension points, including
the extension point for the Welcome page configuration. You must create a copy
of the extension point for the Welcome page configurations in the customization
file, centrasite.xml, in order to define a customized LogWelcomein page. For more
information, see “CentraSite Welcome Page Configuration” on page 71.

You can find the customization file, centrasite.xml, on
<CentraSiteInstall_Directory> \cast\cswebapps\BusinessUI\custom\conf.

3. Start Software AG Runtime.

The changes incorporated are now visible in the Welcome page.

CentraSite Welcome Page Configuration
The element <GUIConfiguration> in the centrasite.xml file contains the properties for
customization of CentraSite Business UI. The Welcome page configuration includes
configuring the header, navigation panel, content panel, and the footer.

Note: Make sure that you specify an image file using its relative path in the
<CentraSiteInstall_Directory> \cast\cswebapps\BusinessUI\custom\images
directory. In a Windows environment, use forward slashes instead of
backward slashes in the path name.
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Header Configuration

Layout
Component

Configuration Property Description

CENTRASITE ProductLogo Contains property seings that are used to
modify the company logo in the Welcome
page of CentraSite Business UI.

To modify the company logo, configure the
property statement:
<ProductLogo
tooltip=
"CS_MSG_INMBX_LBL_PRODUCT_INTRO_HEADER">
images/custom/cs_product_logo_70x70.png
</ProductLogo>

Welcome dashboard Contains property seings that are used to
modify the Welcome title in the Welcome
page of CentraSite Business UI.

To modify the Welcome title, configure the
property statement:
<HeaderLink id="dashboard"
displayName="CS_MSG_INMBU_LINK_DASHBOARD" 
token="welcome:welcome" />

Inbox inbox Contains property seings that are used to
modify the Inbox title in the Welcome page
of CentraSite Business UI.

To modify the Inbox title, configure the
property statement:
<HeaderLink id="inbox"
displayName="CS_MSG_INMBU_LINK_INBOX" 
token="inbox:inbox" />

Help help Contains property seings that are used to
modify the Help title in the Welcome page
of CentraSite Business UI.

To modify the Help title, configure the
property statement:
<HeaderLink id="help"
displayName="CS_MSG_INMBU_LINK_HELP" 
token="help:help" />

About about Contains property seings that are used to
modify the About title in the Welcome page
of CentraSite Business UI.
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Layout
Component

Configuration Property Description

To modify the About title, configure the
property statement:

<HeaderLink id="about"
displayName="CS_MSG_INMBU_LINK_ABOUT"
token="about:about" />

| HeaderMenuSeparator To modify the separator, configure the
property statement:
<HeaderMenuSeparator
tooltip=
"CS_MSG_INMBX_LBL_HEADER_MENU_SEPERATOR">
images/custom/Separator_White_1X1.png
</HeaderMenuSeparator>

Important: You cannot customize the header link Log Out (even if you belong to the
CentraSite Administrator role).

Navigation Panel Configuration

Layout
Component

Configuration
Property

Description

TypeAhead
Search

TypeAheadSearchContains property seings that are used to
modify the TypeAhead Search textbox in the
Welcome page of CentraSite Business UI.

To modify the TypeAhead Search textbox,
configure the property statement:
<TypeAheadSearch minOffsetToStartSearch="3"
numOfResultsToShow="5" 
maxCharactersToShow="60" />

Browse
(link)

BrowseLink Contains property seings that are used to
modify the Browse link.

If the aribute visiblity is set to true, then
the Browse link will appear in the Welcome page
of CentraSite Business UI. This helps users to
browse for assets in the CentraSite registry using
the advanced search options.

If the aribute visiblity is set to false, then
the Browse link will not appear in the user
interface. This enforces users to manually specify
the keywords in the TypeAhead Search textbox.
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Layout
Component

Configuration
Property

Description

You can customize the Browse link in the
following ways:

Enable or disable the Browse link

Provide a custom URL

Rename the Browse link

To modify the details of the Browse link,
configure the property statement:
<BrowseLink visiblity="true"
displayName="CS_MSG_INMBU_LINK_BROWSE" 
token="browse:browse" />

Everything

Assets

SearchScopes Contains property seings that are used to
modify the list of search scopes in the Welcome
page of CentraSite Business UI.

To modify the list of search scopes, configure the
property statement:
<SearchScopes>
 <SearchScope id="Everything" 
  isExpandable="true" 
  class=
       "com.softwareag.centrasite.api.csom.
        search.impl.EverythingScope" 
  exclude=
  "uddi:7613515f-77eb-11dd-bc9f-f62b6cf80b00">
  INMCL_STR_Everything</SearchScope>
 <SearchScope id="Assets" 
  isExpandable="false" 
  class=
       "com.softwareag.centrasite.api.csom.
        search.impl.AssetScope" 
  exclude=
  "uddi:7613515f-77eb-11dd-bc9f-f62b6cf80b00">
  INMCL_STR_Assets</SearchScope>
</SearchScopes>

Search
(icon)

SearchIcon Contains property seings that are used to
modify the Search icon in the Welcome page of
CentraSite Business UI.

To modify the Search icon, configure the property
statement:

<SearchIcon>images/custom/
SearchButton.png</SearchIcon>
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Layout
Component

Configuration
Property

Description

Create
Asset

Generate
Reports

Manage
Organizations

Manage
Governance
Rules

Manage
Taxonomies

Asset
Navigator

Activities Contains property seings that are used to
modify the list of activities in the Welcome page
of CentraSite Business UI.

To modify the list of activities, configure the
property statement:
<Activities>
 <Activity id="Create Assets" 
  class="com.softwareag.centrasite.api.
  activity.impl.
  CreateAssetActivityImpl">
  INMCL_ACTIVITY_CREATE_ASSET
 </Activity>
 <Activity id="Global Reports" 
  class="com.softwareag.centrasite.api.
  activity.impl.
  GlobalReportActivityImpl">
  INMCL_ACTIVITY_GLOBAL_REPORTS
 </Activity>
 <Activity id="Manage Organizations" 
  class="com.softwareag.centrasite.api.
  activity.impl.
  ManageOrganizationsActivityImpl">
  INMCL_ACTIVITY_MANAGE_ORGANIZATIONS
 </Activity>
 <Activity id="ManageGovernanceRules" 
  class="com.softwareag.centrasite.api.
  activity.impl.
  ManageGovernanceRulesActivityImpl">
  INMCL_ACTIVITY_MANAGE_GOVERNANCE_RULES
 </Activity>
 <Activity id="ManageTaxonomies" 
  class="com.softwareag.centrasite.api.
  activity.impl.
  ManageTaxonomiesActivityImpl">
  INMCL_ACTIVITY_MANAGE_TAXONOMIES
 </Activity>
 <Activity id="Asset Navigator" 
  class="com.softwareag.centrasite.api.
  activity.impl.
  AssetNavigatorActivityImpl">
  INMCL_ACTION_ASSETNAVIGATOR
 </Activity>
</Activities>

Content Panel Configuration

Layout
Component

Configuration
Property

Description

Portlets Portlets Contains property seings that are used to modify
the list of portlets in the Welcome page of CentraSite
Business UI.
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Layout
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To modify the list of portlets, configure the property
statement:
<Portlets>
 <Portlet id="MyFavoritesPortlet" 
  description="INMBU_STR_PORTLET_FAVORITES_DESC" 
  type="text" 
  dataFeed="MyFavorites" 
  icon="images/system/favorites_16X16.png" 
  row="0" column="0" isVisible="true" 
  refreshInterval="0" 
  actions=
   "configure,refresh">
   INMBU_STR_PORTLET_NAME_MY_FAVORITES
 </Portlet>
 ...
</Portlets>

PortletActions Portlets Contains property seings that are used to modify the
list of actions in each portlet in the Welcome page of
CentraSite Business UI.

To modify the list of portlet actions, configure the
property statement:
<PortletActions>
 <PortletAction id="configure">
  INMBU_STR_PORTLET_ACTION_EDIT
 </PortletAction>
 <PortletAction id="refresh">
  INMBU_STR_PORTLET_ACTION_REFRESH
 </PortletAction>
</PortletActions>

Footer Configuration

Layout
Component

Configuration
Property

Description

Time Time Contains property seings that are used to modify
Time.

If the aribute visiblity is set to true, then the
Time will appear in the Welcome page of CentraSite
Business UI.

If the aribute visiblity is set to false, then the
Time will not appear in the user interface.

To enable or disable Time, configure the property
statement:
<Time visiblity="true" />
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Powered
by Software
AG

PoweredBy Contains property seings that are used to modify
the Software AG  logo.

If the aribute visiblity is set to true, then the
Software AG  logo will appear in the Welcome page of
CentraSite Business UI.

If the aribute visiblity is set to false, then the
Software AG  logo will not appear in the user interface.

To enable or disable the Powered by Software AG  logo,
configure the property statement:
<PoweredBy
tooltip="CS_MSG_INMBX_LBL_FOOTER_TEXT"
visiblity="true">images/system/
webfooter_powered_by.png
</PoweredBy>

Customizing CentraSite Content Page
To customize content pages, you can use extension points for the CentraSite Business UI
and implement Java classes and methods to plug in to the extension points.

An extension point is characterized by:

An ID with which it can be referenced.

A GWT widget that wraps the extension functionality.

You can find the sample code for defining the extension points in the file
ExtensionViewFactory.java. You can find the file in the demos folder under the
<CentraSiteInstall_Directory>.

Log on to CentraSite Business UI

Usage Use at the start of a session of CentraSite Business UI.

Elements element name=ExtensionPointLogin

Value of aribute custom (true or false)

Processing When you log on to CentraSite Business UI, a user-defined Login
page is rendered.

Provided by BusinessUI
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Example <ExtensionPointLogin custom="false" />

Request an Account

Usage Use this when requesting an account in CentraSite Business UI.

Elements element name=ExtensionPointRegister

Value of aribute custom (true or false)

Processing When you request an account in CentraSite, this invokes a user-
defined registration page that displays parameters required for
entering the user credentials.

Provided by BusinessUI

Example <ExtensionPointRegister custom="false" />

Extending Activity Menu
The Activity menu contains a set of functions that you can perform through CentraSite
Business UI. The Activity menu helps you access the following functions by default:

Create Asset

Generate Reports

Manage Organizations

Manage Governance Rules

Manage Taxonomies

Asset Navigator

You can add a custom activity to have the specific function and format that you require.
Additionally, you can change the order of displaying activities within the activity menu.

To extend the activity menu for additional functions

1. Implement the custom activity as a GWT extension point. For procedures, see
“Implement Activity as an Extension” on page 79.

2. Configure the custom activity in centrasite.xml configuration file. For procedures, see
“Enable Activity through Configuration” on page 79.
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Implement Activity as an Extension

Usage Use this to define a custom activity. For example, add an
activity, reorder the existing activities, and remove activities to
suit your requirements.

Elements id

class

Interfaces ActivityManager

ActivityMenu

Abstract base
class

Activity

Processing When you start the user interface, a custom defined activity
menu is rendered.

Provided by CentraSiteLogicLayer

Code See the sample code.

You can find sample code for defining the custom activity as an extension point in the
file CentraSiteBUIExtension.gwt.xml. You can find the file in the demos folder in the
<CentraSiteInstall_Directory>.
<!-- Use ExtensionWidgetFactory by default --> 
 <replace-with 
  class="com.softwareag.centrasite.bui.extension.client.
  factory.ExtensionWidgetFactory"> 
 <when-type-is 
  class="com.softwareag.centrasite.bui.extension.core.
  client.IExtensionWidgetFactory"/> 
 </replace-with>

Enable Activity through Configuration

After you define a custom activity as an extension you have to enable the activity
configuration so as to display the activity in CentraSite Business UI.

Important: The activity configuration parameters initially defined in the configuration
file are editable and cannot be protected.

To enable the custom activity configuration

1. Open the customization file, centrasite.xml, in a rich text editor.
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You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

2. Locate Activities Configuration under <CLL Configurations>.

The Activities snippet looks like this:
<Activities>
 <Activity id="Create Assets" 
  class="com.softwareag.centrasite.api.
  activity.impl.CreateAssetActivityImpl">
  INMCL_ACTIVITY_CREATE_ASSET
 </Activity>
 <Activity id="Global Reports" 
  class="com.softwareag.centrasite.api.
  activity.impl.GlobalReportActivityImpl">
  INMCL_ACTIVITY_GLOBAL_REPORTS
 </Activity>
 <Activity id="Manage Organizations" 
  class="com.softwareag.centrasite.api.
  activity.impl.ManageOrganizationsActivityImpl">
  INMCL_ACTIVITY_MANAGE_ORGANIZATIONS
 </Activity>
 <Activity id="ManageGovernanceRules" 
  class="com.softwareag.centrasite.api.
  activity.impl.ManageGovernanceRulesActivityImpl">
  INMCL_ACTIVITY_MANAGE_GOVERNANCE_RULES
 </Activity>
 <Activity id="ManageTaxonomies" 
  class="com.softwareag.centrasite.api.
  activity.impl.ManageTaxonomiesActivityImpl">
  INMCL_ACTIVITY_MANAGE_TAXONOMIES
 </Activity>
 <Activity id="Asset Navigator" 
  class="com.softwareag.centrasite.api.
  activity.impl.AssetNavigatorActivityImpl">
  INMCL_ACTION_ASSETNAVIGATOR
 </Activity>
</Activities>

3. Append the property configuration statement for custom activity. For example,
Create Report Templates.
<Activities>  
 <Activity id="Create Report Templates" 
  class="com.softwareag.centrasite.api.
  activity.impl.CreateReportTemplatesImpl"> 
  INMCL_ACTIVITY_CREATE_REPORT _TEMPLATES
 </Activity> 
</Activities> 

The input parameters are:

Parameter Denotes

id A unique identifier for the activity, in this example for
Create Report Templates. It uniquely distinguishes an
activity in the CentraSite registry. If you wish to reset the
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Parameter Denotes
activity at a later stage, you identify the activity using this
id.

class The implementation class of
com.softwareag.centrasite.api.activity.Activity
interface.

INMCL_ACTIVITY The i18n string to display the activity in CentraSite
Business UI.

If you want to specify a localized name, type the message
ID starting with a prefix INMCL (in this example,
INMCL_ACTIVITY_CREATE_REPORT_TEMPLATES). The
activity internally identifies the message ID and displays
the localized name, if available in the message database.
Else, if you specify a name without INMBU prefix, the
activity will simply display a plain text name.

The Activities snippet now looks similar to this.
<Activities>
 <Activity id="Create Assets" 
  class="com.softwareag.centrasite.api.
  activity.impl.CreateAssetActivityImpl">
  INMCL_ACTIVITY_CREATE_ASSET
 </Activity>
 <Activity id="Global Reports" 
  class="com.softwareag.centrasite.api.
  activity.impl.GlobalReportActivityImpl">
  INMCL_ACTIVITY_GLOBAL_REPORTS
 </Activity>
 <Activity id="Manage Organizations" 
  class="com.softwareag.centrasite.api.
  activity.impl.ManageOrganizationsActivityImpl">
  INMCL_ACTIVITY_MANAGE_ORGANIZATIONS
 </Activity>
 <Activity id="ManageGovernanceRules" 
  class="com.softwareag.centrasite.api.
  activity.impl.ManageGovernanceRulesActivityImpl">
  INMCL_ACTIVITY_MANAGE_GOVERNANCE_RULES
 </Activity>
 <Activity id="ManageTaxonomies" 
  class="com.softwareag.centrasite.api.
  activity.impl.ManageTaxonomiesActivityImpl">
  INMCL_ACTIVITY_MANAGE_TAXONOMIES
 </Activity>
 <Activity id="Asset Navigator" 
  class="com.softwareag.centrasite.api.
  activity.impl.AssetNavigatorActivityImpl">
  INMCL_ACTION_ASSETNAVIGATOR
 </Activity>
<Activity id="Create Report Templates" 
  class="com.softwareag.centrasite.api.
  activity.impl.CreateReportTemplatesImpl"> 
  INMCL_ACTIVITY_CREATE_REPORT _TEMPLATES
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 </Activity>
</Activities>

4. Locate Activities Configuration under <UIProperties>.

The configuration snippet looks like this:
<Activities noOfActivitiesInMainNav="5"> 
 <Activity id="CreateAssetBui" refId="Create Assets" numOfProfilesPerRow="3" 
  token="activity:Create_Assets" />
 <Activity id="GlobalReportsBui" refId="Global Reports" 
  token="activity:Global_Reports" />
 <Activity id="ManageOrganizationBui" refId="Manage Organizations" 
  token="activity:Manage_Organizations" />
 <Activity id="ManageGovernaceRulesBui" refId="ManageGovernanceRules" 
  token="activity:governance_rules" />
 <Activity id="ManageTaxonomiesBui" refId="ManageTaxonomies" 
  token="activity:manage_taxonomies" />
 <Activity id="Asset Navigator" refId="Asset Navigator" 
  token="activity:Asset_Navigator" />
</Activities>

5. Append the defined custom activity (for example, Create Report Templates)
configuration statement.
<Activity id="Create Report Templates" 
 token="customactivity:Create Report Templates"/>

The input parameters are:

Parameter Denotes

refId Refers to an unique identifier id for the activity, as defined in the
CLL Configurations.

token The place tokenizer of the activity that helps in rendering the
activity as a deep link URL.

Important: For rendering any custom activity, the place tokenizer
should contain the customactivity: prefix. Thus
for example, a custom activity Create Report
Templates would have the place tokenizer read as
customactivity:Create Report Templates.

The Activities now looks similar to this.
<Activities noOfActivitiesInMainNav="5"> 
 <Activity id="CreateAssetBui" refId="Create Assets" numOfProfilesPerRow="3" 
  token="activity:Create_Assets" />
 <Activity id="GlobalReportsBui" refId="Global Reports" 
  token="activity:Global_Reports" />
 <Activity id="ManageOrganizationBui" refId="Manage Organizations" 
  token="activity:Manage_Organizations" />
 <Activity id="ManageGovernaceRulesBui" refId="ManageGovernanceRules" 
  token="activity:governance_rules" />
 <Activity id="ManageTaxonomiesBui" refId="ManageTaxonomies" 
  token="activity:manage_taxonomies" />
 <Activity id="Asset Navigator" refId="Asset Navigator" 
  token="activity:Asset_Navigator" />
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<Activity id="Create Report Templates" refId="Create Report Templates"
  token="customactivity:Create_Report_Templates"/>
</Activities>

6. Save and close the configuration file.

7. Restart Software AG Runtime.

Replace Standard Search Widget

Usage Use this when the layout of a standard search widget (comprising
of search field, search options, and search execution) needs to be
replaced with custom search widget.

Elements element name=ExtensionPointSearchWidget

Value of aribute custom (true or false)

Processing When you start the user interface, a user-defined (keyword) search
widget is rendered.

Provided by BusinessUI

Example <ExtensionPointSearchWidget custom="false" />

Advanced Search Criteria

Usage Extend the existing advanced search criteria of an asset keyword
search performed by typing custom related search seings, for
example, you can add specific search predicates for your own object
types.

Elements element name=ExtensionPointSearchCriteria

Value of aribute custom (true or false)

Processing This extension is initialized through the
Extension.showSearchResults() method.

Returns a user-defined advanced search (layout) screen displaying
the available search options.

Refreshes the default search results page.

Provided by BusinessUI

Example <ExtensionPointSearchCriteria custom="false" />



M
Even Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 84

Browse Link

Usage Change the text string Browse displayed in the default view.

Change the URL of the Browse link to contain either a page of your
choice within the CentraSite Business UI, or to an external web
page that you regularly visit within the context of your work with
CentraSite.

Elements element name=ExtensionPointBrowseView

Value of aribute custom (true or false)

Processing Browse link that would either open a user-defined Search Results
page or a custom link that would open a CentraSite page or an
external web page of your choice.

Provided by BusinessUI

Example <ExtensionPointBrowseView custom="false" />

Browse Search Criteria

Usage Extend the existing advanced search panel of an asset browse for
typing custom related search seings, for example, you can add
specific search predicates for your own object types.

Elements element name=ExtensionPointBrowseCriteria

Value of aribute custom (true or false)

Processing This extension is initialized through the
Extension.showBrowseResults() method.

Returns a user-defined advanced search (layout) screen showing
the available search options.

Refreshes the default search results page.

Provided by BusinessUI

Example <ExtensionPointBrowseCriteria custom="false" />
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Extend Search View

Usage Change the default layout of entire search view to suit your
requirements.

Elements element name=ExtensionPointSearch

Value of aribute custom (true or false)

Processing When you want to search assets, this invokes:

a user-defined advanced search (layout) screen showing the
available search options.

a user-defined search results (layout) screen displaying all assets
that fit the search criteria.

Provided by BusinessUI

Example <ExtensionPointSearch custom="false" />

Replace Standard Asset Detail Page

Usage Use this to customize the layout of a standard asset details page to
fit your needs.

Elements element name=ExtensionPointAssetDetails

Value of aribute custom (true or false)

Processing If the details page for an asset is opened, an user-defined asset
details page is rendered.

Provided by BusinessUI

Example <ExtensionPointAssetDetails custom="false" />

Extending Action Menu
The action bar in the CentraSite Business UI allows a user to execute a defined set of
actions on the selected objects. You can perform various actions such as modifying object
details, aaching documents, generating reports, and so on, for a single object (through
the object details page) or a set of objects (Search Results page).
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CentraSite Business UI has a predefined set of actions available for the registry objects,
for example, assets, policies, and gateways. In addition to the predefined actions, you
can also define your own custom actions for the objects.

Additionally, you can customize the way in which you want the action to render:

You can add or remove an action to or from the action menu.

You can change the text string displayed for an action in the action menu.

You can change the icon that represents an action in the action menu.

You can enable an action for bulk operation.

To add an action menu

1. Implement the custom action as a GWT extension point. For procedures, see
“Implement Action as an Extension” on page 86.

2. Configure the custom action in centrasite.xml configuration file. For procedures, see
“Enable Action through Configuration” on page 87.

Implement Action as an Extension

Usage Use this to define a custom action in CentraSite Business
UI. For example, add an action, reorder the existing actions,
enable or disable an action, and remove actions to suit your
requirements.

Elements String actionId

String commaSeparatedAssetId

String positionParam

Interface See the sample code

Abstract base
class

ActionListener

Processing When a list of actions for an action menu is retrieved, the
following steps are performed for each known action:

create an instance of class.

implement the method processAction of type String.

Provided by BusinessUI

Code See the sample code.
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You can find sample code for defining the custom action as an extension point in the
file CentraSiteBUIExtension.gwt.xml. You can find the file in the demos folder in the
<CentraSiteInstall_Directory>.
<!-- Use ActionListener by default --> 
 <replace-with 
  class="com.softwareag.centrasite.bui.extension.client.action.ActionListener"> 
 <when-type-is 
  class="com.softwareag.centrasite.bui.extension.core.client.IActionListener"/> 
 </replace-with>

Enable Action through Configuration

After you define a custom action as an extension, you have to enable the custom action
configuration so as to display the action in the CentraSite Business UI.

Important: The action configuration parameters initially defined in the configuration file
are editable and cannot be protected.

To enable an action through configuration

1. Open the customization file, centrasite.xml, in a rich text editor.

You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

2. Locate Actions under <CLL Configuration>.

The Actions snippet looks like this:
<Actions> 
 <Action id="SaveAction" inbox="false" bulk="false" 
  group="basic" 
  icon="images/custom/actionbar/01_Save.gif" 
  class="com.softwareag.centrasite.api.csom.action.impl.
  SaveActionImpl">INMCL_ACTION_SAVE
 </Action>
 <Action id="EditAction" inbox="false" bulk="false" 
  group="basic" 
  icon="images/custom/actionbar/02_Edit.gif" 
  class="com.softwareag.centrasite.api.csom.action.impl.
  EditActionImpl">INMCL_ACTION_EDIT
 </Action>
  .....
  .....
 <Action id="RuntimeAliasAction" inbox="false" bulk="true" 
  group="addRuntimeAction" applicable="policy" 
  icon="images/custom/actionbar/managerRuntimeAlias.png" 
  class="com.softwareag.centrasite.api.csom.action.runtime.impl.
  ManageRuntimeAliasActionImpl">INMCL_ACTION_AddRuntimeAlias
 </Action>
 <Action id="AddGateway" inbox="false" bulk="true" 
  group="addRuntimeAction" applicable="policy" 
  icon="images/custom/actionbar/add_gateway_32X32.png" 
  class="com.softwareag.centrasite.api.csom.action.runtime.impl.
  ManageGatewayActionImpl">INMCL_ACTION_AddGateway
 </Action>
</Actions>



M
Even Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 88

3. Append the property configuration statement for custom action. For example,
Change Owner.
<Action id="ChangeOwnerAction" inbox="false" bulk="false" 
  group="basic" 
  icon="images/custom/actionbar/ChangeOwner.gif" 
  class="com.softwareag.centrasite.api.csom.action.impl.
  ChangeOwnerActionImpl">INMCL_ACTION_CHANGE_OWNER
</Action>

The input parameters are:

Parameter Denotes

Action id A unique identifier for the action, in this example
ChangeOwnerAction. It uniquely distinguishes an action
in the CentraSite registry. If you want to reset the action at
a later stage, you identify the action using this id.

class The implementation class of interface:

com.softwareag.centrasite.api.csom.action.impl.ChangeOwnerActionImpl

INMCL_ACTIVITY The i18n string to display the action in CentraSite Business
UI.

If you want to specify a localized name, type the message
ID starting with a prefix INMBU (in this example,
INMCL_ACTION_CHANGE_OWNER). The action internally
identifies the message ID, and display the localized name,
if available in the message database. Else, if you specify a
name without INMBU prefix, the action displays a plain
text name.

The Actions snippet now looks similar to this.
<Actions> 
 <Action id="SaveAction" inbox="false" bulk="false" 
  group="basic" 
  icon="images/custom/actionbar/01_Save.gif" 
  class="com.softwareag.centrasite.api.csom.action.impl.
  SaveActionImpl">INMCL_ACTION_SAVE
 </Action>
 <Action id="EditAction" inbox="false" bulk="false" 
  group="basic" 
  icon="images/custom/actionbar/02_Edit.gif" 
  class="com.softwareag.centrasite.api.csom.action.impl.
  EditActionImpl">INMCL_ACTION_EDIT
 </Action>
  .....
<Action id="ChangeOwnerAction" inbox="false" bulk="false" 
  group="basic" 
  icon="images/custom/actionbar/ChangeOwner.gif" 
  class="com.softwareag.centrasite.api.csom.action.impl.
  ChangeOwnerActionImpl">INMCL_ACTION_CHANGE_OWNER
 </Action>
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  .....
 <Action id="RuntimeAliasAction" inbox="false" bulk="true" 
  group="addRuntimeAction" applicable="policy" 
  icon="images/custom/actionbar/managerRuntimeAlias.png" 
  class="com.softwareag.centrasite.api.csom.action.runtime.impl.
  ManageRuntimeAliasActionImpl">INMCL_ACTION_AddRuntimeAlias
 </Action>
 <Action id="AddGateway" inbox="false" bulk="true" 
  group="addRuntimeAction" applicable="policy" 
  icon="images/custom/actionbar/add_gateway_32X32.png" 
  class="com.softwareag.centrasite.api.csom.action.runtime.impl.
  ManageGatewayActionImpl">INMCL_ACTION_AddGateway
 </Action>
</Actions>

4. To enable an action entry for bulk usage, change false to true. Similarly, if the
action is already available for bulk usage and you want to revert, set the value to
false.

5. Save and close the configuration file.

6. Restart Software AG Runtime.

Sample Custom Actions

CentraSite includes the following sample custom actions:

Change Owner Action

Runtime Policy Action

The sample custom actions are available in the demos folder in the
<CentraSiteInstall_Directory> .

Change Owner Action

The Change Owner Action does not have any UI associated with it. This action
is applicable for both single and multiple objects. When the action is selected, the
ownership of the selected objects are automatically transferred to the current logged in
user provided the logged in user has the CentraSite Administrator role.

Runtime Policy Action

The Runtime Policy Action has a UI associated with it. This action is applicable only for
a single object. When the action is selected in the Asset Details page, CentraSite displays
a list of policies that are applicable for the selected asset, and the user can select a policy
for the execution. When the user selects the policy, the policy is executed, and the results
of the execution are displayed to the user.

To create a custom action in CentraSite Business UI, the following classes or interfaces
are required:

Interface CSOAction

If you are writing a custom action, you must create a class implementing the
CSOAction interface. The fully qualified name of this class must be mentioned in the
element <Action> in the centrasite.xml file.
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The ChangeOwnerAction.java contains the implementation for the Change Owner
action.

You can find the ChangeOwnerAction.java file in the folder changeowner in the
<CentraSiteInstall_Directory> \demos\CentraSiteBUIExtension\BusinessUIActions
\WithoutUI\src\com\softwareag\centrasite\demos\bui\actions directory.

The RunPolicyAction.java is the implementation class for the Execute Policy action.

You can find the RunPolicyAction.java file in the folder runpolicy in the
<CentraSiteInstall_Directory> \demos\CentraSiteBUIExtension\BusinessUIActions
\WithoutUI\src\com\softwareag\centrasite\demos\bui\actions directory.

Class ActionInfo

CentraSite Business UI makes use of GWT (Google Web Toolkit) to for the UI. To
transmit data between the client and server side applications in GWT, the object
must be serializable. The ActionInfo is a serializable class that holds the data
from the class CSOAction such as the action ID, current action state, and so on. It
also holds additional data, such as the selected assets on which the action has to be
performed and any other inputs that are provided by the user. If your custom action
does not require any user input other than the selected assets, then you can make use
of the ActionInfo class, otherwise you have to create your own class inheriting the
ActionInfo class.

The Change Owner action does not need any other information. Therefore the
ActionInfo implementation class itself is used for it.

The Execute Policy action has additional information that has to be presented to the
user and to be set in the CSOAction implementation class. Therefore, it uses the class
RunPolicyActionInfo.java that is inheriting the ActionInfo class.

Interface IActionConverter

This handles the conversion of the data from class CSOAction to class ActionInfo
and vice versa. There must be a class implementing this interface. If your action does
not require any new data other than the selected objects for executing the action,
then we provide a default converter class, called as DefaultActionConverter.
On the other hand, you require additional inputs from the user, then they must be
handled separately. In this case, you must create your own IActionConverter class
and specify the same in the ActionConverterFactory.getActionConverter()
method so that this converter is used for your action.

The Change Owner action uses the class DefaultActionConverter as it does not have
any new data to be converted.

The Execute Policy action uses the class RunPolicyActionConverter.java to handle
the conversion of the additional data.

Interface IActionHandler

This handles the UI for the action. If your action does not have a UI, then we provide
a default handler class, called as DefaultActionHandler. If your action requires a
UI, then you have to implement the IActionHandler interface and handle the UI
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using this class based on the action states. The action handler for your action must be
specified in the ActionHandlerFactory.getActionHandler() method.

The Change Owner action does not have any UI associated with it, and uses the class
DefaultActionHandler.

The Execute Policy action has a UI, and uses the class
RunPolicyActionHandler.java.

Once the above classes are ready and available to use, you would compile them, and
then deploy the extensions. You will include your custom action in the centrasite.xml file
as follows.
<Action id="{CustomActionName}" inbox="{true|false}" bulk="{true|false}" 
group="{group_name}" icon='{URL/relative_path}' 
class="fully.qualified.class.name">{Custom_Action_Name}</Action>

The input parameters are:

Parameter Description

id="{CustomActionName} Name of the custom action. The
name should be unique as it would
be referenced throughout the action
execution.

inbox="{true|false}" Enable or disable the visibility of the
action in the Actions bar of the Inbox.

bulk="{true|false}" Enable or disable the visibility of the
action in the Search Results page.
If the value of this parameter is
set to false, then the visibility of
the action is restricted to the Asset
Details page.

group="{group_name}" A grouping for your action. This will
help to group the actions according
to the group name. By default, you
can provide "basic" as the grouping.

icon='{URL/relative_path}' The URL of the icon that is to be used
to represent this action in the Actions
bar in CentraSite Business UI.

You can specify the URL for
the icon, or if the icon is located
on your file system specify
the file location relative to the
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Parameter Description
<CentraSiteInstall_Directory> \cast
\cswebapps\BusinessUI directory.

class="fully.qualified.class.name" The fully qualified class name of the
implementation class CSOAction.

{Custom_Action_Name} Display name of the action in the
Actions bar in CentraSite Business
UI.

Adding Portlets
Portlets enable you to create shortcuts and access the frequently-used functions, for
example, Most Popular Assets, Recent Searches, and so on.

The Welcome page contains a default set of portlets, where each portlet represents a
collection of predefined entries fetched using a saved search query.

You can define portlets to suit your needs and configure the tailored portlet to display in
the Welcome page.

Additionally, you can customize the way in which you want portlet to render:

You can add a portlet of type custom.

You can define the configuration seings of the custom portlet.

You can specify a display icon to represent the custom portlet in the Welcome page.

You can make the custom portlet visible or invisible in the Welcome page.

You can specify a location for displaying the custom portlet in the Welcome page.

You can set the refresh interval for the custom portlet.

To add portlets

1. Implement the custom portlet as a GWT extension point. For procedures, see
“Implement Portlet as an Extension” on page 92.

2. Configure the custom portlet in centrasite.xml configuration file. For procedures, see
“Enable Portlet through Configuration” on page 94.

Implement Portlet as an Extension

Usage Use this to define a custom portlet in CentraSite Business UI.

Elements renderPortletContent

String portletId
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String contentId

String commaSeparatedParam

executePortletAction

String portletId

String actionId

String contentId

String commaSeparatedParam

Abstract base
class

IPortletListener

Processing When the Welcome page containing one or more custom type
portlets is loaded in the CentraSite Business UI, the following
steps are performed for each custom portlet:

create an instance of class

implement the method renderPortletContent (within the
class instance) to render each custom portlet defined in the
configuration file.

implement the method executePortletAction (within the class
instance) to render each action of a custom portlet defined in
the configuration file.

Provided by BusinessUI

Code See the sample code.

You can find sample code for defining the custom portlet as an extension point in the
file CentraSiteBUIExtension.gwt.xml. You can find the file in the demos folder in the
<CentraSiteInstall_Directory>.
<!-- Use PortletListener by default --> 
  <replace-with 
class="com.softwareag.centrasite.bui.extension.client.portlet.PortletListener"> 
    <when-type-is 
class="com.softwareag.centrasite.bui.extension.core.client.IPortletListener"/> 
  </replace-with>

Important: On a custom portlet defined as GWT extension point, whenever you execute
a basic action (for example, Expand, Collapse, Close) through the user
interface, CentraSite internally sends a corresponding actionId to the GWT
extension.
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Enable Portlet through Configuration

After you define a custom portlet as an extension, you have to enable the custom portlet
configuration so as to display the portlet in the CentraSite Business UI.

Important: The portlet configuration parameters initially defined in the configuration
file are editable and cannot be protected.

To enable a portlet through configuration

1. Open the customization file, centrasite.xml, in a rich text editor.

You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

2. Locate the Portlet Configuration under BUI Configuration.

This is a sample configuration snippet.
<Portlets> 
 <Portlet id="MyFavoritesPortlet" 
   description="INMBU_STR_PORTLET_FAVORITES_DESC" 
   type="text" 
   dataFeed="MyFavorites" 
   icon="images/system/favorites_16X16.png" 
   row="0" 
   column="0" 
   isVisible="true" 
   refreshInterval="0" 
   actions="configure,refresh"> 
   INMBU_STR_PORTLET_NAME_MY_FAVORITES 
 </Portlet> 
 <Portlet id="LastCreatedAssetsPortlet" 
   description="INMBU_STR_PORTLET_RECENTLY_CREATED_ASSETS_DESC" 
   type="text" 
   dataFeed="LastCreatedAssets" 
   icon="images/system/recently_created_16X16.png" 
   row="1" 
   column="0" 
   isVisible="true" 
   refreshInterval="0" 
   actions="configure,refresh"> 
   INMBU_STR_PORTLET_NAME_LAST_CREATED_ASSETS 
 </Portlet> 
 ...
</Portlets>

3. Append the required custom portlet (for example, My Custom Portlet) configuration
statement.
<Portlet id="MyCustomPortlet" 
 description="INMBU_STR_PORTLET_CUSTOM_DESC" 
 type="text" 
 dataFeed="MyFavorites" 
 icon="images/system/custom_16X16.png" 
 row="1" 
 column="1" 
 isVisible="true" 
 refreshInterval="0" 
 actions="configure,refresh"> 
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 INMBU_STR_PORTLET_NAME_MY_CUSTOM_PORTLET 
</Portlet>

wherein,

Parameter Description

id
[Portlet]

A unique identifier for the portlet. It uniquely distinguishes
a portlet in the CentraSite registry. If you want to reset the
portlet at a later stage, you identify the portlet using this id.

description A comment or descriptive information about the portlet.

type The type of portlet. CentraSite Business UI supports the
following portlet types:

text

iframe

graphical

custom

dataFeed Required for text/graphical type. Name of a saved search query
that feeds in the data to the portlet.

url Required for iframe type. An arbitrary URL that points to any
external HTML page. It renders the HTML content within an
HTML IFRAME on the portlet.

icon An icon to display at the top left corner of the portlet header.

The icon is specified as the path to an image file.

Prerequisite:

The icon must be in PNG format. To ensure proper alignment
when it is displayed in the user interface, the icon must be 16 x
16 pixels in size.

The icon must reside in the folder
<CentraSiteInstall_Directory> \cast\cswebapps\BusinessUI
\images\system.

The path for the icon should be specified as images/system/
icon.png

row,
column

The row and column number to place a portlet in the Welcome
page.
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Parameter Description

By default, the portlet is configured to start at level 0. Thus
a seing of 0 (zero) refers to the first portlet in the Welcome
page.

For example, if you want to place a portlet in second row and
fourth column, you will need to specify row=1column=3.

However, if at a later state, you aempt to drag and drop a
portlet in the Welcome page, it automatically updates the GUI
configuration in the repository.

Important: To define a portlet of type custom, ensure that you
have set the value of row=-1column=-1 in order to
dynamically place the custom portlet in your Welcome
page.

isVisible To show or hide the portlet in the Welcome page when you
log in to CentraSite Business UI for the first time after product
installation. Once you have logged in, you can show or hide
the portlet directly from the Welcome page.

Possible values: true (default value) – show the portlet or false
– hide the portlet.

refresh

Interval

The time interval (in seconds) to refresh your portlet content
automatically.

Note: A value 0 is indicates that the portlet content will not be
refreshed automatically.

actions Actions that you want to display in the portlet's configuration.

By default, CentraSite supports the following actions:

Configure

Refresh

Note: You can specify a comma separated list of actions.

Important: When you define a custom action, ensure that you do
not specify any of the inherited actions (for example,
Expand, Collapse, and Close) explicitly.

Now the Portlet Configuration section looks similar to this.
<Portlets> 
 <Portlet id="MyFavoritesPortlet" 
   description="INMBU_STR_PORTLET_FAVORITES_DESC" 
   type="text" 
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   dataFeed="MyFavorites" 
   icon="images/system/favorites_16X16.png" 
   row="0" 
   column="0" 
   isVisible="true" 
   refreshInterval="0" 
   actions="configure,refresh"> 
   INMBU_STR_PORTLET_NAME_MY_FAVORITES 
 </Portlet> 
 <Portlet id="LastCreatedAssetsPortlet" 
   description="INMBU_STR_PORTLET_RECENTLY_CREATED_ASSETS_DESC" 
   type="text" 
   dataFeed="LastCreatedAssets" 
   icon="images/system/recently_created_16X16.png" 
   row="1" 
   column="0" 
   isVisible="true" 
   refreshInterval="0" 
   actions="configure,refresh"> 
   INMBU_STR_PORTLET_NAME_LAST_CREATED_ASSETS 
 </Portlet> 
 <Portlet id="MyCustomPortlet" 
  description="INMBU_STR_PORTLET_CUSTOM_DESC" 
  type="text" 
  dataFeed="MyFavorites" 
  icon="images/system/custom_16X16.png" 
  row="1" 
  column="1" 
  isVisible="true" 
  refreshInterval="0" 
  actions="configure,refresh"> 
  INMBU_STR_PORTLET_NAME_MY_CUSTOM_PORTLET 
</Portlet>
 ...
</Portlets>

4. Define the actions that you want to render in the portlet's seings.
<PortletActions> 
 <PortletAction id="configure"> 
  INMBU_STR_PORTLET_ACTION_EDIT 
 </PortletAction> 
 <PortletAction id="refresh"> 
  INMBU_STR_PORTLET_ACTION_REFRESH 
 </PortletAction> 
</PortletActions>

Parameter Description

id
[PortletAction]

A unique identifier for the action. It uniquely
distinguishes an action in the CentraSite registry. If you
want to reset the action at a later stage, you identify the
action using this id.

5. Define the parameters that you want to display in the portlet.
<PortletParameters> 
 <PortletParameter 
  id="MyFavoritesPortletParam" ref="MyFavoritesPortlet" 
  params="noOfAssets#VSEP#10#PSEP#assetTypeKeys#VSEP#
  uddi:cd906138-59f5-4d7f-4f5f-6115adfa8d9c#ASEP#
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  uddi:cd906138-59f5-4d7f-4f5f-6115adfa8e3d" 
  attributes="" /> 
</PortletParameters>

Parameter Description

id
[PortletParameter]

A unique identifier for the parameter. It uniquely
distinguishes the portlet's parameter in the
CentraSite registry. If you want to reset the
parameter at a later stage, you identify the parameter
using this id.

ref The specified unique identifier for the portlet.

params Parameters that you want to display in the portlet's
configuration. The parameter values determine
which data displays in the portlet.

When you define a parameter, keep the following
points in mind:

A value separator (#VSEP#) is required between the
parameter name and the value.

Thus, for example, if you want to define a
parameter noOfAssets with value 10, you
can write the parameter name-value pair as
noOfAssets#VSEP#10

A parameter separator (#PSEP#) is required
between the multiple parameters.

Thus, for example, if you want to
define two parameters, one parameter
noOfAssets with value 10, and another
parameter assetTypeKeys with value
uddi:cd906138-59f5-4d7f-4f5f-6115adfa8d9c,
you can write the above parameters as
params="noOfAssetsToReturn#VSEP#10#PSEP#asset
TypeKeys#VSEP#uddi:cd906138-59f5-4d7f-4f5f-
6115adfa8d9c"

An array separator (#ASEP#) is required between
multiple values (that is, an array of values).

Thus, for example, if you want to
assign a parameter assetTypeKeys
with more than one value
(uddi:cd906138-59f5-4d7f-4f5f-6115adfa8d9c,
uddi:cd906138-59f5-4d7f-4f5f-6115adfa8e3d),
you can write the parameter as
assetTypeKeys#VSEP#uddi:cd906138-59f5-4d7f-4f5f-
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Parameter Description
6115adfa8d9c#ASEP#uddi:cd906138-59f5-4d7f-4f5f-
6115adfa8e3d

attributes List of aributes you wanted to display in the
portlet's configuration.

6. For a graphical chart configuration. If you have opted to show different colors in a
graphical chart configuration, specify the colors for each bar, line, or pie plot.

In this case, the line would look like:
<Colors> 
 <Color id="#233356">OceanBlue</Color> 
 <Color id="#038299">LagunaBlue</Color> 
</Colors>

The <Colors> list must have the colors specified in the HEX color code format.
The HEX format is a hash (#) followed by 6 numbers or leers. The position of the
numbers or leers correlates to the RGB value. For example, ,#233356 translates into
OceanBlue.

7. Locate the following property statement and specify the required values.
<PortletConfigurations 
 portletsPerRow="3" 
 settingsPopupColumnCount="2" 
 helpToken="HELPCENTER_007" 
 headerMaxCharacterLength="27">

Parameter Description

PortletsPerRow The number of portlets to display per row in the
Welcome page.

settingsPopupColumnCount The number of columns to display in the
Configure Your Welcome Page dialog.

helpUrl The URL of the standard Help Center that's
delivered with the CentraSite Business UI.

headerMaxCharacterLength The maximum content length of a portlet's
header text. By default, the allowed header
text length is 27 characters. If the character
in the header text exceeds 27, the text gets
automatically truncated.

8. Save and close the configuration file.

9. Restart Software AG Runtime.
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Portlet Display Names

The display name for a portlet or an action is the name that is displayed by the
CentraSite Business UI. A portlet's or action's display name can either be a localized
string fetched from the message database or a plain string.

If you want to specify a localized name, enter the message ID. The message ID (for
example, INMBU_LBL_PORTLET_PENDING_APPROVALS) must begin with a INMBU label.
The portlet internally identifies the message ID, and display the localized name, if
available in the message database. Else, if you specify a name without INMBU label, the
portlet displays a plain text name.

Computed Runtime Actions
If you want a runtime workflow to execute a task that is not provided by a built-in
runtime action, you can create a custom computed runtime action to perform the work.

The CentraSite Business UI contains a default set of actions, where each action
represents a collection of predefined parameters.

Your CentraSite installation contains a sample computed action as an extension in
the <CentraSiteInstall_Directory> /demos folder. You can adapt the sample computed
action to suit your needs and then configure the custom action to display in the policy
accordion.

To define a customized computed action

1. Implement the custom runtime action as a GWT extension point. For procedures, see
“Implement Runtime Action as an Extension” on page 100.

2. Configure the custom runtime action in centrasite.xml configuration file. For
procedures, see “Enable Runtime Action through Configuration” on page 100.

Implement Runtime Action as an Extension

Usage Use this to define a computed runtime action in CentraSite
Business UI.

Provided by BusinessUI

Code See the sample code.

You can find sample code for defining the custom runtime action as an extension point
in the file CentraSiteBUIExtension.gwt.xml. You can find the file in the demos folder in
the <CentraSiteInstall_Directory>.

Enable Runtime Action through Configuration

After you define the computed action as an extension, enable the computed action
configuration so as to display the action in the policy accordion.
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Important: The action parameters defined in the configuration file are editable and
cannot be protected.

To enable runtime action through configuration

1. Open the customization file, centrasite.xml, in a rich text editor.

You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

2. Locate Policy Action Templates under <CLL Configuration>.

The Policy Action Templates snippet looks like this:
<PolicyActions>
 <PolicyAction id="" class="" />
</PolicyActions>

3. Append the property configuration statement for computed runtime action. For
example, MyComputedRuntimeAction.
<PolicyActions> 
 <PolicyAction 
  id="uddi:44e3e2de-064c-432f-b67a-8fbca0fb04d6" 
  class="com.softwareag.centrasite.bui.
         extension.service.MyComputedRuntimeActionParser" />
</PolicyActions>

The input parameters are:

Parameter Description

id A unique identifier for the computed action.

It uniquely distinguishes an action in the CentraSite registry. If
you wish to reconfigure the action at a later stage, you identify
the action using this id.

class A parser implementation for the computed action.

4. Save and close the configuration file.

5. Restart Software AG Runtime.

Installing an Extension
You can use the pluggable architecture to define and install the extensions as part of
customizing the Content pages. This section gives the high-level steps of installing an
extension to customize the Content pages.

To install an extension

1. Set up a new GWT project in Eclipse. For procedures, see “Seing up GWT” on
page 102.
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2. Configure the centrasite.xml configuration file to adapt to the extension points. For
procedures, see “Configuring an Extension” on page 104.

Setting up GWT

Ensure that you have a recent Eclipse version installed on your machine. Eclipse is
available as a download from “hp://www.eclipse.org/”. In Eclipse, select Help >
Install New Software in order to configure usage of GWT plug-in with the Java version
currently supported by CentraSite.

The system requirements can be checked at “hp://documentation.softwareag.com/”.

To set up GWT

1. Set the classpath to specify the classpath variables for the new GTW project.

a. In Eclipse, select Window > Preferences > Java > Build Path

b. Expand the Build Path node.

c. Select the Classpath Variables.

d. In the Classpath Variables dialog, select New. This opens the New Variable Entry
dialog box.

e. Specify a name for the new classpath variable
(CENTRASITE_REDIST_LOCATION) and the location. You can find the redist
folder in <CentraSiteInstall_Directory> (Microsoft Windows) or /opt/softwareag/
CentraSite/redist (UNIX).

f. Click OK.

g. In the Classpath Variables dialog box, click OK.

h. Specify a second classpath variable CENTRASITE_RTS_LOCATION. You can
find the rts folder in <CentraSiteInstall_Directory>.

Two new Java classpath variables called CENTRASITE_REDIST_LOCATION and
CENTRASITE_RTS_LOCATION have been created due to the previous actions.

i. Add all of the JAR files contained in the redist folder to the classpath.

In addition, if you upgrade to CentraSite 9.7 from a previous version of
CentraSite, and you want to use the extension points of the previous version, you
must do the following:

a. Open the MANIFEST.MF file located in the directory
old_<CentraSiteInstall_Directory>\cast\cswebapps\BusinessUI\META-INF.

b. You find the relative path of the jar files, for example,
CentraSiteBUIExtension.jar and CentraSiteBUIExtensionCore.jar, in
the Bundle-ClassPath section:
WEB-INF/lib/CentraSiteBUIExtension.jar,
WEB-INF/lib/CentraSiteBUIExtensionCore.jar

http://www.eclipse.org/
http://documentation.softwareag.com/
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c. Copy the file path into the Bundle-ClassPath section in the MANIFEST.MF
file located in the directory 9.7_<CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\META-INF.

Note: If you have created custom extensions in your previous version of
CentraSite, ensure that you include their associated jar files into the
META-INF folder.

d. Add the extension's associated Java archives to the directory
9.7_<CentraSiteInstall_Directory> \cast\cswebapps\BusinessUI\META-INF.

e. Save the modifications.

f. Restart the Software AG Runtime.

2. Import the GWT project.

a. Select File > Import from the main menu.

b. On the Select page of the Import wizard, select Existing Projects into Workspace and
click Next.

c. On the Import Projects dialog, choose the Select root directory radio buon.

d. Click the Browse buon that is located beside the input field labeled Select root
directory. The Browse for Folder dialog is displayed.

e. Within the Browse for Folder dialog, navigate to and click on the
CentraSiteBUIExtension folder of the Software AG Runtime application.

This folder contains the definitions for the extensions that CentraSite supports
out of the box. The CentraSiteBUIExtension folder resides in the demos folder
under the CentraSite installation directory.

f. Click OK.

g. In the Import Projects dialog, click Finish.

A new Java project called CentraSiteBUIExtension has been created
due to the previous actions. This project is now visible in the Package
Explorer view in Eclipse. It contains example implementations of the
existing extension points for the Business UI. You can modify them
to suit your needs. For using your own Widget as Extension Point,
specify it as a return value in the ExtensionWidgetFactory class in the
com.softwareag.centrasite.bui.extension.client.factory package.

h. Open the file build.properties. Type the paths to your
GoogleWebToolkit_HOME, the Extension target location, the redist and the rts
folder. Now the project can be build using apache ant. Run the build.xml script.

i. To install the extension, use the ant deploy target. Open command line and
navigate to your project location. Type: ant deploy.
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Configuring an Extension

We have now created a Java project inside the Business UI web application. The
extension functionality for the CentraSite Business UI is contained in the custom
configuration file. You can configure this file to adapt to the appropriate extensions as
required

To configure an extension

1. Open the customization file, centrasite.xml, in a rich text editor.

You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

2. Open the file in a text editor, and locate the configuration entry EXTENSION
POINTS.
<Extensions src="">
 <! --centrasitebuiextension/centrasitebuiextension.nocache.js -->
 <ExtensionPointLogin custom="false" />
 <ExtensionPointRegister custom="false" />
 <ExtensionPointBrowseView custom="false" />
 <ExtensionPointBrowseCriteria custom="false" />
 <ExtensionPointSearchWidget custom="false" />
 <ExtensionPointSearch custom="false" />
 <ExtensionPointSearchCriteria custom="false" />
 <ExtensionPointAssetDetails custom="false" />
 <ExtensionPlaces protected="true">
 <ExtensionPlace className=
 "com.softwareag.centrasite.bui.client.place.home.ExtensionPlace"/>
 </ExtensionPlaces>
</Extensions>

3. Specify the extensions file path as CentraSiteBUIExtension/
centrasitebuiextension.nocache.js in order to point to the location of the Java script
file.

4. Identify the extension point that you want to configure to the CentraSite Business UI.

5. Enable the extension point by modifying its custom value from false to true. The
default value is false.

6. After making the above changes, the extension entry would look like this:
<Extensions src="centrasitebuiextension/centrasitebuiextension.nocache.js">
 <ExtensionPointLogin custom="true" />
 <ExtensionPointRegister custom="true" />
 <ExtensionPointBrowseView custom="true" />
 <ExtensionPointBrowseCriteria custom="true" />
 <ExtensionPointSearchWidget custom="true" />
 <ExtensionPointSearch custom="true" />
 <ExtensionPointSearchCriteria custom="true" />
 <ExtenstionPointAssetDetails custom="true" />
 <ExtensionPlaces protected="true">
 <ExtensionPlace className=
 "com.softwareag.centrasite.bui.client.place.home.ExtensionPlace" />
 </ExtensionPlaces>
</Extensions>
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7. Save and close the file.

8. Locate the web.xml configuration file.

You can find the web.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\WEB-INF.

9. Open the file in a text editor, and locate the ExtensionServlet entry:
<servlet>
 <servlet-name>ExtensionServlet</servlet-name>
 <servlet-class>
  com.softwareag.centrasite.ui.extension.service.ExtensionServiceImpl
 </servlet-class>
</servlet>
<servlet-mapping>
 <servlet-name>ExtensionServlet</servlet-name>
 <url-pattern>/centrasitebuiextension/extensionService</url-pattern>
</servlet-mapping>

10. Uncomment the ExtensionServlet entry in order to enable the extension
configurations that are performed in the previous actions. Similarly, if the extension
configuration is already enabled and you want to disable it, simply comment out the
ExtensionServlet entry.

11. Save and close the file.

12. Restart Software AG Runtime.

Note: The extension point's readme file is recommended for reading. The
readme file is available in the <CentraSiteInstall_Directory> \demos
\CentraSiteBUIExtension directory.

Uninstalling an Extension
You can uninstall a single extension or multiple extensions.

Note: The extension point's readme file is recommended for reading. The
readme file is available in the <CentraSiteInstall_Directory> \demos
\CentraSiteBUIExtension.

To uninstall an extension

1. Open the customization file, centrasite.xml, in a rich text editor.

You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

2. Open the file in a text editor, and locate the configuration entry for the required
extension point.
<Extensions src="centrasitebuiextension/centrasitebuiextension.nocache.js">
<ExtensionPointLogin custom="false" />
<ExtensionPointRegister custom="false" />
<ExtensionPointBrowseView custom="false" />
<ExtensionPointBrowseCriteria custom="false" />
<ExtensionPointSearchWidget custom="false" />
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<ExtensionPointSearch custom="false" />
<ExtensionPointSearchCriteria custom="false" />
<ExtensionPointAssetDetails custom="false" />
<ExtensionPlaces protected="false">
<ExtensionPlace className=
"com.softwareag.centrasite.bui.client.place.home.ExtensionPlace"/>
</ExtensionPlaces>
</Extensions>

3. Remove the configuration entry for the selected extension point.

Alternatively, if you want to uninstall multiple extension points, you can set the
extension point's custom value to false.

4. Save and close the file.

5. Restart Software AG Runtime.

Creating a Custom Extension
You can create a custom GWT specific extension to suit your requirements.

To create a custom extension

1. Write a new widget class.

2. Open the file ExtensionWidgetFactory.java that resides in the
CentraSiteBUIExtension folder.

3. Locate the method corresponding to the extension Id whose widget you want to
customize.

4. Return the new widget in the corresponding method.

5. Save and close the ExtensionWidgetFactory.java file.

6. Edit the custom configuration file to configure the extensions as appropriate. For
details on configuring the extension properties, see “Configuring an Extension” on
page 104

Installing CentraSite Business UI Extension

Note: The <CentraSiteInstall_Directory> indicates the installation directory of
CentraSite. For example: C:\SoftwareAG\CentraSite in Windows or /opt/
softwareag/CentraSite in Linux.

To install CentraSite Business UI extension

1. Open the build.properties file.

You can find the file in the folder <CentraSiteInstall_Directory> \demos
\CentraSiteBUIExtension.

2. Update the build.properties file to include the following information:
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a. In the property sag.root.dir, specify the installation directory of SoftwareAG.
For example, C:\SoftwareAG.

b. In the property bnd.jar.path, specify the location of the bnd JAR file.

This property is required for creating JAR files with proper import and export
references. The instructions for obtaining the bnd JAR file is provided in the
build.properties file.

c. Navigate to the directory where you extracted the Google Web Toolkit (GWT)
and include the following Jar files:

gwt-dev.jar

gwt-user.jar

validation-api-1.0.0.GA.jar

validation-api-1.0.0.GA-sources.jar

d. Set the environment variable gwt.home to point to the GWT directory.

3. Run the command ant.

The command compiles the CentraSiteBUIExtension and create the required files.

The syntax is of the format: C:\SoftwareAG\CentraSite\demos
\CentraSiteBUIExtension>ant

Deploying CentraSite Business UI Extension
Pre-requisites:

Before you deploy the CentraSite Business UI extension, make sure that you take a
backup of the following files:

<CentraSiteInstall_Directory> \cast\cswebapps\BusinessUI\WEB-INF\web.xml

<CentraSiteInstall_Directory> \cast\cswebapps\BusinessUI\custom\conf
\centrasite.xml

Note: The <CentraSiteInstall_Directory> indicates the installation directory of
CentraSite. For example: C:\SoftwareAG\CentraSite in Windows or /opt/
softwareag/CentraSite in Linux.

Once the CentraSiteBUIExtension is compiled successfully, the BusinessUI extension has
to be deployed.

To deploy CentraSite Business UI extension

1. Run the command ant deploy.

The command deploys the CentraSiteBUIExtension.

The syntax is of the format: C:\SoftwareAG\CentraSite\demos
\CentraSiteBUIExtension>ant deploy
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2. Open the web.xml file.

You can find the file in the folder <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\WEB-INF\.

3. In the web.xml file, uncomment the following property lines:
<servlet>
  <servlet-name>ExtensionServlet</servlet-name>
  <servlet-class>com.softwareag.centrasite.bui.
   extension.service.ExtensionServiceImpl</servlet-class>
</servlet>
<servlet-mapping>
  <servlet-name>ExtensionServlet</servlet-name>
  <url-pattern>/centrasitebuiextension/extensionService</url-pattern>
</servlet-mapping> 
<servlet>
  <servlet-name>ActionExecutionServlet</servlet-name>
  <servlet-class>com.softwareag.centrasite.bui.
   extension.core.service.action.ActionExecutorServiceImpl</servlet-class>
</servlet>
<servlet-mapping>
  <servlet-name>ActionExecutionServlet</servlet-name>
  <url-pattern>/centrasitebuiextension/action</url-pattern>
</servlet-mapping>

4. If the ActionExecutionServlet is not already available in the web.xml, add the
following XML fragment below the entry ExtensionServlet:
<servlet>
  <servlet-name>ActionExecutionServlet</servlet-name>
  <servlet-class>com.softwareag.centrasite.bui.
  extension.core.service.action.ActionExecutorServiceImpl</servlet-class>
</servlet>
<servlet-mapping>
  <servlet-name>ActionExecutionServlet</servlet-name>
  <url-pattern>/centrasitebuiextension/action</url-pattern>
</servlet-mapping>

5. Open the customization file, centrasite.xml, in a rich text editor.

You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

6. Set the value of the aribute src to centrasitebuiextension/
centrasitebuiextension.nocache.js.
src="centrasitebuiextension/centrasitebuiextension.nocache.js"

7. In the element <Extensions>, set the value of the aribute custom to true to enable
an extension.

The element <Extensions> includes all the possible extensions in CentraSite
Business UI.

8. To enable the custom actions that are available in the demos folder, uncomment the
elements <Actions> and </Actions>.

If the custom action entries Action id="RunPolicyAction" and Action
id="ChangeOwnerAction" are already available in the centrasite.xml file, then
uncomment them.
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If the custom action entries Action id="RunPolicyAction" and Action
id="ChangeOwnerAction" are not available in the centrasite.xml file, then include
the following property statements:
<Actions>
 <Action id="RunPolicyAction" inbox="false" bulk="false" 
  group="basic" 
  icon='images/system/actionbar/execute_policy.png' 
  class="com.softwareag.centrasite.demos.bui.
  actions.runpolicy.RunPolicyAction">Execute Policy
 </Action>
 <Action id="ChangeOwnerAction" inbox="false" bulk="true" 
  group="basic" 
  icon='images/system/actionbar/change_owner.png' 
  class="com.softwareag.centrasite.demos.bui.
  actions.changeowner.ChangeOwnerAction">Change Owner
 </Action> 
</Actions>

9. Save and close the file.

10. Restart Software AG Runtime.

Undeploying CentraSite Business UI Extension

Note: The <CentraSiteInstall_Directory> indicates the installation directory of
CentraSite. For example: C:\SoftwareAG\CentraSite in Windows or /opt/
softwareag/CentraSite in Linux.

To undeploy CentraSite Business UI extension

1. Run the command ant undeploy.

The command undeploys the CentraSiteBUIExtension.

The syntax is of the format: C:\SoftwareAG\CentraSite\demos
\CentraSiteBUIExtension>ant undeploy

Note: You may want to run the command ant undeploy, only if the
CentraSiteBUIExtension is already be deployed.

2. Open the web.xml file, and then undo all changes manually.

You can find the file in the folder <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\WEB-INF\.

3. Open the customization file, centrasite.xml, in a rich text editor.

You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

4. Restart Software AG Runtime.
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Customization of CentraSite Control
CentraSite Control offers a pluggable architecture that allows you to extend the standard
graphical interface by adding your own features.

The CentraSite Control user interface is itself a plug-in to a base infrastructure, in other
words, the base infrastructure provides extension points where CentraSite Control is
plugged in. The base infrastructure is composed of the Application Designer, which
provides the basic graphical infrastructure of the GUI and the plug-in infrastructure
base, which allows plug-ins to communicate with the Application Designer.

The figure illustrates the plug-in architecture of CentraSite Control.

The plug-in infrastructure is inspired by Eclipse that allows the user interface to be
extended by domain-specific or customer-specific functionality.

Plug-ins are implemented as Java classes. The points in the code at which plug-ins can
be added are called extension points. CentraSite Control offers extension points that
allow you to implement or extend the following features:

Provide an alternative login screen.

Add a topic to the navigation pane within any perspective.

Support i18N (internationalization) for layouts contributed by a plug-in.

Add a logo and links to the login dialog.
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Handle the creation and termination of the connection to a backend machine.

Add a perspective contributing the following components: a toolbar, a logo, one or
more topics, and a background screen. A perspective allows you to group topics in
the navigation view.

Add a command to the context menu of a registry object or a repository object.

Add a property to an object. The property is then visible in detail views and under
the General tab.

Add a tab to the detail view of registry objects and repository objects.

Add a source of notifications.

Add secondary icons to nodes in the graphical impact analysis.

Extend the Summary tab.

Replace the standard detail view used as editor for registry and repository objects by
an object type specific editor.

Extend the set of available import commands.

Extend the search dialog by additional conditions.

A plug-in can itself provide extension points for further plug-ins.

Customizing the Welcome Page
The Welcome page of CentraSite Control can be customized as required. You can change
the icons used, colors, text, fonts, and layouts. You can also define links that take you
directly to the CentraSite Control pages that are frequently used and links to external
web sites. In the Welcome page you can specify the language you use for CentraSite
Control and the date format to be used in the various displays. This is the schematic
layout for the Welcome page.
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In the header section you can change the texts, the fonts, and colors used to display
the text in the title and subtitle. You can add an icon adjacent to the title. A search box
allows you to perform a keyword search for registry assets and objects whose name
or description contains the given keyword. You can hide the search box or change the
background color of the search box as part of the page customization. You can change
the background color for the whole header section as well.

Below the header section, are the widgets. Each widget contains a title, with an icon
adjacent to the text and have a list of entries under the title, each representing some
executable action. Typically, an action contains a URL to either a page of your choice
within CentraSite Control, or to an external web page that you regularly visit within the
context of your work with CentraSite. The Welcome page can contain up to 10 widgets.
The widgets are displayed side by side in a single row.

There are several kinds of widget:

Single-column widget - The executable actions are displayed as a table consisting of a
single column. Each table cell contains one executable action. Each cell can also have
an icon beside it. There is a header text above the table.

Multi-column widget - The executable actions are displayed as a table consisting of two
or more columns. Each table cell contains one executable action. Each cell can also
have an icon beside it. There is a header text above each column of the table.

HTML-style widget - The contents are freely programmable as HTML code. The HTML
statements you use must be valid within the context of an HTML table cell, that is,
there is an implicit HTML <td> element enclosing the HTML code you supply.

In general, you can use the CSS stylesheet statements to customize the appearance of
text and colors in the Welcome page.
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Implementation of Welcome Page
The Welcome page is implemented as a plug-in module within the CentraSite pluggable
UI architecture. This means that all the development aspects that are relevant for
implementing CentraSite plug-in modules also apply to the Welcome page.

The layout and contents of the Welcome page are implemented as Java code. Each
customizable part of the Welcome page requires a corresponding Java class. The
Welcome screen can be defined as a combination of the following hierarchical structures:

The header and body of the Welcome page.

The widgets in the body of the Welcome page.

The items in the columns of the widgets.

Screen Component: Welcome Page

The Welcome page is composed of a header and a body. The header contains a title,
subtitle, icon, search box, and background image. The body contains one or more
widgets. The content and appearance of these components are determined by the Java
methods as shown.

The table describes the purpose of these Java methods.

Name of Java
interface

Java Method Description

IWelcomePage getTitle(); Defines the header text to
be used.
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Name of Java
interface

Java Method Description

IWelcomePage getTitleStyle(); Defines the CSS style
information for the
header.

IWelcomePage getSubTitle(); Defines the header
subtitle text to be used.

IWelcomePage getSubTitleStyle(); Defines the CSS style
information for the
header subtitle.

IWelcomePage getImage(); Defines the icon to be
used in the header.

IWelcomePage isSearchVisible(); Defines whether the
search box in the header
part is visible or invisible.

IWelcomePage getSearchBackgroundImage(); Defines a background
image to be used for the
search box.

IWelcomePage getHeaderBackgroundImage(); Defines a background
image to be used for the
header part.

IWelcomePage getBoomBackgroundImage(); Defines a background
image to be used for the
body part.

IWelcomePage getWidgets(); Defines the widgets that
will be used in the body
part.

Screen Component: Widget

The body part of the Welcome page is composed of one or more widgets. A widget
can define just HTML code (an HTML-style widget) or can define content and layout,
similar to the header part of the Welcome page. The content and layout components are:
a background image, a header text, the definition of a single-column table of items, and
the definition of a multi-column table of items.
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The content and appearance of these components are determined by the Java methods as
shown.

The table describes the purpose of these Java methods.

Name of Java interface Java Method Description

IWidget getWidth(); Defines the screen width of
the widget.

IHtmlWidget getHtml(); Defines HTML code for an
HTML-style widget.

IColumnWidget getBackgroundImage(); Defines the background image
to be used for a column of a
widget.

IColumnWidget getTitle(); Defines the header text of a
column of a widget.

IColumnWidget getTitleStyle(); Defines the CSS style for the
header text of a column of a
widget.
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Name of Java interface Java Method Description

IColumnWidget getImage(); Defines the background image
to be used for the header part
of the widget.

ISingleColumnWidget getSubTitle(); Defines the subtitle text of a
single-column widget.

ISingleColumnWidget getSubTitleStyle(); Defines the CSS style for the
subtitle header text of a single-
column widget.

ISingleColumnWidget getItems(); Defines the items contained in
a single-column widget.

IMultiColumnWidget getColumns(); Defines the columns used in a
multi-column widget.

IColumn getSubTitle(); Defines the subtitle text of a
column of a multi-column
widget.

IColumn getSubTitleStyle(); Defines the CSS style for the
subtitle text of a column of a
multi-column widget.

IColumn getItems(); Defines the items contained in
a column of a multi-column
widget.

Screen Component: Item

Each widget in the body part of the Welcome page can contain one or more items,
arranged in one or more table columns. An item represents an executable action that you
can define freely, for example, the action could be the activation of a URL in order to
reach a particular page within CentraSite Control or an external web site.

The content and appearance of these components are determined by the Java methods as
shown.
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The table describes the purpose of these Java methods.

Name of Java interface Java Method Description

IItem getStyle(); Defines the CSS style for the item.

IActionItem getTitle(); Defines the text to be displayed for the
item.

IActionItem getImage(); Defines the icon to be displayed adjacent
to the descriptive text.

ISeparatorItem getHeight(); Defines the height in pixels of the area
that contains the separator image.

ISeparatorItem getImage(); Defines the image be displayed as the
separator item.

Java Methods Not Related to Screen Components

The table lists the Java methods that are not related to a screen component, but are
required for the pluggable UI architecture of CentraSite Control.
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Name of Java
interface

Java Method Description

(all interfaces) setLocale(); This informs the widget or item
about the CentraSite Control locale
that is required to localize texts for
the display.

This method is called automatically
before any other method that might
depend on the locale.

(all interfaces) setActionContext(); This informs the widget or item
about the CentraSite Control context
that is required for the processing
to be done subsequently by the
execute() method.

This method is called automatically
before any other method that might
depend on the action context.

IWidget invalidate(); This sets the status that the display
of the current item must be
refreshed (true) or does not need to
be refreshed (false).

IWidget isInvalidated(); This returns whether or not the
display of the item needs to be
refreshed.

IItem getWidget(); This method gets the widget to
which the current item belongs.

IItem setWidget(); This method sets the widget to
which the current item belongs.

IActionItem execute(); This activates the action to be
performed when you click on the
current item.

Java Interface Hierarchy

The interface hierarchy is as follows:
IWelcomePage 
   
IWidget 
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 IColumnWidget 
    IMultiColumnWidget 
    ISingleColumnWidget 
 IHtmlWidget 
   
IColumn 
  
IItem 
 IActionItem 
 ISeparatorItem

Installing the Customized Welcome Page
The Welcome page is implemented as a CentraSite Control extension point in the context
of CentraSite's pluggable UI architecture. To install the customized Welcome page, you
have to modify CentraSite Control's pluggable UI configuration in the Software AG
Runtime environment.

1. Stop Software AG Runtime.

2. Update the plugin.xml configuration file.

The standard plugin.xml configuration file delivered with the CentraSite kit contains
all the names of the CentraSite Control extension points, including the extension
point for the Welcome page. You must update this file to contain the definition
of the customized Welcome page. The configuration file is located in the folder
<RuntimeDir> \workspace\webapps\PluggableUI\CentraSiteControl.

There are two elements in the standard plugin.xml file that refer to the Welcome
page. The first part defines the name of the extension point to be used for the
Welcome page.
<extension-point id="welcomePage"> 
</extension-point>

The second part defines the Java class that implements the Welcome page.
 <!-- Welcome Page --> 
 <extension 
    point="com.centrasite.control.welcomePage" 
    id="welcomePage" 
    class="com.centrasite.control.ext.welcome.standard.WelcomePage"> 
 </extension>

The point aribute of the extension element in the second part must match the
name given by the id aribute of the plugin element (usually in the first line in
the plugin.xml file) concatenated with a dot and the id aribute of the extension-
point element in the first part. For example, if the id aribute of the plugin element
is com.centrasite.control and the id aribute of the extension-point element
is welcomePage, then the value of point aribute of the extension element must
be com.centrasite.control.welcomePage. The Java class identified by the class
aribute of the extension element must implement the interface IWelcomePage.
To use the customized Welcome page instead of the standard Welcome page, set
the class aribute to the customized Java class that implements the interface
IWelcomePage. The changes that you make in plugin.xml take effect the next time
Software AG Runtime is started.
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Note: Instead of overwriting the standard element in plugin.xml, you may want
to retain a copy of the original element and comment it out. This helps
when you want to revert to the original Welcome page.

3. Deploy the new Java classes to the PluggableUI environment.

You have to copy the Java classes for your customized Welcome page to the
CentraSite Control location in Software AG Runtime. There are two ways of doing
this:

Create a jar file containing the class files for the customized Welcome page, and
copy the jar file to the CentraSiteControl\lib folder in Software AG Runtime.

Copy the class files to the CentraSiteControl\classes folder and its subfolders,
according to the naming convention of the Java package that contains the classes.
For example, if your package name is com.centrasite.control.ext.welcome.sample,
then copy the classes to the CentraSiteControl\classes\com\centrasite\control
\ext\welcome\sample folder.

You can also combine these methods and define some classes using a jar file in
the lib folder and some classes as class files in the appropriate subfolder of the
classes folder. If you have defined a class in both lib and a subfolder of classes, the
class in the CentraSiteControl\classes subfolder will be used. If you have defined
new icons for the customized Welcome page, you have to copy the icons to the
appropriate location under the CentraSiteControl folder. If, for example, your
code contains the definition public String getImage() { return "images/
my_welcome_icon.png"; }, ensure that the icon my_welcome_icon.png is copied to
CentraSiteControl\images.

4. Start Software AG Runtime.

The changes you have made should now be visible when you view the Welcome
Page.

Sample Customized Welcome Page
This section describes the customized Welcome page that is provided as a demo in the
product distribution.

Location of Demo Files

The required files for the demo are located in the folder demos\WelcomePage under the
CentraSite installation location. The files are:

The Java source files. These are located in the subfolder src.

Icons to be displayed in the Welcome page. These are located in the subfolder
resources.

Updates for the Software AG Runtime configuration. These are in the file resources
\plugin.xml.

Eclipse project files .classpath and .project.
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Apache Ant files build.properties and build.xml for building the files that are
deployed to Software AG Runtime.

Differences Between the Standard Welcome Page and the Demo Welcome Page

The figures display the differences between the standard welcome page and the demo
welcome page that is customized as required.

The standard welcome page appears as follows:

The demo welcome page used as an example in this section appears as follows:
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The main changes between the standard welcome page and the customized welcome
page that Software AG supplies as a demo are:

The text in the title of the header section has changed. Also the color of this text has
changed.

The background color in the customized welcome page has changed.

The large icons in the titles of the header part and of the widgets have changed.

The small icons in the CentraSite widget have changed.

The widgets have 3-D effect shadowed borders.

The search box in the header section has been removed.

Implementation of Welcome Page Layout

This section lists the layout possibilities of the welcome page and specifies the Java
methods where the layout is defined.

Note: If any background image that is defined for an area of display is not as wide
as the area, the image is repeated horizontally until the whole width of the
area is covered.

Header Area

Layout component Source file Java Method

Icon WelcomePage.java getImage();



M
Odd Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 123

Layout component Source file Java Method

Background image WelcomePage.java getHeaderBackgroundImage();

Title text WelcomePage.java getTitle();

CSS style of title text WelcomePage.java getTitleStyle();

Subtitle text WelcomePage.java getSubTitle();

CSS style of subtitle text WelcomePage.java getSubTitleStyle();

Background image of the
Search box

WelcomePage.java getSearchBackgroundImage();

Make the Search box
visible/invisible

WelcomePage.java isSearchVisible();

Separator Between Header Part and Widget Part

Layout component Source file Java Method

Image SeparatorItem.java getImage();

Height in pixels SeparatorItem.java getHeight();

Widget CentraSite

Layout component Source file Java Method

Width of widget CentraSiteWidget.java getWidth();

Title text CentraSiteWidget.java getTitle();

CSS style of title text CentraSiteWidget.java getTitleStyle();

Subtitle text CentraSiteWidget.java getSubTitle();

CSS style of subtitle text CentraSiteWidget.java getSubTitleStyle();

Header icon CentraSiteWidget.java getImage();

Background image CentraSiteWidget.java getBackgroundImage();



M
Even Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 124

Layout component Source file Java Method

CentraSite widget: define
the items to be included in
the bullet list

CentraSiteWidget.java getItems();

Icon for item Asset
Catalog

KeywordSearchItem.java getImage();

Text for item Asset
Catalog

KeywordSearchItem.java getTitle();

Icon for item Advanced
Search

AdvancedSearchItem.java getImage();

Text for item Advanced
Search

AdvancedSearchItem.java getTitle();

Icon for item Inbox InboxItem.java getImage();

Text for item Inbox InboxItem.java getTitle();

Icon for item My
Favorites

MyFavoriteItem.java getImage();

Text for item My
Favorites

MyFavoriteItem.java getTitle();

Widget Useful Links

Layout component Source file Java Method

Header icon UsefulLinksWidget.java getImage();

Width of widget UsefulLinksWidget.java getWidth();

Title text UsefulLinksWidget.java getTitle();

CSS style of title text UsefulLinksWidget.java getTitleStyle();

Subtitle text UsefulLinksWidget.java getSubTitle();

CSS style of subtitle
text

UsefulLinksWidget.java getSubTitleStyle();
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Layout component Source file Java Method

Background image UsefulLinksWidget.java getBackgroundImage();

Text for item
CentraSite
Developers
Community

DeveloperCommunityItem.java getTitle();

URL for item
CentraSite
Developers Community
(See note below)

DeveloperCommunityItem.java execute();

Text for item
CentraSite
Community

CentraSiteCommunityItem.java getTitle();

URL for item
CentraSite Community
(See note below)

CentraSiteCommunityItem.java execute();

Text for item
CentraSite Online
Documentation

OnlineDocumentationItem.java getTitle();

URL for item
CentraSite Online
Documentation
(See note below)

OnlineDocumentationItem.java execute();

Define the items to be
included in the bullet
list

UsefulLinksWidget.java getItems();

Note: For the URLs for items CentraSite Developers Community, CentraSite
Community , and CentraSite Online Documentation, the creation of a
hyperlink that opens a new browser page is implemented by a call of the
openPageInNewWindow method of the getDisplayAdapter() class that is available
in the CentraSiteControlUI.jar file in Software AG Runtime.

Widget User Preferences
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Layout component Source file Java Method

Header icon UserPreferencesWidget.java getImage();

Width of widget UserPreferencesWidget.java getWidth();

Title text UserPreferencesWidget.java getTitle();

CSS style of title text UserPreferencesWidget.java getTitleStyle();

Background image UserPreferencesWidget.java getBackgroundImage();

Text of the Languages
subtitle

LanguagesColumn.java getSubTitle();

CSS style of the
Languages subtitle

LanguagesColumn.java getSubTitleStyle();

Width of Languages
column in pixels

LanguagesColumn.java getWidth();

Text of the Date
Formats subtitle

DateFormatsColumn.java getSubTitle();

CSS style of the Date
Formats subtitle

DateFormatsColumn.java getSubTitleStyle();

Width of Date Formats
column in pixels

DateFormatsColumn.java getWidth();

Languages column:
define the items to be
included in the bullet
list

LanguagesColumn.java getItems();

Date Formats column:
define the items to be
included in the bullet
list

DateFormatsColumn.java getItems();

Default Settings for Widgets
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Layout component Source file Constant

Widgets: default "blue
circle" icon to mark
individual entries in a
widget

WelcomePage.java BLUE_CIRCLE_ICON

Widgets: default
"orange circle" icon to
mark individual entries
in a widget

WelcomePage.java ORANGE_CIRCLE_ICON

Widgets: default CSS
style of the title text of a
widget

WelcomePage.java WIDGET_TITLE_STYLE

Widgets: default CSS
style of the subtitle text
of a widget

WelcomePage.java WIDGET_SUBTITLE_STYLE

Widgets: default CSS
style of the text for each
item of a widget

WelcomePage.java ACTION_ITEM_STYLE

Special Programming Techniques

This section summarizes some of the techniques you may find useful when creating a
customized Welcome page. You can find code examples of the techniques in the demos
\WelcomePage folder.

Technique Code Example in demos
\WelcomePage folder

Activate the Advanced Search page. AdvancedSearchItem.java

Activate the Keyword Search page. KeywordSearchItem.java

Start the My Account dialog. UserPreferencesItem.java

Start the Add Asset dialog. CreateAssetItem.java

Start the Import dialog. ImportWsdlFileItem.java
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Technique Code Example in demos
\WelcomePage folder

Activate My CenstraSite and show Assets
I Provide.

MyFavoriteItem.java

Open the external website http://
communities.softwareag.com/centrasite.

CentraSiteCommunityItem.java

Open the external website http://
www.centrasite.com.

DeveloperCommunityItem.java

Open the external website http://
documentation.softwareag.com/
default.htm.

OnlineDocumentationItem.java

Create an empty line in a widget. EmptyItem.java

Create a doed dividing line. SeparatorItem.java

Create a column (list) with all available date
formats.

DateFormatsColumn.java

Select a specific date format from a list. DateFormatItem.java

Create a column (list) with all available
languages.

LanguagesColumn.java

Select a specific language from a list. LanguageItem.java

Implementing the Sample Customized Welcome Page
1. Implement the demo as an Eclipse Java project.

a. Start Eclipse.

If you want to use Eclipse as your development environment for updating the
Java sources of the customized welcome page, the demos\WelcomePage folder
contains the Eclipse project files .classpath and .project. You can use these files to
create an Eclipse Java project for managing your Java sources.

b. Select File > New > Project > Java Project.

c. Select Create project from existing source.

d. Specify the path demos\WelcomePage as the location of the existing project files.
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When you build the project in Eclipse (using for example Project > Build Project),
there should be no errors reported.

2. Build the deployment files for Software AG Runtime.

a. Build the jar file by using Apache Ant with the build file build.xml provided in
the demos\WelcomePage folder.

To deploy the demo Welcome page to Software AG Runtime, you have to create
a jar file containing the Java classes of the Java sources, then copy the jar file and
any required graphic icons to the Software AG Runtime environment.

The file build.xml uses a properties file build.properties to define some customer-
specific files names and folder locations. The build file, build.xml also builds a
zip file that contains the jar file and all required graphical icons. To deploy the
demo welcome page, you can extract the contents of the zip file directly into your
Software AG Runtime location.

The file build.properties contains the following properties that you should tailor
to your working environment before you run build.xml.

Property Description

projectName This is the name that is used for the jar file and zip file
that are created by the Ant task.

The jar file is copied to the CentraSite\lib folder in the
Software AG Runtime environment, so select a name that
is easily distinguishes the jar file from other jar files at the
Software AG Runtime location.

pluggableLocation This is the location of the webapps/PluggableUI folder in
the Software AG Runtime environment. In a Windows
environment, you should use forward slash instead of
backward slash in the path name.

centraSiteLocation This is the path where your CentraSite installation is
located. In a Windows environment, you should use
forward slash instead of backward slash in the path name.

3. Build the deployment files using Eclipse or from Command Line.

The build.xml file contains the definition of the tasks to be performed by Ant. The
tasks defined in the delivered demo version are:

Compile the Java sources that are located in the folder src and store the Java
classes in the folder classes.

Create a jar file containing all of the class files, and store the jar file in the folder
lib.
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Create a zip file that contains the jar file and all icons associated with the
customized welcome page and store the zip file in the folder lib.

The build.xml file is an XML file that contains element definitions such as:
<zipfileset dir="resources" prefix="images"> <include name="*.png" /> </zipfileset>

In such cases, the dir aribute indicates the name of the folder in the build
environment where Ant can locate the required files, and the prefix aribute
indicates the folder in the Software AG Runtime environment where the files is
copied to. In the extract shown above, Ant searches for all PNG graphics files
("*.png") in the resources folder in the build environment and add them to the zip
file so that they can be extracted into the images folder in the Software AG Runtime
environment.

Whether you build the deployment files using Eclipse or the command line, the
Ant tasks defined in the build.xml are processed. Ant builds a new jar file demos
\WelcomePage\lib\SagBlueWelcomePage.jar, containing all of the Java classes
required for the Software AG Runtime environment. It also build a zip file demos
\WelcomePage\lib\SagBlueWelcomePage.zip, containing the jar file and all
required PNG graphics. The name SagBlueWelcomePage comes from the definition
of the property projectName in the file build.properties.

Building the Deployment Files Using Eclipse

i. In Eclipse, select the build.xml file in the Package Explorer view.

ii. In the context menu, click Run As > Ant Build....

iii. Ensure that the options are set for Clear Environment, Compile Sources,
Create JAR file, Create ZIP file.

iv. Click Run.

Building the Deployment Files from the Command Line

i. Open a command prompt window.

ii. Go to the demos\WelcomePage folder.

iii. Type the command ant clean.

iv. Type the command ant.

4. Deploying the Demo to Software AG Runtime

a. Stop Software AG Runtime.

b. Do one of the following alternatives:

Unzip the zip file created by the Ant build into <RuntimeDir> \workspace
\webapps\PluggableUI\CentraSiteControl directory.

This copies the jar file created by Ant into the folder
<RuntimeDir> \workspace\webapps\PluggableUI\CentraSiteControl
\lib and the PNG files into the folder <RuntimeDir> \workspace\webapps
\PluggableUI\CentraSiteControl\images.
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As an alternative to using the zip file, you can just copy the jar file from
the Ant build into <RuntimeDir> \workspace\webapps\PluggableUI
\CentraSiteControl\lib and the PNG files into <RuntimeDir> \workspace
\webapps\PluggableUI\CentraSiteControl\images.

c. Update the plugin.xml file in the Software AG Runtime environment to point to
the Java classes of the customized Welcome page, as described in “Implementing
the Sample Customized Welcome Page” on page 128. The file plugin.xml in
the folder demos\WelcomePage\resources contains the elements that must be
updated in the plugin.xml file for Software AG Runtime.

Copy the entries manually from demos\WelcomePage\resources\plugin.xml
to the plugin.xml file under Software AG Runtime. Remember to comment out
the original entries for the standard Welcome page when you copy in the new
entries.

d. Restart Software AG Runtime.

5. Display the demo Welcome page.

After you have deployed the demo to the Software AG Runtime environment and
restarted Software AG Runtime, the demo Welcome page is visible when you start
CentraSite Control.

Customizing Content Pages
To customize Content pages, you can use extension points for the CentraSite Control
and implement Java classes and methods to plug in to the extension points. An
extension point is characterized by the following properties:

An ID by which it can be referenced.

An interface to be implemented by plug-ins. In most cases there is also an abstract
base class available that implements the interface. It is recommended to extend this
class for your own extensions.

Names of properties to be provided by a plug-in.

Optionally, it may be related / compared to a corresponding extension point offered
in an Eclipse environment.

An extension point provides the name of a class that implements the interface and
property values. In general, if there is an abstract base class, its usage is strongly
encouraged.

Extension Points

I18N for Layouts

Usage Use this when the layout of a plug-in needs to be localized.
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Attributes point="com.softwareag.cis.plugin.i18n"

id

class

project (name of the plug-in directory)

prefix (as used by messages)

file (name of the property file to be used)

Interface I18NHandler

Standard class Common18NHandler

Processing Class I18NManager inside PluggableUI handles this extension
point. If an I18Message or a text ID in a layout definition (as
created using the Application Designer) refers to a source ID
that starts with the given prefix, the I18Manager aempts to
resolve this reference using the given property file. In the case of
a text ID, the corresponding layout must be part of the plug-in
whose directory is indicated by the project aribute.

Provided by PluggableUI

Example
<extension point="com.softwareag.cis.plugin.i18n" 
  id="CentraSiteControl" 
  class="com.softwareag.cis.plugin.ext.Common18NHandler" 
  project="CentraSiteControl" 
  prefix="INMCS" 
  file="com.centrasite.control.adapters.util.INMMessages"> 
</extension>

Parameters for Plug-ins

Usage Use this to get parameters for a plug-in.

Attributes point="com.softwareag.cis.plugin.parameter"

id

value

Interface No interface to be implemented.

Processing Use the plug-in call ApplicationContext.getParameter() to obtain value.

Provided by PluggableUI
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Example
<extension point="com.softwareag.cis.plugin.parameter" 
  id="welcomePageDefault" 
  value="true"> 
</extension>

ConnectionHandler - Logon and Logoff or Exit

Usage Use at the start or end of a session of CentraSite Control.

Attributes point="com.softwareag.cis.plugin.connectionHandler"

id

value

Interface ConnectionHandler

void init (CommonAdapter ca)

void connect (Credentials c, CommonAdapter ca)
throws Exception

void notifyConnected (CommonAdapter ca)

boolean isConnected()

void prepareDisconnect (CommonAdapter ca) throws
Exception

void disconnect (CommonAdapter ca);

Processing Logon:

Obtain credentials from the login screen

Call connect(credentials) for each extension

If an exception occurs:

Show a popup with the exception

Disconnect each extension which is already connected

Restart

If all successful: start the workplace

Logoff:

Call prepareDisconnect() for each extension

If an exception occurs:

Show a popup with the exception

Done
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Disconnect each extension which is already connected by
calling the disconnect() method

Provided by PluggableUI

Example
<extension point=
                   "com.softwareag.cis.plugin.connectionHandler" 
 id="login" 
 class="com.centrasite.control.ext.
                   CentraSiteConnectionHandler"> 
</extension>

Perspectives

Perspectives allow certain predefined screen layouts to be stored. When several
perspectives are defined, it is possible to switch from one to the other easily. The
Perspective buon is visible if more than one perspective is available. When you click
the buon, a popup dialog appears, which allows you to select the required perspective.
The perspective can be switched either by selecting one or more rows (perspectives) and
clicking OK or by double-clicking on a single row.

Multiple perspectives will be represented in a way that the union of the corresponding
topics is displayed on the right-hand side. The header changes depending on the
perspective to which the currently selected topic belongs.

The following features are provided for perspectives:

A fixed set of perspectives as configured through extensions. You can switch a
perspective using the Select Perspective dialog.

A fixed set of topics per perspective. The association between topics and the
corresponding perspective is established through the plug-in configuration file. Each
declaration of a topic extension must contain a reference to the ID of the associated
perspective extension.

A perspective may contribute the following components:

A name and an icon being used to represent the perspective in the Select
Perspective dialog.

An ICONLISTInfo object used to create a toolbar in the header frame. This can be
suppressed if the perspective's supportsViews() method returns false.

The label and valid values for the View list box. This can be suppressed.

A tailored layout to be used as the workplace background. This is only used
if the perspective is used as the initial perspective. For more information, see
“Seing Preferred Plug-in and Order of Plug-ins” on page 149.

Usage Each plug-in may contribute a perspective to contain its own
topics or the topics of other plug-ins

Attributes point="com.softwareag.cis.plugin.perspective"
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id

class

Interface Perspective

String getTitle()

(used in dynamically generated Select Perspective
dialog)

String getImageURL()

(used to represent a perspective by an icon in the Select
Perspective dialog)

Toolbar:

ICONLISTInfo getToolbar()

Logo

String getLogoImageURL ()

(used for header frame)

Handling of the View listbox:

String getViewLabel()

String[] getViewValues()

String getView()

(returns the currently selected view)

void setView(String view)

(called when the user changes the view selection)

Default layout used for perspective background

String getWorkplaceDefaultLayout();

(used for background of workplace if no activity is
opened)

Abstract
base class

AbstractPerspective

Provided
by

PluggableUI

Example (CentraSite Control/plugin.xml)
<extension point="com.softwareag.cis.plugin.perspective" 
  id="controlPerspective"                                <---+ 
  class="com.centrasite.control.ext.ControlPerspective">     | 
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</extension>                                                 | 
<extension point="com.softwareag.cis.plugin.topic"           | 
  id="registry"                                              | 
  perspective="com.centrasite.control.controlPerspective" ---+ 
  class="com.centrasite.control.ext.ImportantTypesTopic"> 
</extension>

If a perspective is selected for display, all topics belonging to that perspective become
visible. If one of these perspectives is selected in the navigation pane, the content of the
header frame is adjusted with respect to the toolbar, the View listbox, and the visible
logo.

Topic

Usage Add a topic in the navigation view.

Attributes point="com.softwareag.cis.plugin.topic"

id

perspective

class

Interface Topic

String getImageURL()

boolean isVisible()

(used when switching views)

Abstract base
class

AbstractTopic

Processing When starting the user interface, a topic is added to the
active perspective for each known extension that refers to the
perspective.

The first topic is selected.

When switching to a different topic, replace the content of
the HEADER frame according to the data provided by the
corresponding perspective.

Provided by PluggableUI

Example
<extension point="com.softwareag.cis.plugin.topic" 
  id="registry" 
  perspective="com.centrasite.control.perspective" 
  class="com.centrasite.control.ext.ImportantTypesTopic"> 
</extension>
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Command for Item

Usage Add a command to a menu.

Attributes point="com.centrasite.control.itemCommand"

id (default: name of implementing class)

class

Interface ExtensionCommand

boolean appliesTo (Item)

String getName()

String getImageURL()

int getCategory()

(used for grouping of commands)

abstract void execute(ActionContext actionContext)

Abstract base
class

AbstractExtensionCommand

Processing When a list of commands for a menu item is retrieved (for
example, for context menu or toolbar), the following steps are
performed for each known extension:

Create an instance of class and invoke appliesTo(Item).

If true is returned, the command is added to the list.

Provided by CentraSite Control

Example
<extension point="com.centrasite.control.itemCommand" 
  id="test" 
  class="com.centrasite.control.extpt.junit. 
  DisplayRegObjKeyCommand"> 
</extension>

Bulk Command for Items

Usage Add a command to a menu in which bulk actions are permied.

Attributes point="com.centrasite.control.itemBulkCommand"

id (default: name of implementing class)
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class

Interface ExtensionCommand

boolean appliesTo (Item)

String getName()

String getImageURL()

int getCategory()

(used for grouping of commands)

abstract void execute(ActionContext actionContext)

Abstract base
class

AbstractExtensionCommand

Processing When a list of commands for a menu item is retrieved (for
example, for context menu or toolbar), the following steps are
performed for each known extension:

Create an instance of class and invoke appliesTo(Item).

If true is returned, the command is added to the list.

Provided by CentraSite Control

Example
<extension point="com.centrasite.control.itemBulkCommand" 
  id="test" 
  class="com.centrasite.control.extpt.junit. 
  DisplayRegObjKeyCommand"> 
</extension>

Add Property

Usage Add a property to a registry object.

Attributes point="com.centrasite.control.registryObjectProperty"

id

class

(boolean) visible by default

Interface ExtensionPropertyAccessor

boolean appliesTo (String objectTypeQName,
Connector con)

String getDisplayName(Locale locale)
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String getDescription(Locale locale)

String getInternalName()

boolean getVisibleByDefault()

String getValue(Item item) throws Exception

void setValue(Item item, String value) throws
Exception

Abstract base
class

AbstractPropertyAccessor (must be explicitly implemented)

Processing When opening a report, all extensions are checked whether
they want to contribute.

The corresponding accessors are added to the report.

Provided by CentraSite Control

Example
<extension 
  point="com.centrasite.control.registryObjectProperty" 
  id="test" 
  class="com.centrasite.control.extpt.junit. 
  LastModifiedPropertyAccessor"> 
</extension>

Note: Additional columns may also show up in upper table of the General tab.

Tab in Detail View

Usage Add a tab in the detail view of an object.

Attributes point="com.centrasite.control.detailViewTab"

id

class

Interface DetailViewTab

String getTitle()

String getImageURL()

String getLayout()

void initAdapterFor (Item, DetailViewTabAdapter)

protected String getAdapterClass();

boolean appliesTo (Item)
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(If this is returned, the tab will be displayed for the
corresponding Item if isVisible() returns true as well,
otherwise the tab will not be displayed)

void setDetailsTabContext (DetailTabContext)

boolean isVisible(Item)

Abstract base
class

AbstractDetailViewTab

Processing If the detail view for an Item is opened, it is checked for each
known extension.

Create an instance of class and invoke appliesTo(Item). If true
is returned, getLayout() is invoked and the layout is added
as a tab. The respective adapter is created implicitly by the
Application Designer when processing the layout.

The title of the tab is set with the result from calling
getTitle().

Currently, items on tabs are not supported. Hence, the
result from getImageURL() is ignored.

Provided by CentraSite Control

Example
<extension point="com.centrasite.control.detailViewTab" 
  id="lifecycle" 
  class="com.centrasite.control.lifecycle.LifeCycleDetails"> 
</extension>

Add Source of Notification

Usage Add a source of a notification.

Attributes point="com.centrasite.control.addRowToMyNotifications"

id (default: name of implementing class)

class

Interface ReportExtensionItemsProvider

Collection getItems() throws Exception;

void setConnector(Connector connector);

boolean isContributedItem(Item item);

String getChangedImageURL (Item item);
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Abstract base
class

AbstractReportExtensionItemsProvider

Processing The extension is initialized using the setConnector() method.

Obtain all items to be added to the list of items with pending
notification using the getItems() method.

isContributedItem() can be used to check whether this extension
has contributed the given item through getItems().

getChangedImageURL() is used to control the icon representing the
reason for the notification.

Provided by CentraSite Control

Example
<extension 
  point="com.centrasite.control.addRowToMyNotifications" 
  id="MyNotificationsApprovalItemsProvider" 
  class="com.softwareag.centrasite.control.lms.ext. 
              MyNotificationsApprovalItemsProvider"> 
</extension>

Impact Anaysis: Node Decorator

Usage Change the visual representation of registry objects

Attributes point="com.centrasite.control.assocNavigatorNodeDecorator"

id (default: name of implementing class)

class

Interface NodeDecorator

String getImageURL(Item)

Abstract base
class

(none)

Processing If the item is to be rendered in Impact Analysis, check all known
extensions to determine whether they contribute to the item's
visualization.

If getImageURL(item) returns null: check for the next extension.

Else, use the URL being returned for secondary icon within
visualization of node in graphical impact analysis.

Provided by CentraSite Control
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Example
<extension 
 point="com.centrasite.control.assocNavigatorNodeDecorator" 
 id="ExternalLinkNodeDecorator" 
 class="com.centrasite.control.ext.ExternalLinkNodeDecorator"> 
</extension>

The picture illustrates how ExternalLinks objects are decorated with icons representing
the type of the object they are referencing.

Append Root Node to Topic

Usage Append a root node to an existing topic.

Attributes point="com.centrasite.control.topicItems"

id

class

Interface TopicItems

boolean appliesTo (Topic)

Collection getItems()

Abstract base
class

AbstractTopicItems

Processing For each topic whose implementation class is derived from
a class named BaseTopic (true for all topics contributed by
CentraSite Control) it is checked whether there are any
extension for the topicItems extension point. Each extension
whose appliesTo() method returns true, the collection of Item
objects returned by getItems() is appended to the set of root nodes
for the corresponding topic.
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Provided by CentraSite Control

Example
<extension point="com.centrasite.control.topicItems" 
  id="filesystem" 
  topic="com.centrasite.control.administration" 
  class="com.centrasite.control.ext.junit. 
  FileSystemTopicItems"> 
</extension>

Note: Here, the FileSystemTopicItems extension is an
extension of the base class AbstractTopicItems whose appliesTo()
method returns true if the value of the topic aribute
matches the ID of the topic being passed.

Replace Standard Detail View by Another Editor

Usage Add an editor that can be configured per object type, even per
object instance.

Attributes point="com.centrasite.control.itemEditor"

id (default: name of implementing class)

class

Interface ItemEditor

public boolean appliesTo (Item item, Connector
connector);

public String getLayout();

public String getTitle(Item item);

public String getAdapterClass();

(must return a class implementing the ItemEditorAdapter
interface)

Abstract base
class

AbstractItemEditor

Processing If appliesTo() returns true, the editor is used when opening the
detail for the item being passed:

The given adapter class will be instantiated and initialized.

The given layout (=pageURL) is opened in the CONTENT
frame on the right-hand side.

The title returned by getTitle() is used as the label for the
activity.
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Provided by CentraSite Control

Example
<extension point="com.centrasite.control.itemEditor" 
  id="DataType" 
  class="com.softwareag.centrasite.ext.DataTypeEditor"> 
</extension>

Extend Search Dialog by Additional Conditions

Usage Extend the search dialog by additional conditions, for example,
you can add specific search predicates for your own object
types.

Attributes point="com.centrasite.control.searchPredicate"

id

class

Interface PredicateEditor

Predicate getPredicate()

(Get predicate to be added by this editor)

String getLayout()

(Get URL of layout to be rendered)

String getAdapterClass()

(Get name of adapter class to be used for rendering, must be a
subclass of AbstractPredicateAdapter)

String getPredicateClass()

(Get name of predicate class to be used for rendering, must be
a subclass of AbstractPredicate)

 The interface Predicate (many implementing classes are already
available in CentraSiteUtils.jar) with its abstract subclass
AbstractPredicate has the following methods:

boolean appliesTo(String objectTypeValue,
CentraSiteQueryManager qm)

(Check whether this predicate applies to objects of given object
type)

String getInternalType ()

(Get unique internal string representation of type of predicate;
not to be localized. You may use a namespace-like notation for
your own.)
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String getDisplayType ()

(Get human readable localized representation of type of
predicate; CentraSite Control will display it on the left hand
side in the Add Condition dialog)

void validate() throws InvalidPredicateException

(Validate parameters set for this predicate. The
InvalidPredicateException should contain a localized message
text)

String getDisplayString () throws Exception

(Get human readable localized string representation of
predicate including values predicate; CentraSite Control
displays it in the condition table in the header section of the
Search Registry dialog)

boolean requiresEnterpriseLicense()

(Check whether this predicate requires an Enterprise license)

void addTo (BusinessQuery bq) throws JAXRException

(Add contribution of predicate to given BusinessQuery. This is
the worker method applying the predicate to the search result.)

 AbstractPredicate also provides implementations for the
following methods:

Used for I18N support

Locale getLocale()

Void setLocale(Locale)

used for persisting predicates as part of queries.

String toXML ();

void setFromDom(Element predicateEement, Connection
connection)

used to initialize the search dialog with read only predicates or
conditions, which can not be modified or removed:

void setReadOnly(boolean readOnly);

boolean isReadOnly();

Abstract base
class

AbstractPredicateEditor
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Processing When you click the appropriate buon, this invokes the user-
defined Adapter (layout) screen for entering custom search
related seings.

Create an instance of the class

Execute

Provided by CentraSite Control

Example
<extension point="com.centrasite.control.searchPredicate" 
 id="ObjectTypePredicateEditor" 
 class="com.centrasite.control...ObjectTypePredicateEditor">             
</extension>

Download Documents

There is a menu entry in each asset's context menu that allows you to create a zipped
archive of the asset and optionally any aached documents, and to download the zipped
archive to the file system. You can customize the way in which the download feature
behaves:

You can make the download entry in the context menu visible or invisible for users
with the Guest role.

You can change the text string displayed in the context menu.

You can change the format of the zipped archive.

If a user with the Guest role can access an asset and view its context menu, the context
menu entry Download Document is visible by default. You can specify whether this entry is
visible or invisible for such users as follows:

To make the download menu entry visible or invisible for guest users

1. Locate the configuration file plugin.xml in the <RuntimeDir> \workspace\webapps
\PluggableUI\CentraSiteControl directory.

2. Open the file and locate the following entry:
<extension point=com.softwareag.cis.plugin.parameter 
id=guestCanDownloadDocuments value=true/>

3. To make the context menu entry invisible for guest users, change true to false and
restart Software AG Runtime. Similarly, if the context menu entry is already invisible
and you want to make it visible for guest users, set the value to true and restart
Software AG Runtime.

Changing the text string displayed in the Context menu

The text string displayed in the context menu is by default Download Document. You
can change this by extending the CentraSite Control functionality through the extension
point downloadDocumentCommand. This extension point has the following definition:
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Usage Change the text string displayed in the context menu for
downloading an asset.

Attributes com.centrasite.control.downloadDocumentCommand

id (default: name of implementing class)

class

Interface See the sample code.

Abstract base
class

AbstractExtensionCommand

Provided by CentraSite Control

Example See the sample code.

To change the text displayed for the context menu, the implementation of the extension
point must define a method getName() of type String. The return value of this method is
the text that will be displayed in the context menu.

You can find sample code for defining the extension point in the file
DownloadDocumentCustomCommand.java that is provided in the demo folder under
the CentraSite installation folder.

Changing the format of the zipped archive

By default, the zipped archive contains the folder structure of the asset and its aached
documents. You can change this by extending the CentraSite Control functionality
through the extension point downloadDocumentCommand.

To change the format of the zipped archive, your implementation of the extension point
must define a method that extends the base class DownloadOperation.

You can find sample code for defining the extension point in the files
DownloadDocumentCustomCommand.java and DownloadCustomOperation.java that
are provided in the demo folder under the CentraSite installation folder.

Attach Documents

Some assets include file-related aributes that allow you to aach supporting
document(s) such as programming guides, sample code, and script files with the asset.
While trying to aach a supporting document with an asset, CentraSite Control displays
the available documents underneath their respective organization directory by default.
You can change this (that is, simply display the documents by the side of its organization
directory) by extending the CentraSite Control functionality through the extension point
attachDocumentCommand.
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To customize the document layout

1. Locate the configuration file plugin.xml in the <RuntimeDir> \workspace\webapps
\PluggableUI\CentraSiteControl directory.

2. Open the file and locate the following entry:
<extension point="com.softwareag.cis.plugin.parameter" 
  id="isCustomAttachDocument" value="false" /> 
  
  <extension point="com.centrasite.control.attachDocumentCommand" 
  id="AttachDocumentCustomCommand" 
  class="com.centrasite.control.extpt.AttachDocumentCustomCommand" 
/>

Where com.centrasite.control.extpt.AttachDocumentCustomCommand is the name of the
abstract base class that implements the interface.

3. To define your custom document layout, change false to true and restart Software
AG Runtime. Similarly, if the document layout is already customized and you want
to revert to the standard layout, set the value to false and restart Software AG
Runtime.

Usage Use this to define a custom layout of the documents while
aaching to an asset through the Attach Document dialog.

Attributes com.centrasite.control.aachDocumentCommand

id (default: name of implementing class)

class

Interface See the sample code.

Abstract base
class

AbstractExtensionCommand

Processing When you click the appropriate buon, this invokes
the user-defined Adapter (layout) screen displaying all
documents that are available for aaching to an asset.

Create an instance of the class

Execute

Provided by CentraSite Control

Example
<extension 
  point="com.centrasite.control.attachDocumentCommand" 
  id="AttachDocumentCustomCommand" 
  class="com.centrasite.control.
         extpt.AttachDocumentCustomCommand" />
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You can find sample code for defining the extension point in the files
AachDocumentCustomCommand.java, AachFile.xml, and AachFileAdapter.java
that are provided in the demos folder under the CentraSite installation folder.

Activating the IDE
The CentraSite distribution kit contains an IDE (integrated development environment)
that you can use to create and design a layout page. The IDE is a web application whose
clients run on a web browser. The URL (assuming installation defaults) to start the IDE
on a machine where CentraSite is installed is:

hp://localhost:53307/PluggableUI/HTMLBasedGUI/workplace/ide.html

The IDE is deactivated by default. In order to activate the IDE, set the aribute
plugindevelopment in the file cisconfig.xml to true. This file is located in the
CentraSite Control web application (in the Application Server or Software AG Runtime
location) in the folder cis/cisconfig.

The following example illustrates the required configuration seing:
<cisconfig plugindevelopment="true" ...> 
... 
</cisconfig>

Security Considerations

When activated, the IDE and included development tools do not require further
authentication. The following example illustrates the security-constraint and
login-config elements to protect the IDE and development tools with the HTML basic
authentication method.
<security-constraint> 
  <web-resource-collection> 
    <web-resource-name>Plugin Development</web-resource-name> 
    <url-pattern>/HTMLBasedGUI/workplace/*</url-pattern> 
    <url-pattern>/servlet/*</url-pattern> 
  </web-resource-collection> 
  <auth-constraint> 
    <role-name>developer</role-name> 
  </auth-constraint> 
</security-constraint> 
<login-config> 
  <auth-method>BASIC</auth-method> 
  <realm-name>Plugin Development</realm-name> 
</login-config>

In order to protect passwords transmied in clear text between a browser and
development tools running on the application server, it is recommended to protect the
communication through the use of SSL. For more information about configuring secure
communication between CentraSite components, see CentraSite Administrator’s Guide.

Setting Preferred Plug-in and Order of Plug-ins
You can adapt the URL used to invoke the pluggable user interface with a preferred
plug-in by appending a query parameter such as
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PLUGIN=com.centrasite.control

So the modified URL will be: http://localhost:53307/
PluggableUI/servlet/StartCISPage?PAGEURL=/PluggableUI/
Login.html&PLUGIN=com.centrasite.control&LOCALE=en

The value of the PLUGIN parameter must match the value of the id parameter of a
<plugin> root element in one of the plug-ins. This sets the preferred plug-in.

This implies that for all extensions for a specific extension point, the extensions
belonging to the referenced plug-in is first in order (normally the order is determined by
the order aribute in the plug-in configuration file).

For any extension point, the order of the associated extensions is determined by the
following properties:

The processing order of the plug-ins is controlled by the value of the order aribute
of <plugin> in the plugin.xml file. Plug-ins with a smaller value of the order
aribute are processed first. The preferred plug-in is always processed first.

The order of extensions, as configured in plugin.xml, for the associated extension
point.

Depending on the extension point, the order of the extensions has a specific impact, for
example:

The login screen displayed when the user interface is started in the browser.

The initial perspective shown after login.

Installing and Uninstalling Plug-ins

Directory Structure

The plug-in environment is contained in a directory structure under the installation
directory <RuntimeWebAppsDir>  of the Software AG Runtime.

Under <RuntimeWebAppsDir> \PluggableUI we have the following structure:
WEB-INF/ 
   classes/ 
       log4j.xml 
   lib/          //JARs 
      
cis/ 
  
HTMLBasedGUI/ 
  
PluggableUI 
    plugin.xml 
    *.html 
  
    accesspath/ 
    xml/         // layout definitions 
    images/ 
  
CentraSiteControl 
    plugin.xml 
    *.html 
    *_SWT.xml 



M
Odd Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 151

  
    accesspath/ 
    xml/         // layout definitions 
    images/      // icons 
    lib/         // JARs 
    classes/     // class files 
  
MyPlugIn 
    plugin.xml 
    *.html 
    *_SWT.xml 
  
    accesspath/ 
    xml/         // layout definitions 
    images/      // icons 
    lib/         // JARs 
    classes/     // class files

The structure includes a sample user-wrien plug-in MyPlugIn for illustration purposes.

Installing a Plug-in

A plug-in should be provided as a ZIP archive with the directory structure.

The following actions need to be performed when installing a plug-in manually:

Check for availability of other plug-ins.

Copy files (except the plugin.xml configuration file) into the directory structure.

Compile layout definitions.

Note: Using the plug-in may require a restart of the Software AG Runtime.

Uninstalling a Plug-in

The following actions need to be performed to uninstall a plug-in manually:

Before you uninstall a plug-in, ensure that it is not required by another plug-in.

Remove the plug-in configuration file plugin.xml.

Remove the plug-in directory, for example MyPlugIn.

Note: It might not be possible to remove files if they are in use, for example, while
the application server is running.

Plug-In Management Perspective

A separate Plug-In Management perspective offers the following functions:

Function Description Invoke via...

Install Plug-In Import a ZIP-file
containing all required
files for a plug-in

Buon in toolbar
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Function Description Invoke via...

Table of Plug-ins Similar to the About
dialog

Select a node in the Plug-
Ins topic

Uninstall Plug-In Check which other plug-
ins rely on the plug-in to
be uninstalled. If there
are no dependencies, the
plug-in is uninstalled.

Select the plug-in in
the table and select the
command from the
context menu

Compile Layouts Required when the
underlying Application
Designer runtime is
upgraded

Select plug-in in table
and select command
from context menu

Start the Application
Designer layout editor

 Buon in toolbar

The Plug-In Management perspective is not visible by default. It is only visible if you set
the preferred plug-in using PLUGIN=com.softwareag.cis.plugin in the URL that is
used to start the GUI.

Example:

http://localhost:53307/PluggableUI/servlet/StartCISPage?PAGEURL=/
PluggableUI/Login.html&PLUGIN=com.softwareag.cis.plugin&LOCALE=en

Special and Advanced Topics
Icons

There are various optional references to icons which may be contributed by a plug-in.
Most icons should be transparent GIFs unless stated otherwise in the table below. Here
is a set of potential locations for contributing icons:

Context Recommended Size in
Pixels

Remarks

Plug-in icon appearing
in the common About
dialog

16x16 Transparent GIF

Bitmap for plug-in
specific 2nd-level About
dialog

None May be also JPG or
PNG file



M
Odd Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 153

Context Recommended Size in
Pixels

Remarks

Perspective icon in
Select Perspective dialog

16x16 Transparent GIF

Header icon
contributed by
perspective

Height: 35. Width:
depends on space
required for toolbar
and view listbox.

May be also JPG or
PNG file

Icon representing an
item in tree or table

16x16 Transparent GIF

Icon for command for
an item (context menu
or toolbar in detail
view)

16x16 Transparent GIF

Class Loading

The Pluggable UI depends on dedicated class loaders. The code for a normal web
application is only loaded through the basic WebappClassLoader provided by the
servlet container (for example, Tomcat), this class loader is only used for loading
the classes resembling the PluggableUI base with the underlying Application
Designer. The respective classes are loaded from the following directories below
<RuntimeWebAppsDir> \PluggableUI:
 WEB-INF/classes WEB-INF/lib/*.jar

In addition, locations holding common or shared class or jar files are searched by the
WebappClassLoader when aempting to resolve references to required classes.

Any code contributed by a plug-in is loaded by a corresponding instance
of the PlugInWebappClassLoader from the following directories below
<RuntimeWebAppsDir> /PluggableUI:
 plugInDir/classes plugInDir/lib/*.jar

If resolution fails, the PlugInWebappClassLoader for the current plug-in delegates
class loading to the PlugInWebappClassLoaders for other plug-ins in the order listed
as <requiredPlugin> in the plugin.xml of the current plug-in recursively. Finally,
if resolution through required plug-in fails, the PlugInWebappClassLoader delegates
class loading to the WebappClassLoader.

The following picture illustrates the scenario of the LifeCycleManagement plug-in
(representing any other third party plug-in) that depends on the CentraSiteControl plug-
in and the PluggableUI base infrastructure.
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The AdapterPlugInClassLoader is used by Application Designer when
resolving references to adapter classes found in layout definitions. The
AdapterPlugInClassLoader never loads classes itself. Instead, it asks all known
PlugInWebappClassLoaders in an unspecified order to load a required class.

Caution: You must avoid having the same adapter classes in more than one plug-in,
else it results in various classloading related issues (ClassCastException,
ClassNotFoundException, …). Under normal conditions, fulfilling this
restriction should not cause any problems.

In general, you should avoid having multiple locations contributing the same classes
within the graph of locations spanned by the required plug-ins.

Multithreading and Synchronization

Normally, when executing the HTTP requests on behalf of a single Application Designer
session, there is no parallel execution in multiple threads (unless the code contributed
by a plug-in starts a thread on its own). Hence, access to objects or properties having a
scope restricted to the session context does not require any synchronization.

However, when using global or static variables, this is no longer true. Multiple active
user sessions may be processed in parallel.

Avoid usage of global variables, which might lead to the following issues:

Synchronization is required otherwise non-reproducible race conditions occur.

Memory leakages if global collections that grow for each session are used.
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Global references to JAXR-based RegistryObjects. A RegistryObject contains a
reference to the JAXR-based Connection (including the underlying credentials)
that had been used to load it. When resolving a secondary reference either of the
following may happen:

If the connection is still open, credentials of another user is used, thus causing a
security hole.

If the connection is no longer open, a corresponding exception occurs (trying
to use a closed connection).

Nested Layouts

All adapter classes of a plug-in should not be just subclasses of
com.softwareag.cis.server.Adapter. Instead, they should be derived from one of
the following classes:

com.softwareag.cis.plugin.adapter.util.CommonAdapter - for a plug-in that
does not depend on CentraSite Control

com.centrasite.control.adapters.BaseAdapter - for a plug-in that depends on
CentraSite Control

BaseAdapter is a subclass of CommonAdapter and thus inherits certain properties. Among
those is the implicit registration of all adapters as known adapters in the current
session context. However, under certain circumstances it may happen that adapters
for nested pages displayed using a SUBCISPAGE or ROWTABSUBPAGES control are not
automatically deregistered when closing, for example, an activity displayed in the
CONTENT frame on the right hand side of the workplace. This may lead to subsequent
NullPointerExceptions.

Normally, deregistration is accomplished within the destroy() method in CommonAdapter.
Hence, be careful when overriding this method in a subclass to call super.destroy(). In
addition, you should override the endProcess() method in the adapter for the container
layout, which should perform at least the following actions:

call super.endProcess()

call CommonAdapter.removeKnownAdapter (subPageAdapter) for each
subPageAdapter

Creating a Sample Customized Plug-in for Content Pages
This section describes how to create customized plug-ins for the CentraSite Control
Content pages. The descriptions in this topic are based on a sample plug-in named
DemoPlugIn01 . It describes how to use Eclipse and standard CentraSite features in
order to add the plugin to CentraSite.
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Eclipse Prerequisites
Before you start, ensure that you have a recent Eclipse version installed on your
machine.

In Eclipse, select Window > Preferences > Java > Compiler in order to configure usage of /
compliance with the Java version currently supported by CentraSite.

You can check the system requirements at “hp://documentation.softwareag.com”.

Example:

Click Apply to activate the seings. Eclipse asks you to confirm the change, indicating
that an internal rebuild is required. Click Yes. The rebuild takes a few seconds.

Setting up the Plug-in Project
As part of seing up a plug-in project you have to create a new Java project, adapt it to
suit your environment, and add icons required for the plug-in.

To setup the plug-in project

1. Create a new Java Project in Eclipse.

a. Click File > New > Project > Java Project.

a. Specify DemoPlugIn01 as the project name and select Create project from existing
source.

http://documentation.softwareag.com
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b. Click Browse.

c. In the Browse For Folder dialog, navigate to and click on the PluggableUI web
application folder of the Software AG Runtime application. In the remainder of
this document, this folder is indicated by <PluggableUIFolder> .

d. Click Make New Folder.

This creates an entry New Folder under PluggableUI.

e. Select New Folder, and from its context menu select Rename and type the name
DemoPlugIn01.
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f. Click OK.

g. In the New Java Project dialog, click Finish.

A new Java project called DemoPlugIn01 is created. This project is now visible in
the Package Explorer view in Eclipse.

2. Adapt the project to suit the environment.

a. Create the four subfolders accesspath, classes, images, and xml by selecting New
> Folder from the context menu of DemoPlugIn01 in the package explorer and
typing the name in the New Folder dialog.

b. Create a source folder called src by selecting New > Source Folder from the context
menu of DemoPlugIn01.

c. In the context menu of DemoPlugIn01, select Properties.

d. Select Java Build Path in the left navigation tree.

e. Select the Source tab and type the value DemoPlugIn01/classes in the field
Default output folder.
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f. Click the Libraries tab.

An entry for the JRE library should be visible. If you do not see this entry, click
Add Library, select the JRE system library from the displayed list, and click Finish.

g. Click Add External JARs.

h. In the JAR Selection dialog, navigate to <PluggableUIFolder> /WEB-INF/lib and
open the folder.

i. Select all files and click Open.

j. Click Add External JARs again.

k. In the JAR Selection dialog, navigate to <PluggableUIFolder> /CentraSiteControl/lib
and open the folder.

l. Select all files and click Open.

m. Click OK in the Properties for DemoPlugIn01 dialog.

Your project should now look like this:
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Note: The classes subfolder of the project DemoPlugIn01 does not appear.
This is normal because the Java Development Tools (JDT) of Eclipse
suppress output folders from displaying by default (but they still
exist on your hard disk). Also, the old output folder bin that has been
created by the JDT when creating the Java project is not of any use, so
you can delete it.

3. Add icons required for the plug-in. Here we are copying and renaming some already
existing icons from the CentraSite Control plug-in and using them.

a. Using Windows Explorer, navigate to <PluggableUIFolder> /CentraSiteControl/
images.

b. Copy the files myFavorites.gif and myFavorites24x24.gif to the images subfolder
of the Java project DemoPlugIn01.

c. In DemoPlugIn01/images, rename the file myFavorites.gif to star-16x16.gif and
rename myFavorites24x24.gif to star-24x24.gif. Use the command File > Rename in
the Eclipse menu to do this.

d. In Eclipse, refresh the display of the package explorer. The names of the two
images should now be visible.
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Plugging into CentraSite Control
You have to plug-in into CentraSite Control to let it know the presence of the plug-in
configuration file. The plug-in configuration file contains the information about where
a plug-in plugs into CentraSite Control. The CentraSite Control software provides
extension points. These are positions in the program logic of the CentraSite Control
program where functionality can be added by a plug-in. Every time the program flow
comes to such an extension point, a search for plug-ins that extend CentraSite Control at
this point takes place and the code provided by the plug-ins is invoked.

1. Convert the Java project to a CentraSite Control plug-in folder by providing a plug-
in configuration file

a. In the context menu of DemoPlugIn01 in the package explorer, select New > File.

b. Type plugin.xml as the file name and click Finish.

c. Type the following XML code:
<plugin id="demo.plugin01" order="101"> 
  
 <requiredPlugin id="com.softwareag.cis.plugin" /> 
  
 <!-- PlugInInfo --> 
 <extension point="com.softwareag.cis.plugin.plugInInfo" 
            id="DemoPlugIn01Info" 
            class="demo.plugin01.ext.PlugInInfo"> 
 </extension> 
  
</plugin>

d. Save the file using Ctrl+S.

A plug-in must have an identifier (here demo.plugin01) which has to be unique
among all plug-ins. It is recommended to use naming conventions similar to
Java package names. The order number of a plug-in (here 101) gives CentraSite
Control a priority for the sequence in which the plug-ins have to be loaded at
startup. The higher the number, the later a plug-in is loaded. We have to declare
the plug-in as being dependent on the com.softwareag.cis.plugin because we
use an extension point provided by this plug-in. This dependency is indicated
through the requiredPlugin XML element. The extension XML element in
the file DemoPlugIn01/plugin.xml denotes that our plug-in extends the user
interface at a point where information about a plug-in can be contributed.
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The string that looks like a Java package name is the name of the extension
point (com.softwareag.cis.plugin.plugInInfo). The extension identifier (here
DemoPlugIn01Info) must be unique among all extension identifiers of a
plug-in. The class aribute specifies the fully qualified name of the class
that implements the extension (here demo.plugin01.ext.PlugInInfo). The top
level package name for all of our Java code is demo.plugin01. Select ext as the
subpackage name for the implementing class to denote that code that extends
CentraSite Control resides here.

2. Implement the extension, that is, provide a Java class called
demo.plugin01.ext.PlugInInfo, which implements a specific interface required by the
extension point.

a. In the context menu of DemoPlugIn01/src in the package explorer, select New >
Class.

b. Specify demo.plugin01.ext for the package name, PlugInInfo for the class name
and com.softwareag.cis.plugin.extpt.util.AbstractPlugInInfo for the superclass
(you can use the Browse buon to avoid typing).

c. Make sure that the check box labeled with Inherited abstract methods is selected
and click Finish.
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Eclipse now opens the file PlugInInfo.java in the Java editor.

d. Modify PlugInInfo.java in the Java editor as follows:
package demo.plugin01.ext; 
  
import com.softwareag.cis.plugin.extpt.util.AbstractPlugInInfo; 
  
public class PlugInInfo extends AbstractPlugInInfo { 
     
   public String getImageURL() { 
       return "../DemoPlugIn01/images/star-16x16.gif"; 
   } 
     
   public String getLayout() { 
       return null; 
   } 
     
   public String getTitle() { 
       return "DemoPlugIn01"; 
   } 
   public String getVendor() { 
       return "Software AG"; 
   } 
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   public String getVersion() { 
       return "0.0.0.1"; 
   } 
}

e. Save the modified file and ensure that no compilation errors occur.

When you save the file, the Java file is automatically compiled into the folder
classes of the project DemoPlugIn01. (Remember, the classes subfolder of the
project is suppressed from displaying). The resulting class file is now accessible
for the pluggable user interface of CentraSite Control.

3. Check if CentraSite Control is aware of the plug-in.

a. Restart the Windows service Software AG Runtime.

b. Start the CentraSite Control application from the Windows Start > All Programs >
Software AG menu, and log in using your credentials for ID and password.

c. Click the About buon at the top of the page and click Plug-Ins.

If everything works fine, a dialog box whose contents look quite similar to the
following figure appears. In particular, the line that represents the sample plug-
in DemoPlugIn01 should be visible:

Including Your Own Layouts to the Screen
You can extend CentraSite Control by embedding customized layout pages. This section
describes how to create a layout page using the Application Designer IDE and include
them onto the screen.

The figure depicts the final result of this procedure:



M
Odd Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 165

The CentraSite distribution kit contains an IDE (integrated development environment)
that you can use for creating a layout. The IDE is a web application whose clients
run on a web browser. The URL (assuming installation defaults) to start the IDE on a
machine where CentraSite is installed is http://localhost:53307/PluggableUI/
HTMLBasedGUI/workplace/ide.html. There is no shortcut created by the installation to
start IDE. Therefore you have to create one manually.

The IDE delivered in the distribution kit needs to be activated before you can use it. For
information on how to do this, see .

1. Create the layout page.

a. Start the IDE and leave the Eclipse instance running.

b. Click the DemoPlugIn01 buon in the buon list displayed on the left.

c. Click New Layout on the left side directly below the DemoPlugIn01 buon.

d. Type SimpleInfoPage.xml in the input field labeled Name in the resulting
dialog.



M
Even Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 166

e. Click the leftmost image below the input field, as shown, to create an HTML
page.

The IDE presents a standard HTML page in the preview area of the layout
painter. This displays how the newly created layout looks. To view the preview,
select the Preview icon from the toolbar of the layout painter (located beside the
diskee symbol). The current look of layout SimpleInfoPage.xml is displayed in
the preview area.
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2. Design the layout as required.

a. Click on the title bar of the layout.

b. In the Properties view for the title bar, located at the lower left corner of the layout
painter, change the name property from Template to Simple Info Page.

c. Click Save.

d. Change the name property from Save to Refresh and set the method property to
onRefresh.

e. Click the diskee symbol in the tool bar of the layout painter to save the layout.
The preview of the layout changes and now reflects the properties that were
modified.

f. Click Controls in the Controls view (located right to the preview area).
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g. Add three Independent Row controls to the body of the page:

a. Click Independent Row and hold the left mouse buon down.

b. Drag the Independent Row icon to the page body of the layout (the white area
below the buon that is now labeled Refresh) and release the left mouse
buon.

c. Click Add as Subnode from the popup menu that appears.

d. Perform the same action to add a second and a third Independent Row control
to the page body and click Add as last Subnode from the popup menu that
appears after releasing the mouse buon.

The pagebody node of the Layout view (located above the Properties view)
now contains three itr subnodes, representing the three Independent Row
controls.
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h. From the Controls view, drag and drop a Label control onto the first itr sub node
of the pagebody node in the Layout view.

i. In the Properties view set the name property to Some application context
information.

j. Set the asheadline property of the label to true.

To access this property, you have to select the Appearance tab at the boom of the
Property view. You can select the value true using the combo box to the right of
the property name.

k. Drag and drop a Horizontal Distance control onto the second itr sub node of the
pagebody node in the Layout view.

l. In the Properties view, set the width property for the Horizontal Distance control to
10 by just typing it in.

m. Drag and drop a Label control onto the second itr sub node of the pagebody
node in the Layout view.

n. From the popup menu that appears after you release the mouse buon, click Add
as last Subnode.

o. Set the name property of the newly added label to Title: and the width
property to 200.

p. Add a Dynamic Text control as the last sub node to the second itr sub node of
pagebody. Set the valueprop property to title and the width property to 500.

q. Execute the last five steps again for the third itr sub node of the pagebody
node in the Layout view. Set the name property of the Label control to Web
application directory: and the valueprop property of the Dynamic Text
control to webAppDir. All width properties remain the same as for the children of
the second itr sub node of pagebody.

r. Surround the first itr sub node with two vertical distances by dragging and
dropping two Vertical Distance controls onto the first itr sub node of pagebody
(one as a preceding node and one as a subsequent node of the itr). Set the
height property for each Vertical Distance control to 10.
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s. Click on the diskee symbol in the tool bar of the layout painter to save the
layout.

The layout looks as required.

3. Create an adapter for SimpleInfoPage:

Each layout needs to have some code behind it (called the page adapter) which is not
provided yet. In the page adapter you can specify how to react on events that occur
due to user interactions (the push of a buon for example) or fill the controls with
application specific values, and so on.

The code behind the layout at this stage is provided by a dummy adapter that comes
with the IDE. But you have to provide your own so that the adapter knows what to
do when a user presses the Refresh buon, for example.

a. Navigate to the Home tab of the layout painter.

b. Select Preferences and type the absolute path for the Java source directory of the
CentraSite Control plug-in DemoPlugIn01.

Tip: Instead of typing the complete path, you can copy and paste the
content of the field labeled Directory in the input field for the source
directory and then append /src to the copied content as shown.
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c. Click Save and Apply.

d. In the Layout view, select the tree node page.

e. Change the model property of page from DummyAdapter to
demo.plugin01.adapters.SimpleInfoPageAdapter.

f. Click the diskee symbol to save the layout. The content of the Preview view
changes and indicates an error now. This is normal and can be ignored.

g. Click the Tools tab of the IDE and select Code Assistant. The look of the IDE
changes and the generated code for the page adapter is visible on the right side.
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You can apply the necessary changes for the adapter class using the IDE. A easier
way is doing this inside the already existing eclipse project. Click the diskee
icon again to save the adapter source code in the Java source directory of the
CentraSite Control plug-in DemoPlugIn01.

4. Close the IDE and return to the Eclipse environment.

5. Refresh the plug-in project

a. Select the folder DemoPlugIn01 and select Refresh from the context menu.

b. Expanding all folders that relate to the plug-in.

The eclipse project should look like as shown. The contents of subfolders
accesspath and xml have been created by the IDE activities. There is
a new package called demo.plugin01.adapters containing the class
SimpleInfoPageAdapter. The adapter classes used for plug-ins to CentraSite
Control should be derived from the class BaseAdapter rather than from the class
Adapter as provided by Application Designer.

6. Apply application code to the adapter SimpleInfoPageAdapter.

a. Open the file SimpleInfoPageAdapter.java by double-clicking its node in the tree.

b. Type the following code inside the body of method onRefresh:
ApplicationContext applicationContext = new ApplicationContext(this); 
// Application context 
String title =  applicationContext.getTitle(); 
File webAppDir = applicationContext.getWebAppDir(); 
this.setTitle(title != null ? title : "n/a"); 
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this.setWebAppDir(webAppDir != null ? webAppDir.getAbsolutePath() : "n/a");

Some types are marked by the Java editor as unknown when you type the code.

c. Press Ctrl + Shift + O to instruct the Java editor to add the necessary import
statements automatically (for the missing class called File select java.io.File from
the resulting dialog).

d. Save the file

There should be no compilation errors.

7. Bring the user-defined layout inside CentraSite Control to the screen and extend
CentraSite Control at another point in order to add a perspective

a. Add the following XML element to the plug-in description file plugin.xml in the
Eclipse environment and save it to inform the pluggable infrastructure that we
are extending

b. Add the following requiredPlugin XML element after the existing
requiredPlugin XML element:
<requiredPlugin id="com.centrasite.control" />

c. Add the following XML element to the already existing XML code:
<!-- Perspective --> 
<extension point="com.softwareag.cis.plugin.perspective" 
  id="DemoPlugIn01Perspective" 
  class="demo.plugin01.ext.PlugInPerspective" > 
</extension>

d. Save the file plugin.xml.

8. The implementation of our new perspective requires a new class which implements
the necessary interface:
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a. In the context of DemoPlugIn01/src, create a new Java class
called PlugInPerspective in package demo.plugin01.ext. Use class
com.softwareag.cis.plugin.extpt.util.AbstractPerspective as the superclass.

b. Let method getTitle() return the string DemoPlugIn01.

c. Let the getLogoImageURL() method return the path to our 24x24 icon (../
DemoPlugIn01/images/star-24x24.gif).

d. Insert the methods.
public boolean hasTopicTree() 
{ 
 return false; 
}

and
public boolean supportsViews() 
{ 
 return false; 
}

The Java source should look like:
package demo.plugin01.ext; 
  
import java.util.List; 
  
import com.softwareag.cis.plugin.extpt.util.AbstractPerspective; 
import com.softwareag.cis.plugin.extpt.util.WorkplaceContext; 
import com.softwareag.cis.server.util.ICONLISTInfo; 
  
public class PlugInPerspective extends AbstractPerspective 
{ 
  
 public String getTitle() 
 { 
   return "DemoPlugIn01"; 
 } 
  
 public String getImageURL() 
 { 
   return null; 
 } 
  
 public boolean hasTopicTree() 
 { 
   return false; 
 } 
  
 public boolean supportsViews() 
 { 
   return false; 
 } 
  
 public String getLogoImageURL() 
 { 
   return "../DemoPlugIn01/images/star-24x24.gif"; 
 } 
  
 public ICONLISTInfo getToolbar() 
 { 
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   return null; 
 } 
  
 public String getView() 
 { 
   return null; 
 } 
  
 public String getViewLabel() 
 { 
   return null; 
 } 
  
 public List getViewValues() 
 { 
   return null; 
 } 
  
 public String getWorkplaceDefaultLayout() 
 { 
   return null; 
 } 
  
 public void setView(String arg0) 
 { 
 } 
  
 public void setWorkplaceContext(WorkplaceContext arg0) 
 { 
 } 
  
}

e. Save and close the Java source file.

9. Extend CentraSite Control with a new topic.

a. Add the following XML element to the plug-in description file plugin.xml in the
Eclipse environment and save it.
<!-- Topic --> 
<extension point="com.softwareag.cis.plugin.topic" 
  id="DemoPlugIn01Topic" 
  perspective="demo.plugin01.DemoPlugIn01Perspective" 
  class="demo.plugin01.ext.PlugInTopic" > 
</extension>

10. Implement the adapter class.

a. In the context of DemoPlugIn01/src, create a new Java class called
PlugInTopicAdapter in package demo.plugin01.ext.adapters. Use class
com.centrasite.control.adapters.TopicAdapter as the superclass. Do not inherit abstract
classes here.

b. Add a public default constructor to the class. The Java source should look like:
package demo.plugin01.ext.adapters; 
  
import com.centrasite.control.adapters.TopicAdapter; 
  
public class PlugInTopicAdapter extends TopicAdapter 
  
{ 
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   public PlugInTopicAdapter() 
   { 
   } 
  
}

c. Save and close the Java source file.

11. Extend class.

a. In the context of DemoPlugIn01/src, create a Java class called
PlugInTopic, in the package demo.plugin01.ext, using the superclass
com.centrasite.control.ext.util.BaseTopic. Select Inherited abstract methods.

b. Add a public default constructor that invokes the super(int) constructor to the
source.
public PlugInTopic () 
{ 
   super(0); 
}

c. Let method getTopicAdapterClass() return PlugInTopicAdapter.class.

d. Let method getTitle() return the string DemoPlugIn01.

e. Add the following code to method initTree.
String title = "Simple Info Page"; 
String pageUrl = "../DemoPlugIn01/SimpleInfoPage.html"; 
String adapterClass = SimpleInfoPageAdapter.class.getName(); 
ActionContext actionContext = getTopicAdapter().getActionContext(); 
actionContext.showPage(pageUrl, title, adapterClass);

f. Press Ctrl+Shift+O to resolve compilation problems.

g. Save the Java source file and make sure that no compilation errors occur. After
applying the changes, the Java source code for class PlugInTopic should look like:
package demo.plugin01.ext; 
  
import com.centrasite.control.ActionContext; 
import com.centrasite.control.Item; 
import com.centrasite.control.ext.util.BaseTopic; 
  
import demo.plugin01.adapters.SimpleInfoPageAdapter; 
import demo.plugin01.ext.adapters.PlugInTopicAdapter; 
  
public class PlugInTopic extends BaseTopic 
{ 
  
   public PlugInTopic() 
   { 
     super(0); 
   } 
  
   protected Class getTopicAdapterClass() 
   { 
     return PlugInTopicAdapter.class; 
   } 
  
   protected void initTree() throws Exception 
   { 
      String title = "Simple Info Page"; 
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      String pageUrl = "../DemoPlugIn01/SimpleInfoPage.html"; 
      String adapterClass = SimpleInfoPageAdapter.class.getName(); 
      ActionContext actionContext = getTopicAdapter().getActionContext(); 
      actionContext.showPage(pageUrl, title, adapterClass); 
   } 
  
   public void refresh(Item arg0, int arg1) 
   { 
   } 
  
   public String getTitle() 
   { 
     return "DemoPlugIn01"; 
   } 
  
   public String getImageURL() 
   { 
        return null; 
   } 
  
 }

12. Restart the Software AG Runtime service.

13. Open CentraSite Control.

The navigation pane shows the new perspective DemoPlugIn01 which has a topic
entry DemoPlugIn01. Note that the star-24x24.gif graphic is visible in the header bar.

14. Click Refresh in the Simple Info Page display.

The values for Title and Web application directory are updated as shown.

Implementation of Computed Attributes and Profiles
This section describes implementing computed aributes and implementing computed
profiles for CentraSite Business UI and CentraSite Control.

Implementing Computed Attributes
A computed aribute is defined as an implementation of the ComputedAttribute
interface.



M
Even Header

Customizing CentraSite

CentraSite Developer's Guide Version 10.2 (Innovation Release) 178

The implementation of a Java-based computed aribute includes a set of predefined
ComputedAttribute and ProfileAttribute interfaces. These implementation
interfaces are bundled in the CentraSiteUtils.jar, which is available in the
<CentraSiteInstall_Directory>/redist folder.

Interfaces Description

ComputedAttribute Declares the basic rendering methods for a computed
aribute interface. It extends the ProfileAttribute
interface.

boolean: isUsed(): returns true if this aribute is used
in at least one asset instance of the corresponding type.

Collection: setValue(Collection): sets the aribute
value.

ProfileAttribute void:
init(Collection<CentraSiteRegistryObject>,
Locale)

The parameter Collection includes a single
CentraSiteRegistryObject asset instance for which the
aribute value is to be obtained. The parameter Locale
provides the preferred locale of the logged in user.

Collection: getValue(): returns the actual set of
values that are represented by this aribute for an asset
instance.

If the data is of type String, the method returns
a collection of Strings. If the data is of type
Relationship, the method returns a collection of
RegistryObjects. If the data is of type File, the method
returns a collection of ExternalLinks.

String: getAttributeKey()

AttributeDescriptor: getAttributeDescriptor():
returns the definition of aribute.

String: getName(): returns the JAXR-based name of
aribute.

AttributeDescriptorDeclares the standard properties (isReadOnly(), is
Required()...) for an aribute.

String: getDataType(): returns the data type of
aribute. It can be one of the supported standard
types (xs:...). The constants are referred from the
CentraSiteSlotType interface, which is available in the
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Interfaces Description
package com.centrasite.jaxr.type and bundled as a
CentraSiteJAXR-API.jar in the CentraSite installation.

If the computed aribute is of association or relationship
type and returns the RegistryObjects, then the aribute
data type is Relationship. If the computed aribute is
of classification type and returns the Concept objects,
then the aribute data type is Classification. If the
computed aribute is of file type, then the aribute data
type is File.

Object: getDefaultValue(): returns the default
aribute value.

String[]: getEnumValues()

int: getMaxLength(): returns the maximum length of
aribute.

String: getMaxOccurs(): denotes if the aribute
can have multiple occurrences. The options
are: ProfileAttribute.MAXOCCURS_1 and
ProfileAttribute.MAXOCCURS_UNBOUNDED.

String: getMinOccurs(): denotes whether the
aribute is optional or mandatory. The options
are: ProfileAttribute.MINOCCURS_0 and
ProfileAttribute.MINOCCURS_1.

Object: getNativeAtribute(): returns the native
aribute instance if it is not a primitive data type. Else,
returns null.

int: getPrecision(): returns the precision for a
number aribute.

String: getUnitLabel(): returns the slots' unit label.

boolean: hasDefaultValue(): returns if the aribute
has a default value.

boolean: isPrefix(): returns true if the slots' unit
label is a prefix, and false if the unit label is a suffix.

boolean: isReadOnly(): denotes if the aribute is read-
only.

boolean: isRequired(): denotes if the aribute is
required.
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Structure of Archive File

The plug-in uses the policy engine infrastructure, so it uses the structure of a Java policy
(archive file structure and classloader). The archive file must contain the following
folders and files:

Zip folder Description

META-
INF

This folder contains the config.properties file, which is the build
file for the plug-in. This properties file contains an entry of the
following format:
com.softwareag.centrasite.computed.attr.impl.class= 
 com.sample.StringAttrImpl

lib This folder contains the archive file with the source code
examples, the plug-in's executor class and the external libraries.

Sample Code

The sample Java code for implementing a computed aribute in CentraSite is
shipped in the <CentraSiteInstall_Directory>/demos/ComputedAttribute/
EndPointAttribute/src/com/softwareag/centrasite/demo/computedattribute/
EndPointAttribute.java folder.

A sample computed aribute is shipped in the <CentraSiteInstall_Directory>/
demos/ComputedAttribute/EndPointAttribute folder.

Loading a Computed Attribute into an Asset Type Definition

After you have created an archive file that contains the aribute definition, you need
to load the archive file into the asset type definition. You do this by starting the Edit
Asset Type wizard for the appropriate existing asset type, or the Add Asset Type wizard
for a new custom asset type and specifying in the wizard that you are defining a new
computed aribute.

For procedures on how to load an archive file of a computed aribute into an asset type
definition, see CentraSite User’s Guide.

When you have loaded the archive file, the new aribute is displayed in the list of
aributes that can be assigned to an asset type profile.

Implementing Computed Profiles for CentraSite Business UI
In the following sections, we demonstrate a custom profile named SampleProfile that
illustrates how to write a computed profile. The sample extends the profile selection
list for an asset type and presents a screen that prompts for the profile archive to be
uploaded. After confirming the archive, the appropriate adapter classes are called.
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You may use this sample as a guideline, adapting it and renaming it to suit your
individual requirements. The sample indicates where customization is required.

Definition of Java-Based Computed Profile

A Java based computed profile has the following rendering mechanism:

WithUiRendering: This dictates the user-defined rendering of the profile's aributes.

WithoutUiRendering: This dictates the CentraSite's default rendering of the profile’s
aributes. This default rendering is based on the aribute’s data type.

The Build Environment

This section explains the build environment for generating the HTML files that are used
for the GUI and for compiling the necessary Java source files. It assumes the use of Ant,
the Java-based build tool.

The following file system structure under the computed profile directory is assumed:

Name of File or Folder Description

META-INF This folder contains the config.properties file,
which is the build file for the computed profile. This
properties file contains an entry of the following
format:
com.softwareag.centrasite.computed.profil 
e.bui.impl.class=com.softwareag.centrasite.bui.profil 
e.server.SampleComputedProfileImpl

src This folder that holds the Java source files.

lib This folder contains the archive file with the source
code examples, the plug-in's executor class and the
external libraries.

html This folder holds the html files that specify your
computed profile window.

images This folder holds the image files.

css This folder holds the css files.

js This folder holds the JavaScript codes.

build.xml The Ant input file for building the destination files
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The Ant file shown below, named build.xml, can be used to establish a custom
computed profile.
<?xml version="1.0" encoding="utf-8"?> 
<project name="SampleProfile" default="all" basedir="."> 
  <property file="${basedir}/build.properties" /> 
  <property name="src.dir" value="${basedir}/src" /> 
  <property name="classes.dir" value="${basedir}/classes" /> 
  <property name="build.output.dir" value="${basedir}/build_output" /> 
  <path id="project.class.path"> 
    <fileset dir="${gwt.home}"> 
      <include name="gwt-dev.jar" /> 
      <include name="gwt-user.jar" /> 
      <include name="validation-api-1.0.0.GA.jar" /> 
      <include name="validation-api-1.0.0.GA-sources.jar" /> 
    </fileset> 
    <fileset dir="${centrasite.redist.dir}"> 
      <include name="gf.jaxr-api-osgi.jar" /> 
      <include name="INMConfiguration.jar" /> 
    </fileset> 
    <fileset dir="${centrasite.rts.dir}"> 
      <include name="CentraSiteLogicLayer-API.jar" /> 
      <include name="CentraSiteLogicLayer-impl.jar" /> 
      <include name="CentraSiteUtils.jar" /> 
      <include name="gf.jaxr-api-osgi.jar" /> 
      <include name="CentraSiteJAXR-API.jar" /> 
    </fileset> 
    <fileset dir="${others.dir}"> 
      <include name="gson-2.2.2.jar" /> 
    </fileset> 
    <pathelement location="${src.dir}" /> 
  </path> 
  <target name="all" 
  depends="clean, compile, compile-to-javascript,create-jar,create-zip" /> 
  <target name="clean"> 
    <delete dir="${basedir}/gwt-unitCache" /> 
    <delete dir="${build.output.dir}" /> 
    <delete dir="${classes.dir}" /> 
    <delete dir="${basedir}/html/SampleProfile" /> 
  </target> 
  <target name="compile"> 
    <mkdir dir="${classes.dir}" /> 
    <javac srcdir="src" destdir="${classes.dir}" debug="${javac.debug}" 
    debuglevel="${javac.debuglevel}" optimize="${javac.optimize}" 
    deprecation="${javac.deprecation}" classpathref="project.class.path" 
    failonerror="true" memoryMaximumSize="512m" fork="true" /> 
  </target> 
  <target name="compile-to-javascript" depends="compile" 
  description="GWT compile to JavaScript"> 
    <mkdir dir="${build.output.dir}" /> 
    <java failonerror="true" fork="true" 
    classname="com.google.gwt.dev.Compiler" classpathref="project.class.path"> 
      <arg value="-war" /> 
      <arg value="${build.output.dir}" /> 
      <arg value="com.softwareag.centrasite.bui.profile.SampleProfile" /> 
      <jvmarg value="-Xms1024m" /> 
    </java> 
  </target> 
  <target name="create-jar" depends="compile" 
  description="create the jar by including the domain and server"> 
    <jar destfile="classes/lib/SampleProfile.jar"> 
      <fileset dir="classes" 
      excludes="**/client/** **/junit/** **/test/** **/lib/**" /> 
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      <manifest> 
        <section name="com/softwareag/centrasite/bui/profile/server"> 
          <attribute name="Implementation-Title" 
          value="Rule for SampleProfile profile assertion" /> 
          <attribute name="Implementation-Version" 
          value="${component.full.version}.${working.build.number}" /> 
          <attribute name="Implementation-Vendor" value="Software AG" /> 
        </section> 
      </manifest> 
    </jar> 
  </target> 
  <target name="create-zip" depends="compile,compile-to-javascript,create-jar" 
  description="Creating the computed profile zip"> 
    <delete dir="html/SampleProfile" /> 
    <copydir src="${build.output.dir}/SampleProfile" 
    dest="html/SampleProfile" /> 
    <zip update="yes" basedir="." includes="META-INF/**" 
    destfile="${build.output.dir}/SampleProfile.zip" /> 
    <zip update="yes" basedir="." includes="html/**, css/**, js/**" 
    destfile="${build.output.dir}/SampleProfile.zip" /> 
    <zip update="yes" basedir="classes" includes="lib/**" 
    destfile="${build.output.dir}/SampleProfile.zip" /> 
  </target> 
</project>

The classpath for the build step must refer to all JAR files contained in the redist folder
of the CentraSite installation. Add these JAR files to the build path of your java project
also.

Implementation Guidelines for Computed Profile

This section does not explain all the details of the Java source file; its purpose is to
indicate the code that must be modified to suit your environment.

src\com\softwareag\centrasite\bui\profile\server\SampleComputedProfileImpl.java
public class SampleComputedProfileImpl implements BUIProfile { 
      private static final String VIEW_PAGE_URL = "html/SampleProfile.html"; 
   private static final String EDIT_PAGE_URL = "html/EditSampleProfile.html"; 
     
   private CentraSiteRegistryObject csro; 
   private CentraSiteSession session; 
   private Locale locale; 
     
   @Override 
   public boolean canRenderUI() { 
      return true; 
   } 
   @Override 
   public Collection<ProfileAttribute> getProfileAttributes() { 
      return null; 
   } 
   @Override 
   public void init(Collection registryObjects, Locale locale) { 
      this.locale = locale; 
      if (registryObjects == null || registryObjects.isEmpty()) { 
         return; 
      } 
        
      Iterator iterator = registryObjects.iterator(); 
      while (iterator.hasNext()) { 
         Object element = iterator.next(); 
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         if (element instanceof CentraSiteRegistryObject) { 
            csro = (CentraSiteRegistryObject) element; 
         } else if (element instanceof CentraSiteSession) { 
            this.session = (CentraSiteSession) element; 
         } 
      } 
   } 
   @Override 
   public Collection<CentraSiteRegistryObject> updateAsset() { 
      return null; 
   } 
   @Override 
   public Collection<CentraSiteRegistryObject> computeProfileData(String arg0) 
         throws Exception { 
      return null; 
   } 
   @Override 
   public String getProfileDataAsJson() throws Exception { 
      ArrayList<ComputedInfo> computedInfos = new ArrayList<ComputedInfo>(2); 
      computedInfos.add(new ComputedInfo("one", "One")); 
      computedInfos.add(new ComputedInfo("two", "Two")); 
      Gson gson = new Gson(); 
      return gson.toJson(computedInfos); 
   } 
   @Override 
   public String getViewPageURL() { 
      return VIEW_PAGE_URL; 
   } 
     
   @Override 
   public String getEditPageURL() { 
      return EDIT_PAGE_URL; 
   } 
}

The SampleComputedProfileImpl class implements the interface BUIProfile, which
declares the basic rendering methods specific to the CentraSite Business UI.

Implementations Description

boolean canRenderUI() Determines whether the rendering
is based on the UI (true) or on the
triples associated with the profile
(false).

Collection<ProfileAttribute>
getProfileAttributes()

Returns a collection of
ProfileAttribute and would be
called only when canRenderUI()
returns true.

void init(Collection
registryObjects, Locale locale)

With CentraSiteRegistryObject
as a parameter where the necessary
implementation is done and
updateAsset() which would return
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Implementations Description
a collection of registry object serves as
a save hook.

Collection<CentraSiteRegistry
Object> updateAsset()

Returns a collection of
CentraSiteRegistryObject.

String getEditPageURL() Returns URL of the edit page of
computed profile and would be called
only when canRenderUI() returns
true.

String getViewPageURL() Returns URL of the view page of
computed profile and would be called
only when canRenderUI() returns
true.

String getProfileDataAsJson() Returns a collection of profile data as
JSON-formaed string.

Collection
computeProfileData(String
userInputsAsJSON)

Sets a collection of profile data as
JSON-formaed string.

The following diagram describes the main methods on each of the two Java source files
SampleComputedProfileImpl.java and computed.js and describes the type of functions
that they serve.
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# Description

The getProfileDataAsJson method returns a collection of profile
data as JSON-formaed string and would be called only when
canRenderUI() returns true.

This method internally invokes the setJson function when trying to
view or edit the computed profile asset.

The setJson method sets the JSON-formaed data representing the
computed profile and would be called only when canRenderUI()
returns true.

This method is invoked when trying to view or edit the computed
profile asset.

The getJson method retrieves the JSON-formaed data representing
the computed profile using a HTTP GET request and would be called
only when canRenderUI() returns true.

This method is invoked when trying to save the updated asset.
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# Description

The computedInfos method stores a collection of profile data
as JSON-formaed string and would be called only when
canRenderUI() returns true.

This method is internally invoked by the getJson function when
trying to save the updated asset.

Here is the frame of the computed profile implementations:

\js\computed.js
/** 
  Function to resize the current profile frame 
**/ 
var resize = function() { 
   parent.resizeFrame(profileId); 
} 
/** 
  Function to validate the given input 
**/ 
var validate = function() { 
   return true; 
} 
/** 
  Main function which is triggered from the computed profile 
  infrastructure. Implementaion should be called from the function. 
**/ 
var setJson = function(profileId, json, isView) { 
   window.jsonData = json; 
   window.sampleProfileId = profileId; 
     
   console.log("isView = " + isView) 
     
   try { 
      if (isView) { 
         renderSampleProfile(); 
      } else { 
         editSampleProfile(); 
      } 
   } catch(err) { 
   } 
} 
/** 
  Function to to indicate whether the current profile is modified or not 
  Custom implementation can be possible here 
**/ 
var isModified = function() { 
   return false; 
}

As mentioned above, in order to present a user-defined computed profile in the asset
details page, HTML files (viewSampleProfile.html and editSampleProfile.html) that
describe the GUI (in view or edit mode) must be located in the html directory.

\html\SampleProfile.html
<head> 
    <meta http-equiv="content-type" content="text/html; charset=UTF-8"> 
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    <!--                                                               --> 
    <!-- Consider inlining CSS to reduce the number of requested files --> 
    <!--                                                               --> 
    <!--<link type="text/css" rel="stylesheet" href="SampleProfile.css">--> 
    <script type="text/javascript" language="javascript" 
            src="SampleProfile/SampleProfile.nocache.js"> 
    </script> 
   <script src="../js/computed.js"></script> 
  </head>

The HTML file specifies the Java source files that are user-defined to render the asset
details page in the appropriate view or edit mode.

\html\EditSampleProfile.html
<head> 
    <meta http-equiv="content-type" content="text/html; charset=UTF-8"> 
    <!--                                                               --> 
    <!-- Consider inlining CSS to reduce the number of requested files --> 
    <!--                                                               --> 
    <!--<link type="text/css" rel="stylesheet" href="SampleProfile.css">--> 
    <script type="text/javascript" language="javascript" 
            src="SampleProfile/SampleProfile.nocache.js"></script> 
   <script src="../js/computed.js"></script> 
  </head>

Assuming that you have set up all the Java files correctly in the directories, you should
be able to build with the command:
ant -f build.xml jar all

This creates the profile specific JAR file in the subdirectory lib and archives the necessary
profile files into the file SampleProfile.zip.

Structure of Archive File

The archive file must contain the following folders and files:
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Sample Code

Your CentraSite installation contains a sample computed profile, SampleProfile (in the
demos folder) that you can use to create an archive file for the computed profile specific
to the CentraSite Business UI.

Load a Computed Profile into an Asset Type Definition

After you have created an archive file that contains the profile definition, you need to
load the archive file into the asset type definition. You do this by starting the Edit Asset
Type wizard for the appropriate asset type and specifying in the wizard that you are
defining a new computed profile.

For details about how to load the archive file of a computed profile into an asset type
definition, see CentraSite User’s Guide.

When you have loaded the archive file, the new profile is displayed in the detail page of
all assets of the asset type.

Implementing Computed Profiles for CentraSite Control
The following sections describe how to define a computed profile for the CentraSite
Control UI.
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Definition of Java-Based Computed Profile

A Java based computed profile has the following rendering mechanism:

WithUiRendering: This dictates the user-defined rendering of the profile's aributes.

WithoutUiRendering: This dictates the CentraSite's default rendering of the profile’s
aributes. This default rendering is based on the aribute’s data type.

Implementation Guidelines for Java-Based Computed Profiles

This section describes the Java interfaces and methods that you need to implement for a
computed profile.

Interfaces Description

ComputedProfile This interface declares basic rendering methods for
the user interface.

void: init(java.lang.Object, Locale): with
CentraSiteRegistryObject as a parameter
where the necessary implementation is done and
updateAsset() which would return a collection of
registry object serves as a save hook.

boolean: canRenderUI(): This determines whether the
rendering is based on the UI (true) or on the triples
associated with the profile (false).

Collection: getAributes(): returns a collection of
ProfileAttribute and would be called only when
canRenderUI() returns true.

Collection: updateAsset(): returns a collection of
CentraSiteRegistryObject and would be called
only when canRenderUI() returns true.

WebUIProfile This interface is specific to the rendering for
CentraSite Control.

java.lang.Object: createProfileContent(): create the
profile contents with XML content (in compliance
with Application Designer).

EclipseProfile This interface is specific to the rendering for Eclipse
Designer.

createFormContent(): create the profile contents on the
supplied IManagedForm (in compliance with Eclipse
Designer SWT/JFace library).
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Interfaces Description

BUIProfile This interface is specific to the rendering for
CentraSite Business UI.

getEditPageURL(): returns URL of the edit page of
computed profile and would be called only when
canRenderUI() returns true.

getViewPageURL(): returns URL of the view page
of computed profile and would be called only when
canRenderUI() returns true.

getProfileDataAsJson(): returns a collection of profile
data as JSON-formaed string.

Collection computeProfileData (String
userInputsAsJSON): sets a collection of profile data as
JSON-formaed string.

ProfileAribute This interface deals with the standard UI rendering
of the profile's aributes and allows defining the
aributes as key value pairs. The rendering of
each aribute is the standard rendering for the
corresponding datatype of the aribute.

AributeDescriptor: getAributeDescriptor(): returns
the descriptor of the aribute.

String: getAributeKey(): returns the key of the
aribute.

String: getName(): returns the name of the aribute.

Collection: getValue(): returns the value of the
aribute.

ComputedAributeLine This interface deals with the user-defined UI
rendering of the profile's aributes. The UI rendering
of the aributes is determined by the coding of this
interface.

void: buildUI(StringBuilder layout): This method is
responsible for rendering the layout definition.

void: passivate(): This method is responsible for
storing the values back to the object.

void: revert(): This method is to revert the changes.

AributeDescriptor This interface deals with the standard properties
(isReadOnly(), is Required()...) for an aribute.
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Interfaces Description

String: getMinOccurs(): returns the minimum allowed
occurrences of this aribute.

String: getMaxOccurs(): returns the maximum
allowed occurrences of this aribute.

boolean: isRequired(): returns whether this aribute is
required.

boolean: isReadOnly(): returns whether this aribute
is read-only.

boolean: hasDefaultValue(): returns whether this
aribute has a default value.

Object: getDefaultValue(): returns the default value of
this aribute.

int: getMaxLength(): returns the maximum length of
this aribute.

String: getDataType(): returns the data type of this
aribute.

Object: getNativeAtribute(): returns the native
aribute instance if the data type is not primitive,
otherwise returns null.

String[]: getEnumValues():

boolean: isPrefix(): returns whether this slot's unit
label is a prefix or suffix value. Return true if the unit
label is a prefix, false for suffix.

int getPrecision(): returns the precision for a number
aribute.

String: getUnitLabel(): returns this slot's unit label.
The label may be null.

Structure of Archive File

The plug-in uses the policy engine infrastructure, so it uses the structure of a Java policy
(zip file structure and classloader). The archive file must contain the following folders
and files:
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Zip folder Description

META-
INF

This folder contains the config.properties file, which is the build
file for the plug-in. This properties file contains an entry of the
following format:
com.softwareag.centrasite.computed.
profile.webui.impl.class= 
com.sample.MyProfileImpl

lib This folder contains the archive file with the source code
examples, the plug-in's executor class and the external libraries.

Sample Code

Your CentraSite installation contains two sample computed profiles (which is contained
in demos folder) that you can use to create an archive file for the computed profile
specific to CentraSite Control.

NonPrimitiveDataTypeSamples

SampleComputedProfile

Load a Computed Profile into an Asset Type Definition

After you have created an archive file that contains the profile definition, you need to
load the archive file into the asset type definition. You do this by starting the Edit Asset
Type wizard for the appropriate asset type and specifying in the wizard that you are
defining a new computed profile.

For details about how to load the archive file of a computed profile into an asset type
definition, see CentraSite User’s Guide.

When you have loaded the archive file, the new profile is displayed in the detail page of
all assets of the asset type.

Customizing CentraSite i18n Messages
CentraSite supports Internationalization (i18n) out of the box. With CentraSite's
extensibility you can customize the default i18n messages that appear in the Business UI
based on a user's language.

Understanding Message Bundles

To use different languages in CentraSite you create message bundle file for each
different languages that you wish to render. Message bundles in CentraSite are located
on <CentraSiteInstall_Directory> /cast/cswebapps/BusinessUI/custom/resources folder and
are simple Java properties files.
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Each bundle starts with the name i18nresources by convention and ends with the
language (_en). By default, CentraSite looks in the i18nresources_xx.properties file for
messages based on the user specific language.

Customizing i18n Messages

The i18n messages are stored in the form of key/value pairs. The key is the identifier
used by CentraSite to retrieve the text, and the value is the actual text. CentraSite allows
you to modify the default i18n messages to suit your needs.

After you decide which specific i18n message you want to customize, you must first
fetch the key (unique identifier) from CentraSite's message database, and then manually
update the i18n properties file.

Fetching Message Key
Pre-requisites:

To fetch a message key through the CentraSite Command Line Interface, you must have
the CentraSite Administrator role.

CentraSite provides a Java tool named i18NMessageFinder.jar for this purpose.

To fetch a message key

Run the Java tool i18NMessageFinder.jar.

The syntax is of the format:

C:\SoftwareAG\CentraSite\utilities>CentraSiteToolbox.cmd
I18NMessageFinder.jar -message <value of the message to be
customized>

C:\SoftwareAG\CentraSite\utilities>CentraSiteToolbox.cmd
I18NMessageFinder.jar -file <config file> [-dump] [-locale
<messages of this locale>]

The input parameters are:

Parameter Description

-message The message for which key is to be found.

-file Name of the configuration file containing all of the
messages for which keys are to be found. For multiple
messages, use a comma to separate the values.

-dump Dumps all of the key-value pairs to be used for
customization of messages. If -file parameter is specified,
the key-value pairs are dumped in the given file. If -
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Parameter Description
file parameter is not specified, the key-value pairs are
displayed in the console.

-locale Represents a language code of the form xx. The language
code is always in lower case. The -locale parameter is
used only if the -dump parameter is specified. Default value
is en.

This process may take some time. The tool progress is reported to standard output.

Note: Please make sure the combination of configuration parameters in the
command syntax is valid. The invalid combinations are: -message and -
file are mutually exclusive; -message and -dump are mutually exclusive.

The precedence of the configuration parameters for i18n customization is as follows:

If you configure all of the parameters - -message, -dump and -file for
customization, then the -message configuration takes precedence over the -dump
and -file configurations.

If you configure the parameters - -dump and -file for customization, then the -
dump configuration takes precedence over the -file configuration.

Examples (all in one line):

Fetching message ID of a single message text

C:\SoftwareAG\CentraSite\utilities>CentraSiteToolbox.cmd
I18NMessageFinder.jar -message “Welcome to CentraSite Business UI”

The script generates a single message ID for the corresponding message text in
the following format:

INMBU_STR_WELCOME_PAGE_MESSAGE

Fetching multiple message IDs of the default locale in one execution of the tool:

C:\SoftwareAG\CentraSite\utilities>CentraSiteToolbox.cmd
I18NMessageFinder.jar -dump

The script displays all of the messages that belong to the default English (en)
locale in the console.

Fetching multiple message IDs of the user-defined locale in one execution of the
tool:

C:\SoftwareAG\CentraSite\utilities>CentraSiteToolbox.cmd
I18NMessageFinder.jar -dump -locale ar

The script displays all of the messages that belong to the user-defined, for
example, Arabic (ar) locale, in the console.
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Fetching multiple message IDs of multiple message texts in one execution of the
tool:

C:\SoftwareAG\CentraSite\utilities>CentraSiteToolbox.cmd
I18NMessageFinder.jar -dump - locale ar -file c:\tmp\customize-
config.xml

Here, the parameter customize-config.xml specifies a plain-text file that
contains the comma-separated message texts.

The script generates an <config file>_ results.properties file that contains a list of
the message IDs. Each line of the configuration file includes a message ID and the
corresponding message text.

Changing Message Value
After you have identified the message key, you must then manually configure the i18n
properties file in the following way:

1. Open the i18nresources_xx.properties file.

You can find the i18nresources_xx.properties file on <CentraSiteInstall_Directory> /cast/
cswebapps/BusinessUI/custom/resources.

Note: If you don't have an i18nresources_xx.properties file that suits your
language, create one custom properties file that ends with the language
you are interested. For example, i18nresources _de.properties for German
language.

2. Add the message ID and the corresponding text you want to display in the
CentraSite Business UI as follows:

<ID of the message to be customized>=<text of the message to be
customized>

Example:

INMBU_STR_WELCOME_PAGE_MESSAGE=Welcome to CentraSite

3. Repeat the previous step for the required message IDs.

4. Save your configuration.

5. Restart Software AG Runtime.

6. Log in to the CentraSite Business UI to see your customized messages.
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Custom Policy Actions
You can use a policy to execute a task that is not provided by a built-in action by creating
a custom action. For example, a custom action can consist of a Java class that performs
the required task, such as running a test, creating a required aribute, or logging an
entry in an external database. You can insert custom actions into a policy.

Creating a custom action consists of the following high-level steps:

1. Create a custom action category to associate the action.

2. Create an action template to specify the scope of objects and events to which the action
applies.

3. Specify the location of your custom action rule to be used in a design or change time
policy for an action template.

4. Add parameter templates to define the parameters that serve as input parameters to
the action.

There are two ways you can add custom actions:

You can use CentraSite Control to create action categories and action templates,
and create action rules using Java programs. You then upload the rules into action
templates when you create the action templates, using CentraSite Control.

You can create action categories, action templates, and action rules using Java
programs. You then upload the rules scripts to action templates using JAXR-based
calls in the action templates.

To create and manage action templates for design/change-time policies, you must
belong to a role that includes the Manage System-wide Design/Change-Time Policies
permission. By default, the following predefined roles include the Manage System-wide
Design/Change-Time Policies permission:

CentraSite Administrator

Asset Type Administrator

Operations Administrator

Action Categories
Action categories identify the action templates assigned to the category and the type
of action those templates represent. CentraSite includes a set of predefined action
categories and custom action categories.

Predefined Action Categories Installed with CentraSite

By default, the policy actions that are installed with CentraSite are grouped into these
categories:
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ARIS Category

Change-Time Category

Collector Category

Design-Time Category

Global Category

Handler Category

Run-Time Category

WS-I Compliance Category

Custom Action Categories

If you want to enforce policies using actions that are not provided by your CentraSite,
you can create your own categories to define the custom actions. For example, a custom
category can consist of user-defined actions to enforce policies. You can enforce policies
of the custom actions just like you would enforce policies using the system (built-in)
actions.

Action Templates
An action template specifies the object and event types to which the action applies. In
addition, an action template for a design or change time policy contains your custom
action rule, which fires when the action executes.

Types of Actions

CentraSite supports the following types of actions:

Manual Actions are long-run processes that involve manual user intervention to
complete the execution of the action. For example, Approval.

Note: Although CentraSite allows you to use system-defined manual actions in
creating policies, you cannot create a new manual action.

Axiomatic Actions are simple actions used to configure parameters. No code is
involved in the execution of axiomatic actions. Axiomatic actions are used in run-
time policies.

Programmatic Actions are usually executed by means of program code. Specifically,
a programmatic action triggers an action rule when the action executes. You write an
action rule as a Java class. Programmatic actions are used only in design/change-time
policies. CentraSite provides sample action rules. You can upload action rules when
you create a custom action template.
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Supported Object Events

It is possible to create an action template whose scope encompasses any combination
of object types and event types, however, not all combinations are enforceable. This is
because, certain types of events do not occur for certain types of objects.

For example, a PreStateChange event occurs only on Assets, Policies, and Lifecycle
Models. If you create a policy for a PreStateChange event on a User object, that policy
does not execute because a PreStateChange event does not occur on a User object.

Parameter Templates
Parameter templates are a part of the action template. The parameter templates assigned
to the action template serve as input parameters for the policy action at enforcement
time. You can configure the required parameters of an action template in two ways:

Default values: You can define parameters with multiple values and select one of these
values as the default value. When the action template and its associated parameter
template are used in a policy, you can restrict the policy action to use only the
defined default values.

Blank values: Alternatively, you can define parameters with blank values. When the
action template and its associated parameter template are used in a policy, the policy
action accepts any desired value.

Viewing Action Categories List
The Action Templates page displays the list of action categories and templates defined on
your instance of CentraSite.

To view the action categories and templates list

1. In CentraSite Control, go to Policies > Action Templates.

2. The action templates list provides the following information about a category or
template:

Column Description

Action Templates Lists the action templates assigned to each category.

Description Provides additional comments or descriptive information
about an action template.

Type Indicates whether an action category contains design/
change-time or run-time action templates and whether an
action template type is manual or programmatic.
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Creating Custom Actions Using the CentraSite UI
You can create a custom action category and save it to CentraSite.

To create a custom action category

1. In CentraSite Control, go to Policies > Action Templates.

2. ClickAdd Action Category available on the upper-right corner of the Policy Information
panel.

3. In the Add Action Category dialog box, do the following:

a. Specify a name for the new custom category.

An action category name need not be unique within the CentraSite Registry.
However, to reduce ambiguity, you should avoid giving multiple action
categories the same name.

An action category name can contain any character (including spaces).

b. Select the type of template that the category contains (for example, Design/
Change-Time, or Run-Time templates).

c. Click OK.

Adding an Action Template to a Custom Action Category
You can add an action template to a custom action category and save it to CentraSite.

To add an action template to a custom action category

1. In CentraSite Control, go to Policies > Action Templates.

2. Click Add Action Template.

3. If a custom action category does not exist, the Add Action Category dialog box appears,
prompting you to create a custom action category.

After you create a custom action category, the Add Action Template page appears
and is described in the next step.

4. In the Add Action Template page, do the following:

In this field... Do the following...

Category Select the action category for which you want to add the
action template.

Name Type a name for the new action template. Follow these
guidelines:
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In this field... Do the following...

An action template name must be unique.

An action template name can contain any character
(including spaces).

Description (Optional). Type a description for the new action template.
This description appears when the user displays a list of
action templates in the Policy Information panel.

Type No action is necessary.

By default, CentraSite sets the action type to Programmatic
for a design-time or change-time action and Axiomatic for a
run-time action.

Uploaded File Click the Browse buon and upload the action's rule (Java
Zip file).

Note: Alternatively, you can download the rules used by
the system action templates, and modify them for use
with the custom action template.

5. In the Scope panel, do the following:

In this field... Specify...

Object Types Select the type of objects to which this action template
applies.

Event Types Select the type of events to which this action template
applies.

Note: Not all event types are supported by all objects.

6. Click Save.

Upon saving the action template, CentraSite displays the Edit Action Template Detail
page. You use this page's Parameter Templates profile to add parameter templates for
this action.

Adding Parameter Template to Action Template
To complete the action template, you must define its input parameters.
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To add a parameter template to the action template

1. In CentraSite Control, go to Policies > Action Templates.

2. Select the action template for which you want to define parameter templates.

3. In the Edit Action Template Detail page, select the Parameter Templates profile.

4. Click Add Parameter Template.

5. Define the first parameter as follows:

In this field... Do the following...

Name Type a name for the new parameter template.

Type Select a data type.

Default Value If you want to specify a default value, type a value in this
field.

If the selected data type is String, Number, or URL, you
can specify one or multiple default values. You can specify
multiple possible values from which to select as follows:

a. Select the Edit icon to the right of the Default Value field.

b. In the Add Default Values dialog box, type a value and click
Add. Repeat for as many values as you need.

c. Click OK.

d. In the Default Value field select from the drop-down list the
value you want to use as the default value.

Note: If you would rather fill in required values when this
template is used in a policy, leave this field blank.

Array Select this check box if you want the data type as an array.

Required Select this check box if you want the parameter template to
be mandatory.

6. If you want to define additional parameters, click Add Parameter Template and repeat
the previous step.

7. Click Save and then Close.

The parameter templates that you added appear under the Parameter Templates
profile.
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Creating Action Rules in a Java Class
You can create a rule in a Java class.

To create a rule in a Java class

1. Create a Java action executor class that implements the
com.softwareag.centrasite.policy.api.IActionExecutor interface. To view
the Javadoc for this interface, see the CentraSite Java API Reference.

Important: The Java executor class must return an AssertionResult object
that contains the completion code ResultStatus.SUCCESS (if the
action was successful) or ResultStatus.FAILURE (if the action
failed). There are other possible completion codes (for example,
ResultStatus.IN_PROCESS), however, these codes are used by internal
processes and are not intended to be returned by user-defined actions.
Custom actions that you create must only return a completion code of
ResultStatus.SUCCESS or ResultStatus.FAILURE.

2. Create the <action_name>.zip file by executing the ant command "ant -f
build_demos_customer.xml".

Example:

C:\SoftwareAG\CentraSite\demos\CustomActions\Java>ant -f
build_demos_customer.xml

The <action_name>.zip file should include the following components:

A folder named lib, which would contain a jar file with the action’s executor
class and the external libraries.

A folder named META-INF, which would contain a property file named
assertion.properties, which is the build file for the action. It includes an
entry of the following format:
com.softwareag.centrasite.policy.rule.class=<fully_qualified_class_name>

3. Upload the <action_name>.zip file.

Uploading Action Rules to Action Templates
Before you upload a Java action rule, you must first create a .zip file.

To upload an action rule

There are two ways you can upload an action rule (Java Zip file) to a custom action
template:
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If you are uploading the action rule to a custom action template through CentraSite
Control, you upload the Java Zip file when creating the template in the Add Action
Template page.

If you are uploading the action rule to a custom action template programmatically,
you upload the Java Zip file using a JAXR-based call in the action template.

Viewing or Modifying an Action Category
You can use the Edit Action Category to examine and modify the properties of an action
category. When viewing or changing the properties of an action category, keep the
following points in mind:

You cannot modify or delete the predefined categories that are installed with
CentraSite.

You can change any property of an custom category; however cannot modify the
type.

You can modify a category only after deactivating all the policies that use it.

You can rename an action category at any time

To view or modify the properties of an action category

1. In CentraSite Control, go to Policies > Action Templates.

2. In the Policy information panel, select the action category whose details you want to
view or modify.

3. Examine or modify the category’s properties on the Edit Action Category dialog box as
appropriate.

Viewing or Modifying an Action Template
You can use the Edit Action Template to examine and modify the properties of an action
template. When viewing or changing the properties of an action template, keep the
following points in mind:

You cannot modify or delete the predefined action templates that are installed with
CentraSite.

You can change any property of an action template; however cannot modify the type.

You can modify an action template only after deactivating all the policies that use it.

To view or modify the properties of an action template

1. In CentraSite Control, go to Policies > Action Templates.

2. In the Policy information panel, select the action template whose details you want to
view or modify.
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3. Examine or modify the template’s properties on the Edit Action Template page as
appropriate.

4. Select the Scope profile. View or modify the object types and event types to which
this action template applies as appropriate. To modify the list of object or event
types, do the following:

a. Click the Select buon beside the list of applicable object or event types.

b. Use the controls in the Select Object/Event Types dialog box to adjust the list.

c. Click Save to update the modification.

Note: Not all event types are supported by all objects.

5. Select the Parameter Templates profile. View or modify the parameter fields as
appropriate.

6. If you have modified a template’s properties, click Save.

Downloading Rules from System Action Templates
You can download the rules associated with CentraSite system action templates.

To download a rule

1. In CentraSite Control, go to Policies > Action Templates.

2. Locate the action template whose rule you want to download and select its name.

3. Select the .zip file in the Uploaded File field and then download the rule.

The structure of the zip file created by the download feature is as follows:

A folder named lib, which contains a jar file with the action’s executor class and the
external libraries.

A folder named META-INF, which contains a property file named
assertion.properties, which is the build file for the action. It includes an entry of
the following format:
com.softwareag.centrasite.policy.rule.class=<fully_qualified_class_name>

Delete Custom Action Categories and Templates
When you delete custom action categories, action templates and parameter templates,
you must delete these items in the below order:

1. Parameter templates

2. Action templates

3. Action categories
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Deleting a Parameter Template
Before you aempt to delete a parameter template, you must first delete all the policies
consuming it.

To delete a parameter template

1. In CentraSite Control, go to Policies > Action Templates.

2. Locate the custom action template whose parameter template you want to delete and
select its name.

3. Select the Parameter Templates profile.

4. Select the parameter template and click Delete.

This temporarily revokes the selected parameter template from the action template.

5. Click Save.

Deleting a Custom Action Template
Before you aempt to delete a custom action template, you must first delete all the
policies consuming it. Note that when you delete a custom action template, CentraSite
also deletes all previous versions of the template.

To delete a custom action template

1. In CentraSite Control, go to Policies > Action Templates.

2. Locate the custom action template that you want to delete.

3. Select the action template and click Delete.

Deleting a Custom Action Category
Before you aempt to delete a custom action category, you must first delete all the
policies that are using the action templates under this category.

To delete a custom action category

1. In CentraSite Control, go to Policies > Action Templates.

2. Locate the custom action category that you want to delete.

3. Select the action category and click Delete.

Versioning a Custom Action Template
If you want to modify a custom action template, you can create a new version of the
existing template and modify the new version as required. When you create a new
version of a custom action template, CentraSite creates an identical copy of the existing
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template; you can then modify the copy as required. (The new version of the custom
action template gets its own copy of the Java Zip file.)

Note that CentraSitedoes not automatically apply the new custom action template to
policies that use existing versions of the custom action. Policies that use existing versions
of the action continue to use the versions that they have. If you want to apply the new
version of the action to these policies, you must edit the policies (or create new versions
of them) and replace the old version of the action with the newer one.

Similarly, modifying the parameter definitions in a new version of an action template
does not affect the parameter definitions in any of the existing policies that use the action.
Parameter definitions are specific to a version of the template.

When you create a new version of a custom action, be aware that:

You can only create a new version from the latest version of an action. For example, if
an action already has versions 1.0, 2.0, and 3.0, CentraSite only allows you to create a
new version of the action from version 3.0.

The new version of the action is identical to the version from which you created it
(except for the system-assigned version identifier, which is always incremented by
one).

CentraSite automatically establishes a relationship between the new version of the
policy action and the previous version. CentraSite uses this relationship to identify
versioned actions.

You can only create new versions of custom actions that exist on your instance of
CentraSite (that is, actions that you have added to CentraSite). You cannot create
new versions of the predefined actions that are installed with CentraSite.

To version a custom action

1. In CentraSite Control, go to Policies > Action Templates to display the list of action
templates.

2. Locate the most recent version of the custom action for which you want to create a
new version.

3. From the context menu for the custom action, click Create New Version.

4. Modify the new version of the custom action as required and save it.

Tip: To make the new version of the custom action distinguishable from earlier
versions, consider appending the version number to the name of the
custom action.

Sample Java Action: Enforce Unique Asset Names
You can use the sample Java class action rule uniquenamechecker that is present in the
CentraSite installation to create a custom action, Unique Name Checker. This action
ensures that the name and version combination of a newly-created asset is unique within
the CentraSite catalog.
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Note: If the name and version combination of a newly-created asset is not unique,
then the action returns a Failure message, and does not create the new asset in
CentraSite registry.

To create the custom action, you have to:

1. Create a custom action category.

2. Create a custom action template, to which you upload the sample Java rule.

3. Create a Design/Change-Time policy and add the custom action template to it.

To create and test the custom action Enforce Unique Asset Names

1. In CentraSite Control, go to Policies > Action Templates.

2. Click the Add Action Category buon.

3. In the Add Action Category dialog box, do the following:

a. Specify a name for the new custom category, for example My Custom Actions.
An action category name can contain any character (including spaces).

b. Select Design/Change-Time as the action category type.

c. Click OK.

The action category that you created appears as a custom category next to an icon in
the Policy Information panel.

4. Click Add Action Template.

5. In the Add Action Template page, specify the following information:

In this field... Do the following...

Category Select the custom action category you just created.

Name Type the name Enforce Unique Asset Names for the
new action template.

Description (Optional). Type a description for the new action
template. For example: Ensures that asset names
are unique.

Uploaded File Click Browse and upload the Java class action rule:

<CentraSiteInstall_Directory> \demos\CustomActions
\Java\uniquenamechecker.zip

6. In the Scope panel, specify the following information:
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In this field... Do the following...

Object Types Select Service as the type of object to which this action
template applies.

Event Types Select Pre-Create as the type of event to which this action
template applies.

7. Click Save.

The Edit Action Template Detail page is displayed.

8. Create a policy and add the sample action to the policy as follows:

a. In CentraSite Control, go to Policies > Design/Change Time.

b. Click Add Policy.

c. In the Policy Information panel, type a name for the new policy, for example,
Ensure Unique Asset Names Policy. A policy name can contain any character
(including spaces).

d. In the Scope panel, specify the object and event types to which the policy applies
as follows:

In the Object Types field, select Service as the type of object to which this policy
applies.

In the Event Types field, select Pre-Create as the type of event to which this
policy applies.

In the Organization field, select your organization name as the organization to
which this policy belongs (and to whose objects the policy is applied).

e. Click Next.

f. From the Available Actions list, select the custom action Enforce Unique Asset Names
action that you created.

g. Click Finish to save the new policy.

The Design/Change-Time Policy Details page is displayed.

h. Activate the policy by clicking the Change State buon and selecting the Productive
state.

Computed Run-Time Actions
CentraSite Business UI offers you the possibility to add computed runtime actions into
the policy workflow; this gives you the option to define your own runtime action, which
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means that you can implement your own algorithms for representing the action's user
interface.

Computed runtime actions let you create your own layout by using a UI Rendering
Concept. You can also specify your own rendering logic to display the computed values.
You could, for example, create a custom display of the aribute as a drop down or a
radio buon.

A computed runtime action can be implemented using the GWT framework. For a
computed runtime action, you create an archive file that contains the plug-in definition,
and you load the archive file in the CentraSite BUIExtension folder.

Writing Your Own Computed Runtime Action

A computed runtime action can be implemented as a plug-in. The prepared plug-
in is a collection of files in a specific directory structure. After implementing
the plug-in, the files are copied into the CentraSiteBUIExtension folder in
<CentraSiteInstall_Directory> \demos directory.

In the following sections, we demonstrate a sample framework named
MyComputedRuntimeAction that illustrates how a custom computed runtime action
may be set up.

You may use this sample as a guideline, adapting it and renaming it to suit your
individual requirements. The sample indicates where customization is required.

The Build Environment

This section explains the build environment for generating the files that are used for
the GUI and for compiling the necessary Java source files. It assumes the use of Ant, the
Java-based build tool.

The following file system structure under the computed runtime action directory is
assumed:

Name of File or Folder Description

src This folder that holds the Java source files.

lib This folder contains the archive file, plug-in's
executor class and the external libraries.

build.xml The Ant input file for building the destination
files

The Ant file,build.xml can be used to establish a custom computed profile.

The classpath for the build step must refer to all JAR files contained in the redist folder
of the CentraSite installation. Add these JAR files to the build path of your java project
also.
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Implementation for Computed Action UI

src\com\softwareag\centrasite\bui\extension\client\runtime\action
\MyComputedRuntimeActionWidget.java
public class MyComputedRuntimeActionWidget extends Composite { 
    private PolicyActionJSO policyActionJso = null; 
    private TextBox valueBox = null; 
    private static final String WARNING_CSS = "loginTextBoxErrorBorder"; 
      
    public MyComputedRuntimeActionWidget(String policyActionJson) { 
        FlowPanel container = new FlowPanel(); 
        initWidget(container); 
          
        policyActionJso = getPolicyActionJso(policyActionJson); 
        if (policyActionJso == null) { 
            Label helloLabel = new Label("The JSON content is empty"); 
            container.add(helloLabel); 
            return; 
        } 
          
        //Render widgets 
        container.add(getParametersView(policyActionJso)); 
    } 
      
    private Widget getParametersView(PolicyActionJSO policyActionJso) { 
        FlowPanel parametersContainer = new FlowPanel(); 
          
        JsArray<ParameterJSO> parameters = policyActionJso.getParameters(); 
        if (parameters == null) { 
            return parametersContainer; 
        } 
          
        for (int i = 0; i < parameters.length(); i++) { 
            parametersContainer.add(getParameterView(parameters.get(i))); 
        } 
          
        return parametersContainer; 
    } 
    private Widget getParameterView(ParameterJSO parameterJso) { 
        FlowPanel parameterContainer = new FlowPanel(); 
        Label nameLabel = new Label(parameterJso.getName()); 
        parameterContainer.add(nameLabel); 
          
        valueBox = new TextBox(); 
        valueBox.setLayoutData(parameterJso.getId()); 
          
        String[] values = parameterJso.getValues(); 
        if (values != null && values.length > 0) { 
            valueBox.setValue(values[0]); 
        } 
          
        parameterContainer.add(valueBox); 
        return parameterContainer; 
    } 
    public static native PolicyActionJSO getPolicyActionJso(String json) /*-{ 
        return eval('(' + json + ')'); 
    }-*/; 
    public String getJson() { 
        JsArray<ParameterJSO> parameters = policyActionJso.getParameters(); 
        ParameterJSO parameterJso = null; 
        if (parameters != null && parameters.length() > 0) { 
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            parameterJso = parameters.get(0); 
              
            String[] values = {valueBox.getValue()}; 
            parameterJso.setValues(values); 
        } 
          
        return policyActionJso.toJSON(); 
    } 
    public boolean isValid() { 
        String value = valueBox.getValue(); 
        boolean isValid = (value != null && !"".equals(value)); 
        if (!isValid) { 
            valueBox.addStyleName(WARNING_CSS); 
        } else { 
            valueBox.removeStyleName(WARNING_CSS); 
        } 
          
        return isValid; 
    } 
}

The MyComputedRuntimeActionWidget class extends the class Composite, which
declares the basic rendering methods for the CentraSite Business user interface.

Implementations and Description

MyComputedRuntimeActionWidget(String policyActionJson)

Constructor dictates the user-defined rendering of the action's UI.

getPolicyActionJson

Returns the JSON object from the specified object.

String getJson()

Returns a JSON encoded string representing the action's parameters.

boolean isValid()

Enforces validation logic for the action's parameter values.

Implementation for Computed Action Parser

To implement your own computed runtime action with custom UI rendering, the parser
(MyComputedRuntimeActionParser.java) must be located in the service directory. A
parser is responsible for generating compressed JSON data from the given policy action
instance, and creating a custom rendering of the action instance using the JSON data.

Here is the frame of the computed runtime action parser implementation:

src\com\softwareag\centrasite\bui\extension\service\ MyComputedRuntimeActionParser.java
public class MyComputedRuntimeActionParser extends 
                                            BasePolicyActionExtensionParser { 
    public MyComputedRuntimeActionParser(CentraSiteSession centraSiteSession, 
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            CentraSitePolicyActionTemplate actionTemplate, 
            CentraSitePolicyActionInstance actionInstance) { 
        super(centraSiteSession, actionTemplate, actionInstance); 
    } 
    @Override 
    public CentraSitePolicyActionInstance getActionInstance(String json) 
      throws CLLException { 
        Gson gson = new Gson(); 
        MyComputedRuntimeActionInfo = gson.fromJson(json, 
                                      MyComputedRuntimeActionInfo.class); 
        if (actionInfo == null) { 
            return null; 
        } 
          
        CentraSitePolicyActionInstance policyActionInstance = null; 
        CentraSiteObjectManager objectManager = 
                         getCentraSiteSession().getCentraSiteObjectManager(); 
          
        if (actionInfo.isActionInstance()) { 
            policyActionInstance = objectManager.getPolicyActionInstance(action 
Info.getId()); 
        } else { 
            policyActionInstance = objectManager.createPolicyActionInstance(act 
ionInfo.getId()); 
        } 
          
        if (policyActionInstance == null) { 
            return null; 
        } 
          
        setParameterValues(policyActionInstance, actionInfo); 
        return policyActionInstance; 
    } 
    private void setParameterValues(CentraSitePolicyActionInstance 
            policyActionInstance, MyComputedRuntimeActionInfo actionInfo) 
            throws CLLException { 
        List<MyComputedRuntimeParameterInfo> parameters = actionInfo.getParame 
ters(); 
        if (parameters == null || parameters.isEmpty()) { 
            return; 
        } 
          
        MyComputedRuntimeParameterInfo parameterInfo = parameters.get(0); 
        Collection<Object> convertedParameterValues = new ArrayList<Object>(); 
        convertedParameterValues.addAll(parameterInfo.getValues()); 
        policyActionInstance.setAttributeValue(parameterInfo.getId(), 
           convertedParameterValues); 
    } 
    @Override 
    public String getJson() throws CLLException { 
        Gson gson = new Gson(); 
          
        MyComputedRuntimeActionInfo actionInfo = null; 
        if (getActionInstance() != null) { 
            CentraSitePolicyActionTemplate policyActionTemplate = 
            getActionInstance().getCentraSitePolicyActionTemplate(); 
            actionInfo = new MyComputedRuntimeActionInfo(getActionInstance().g 
etId(), 
            policyActionTemplate.getName()); 
            actionInfo.setActionId(policyActionTemplate.getId()); 
            actionInfo.setIsActionInstance(true); 
        } else if (getActionTemplate() != null) { 
            actionInfo = new MyComputedRuntimeActionInfo(getActionTemplate().g 
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etId(), 
            getActionTemplate().getName()); 
            actionInfo.setActionId(getActionTemplate().getId()); 
        } 
          
        fillParameterInfos(getActionTemplate(), actionInfo); 
        return (actionInfo != null ? gson.toJson(actionInfo) : null); 
    } 
    private void fillParameterInfos(CentraSitePolicyActionTemplate 
                                                               actionTemplate, 
            MyComputedRuntimeActionInfo actionInfo) throws CLLException { 
        if (actionTemplate == null) { 
            return; 
        } 
          
        Collection<CentraSiteObjectAttribute> attributes = actionTemplate.getA 
ttributes(); 
        if (attributes == null || attributes.isEmpty()) { 
            return; 
        } 
          
        List<MyComputedRuntimeParameterInfo> parameters = new 
        ArrayList<MyComputedRuntimeParameterInfo>(attributes.size()); 
        MyComputedRuntimeParameterInfo parameter = null; 
        for (CentraSiteObjectAttribute attribute : attributes) { 
            parameter = new MyComputedRuntimeParameterInfo(attribute.getName(), 
                        attribute.getDisplayName()); 
            parameters.add(parameter); 
        } 
          
        actionInfo.setParameters(parameters); 
    } 
}

Computed Run-Time Action Plug-in
The following list shows the main methods on each of the two Java source files
MyComputedRuntimeActionWidget.java and MyComputedRuntimeActionParser.java
and describes the type of functions that they serve.

The getPolicyActionJson method returns the JavaScript Object (JSO) from the
given JSON-formaed string.

The getActionInstance method returns a CentraSitePolicyActionInstance
object from the given JSON-formaed string.

The String getJson method returns a JSON-formaed string from the existing
policy action instance.

The boolean isValid() method enforces a validation logic for the user-defined
rendering of the runtime action.

Assuming that you have set up all the Java files correctly in the directories, you should
be able to build with the command:
ant -f build.xml jar all
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Activating the Computed Run-Time Action
After you define the computed action as a plug-in (extension point) with the above
steps, enable the computed action in the Business UI customization file, centrasite.xml, in
order to display the action in the policy accordion.

Important: Remember that the action parameters defined in the configuration file are
editable and cannot be protected.

To activate the plug-in

1. Open the customization file, centrasite.xml, in a rich text editor.

You can find the centrasite.xml file on <CentraSiteInstall_Directory> \cast\cswebapps
\BusinessUI\custom\conf.

2. Navigate to the property lines <UIProperties> -> <Extensions> -> <PolicyActions>

3. Append the property statement for your custom computed runtime action
(MyComputedRuntimeAction) as below:
<PolicyActions> 
   <PolicyAction id="uddi:44e3e2de-064c-432f-b67a-8fbca0fb04d6" 
   class="com.softwareag.centrasite.bui.extension.service. 
MyComputedRuntimeActionParser" /> 
</PolicyActions>

wherein,

Parameter Description

id A unique identifier for the computed action.

It uniquely distinguishes an action in the CentraSite registry. If
you wish to reconfigure the action at a later stage, you identify the
action using this id.

class A parser implementation for the computed action.

4. Save and close the configuration file.

5. Restart Software AG Runtime.

Sample Computed Run-Time Action
Your CentraSite installation now contains few sample custom plug-in actions defined
especially for the Business UI and available for use in the CentraSiteBUIExtension folder
in <CentraSiteInstall_Directory> \demos directory.
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For more information about the implementation and usage of these sample custom plug-
in actions, see the readme file included in the following directory:

<CentraSiteInstall_Directory> \demos\CentraSiteBUIExtension
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Writing Your Own Reporting Search
CentraSite includes a set of predefined reporting searches that you can execute and
capture design-time and/or run-time information of registry objects. In addition to the
predefined reporting searches, you can create your own custom reporting search to
execute and capture information on the registry objects that best suit your needs.

In CentraSite, you use queries in XQuery format to search and report for registry
objects. You define custom queries and report your searches using XQuery modules and
functions.

Reporting searches that are developed using XQuery modules and functions are
applicable to CentraSite registry objects, such as reports and portlets in CentraSite
Business UI.

In the following sections, we demonstrate a sample named,
TopXAssetsBasedonAPIKeys that illustrates how a custom reporting search can be set
up using the XQuery module and functions in CentraSite Business UI.

The sample extends to use the Add New Portlet dialog box which prompts for the data set
you need to display in the new portlet. After confirming the data set, the corresponding
search results are displayed in the newly created portlet Top X Assets Based on API
Keys.

You may use this sample as a guideline, adapting it and renaming it to suit your
individual requirements.

To add a custom reporting search in CentraSite Business UI, you must perform the
following steps:

Write XQuery Module

Upload XQuery Module to CentraSite Registry Repository

Write Saved Search XML

Upload XML Search File from the Command Line

Activate the Reporting Search

Writing XQuery Module and Functions
XQuery modules are libraries of user-defined functions. An XQuery module contains
one or multiple functions that you require to retrieve specific data from the CentraSite
registry using the XML query language. You can create a module of functions in one
XQuery file and then use the functions defined in that XQuery module in any other
XQuery by using the import module directive. The user-defined functions belonging
to the same context can be bundled into modules. Thus based upon these functions the
implementation of complex queries within that context becomes much easier.
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An XQuery module is made up of a prolog and a body. In CentraSite XQuery, the
XQuery prolog is a series of definitions and functions that together create the required
environment for query processing.

The XQuery prolog includes namespace declarations. The XQuery body is made up of a
sequence of expressions that specify the intended query result.

Example:
module namespace au="http"//namespaces.CentraSite.com/modules/reports/apiusage";
 import module namespace cs=
                         "http://namespaces.CentraSite.com/Schema/jarx";
 import module namespace csdt=
                         "http://namespaces.CentraSite.com/modules/datetime";
 import module namespace util=
                         "http://namespaces.CentraSite.com/jaxr/contants";
 import module namespace util=
                         "http://namespaces.CentraSite.com/modules/util";
 import module namespace cs1=
                         "http://namespaces.CentraSite.com/Schema";

The following XQuery is specified against the getAPIsWithAPIKeys declaration of
integer type. The query retrieves the total number of APIs that use an API key to
authenticate clients.
declare function au:getAPIsWithAPIKeys($noOfAssets as xs:integer)as node()*
{
(
let $ulp  := csdt:getUserLocalePreferences()
for $assetKey in au:getUniqueAPIswithAPIKeys()
let $oi  := collection("CentraSite")/cs:objectInfo[@v3key = @assetKey]
let $apiKeysCount  := au:getNumberofAPIKeys($assetKey)
order by $apiKeysCount descending
return
<result>
<assetKey>{$assetKey}</assetKey>
<assetName>{if(empty($oi/cs:name)) then () 
 else data(cs:localString($oi/cs:name, $ulp))}</assetName>
<assetDesc>{if(empty($oi/cs:description)) then () 
 else data(cs:localString($oi/cs:description, $ulp))}</assetDesc>
<apiKeysCountForAsset>{$apiKeysCount}</apiKeysCountForAsset>
</results.
)[position() <= $noOfAssets]
}

Note the following from the previous query:

The XQuery prolog includes a namespace prefix (cs) declaration, namespace
cs="http://namespaces.CentraSite.com/Schema/jarx";.

The declare namespace keyword defines a namespace prefix (cs) that is used later
in the query body.

let $oi := collection("CentraSite")/cs:objectInfo[@v3key = @assetKey]
is the query body.

CentraSite mandates XQuery modules and functions, especially for reports, when
specifying data sets that are based on the CentraSite XQuery Data Source. The XQuery
modules and functions help integrate the following functionality into the BIRT reports:
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Identify data sources that connect your reports to the CentraSite registry.

Identify data sets that specify the data to retrieve from the CentraSite registry.

The XQuery functions must be wrien in the XQuery syntactical and semantical
requirements of CentraSite, to specify the data to be retrieved from the registry and to be
included in the data set, and return a list of registry objects as its result; therefore, you
must have a good knowledge of XQuery language.

The following query retrieves all registry objects of type Organization from the
CentraSite registry.
declare namespace cs="http://namespaces.CentraSite.com/Schema/jaxr"; 
for $ro in collection("CentraSite")/cs:organization return $ro

The syntax for user-defined functions, which are declared in the XQuery prolog, is as
follows:

The syntax diagram tells us that a function declaration starts with the two words declare
function followed by a QName. The QName (=qualified name) must be in a namespace, that
is, either a default function namespace declaration must be in effect or the QName must
use a prefix. When using a prefix, a namespace binding declaration can be avoided by
using the prefix local.

The function's name is followed by a possibly empty comma-separated list of variables
that is enclosed in parentheses. Each variable may optionally be accompanied by a type
specification. Also the result type of a function may optionally be specified. The term
enclosedexpr is an expression enclosed in curly braces that contains what the function
returns if called or rather what the function call expression evaluates to (in functional
language speak).

Thus the simplest query containing (and using) a function declaration in our sample is:
declare function au:getAPIsWithAPIKeys($noOfAssets as xs:integer)as node()*

This query returns the total number of APIs that use an API key to authenticate clients.
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Once you have the user-defined XQuery function getAPIsWithAPIKeys() defined in
the above XQuery format , you must enclose the function in an XQuery module. In our
sample, we call this module as apiusage.

To enable queries to use user-defined functions without having to define them in every
query, CentraSite XQuery allows for so called library modules. The declaration of such a
library module is as follows:

A library module begins with the words module namespace followed by an NCName
(a no-colon-name) that is used as a namespace prefix throughout the subsequent
declarations. This is followed by an = sign and a string literal that specifies the
namespace identifying the following declarations. This namespace specifier should be a
URL that reflects the purpose of the module's content. The final semicolon (;) is optional
due to compatibility reasons.

CentraSite stores modules in the database (Registry Repository) itself. After you create
the required XQuery library module in to an XQuery file, you must upload it to the
CentraSite Registry Repository.

A main module refers to library modules by importing the namespace that identifies the
module's contents, that is, the module's target namespace as such:

A library module may be imported into a main module (or just as well into another
library module) by writing import module namespace followed by a binding that
binds a prefix to the library module's target namespace. The imported module's contents
are then accessible using this prefix. The ability to bundle functions into modules can be
exploited to make queries much more concise.

Thus the simplest way of importing a module in our sample is:
import module namespace cs="http://namespaces.CentraSite.com/Schema/jarx";

The final XQuery module would look like the following:
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Uploading XQuery Module through CentraSite Control
After you create the XQuery search module, you must upload the new XQuery module
to the CentraSite repository.

To upload the XQuery module

1. In CentraSite Control, go to Asset Catalog > Search.

This opens the Asset Search page.

2. Click the XQuery tab.

3. Type the new XQuery code in the text box.
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4. Click Save.

Uploading XQuery Module through Command Line
To upload a custom XQuery module through the CentraSite Command Line (.cmd)
Interface, you must have the CentraSite Administrator role.

CentraSite provides a Java tool named LoadModule.jar for this purpose.

Run the Java tool LoadModule.jar.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteToolbox.cmd LoadModule.jar <CentraSite URL>
<admin user id> <password> <module file name> [<module name>]

The input parameters are:

Parameter Description

CentraSite URL The URL of the CentraSite registry. For example,
http://localhost:53307/CentraSite/CentraSite.

admin user id The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

password The password for the CentraSite user identified by the
parameter admin user id.

module file name Name of the XQuery file that contains the module and
functions to upload. If the file name contains white
spaces, enclose the name with " ".

module name Name of the XQuery module to upload. If the module
name contains white spaces, enclose the name with " ".

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteToolbox.cmd
LoadModule.jar http://localhost:53307/CentraSite/CentraSite DOMAIN
\admin pAsSw0rD MyReport.xquery

Writing Saved Search XML
This section explains how you write a saved search XML file that makes use of the above
XQuery function and defines the required search parameters and result aributes.



M
Even Header

Custom Reporting Searches

CentraSite Developer's Guide Version 10.2 (Innovation Release) 226

Note: Make sure that the value of XQuery function name and module namespace
in the saved search XML file exactly match with the values specified in
the XQuery module definition. Let's call this saved search XML file as
TopXAssetsBasedonAPIKeys.xml.

Uploading Custom Reporting Search through Command Line
Pre-requisites:

To upload a custom reporting search through the CentraSite Command Line Interface,
you must have the CentraSite Administrator role.

After you create the XQuery search module and search XML file, you must upload them
to the CentraSite repository.

CentraSite provides a command tool named add Search for this purpose.

Important: CentraSite relies on file extensions to determine a file's type. When you
upload a saved search XML file or an XQuery module from your local
machine using the command line, be sure you specify the name of the file
along with its extension (.xml or .xquery) so that CentraSite can determine
the file's type and mark it correctly in the repository.

To upload a custom reporting search

Run the command add Search.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd add search [-url <CENTRASITE-URL>]
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-user <USER-ID> -password <PASSWORD> [-module <XQUERY-MODULE>] [-
overwrite <CONFIRM-OVERWRITE>] [-scope <SCOPE>] -savedSearchFile
<SAVED-SEARCH-FILE>

The input parameters are:

Parameter Description

CENTRASITE-URL (Optional). The URL of the CentraSite registry. For
example, http://localhost:53307/CentraSite/
CentraSite.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user
identified by the parameter USER-ID.

XQUERY-MODULE The absolute or relative path to the XQuery module.

CONFIRM-OVERWRITE Specifies whether to overwrite an existing report
XQuery module with the new XQuery module.

The possible values:

true - Overwrite existing XQuery module.

false - Do not overwrite existing XQuery module.

SCOPE The folder to store the newly added saved search in
CentraSite.

The possible values are:

global - This option stores the search information in
"Default Organization" folder.

org - This option stores the search information in the
user's organization folder.

user (default value) - This option stores the search
information in the user folder.

SAVED-SEARCH-FILE Name of the XML file which contains the saved search.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd add
Search -url http://localhost:53307/CentraSite/CentraSite -user
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Administrator -password manage -savedSearchFile MySearch.xml -module
MyPortlet.xquery -overwrite true -scope org

The response to this command could be:
Executing the command : add Search 
Successfully executed the command : add Search

After the command executes successfully, the newly created portlet, MyPortlet, is
displayed in the Data Feed list in Add New Portlet dialog box.

Activating Custom Reporting Search through CentraSite Business UI
After you upload the custom reporting search to CentraSite repository, you must
activate this reporting search through CentraSite Business UI.

To activate the custom reporting search

1. In CentraSite Business UI, click the Welcome link in the upper-right corner of the
header area.

The Welcome page displays a list of portlets that are configured for your view.

2. Click the Configure link (below the label Welcome to CentraSite Business UI).

The Configure your Welcome Page dialog box opens to display the list of portlets that
are available to you.

3. In the Configure Your Welcome Page dialog box, click the Add a portlet link.

This opens the Add a portlet dialog box.

4. In the Add Portlet dialog box, provide the required information for each of the
displayed data fields. For more information about specifying the data fields, see the
CentraSite User’s Guide.

5. In the Data Feed box, select the custom reporting search that you uploaded to the
CentraSite repository.

6. Click OK.

The portlet that you just created with the custom reporting search is added to the
CentraSite Registry Repository, and you are redirected to the Configure Your Welcome
Page dialog box.

By default, this newly created portlet is disabled and is not displayed in the Welcome
page.

7. In the Configure Your Welcome Page dialog box, select the newly created portlet to add
to your Welcome page.

8. Click OK.

The newly created portlet is displayed in your personalized Welcome page.
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Deleting Custom Reporting Search through Command Line
Pre-requisites:

To delete a custom reporting search through the CentraSite Command Line Interface,
you must have the CentraSite Administrator role.

CentraSite provides a command tool named delete Search for this purpose.

To delete a custom reporting search

Run the command delete Search.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd delete search [-url <CENTRASITE-
URL>] -user <USER-ID> -password <PASSWORD> [-savedSearch <SAVED-
SEARCH>] [-scope <SCOPE>]

The input parameters are:

Parameter Description

CENTRASITE-URL (Optional). The URL of the CentraSite registry. For
example, http://localhost:53307/CentraSite/
CentraSite.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user
identified by the parameter USER-ID.

SAVED-SEARCH Name of the saved search you want to delete.

SCOPE Name of the folder that contains the saved search you
want to delete.

The possible values are:

global - List of saved searches that belong to the
Default Organization.

org - List of saved searches that belong to the logged-
in user's organization.

user - Default. List of saved searches that belong to
the logged-in user.
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Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd delete
Search -url http://localhost:53307/CentraSite/CentraSite -user
Administrator -password manage -savedSearch "My Saved Search" -scope
org

The response to this command could be:
Executing the command : delete Search 
Successfully executed the command : delete Search

Displaying List of Reporting Searches
Pre-requisites:

To display the list of all reporting searches through the CentraSite Command Line
Interface, you must have the CentraSite Administrator role.

CentraSite provides a command tool named list Search for this purpose.

To display the list of reporting searches

Run the command list Search.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd list search [-url <CENTRASITE-URL>]
-user <USER-ID> -password <PASSWORD> [-scope <SCOPE>]

The input parameters are:

Parameter Description

CENTRASITE-URL (Optional). The URL of the CentraSite registry. Default
value is http://localhost:53307.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user
identified by the parameter USER-ID.

SCOPE The folder to store the newly added saved search in
CentraSite.

The possible values are:

global - This option stores the search information in
"Default Organization" folder.
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Parameter Description

org - This option stores the search information in the
user's organization folder.

user (default value) - This option stores the search
information in the user folder.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd list Search
-url http://localhost:53307/CentraSite/CentraSite -user Administrator
-password manage -scope org

Obtaining Details of Reporting Search
Pre-requisites:

To obtain the details of a reporting search through the CentraSite Command Line
Interface, you must have the CentraSite Administrator role.

CentraSite provides a command tool named get Search for this purpose.

To display the details of a reporting search

Run the command get Search.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd get search [-url <CENTRASITE-URL>]
-user <USER-ID> -password <PASSWORD> -savedSearch <SAVED-SEARCH> [-
scope <SCOPE>]

The input parameters are:

Parameter Description

CENTRASITE-URL (Optional). The URL of the CentraSite registry. Default
value is http://localhost:53307.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user
identified by the parameter USER-ID.

SAVED-SEARCH Name of the saved search in CentraSite.
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Parameter Description

SCOPE The folder to store the newly added saved search in
CentraSite.

The possible values are:

global - This option stores the search information in
"Default Organization" folder.

org - This option stores the search information in the
user's organization folder.

user (default value) - This option stores the search
information in the user folder.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd get Search -
url http://localhost:53307/CentraSite/CentraSite -user Administrator
-password manage -savedSearch MySearch -scope org

Copying Reporting Search
Pre-requisites:

To create a copy of an existing reporting search through the CentraSite Command Line
Interface, you must have the CentraSite Administrator role.

A saved search can become quite complex, especially if it contains several aributes.
Instead of creating a new saved search “from scratch”, it is sometimes easier to copy an
existing search that is similar to the one you need and edit the copy.

CentraSite provides a command tool named copy Search for this purpose.

To copy a custom reporting search

Run the command copy Search.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd copy search [-url <CENTRASITE-URL>]
-user <USER-ID> -password <PASSWORD> -savedSearch <SAVED-SEARCH> [-
overwrite <CONFIRM-OVERWRITE>] [-scope <SCOPE>] [-targetuser <TARGET-
USER>]

The input parameters are:
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Parameter Description

CENTRASITE-URL (Optional). The URL of the CentraSite registry. Default
value is http://localhost:53307.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user
identified by the parameter USER-ID.

SAVED-SEARCH Name of the saved search in CentraSite.

SCOPE The folder to store the newly added saved search in
CentraSite.

The possible values are:

global - This option stores the search information in
"Default Organization" folder.

org - This option stores the search information in the
user's organization folder.

user (default value) - This option stores the search
information in the user folder.

TARGET-USER The name or UUID of a CentraSite user to whom
you want to transfer ownership of the objects that
are referenced by the organization identified by the
parameter  SAVED-SEARCH.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd copy Search
-url http://localhost:53307/CentraSite/CentraSite -user Administrator
-password manage -savedSearch MySearch -scope org -targetuser
SAGDomain\Claire

Sample XQueries for Reporting Searches
CentraSite provides a collection of sample queries which can be used fetch the search
results directly or in a modified version against the CentraSite server. For the purpose
of demonstration, let us suppose that our search data is based on an online fictional
store selling a wide range of sheet music. In order to make this music store available
online, CentraSite provides a set of suitable services. The services operate on a common
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database that includes the required information about the music sheets offered, the
customers, and the orders. The services and their usage are exposed to the potential
callers.

XQueries for Retrieving Primary Objects
Primary objects include services, organizations, classificationSchemes, concepts,
packages, externalLinks, and instances of user-defined object-types. There are a number
of primary object types in the JAXR data model representation of CentraSite database.
Also, instances of the user-defined object types become primary objects, since when you
add a new type to CentraSite, a respective schema is created that defines the new type
as a new doctype to the CentraSite database. Instances of the primary object types are
represented as XML documents in the CentraSite database collection.

The sample XQuery to find all organizations in CentraSite, for example, is:
for $organization in collection("CentraSite")/*:organization 
return $organization

The document element name paern *:organization  finds all documents with a
local-name organization in any namespace. A proper namespace allows the XQuery
processor more means of optimization (index utilization, for example), and therefore we
enhance the XQuery definition as:
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr" 
for $organization in collection("CentraSite")/jaxr:organization 
return $organization

To find a specific organization, we include a where clause in the above XQuery
definition. Note that most of the elements to be retrieved (as the key element holding the
unique UDDI key) are also in the JAXR namespace.
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr"; 
for $organization in collection("CentraSite")/jaxr:organization 
where $organization/jaxr:key = "uddi:4299de0d-51a4-11de-9115-99700cdcef42" 
return $organization

To return a more sophisticated result than just the retrieved element as it is contained in
the CentraSite database, define a result structure as the XQuery result and insert the data
taken from the element. The next XQuery returns a generated element organization 
containing the organization's name  and its owner . The owner  is identified as a user 
(another primary object type) and is defined by the organization's sub-element owner .
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr"; 
for $organization in collection("CentraSite")/jaxr:organization 
where $organization/jaxr:key = "uddi:4299de0d-51a4-11de-9115-99700cdcef42" 
return 
 <organization> 
  <name> { string(($organization/jaxr:name/jaxr:localString)[1]) } </name>
  <owner> { 
    let $owner := collection("CentraSite")/*:user
      [jaxr:key = $organization/jaxr:owner] 
    return string(($owner/jaxr:name/jaxr:localString)[1]) 
  } </owner>
 </organization>
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This results in a newly generated element node containing elements for the
organization's name  and owner as below:
<xq:result xmlns:xq="http://namespaces.softwareag.com/tamino/XQuery/result">
  <organization>
    <name>Mozart Music GmbH</name>
    <owner>INTERNAL\Administrator</owner>
  </organization>
</xq:result>

To find a primary object's name, we declare and use a user-defined XQuery function:
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr"; 
declare function local:getName($node as node()) as xs:string { 
  string(($node/jaxr:name/jaxr:localString)[1]) 
}; 
for $organization in collection("CentraSite")/jaxr:organization 
where $organization/jaxr:key = "uddi:4299de0d-51a4-11de-9115-99700cdcef42" 
return 
 <organization> 
  <name> { local:getName($organization) } </name> 
  <owner> { 
    let $owner := collection("CentraSite")/*:user 
      [jaxr:key = $organization/jaxr:owner] 
    return local:getName($owner) 
  } </owner> 
 </organization>

XQueries for Retrieving Embedded Objects
Embedded objects (for example, slots, classifications, and associations) occur embedded
within the primary objects.

As an example, let us look at the slots provided with the service MusicQuoteService.
The MusicQuoteService provides information on the music sheets by a composer. This
service uses the composer's name as an input and returns the list of music sheets by that
specific composer. A sheet, in this case, is a paired value consisting of a sheet's title and
an ID that identifies the sheet in the online store database.

Let us assume that we bundle this service into different colour schemes and aach the
property colour as a slot (key-value pair) to the service.
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You may use an XQuery function to find the colour property:
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr"; 
declare function local:getName($node as node()) as xs:string { 
  string($node/jaxr:name/jaxr:localString) 
}; 
for $service in collection("CentraSite")/jaxr:service 
where local:getName($service) = "MusicQuoteService" 
return $service/jaxr:instanceSlots/colour

This XQuery function returns :
<colour xmlns="">blue</colour>

When dealing with function calls, the optimizer sometimes decides to inline the XQuery
function. That is, before an XQuery gets executed, a function call is replaced with the
body of the respective function. In this XQuery, the function call to local:getName
might not get inline during optimization. Optionally, you can precede the function
declaration with an inline XQuery pragma.
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr";
{?inline?}
declare function local:getName($node as node()) as xs:string { 
  string($node/jaxr:name/jaxr:localString) 
};
for $service in collection("CentraSite")/jaxr:service
where local:getName($service) = "MusicQuoteService"
return $service/jaxr:instanceSlots/colour

The optimization pragma {?optimization inline="full"?} at the beginning of the
XQuery would make all user-defined functions to be inline except those that directly or
indirectly reference themselves.

Some of the embedded object types are related to specific primary object types as
serviceBindings that occur as sub elements of the services. An XQuery using the
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local-name function would retrieve the sub elements that exist under the current
element in an XML document:
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr";
declare function local:getName($node as node()) as xs:string { 
  string($node/jaxr:name/jaxr:localString) 
};
for $service in collection("CentraSite")/jaxr:service
where local:getName($service) = "MusicQuoteService"
return for $subelement in $service/*
       return local-name($subelement)

This XQuery function yields:
<xq:result xmlns:xq="http://namespaces.softwareag.com/tamino/XQuery/result">
  <xq:value>key</xq:value>
  <xq:value>owner</xq:value>
  <xq:value>name</xq:value>
  <xq:value>description</xq:value>
  <xq:value>submittingOrganization</xq:value>
  <xq:value>externalLinks</xq:value>
  <xq:value>classifications</xq:value>
  <xq:value>majorVersion</xq:value>
  <xq:value>minorVersion</xq:value>
  <xq:value>stability</xq:value>
  <xq:value>status</xq:value>
  <xq:value>providingOrganization</xq:value>
  <xq:value>serviceBindings</xq:value>
  <xq:value>instanceSlots</xq:value>
</xq:result>

XQueries for Retrieving Classifications
The purpose of classifying objects is to allow a means of semantic retrieval. Let us
assume that we have the following taxonomy classifications to describe the different
types of music:

e: Classical Music

ec: Classical Chamber Music

ecb: Brass Chamber Music

eo: Classical Music for Orchestras

u: Non-Classical Music

us: Music for Small Bands

ub: BigBand Music

This enables the customer to retrieve specific music sheets as classified in the online
store. An XQuery function to retrieve the concept object representing the taxonomy
classification ecb (Brass Chamber Music):
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr";
for $concept in collection("CentraSite")/jaxr:concept
where $concept/jaxr:name/jaxr:localString = "ecb"
return $concept



M
Even Header

Custom Reporting Searches

CentraSite Developer's Guide Version 10.2 (Innovation Release) 238

Make sure that you do not use the user-defined function local:getName in the above
XQuery function, because this function assumes that every such concept only has one
name which cannot be expected in an internationalized environment.

The following XQuery function retrieves the services that are classified by this concept
to search for music sheets applicable to Brass Chamber Music.
declare namespace jaxr = "http://namespaces.CentraSite.com/Schema/jaxr";
declare function local:getName($node as node()) as xs:string { 
  string($node/jaxr:name/jaxr:localString) 
};
let $concept := collection("CentraSite")/jaxr:concept[jaxr:name/
                                                         jaxr:localString="ecb"]
for $service in collection("CentraSite")/jaxr:service
where $service//jaxr:classification/jaxr:concept = $concept/jaxr:key
return local:getName($service)

XQueries for Retrieving Associations
Let us assume a service serv1 relates to two other services serv2 and serv3 using the
predefined association types Contains and Uses respectively.

The following XQuery function finds all registry entries using the Contains association
from the service serv1. Initially, XQuery finds the concept corresponding to association
type Contains and the service serv1. Associations are stored with the primary
objects they start from, that is, the two associations starting from serv1 are stored as
cs:association descendants of serv1.
declare namespace cs="http://namespaces.CentraSite.com/Schema/jaxr"
let $concept := collection("CentraSite")/cs:concept
              [cs:name/cs:localString = "Contains"]/cs:key
let $service := collection("CentraSite")/
                               cs:service[cs:name/cs:localString="serv1"]
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for $target in $service//cs:association[cs:associationType=$concept]/
                               cs:targetObject
return collection("CentraSite")/cs:*[cs:key=$target]

This XQuery function returns the complete service serv2. The next XQuery function
uses the local function getName to only return the services name.
declare namespace cs="http://namespaces.CentraSite.com/Schema/jaxr"
declare function local:getName($node as node()) as xs:string
{
  xs:string($node/cs:name/cs:localString)
}
let $concept := collection("CentraSite")/cs:concept
              [cs:name/cs:localString = "Contains"]/cs:key
let $service := collection("CentraSite")/cs:service
              [cs:name/cs:localString="serv1"]
for $target in $service//cs:association
              [cs:associationType=$concept]/cs:targetObject
return local:getName(collection("CentraSite")/cs:*[cs:key=$target])

The following XQuery function uses another local function followAssocOnce to follow
the association.
declare namespace cs="http://namespaces.CentraSite.com/Schema/jaxr"
declare function local:getName($node as node()) as xs:string
{
  xs:string($node/cs:name/cs:localString)
}
declare function local:followAssocOnce($entry as node(),
                                       $assoc as xs:string) 
  as node()*
{
  for $key in $entry//cs:association
              [cs:associationType=$assoc]/cs:targetObject
  return collection("CentraSite")/*[cs:key=$key]
}
let $concept := collection("CentraSite")/cs:concept
              [cs:name/cs:localString = "Contains"]/cs:key
let $service := collection("CentraSite")/cs:service
              [cs:name/cs:localString="serv1"]
for $target in local:followAssocOnce($service,$concept)
return local:getName($target)

Let us further assume that serv2 points to three other entries, namely the services serv4
and serv5 with Contains association and the service serv6 with Uses association.
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The following XQuery function includes a recursive local function
followAssocMultiple. This function retrieves all entries that are reachable by
following a specific association from a specific entry. When this XQuery function is
applied upon the service serv1 and association Contains, it returns the services serv2,
serv4, and serv5.

This XQuery function, if applied on an entry that is part of or forms a closed loop
system, yields a stack overflow.
declare namespace cs="http://namespaces.CentraSite.com/Schema/jaxr";
declare function local:getName($node as node()) as xs:string
{
  xs:string($node/cs:name/cs:localString)
}
declare function local:followAssocOnce($entry as node(),
                                       $assoc as xs:string) 
                   as node()*
{
  for $key in $entry//cs:association
                            [cs:associationType=$assoc]/cs:targetObject
  return collection("CentraSite")/*[cs:key=$key]
}
declare function local:followAssocMultiple($entry as node(),
                                           $assoc as xs:string) 
                   as node()*
{
  for $target in local:followAssocOnce($entry,$assoc)
  return ($target,local:followAssocMultiple($target,$assoc))
}
let $concept := collection("CentraSite")/cs:concept
                             [cs:name/cs:localString = "Contains"]/cs:key
let $service := collection("CentraSite")/cs:service
                             [cs:name/cs:localString="serv1"]
for $target in local:followAssocMultiple($service,$concept)
return local:getName($target)
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The following XQuery function is applicable on an entry that is part of or forms a closed
loop system. This requires that the recursive function takes three parameters. The first
parameter is the list of already found nodes. The second parameter holds the current
nodes, that is, the nodes found in the previous step. Each time you call the XQuery
function, it finds the nodes reached directly from the current nodes. These nodes become
the new nodes unless they have previously been found.
declare namespace cs="http://namespaces.CentraSite.com/Schema/jaxr";
declare function local:getName($node as node()) as xs:string
{
  xs:string($node/cs:name/cs:localString)
}
declare function local:followAssocOnce($entry as node(),
                                       $assoc as xs:string) 
                  as node()*
{
  for $key in $entry//cs:association
    [cs:associationType=$assoc]/cs:targetObject
  return collection("CentraSite")/*[cs:key=$key]
}
declare function local:followAssocMultiple($current as node()*,
                                           $assoc as xs:string) 
                  as node()* {
  let $first := for $node in $current
                return local:followAssocOnce($node,$assoc)
  return local:followAssocMultipleRecursive((),$first,$assoc)
}
declare function local:followAssocMultipleRecursive(
                             $old as node()*,
                             $current as node()*,
                             $assoc as xs:string) as node()* {
  if ($current)
  then let $new := for $entry in $current
                   return local:followAssocOnce($entry,$assoc)
       let $nextold := $old union $current
       let $nextcurrent := $new except $nextold
       return local:followAssocMultipleRecursive($nextold,
                                                 $nextcurrent,
                                                 $assoc)
  else $old
}
let $concept := collection("CentraSite")/cs:concept
                           [cs:name/cs:localString = "Contains"]/cs:key
let $service := collection("CentraSite")/cs:service
                           [cs:name/cs:localString="serv1"]
for $target in local:followAssocMultiple($service,$concept)
return local:getName($target)

When following relations in backward direction, retrieval of entries is slightly more
complex. To retrieve all entries from which a relation $assoc traverses to a specific entry
$entry, find all the entries and check its relations. The following XQuery function uses
a local function followAssocOnceBackwards to find all entries starting from serv4,
traversing the association Contains in backward direction, and yields serv2.
declare namespace cs="http://namespaces.CentraSite.com/Schema/jaxr"
declare function local:getName($node as node()) as xs:string
{
  xs:string($node/cs:name/cs:localString)
}
declare function local:followAssocOnceBackwards($entry as node(),
                                                $assoc as xs:string) 
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                       as node()*
{
  for $everyentry in collection("CentraSite")/*
  for $target in $everyentry//cs:association
              [cs:associationType=$assoc]/cs:targetObject
  where $target = $entry/cs:key
  return $everyentry
}
let $concept := collection("CentraSite")/cs:concept
              [cs:name/cs:localString = "Contains"]/cs:key
let $service := collection("CentraSite")/cs:service
              [cs:name/cs:localString="serv4"]
for $target in local:followAssocOnceBackwards($service,$concept)
return local:getName($target)
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Overview of the UDDI Standard
UDDI (Universal Description Discovery and Integration) is a platform-independent
standard maintained by the OASIS consortium. The standard describes a Service
Oriented Architecture (SOA) registry and its interfaces. UDDI allows clients to discover
registered businesses (organizations or providers) and the web services they provide.
UDDI also provides programming interfaces to create and update the stored registry
information.

The current release of UDDI is V3.0.2. In this document, the UDDI version number is
abbreviated to V3.

The UDDI data model defines the following entity types:

Entity Type Description

businessEntity Represents a business.

businessService Represents one or more web services provided by a
business.

bindingTemplate Describes how to use a web service.

tModel Categorizes a web service type.

publisherAssertion Represents a relationship between two business entities.

UDDI defines a set of APIs for accessing and modifying the data stored in the registry.

These APIs include:

UDDI Inquiry

This API allows you to search for registry entries and retrieve information about
them. The search mechanism allows the use of browse paerns (that is, wildcards)
to be used, so that a set of matching business entities can be returned. The use of a
subsequent so-called drill-down paern allows information to be retrieved from a
business entity.

UDDI Publication

This API allows you to add entries to the registry or modify existing entries.

UDDI Security

This API determines which security seings apply for a registry entity.

Custody and Ownership Transfer



M
Odd Header

Access Using UDDI

CentraSite Developer's Guide Version 10.2 (Innovation Release) 245

This API set is for transferring UDDI objects between multiple nodes of a UDDI
registry and transferring the ownership of UDDI objects between users.

Replication

This API set is for synchronizing the data of multi-node UDDI registries.

In addition, the UDDI specification defines the following client API set:

Value Set

Summary of UDDI Support in CentraSite
CentraSite provides support for UDDI V3. The full list of features of UDDI V3 is
available at the OASIS website.

The features currently not supported in CentraSite are as follows:

Value Set API Set

Replication

Publishing Across Multiple Registries

UDDI Policies

Note: UDDI policies are not the same as web service policies.

CentraSite supports ownership transfer but not inter-node custody transfer.

Multi-Version Support

The following features are not supported:

Migrating version 2 keys to a version 3 registry

Multiple xml:lang aributes of the same language

Supporting external value set providers across versions

White space handling

Multiple overviewDoc data

Multiple personName data

CentraSite UDDI Architecture
CentraSite behaves like an UDDI registry, as described in the UDDI specification. The
main components of CentraSite's UDDI environment are:

The CentraSite Registry or Repository, in which the UDDI objects are stored.
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One or more UDDI servlets running on different application servers. Each UDDI
servlet implements the web services of the UDDI API sets.

This figure illustrates the multiple UDDI servlet scenario, in which multiple UDDI
clients and a JAXR client interact with a single CentraSite Registry or Repository:

Although, there can be multiple UDDI servlets, CentraSite installation is a single-node
UDDI registry. Each UDDI servlet provides an alternative endpoint for the UDDI web
services.

When UDDI data is stored in the CentraSite Registry or Repository, it is mapped to
a data model that is common for JAXR and UDDI clients. The data model is an XML
representation of JAXR data. Since this representation is also used to store data from the
JAXR API, UDDI, and JAXR clients act on the same data.

Note: JAXR instance-based security is the basis of the CentraSite UDDI security,
so modifications made to the JAXR instance-based security may affect UDDI
security.

Client Access using UDDI

UDDI clients can access the CentraSite registry using the:

URL for the inquiry API: http://<hostname>:53307/UddiRegistry/inquiry, where
<hostname>  is the name of the host machine. For example, if the UDDI client is running
on the same machine as the UDDI servlet, the URL is http://localhost:53307/
UddiRegistry/inquiry.

URL for the publish API: http://<hostname>:53307/UddiRegistry/publish.

Every UDDI servlet in a multiple UDDI servlet environment has these endpoints.
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Localization

Localization for UDDI means that the error messages are localized. These messages
are given in the content of an errorInfo element in the disposition report. Example of
disposition report:
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"> 
  <soapenv:Body> 
    <soapenv:Fault> 
      <faultcode>Client</faultcode> 
      <faultstring>Client Error</faultstring> 
      <faultactor /> 
      <detail> 
      <dispositionReport generic="3.0" xmlns="urn:uddi-org:api_v3"> 
        <result errno="10120"> 
          <errInfo errCode="E_authTokenRequired"> 
            The authentication token value dummy passed in the authInfo 
            argument of the UDDI request is not valid. 
          </errInfo> 
        </result> 
      </dispositionReport> 
      </detail> 
    </soapenv:Fault> 
  </soapenv:Body> 
</soapenv:Envelope>

Modeling of the Node Business Entity

The modeling of the Node Business Entity is based on the Recommended Modeling of
Node Business Entity in the UDDI 3.0.2 standard.

Key Generator tModel

The UDDI objects needed for the self-modeling of the node business entity have keys
defined internally by CentraSite that belong to the key partition that is owned by the key
generator:
<tModel 
  tModelkey="...:keyGenerator" 
  xmlns="urn:uddi-org:api_v3"> 
    <name xml:lang="en-US">centrasite-node-com:keyGenerator</name> 
    <description xml:lang="en-US"> 
        Key generator for self registering node business entity 
    </description> 
    <categoryBag> 
       <keyedReference 
          tModelkey="...:keyGenerator" 
          keyName="uddi-org:types:keyGenerator" 
          keyValue="keyGenerator"/> 
     </categoryBag> 
  </categoryBag> 
</tModel>

The key generator is preloaded in the UDDI registry.
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Node Business Entity

The node business entity that is preloaded into the Registry or Repository looks like this:
<businessEntity  
  businessKey="..."> 
    <name xml:lang="en-US">NodeBusinessEntity</uddi:name> 
    <description xml:lang="en-US"> 
        Node Business Entity of the CentraSite UDDI registry 
    </description> 
    <categoryBag> 
       <uddi:keyedReference 
          keyName="" 
          keyValue="node" 
          tModelkey="...:keyGenerator"/> 
    </categoryBag> 
</businessEntity>

The node business entity references certain businessService objects which reflect the
UDDI API sets. The first UDDI registry interacting with the Registry or Repository adds
the businessService objects. It also adds the bindingTemplate objects pointing to
the API set's endpoints offered by the UDDI registry. Every additional UDDI registry
in a multiple UDDI servlet environment adds bindingTemplate objects pointing to the
additional endpoints where the UDDI services can be called. The tModels referenced
by the businessService objects are preloaded into the UDDI registry. Due to the
fact that multiple bindingTemplate objects are defined for each UDDI registry, the
bindingTemplate objects get node generated keys.

The web services that implement the UDDI API sets are registered in the UDDI registry.
For CentraSite, only the supported API sets are reflected by this self-registration. These
are:

Inquiry API set

Publication API set

Security Policy API set

Custody and Ownership Transfer API Set

Inquiry API Set
<businessService 
  serviceKey="uddi:centrasite.node.com:service_inquiry" 
  businessKey="..." 
  xmlns="urn:uddi-org:api_v3"> 
    <name xml:lang="en-US">UDDI Inquiry Services</name> 
    <description xml:lang="en-US">Web Service supporting UDDI Inquiry APIs 
    </description> 
    <bindingTemplates> 
       <bindingTemplate 
          bindingKey="..." 
          serviceKey="uddi:centrasite.service.com:inquiry"> 
            <description xml:lang="en-US"> 
               This binding supports the UDDI Programmer's API Specification 
               For inquiry 
            </description> 
            <accessPoint useType="endPoint"> 
               http://localhost:53307/UddiRegistry/inquiry 



M
Odd Header

Access Using UDDI

CentraSite Developer's Guide Version 10.2 (Innovation Release) 249

            </accessPoint> 
            <tModelInstanceDetails> 
              <tModelInstanceInfo 
                tModelkey="...:keyGenerator"> 
                  <description xml:lang="en-US"> 
                      This access point supports the UDDI Version 2.0 
                      Programmer's API Specification for inquiry 
                 </description> 
              </tModelInstanceInfo> 
           </tModelInstanceDetails> 
       </bindingTemplate> 
       <bindingTemplate 
         bindingKey="..." 
         serviceKey="uddi:centrasite.node.com:service_inquiry"> 
            <description xml:lang="en-US"> 
               This binding supports the UDDI Programmer's API Specification 
               for inquiry 
            </description> 
            <accessPoint useType="endPoint"> 
               http://localhost:53307/UddiRegistry/inquiry 
            </accessPoint> 
            <tModelInstanceDetails> 
               <tModelInstanceInfo tModelkey="...:keyGenerator"> 
                  <description xml:lang="en-US"> 
                      This access point supports the UDDI Version 3.0 
                      Programmer's API Specification for inquiry 
                  </description> 
               </tModelInstanceInfo> 
            </tModelInstanceDetails> 
       </bindingTemplate> 
    </bindingTemplates> 
</businessService>

Publish API Set
<businessService 
  serviceKey="uddi:centrasite.node.com:service_publish" 
  businessKey="..." 
  xmlns="urn:uddi-org:api_v3"> 
    <name xml:lang="en-US">UDDI Publish API Services</name> 
    <description xml:lang="en-US"> 
        Web Service supporting UDDI specifications 
    </description> 
    <bindingTemplates> 
        <bindingTemplate 
          bindingKey="..." 
          serviceKey="uddi:centrasite.node.com:service_publish"> 
            <description xml:lang="en"> 
                This binding supports the UDDI Programmer's API Specification 
                for publication 
            </description> 
            <accessPoint useType="endPoint"> 
                http://localhost:53307/UddiRegistry/publish 
            </accessPoint> 
            <tModelInstanceDetails> 
                <tModelInstanceInfo 
                  tModelkey="...:keyGenerator"> 
                    <description xml:lang="en"> 
                        This binding supports the UDDI Version 2.0 Programmer's 
                        API Specification for publication 
                    </description> 
                </tModelInstanceInfo> 
            </tModelInstanceDetails> 



M
Even Header

Access Using UDDI

CentraSite Developer's Guide Version 10.2 (Innovation Release) 250

        </bindingTemplate> 
        <bindingTemplate 
          bindingKey="uddi:centrasite.node.com:binding_publish_v3" 
          serviceKey="uddi:centrasite.node.com:service_publish"> 
            <description xml:lang="en"> 
                This binding supports the UDDI Programmer's API Specification 
                for publication 
            </description> 
            <accessPoint useType="endPoint"> 
                http://localhost:53307/UddiRegistry/publish 
            </accessPoint> 
            <tModelInstanceDetails> 
                <tModelInstanceInfo tModelkey="...:keyGenerator"> 
                    <description xml:lang="en"> 
                        This binding supports the UDDI Version 3.0 Programmer's 
                        API Specification for publication 
                    </description> 
                </tModelInstanceInfo> 
            </tModelInstanceDetails> 
        </bindingTemplate> 
    </bindingTemplates> 
</businessService>

Security API Set
<businessService 
  serviceKey="uddi:centrasite.node.com:service_security" 
  businessKey="..." 
  xmlns="urn:uddi-org:api_v3"> 
    <name xml:lang="en">UDDI Security Service</name> 
    <description xml:lang="en-US"> 
       Web Service supporting UDDI Security API 
    </description> 
    <bindingTemplates> 
        <bindingTemplate 
          bindingKey="..." 
          serviceKey=" uddi:centrasite.node.com:service_security"> 
            <description xml:lang="en"> 
                This binding to authenticate with the UDDI services using the 
                UDDI Security API. 
            </description> 
            <accessPoint useType="endPoint"> 
               http://localhost:53307/UddiRegistry/publish 
            </accessPoint> 
            <tModelInstanceDetails> 
                <tModelInstanceInfo tModelkey="...:keyGenerator"> 
                    <description xml:lang="en"> 
                         This binding's supports the UDDI v3 Security API. 
                    </description> 
                </tModelInstanceInfo> 
            </tModelInstanceDetails> 
        </bindingTemplate> 
    </bindingTemplates> 
</businessService>

Custody and Ownership Transfer API Set
<businessService 
  serviceKey="uddi:centrasite.node.com:service_ownership_transfer" 
  businessKey="..." 
  xmlns="urn:uddi-org:api_v3"> 
    <name xml:lang="en">UDDI Custody and Ownership Transfer API</name> 
    <description xml:lang="en-US"> 
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       Web Service providing partly support for the UDDI Custody and Ownership 
       Transfer API 
    </description> 
    <bindingTemplates> 
        <bindingTemplate 
          bindingKey="uddi..." 
          serviceKey=" uddi:centrasite.node.com:service_ownership_transfer"> 
            <description xml:lang="en-US"> 
                This binding provides partly support for the UDDI Custody and 
                Ownership Transfer API. 
            </description> 
            <accessPoint useType="endPoint"> 
               http://localhost:53307/UddiRegistry/publish 
            </accessPoint> 
            <tModelInstanceDetails> 
                <tModelInstanceInfo 
                  tModelkey="...:keyGenerator"> 
                    <description xml:lang="en-US"> 
                        This binding provides partly support for the UDDI 
                        Custody and Ownership Transfer API 
                    </description> 
                </tModelInstanceInfo> 
            </tModelInstanceDetails> 
        </bindingTemplate> 
    </bindingTemplates> 
</businessService>

WSDL

The referenced tModels refer to the WSDL file as follows. Each port, specified by the
<port> element, specifies an access point. The WSDL representation is a description of
the web services that are provided by the UDDI servlets:
<?xml version="1.0" encoding="UTF-8"?> 
<definitions name="UDDI_API_V3" 
  xmlns="http://schemas.xmlsoap.org/wsdl/" 
  xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/" 
  xmlns:api_v3_binding="urn:uddi-org:api_v3_binding" 
  xmlns:tns="urn:uddi-org:api_v3" 
  targetNamespace="urn:uddi-org:api_v3"> 
  
    <documentation> 
    UDDI V3 Security, Publication, Inquiry and Transfer APIs. 
    </documentation> 
  
    <import 
      namespace="urn:uddi-org:api_v3_binding" 
      location="http://uddi.org/wsdl/uddi_api_v3_binding.wsdl"/> 
    <import 
      namespace="urn:uddi-org:api_v3_binding" 
      location="http://uddi.org/wsdl/uddi_custody_v3_binding.wsdl"/> 
    <service name="UDDI_Security_SoapService"> 
        <port 
          name="UDDI_Security_PortType" 
          binding="api_v3_binding:UDDI_Security_SoapBinding"> 
            <soap:address 
              location="http://localhost:53307/UddiRegistry/publish"/> 
        </port> 
    </service> 
    <service name="UDDI_Publication_SoapService"> 
        <port 
          name="UDDI_Publication_PortType" 
          binding="api_v3_binding:UDDI_Publication_SoapBinding"> 
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            <soap:address 
              location="http://localhost:53307/UddiRegistry/publish"/> 
        </port> 
    </service> 
    <service name="UDDI_Inquiry_SoapService"> 
        <port 
          name="UDDI_Inquiry_PortType" 
          binding="api_v3_binding:UDDI_Inquiry_SoapBinding"> 
            <soap:address  
              location="http://localhost:53307/UddiRegistry/inquiry"/> 
        </port> 
    </service> 
    <service name="UDDI_Ownership_Transfer_SoapService"> 
        <port 
          name="UDDI_Inquiry_PortType" 
          binding="api_v3_binding:UDDI_Inquiry_SoapBinding"> 
            <soap:address  
              location="http://localhost:53307/UddiRegistry/inquiry"/> 
        </port> 
    </service> 
</definitions>

The WSDL defines the proper endpoints of each web service. Each UDDI registry adds a
port pointing to its endpoints. The first UDDI registry also inserts the service elements.
The WSDL file can be accessed through these URIs:

http://localhost:53307/UddiRegistry/inquiry?WSDL

http://localhost:53307/UddiRegistry/publish?WSDL

The WSDL is stored in the CentraSite repository.

UDDI Representation of the Object Model
Attributes

Aributes in CentraSite associate values, classifications, and associations with names.
For the UDDI representation in CentraSite, the aributes are grouped together in a
uddi:keyedReferenceGroup containing all the aributes of the UDDI object.

Key/Value Pair Attributes

Key/value pair aributes are represented in a uddi:categoryBag as:
<categoryBag> 
 <keyedReference 
     tModelKey="uddi:uddi.org:categorization:general_keywords" 
     keyName="Encryption Required" keyValue="false"/> 
 <keyedReference 
     tModelKey="uddi:uddi.org:categorization:general_keywords" 
     keyName="Demo Available" keyValue="false"/> 
</categoryBag>

Rich Text Attributes

For tModels and instanceDetails, the Rich Text aributes are represented in a
uddi:overviewDoc element as:
<overviewDoc> 
 <description> 
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  Detailed Description 
 </description> 
 <overviewUrl useType="uddi:centrasite.com:attributes:richText"> 
  http://10.22.21.94:2020/... 
 </overviewUrl> 
</overviewDoc>

For all other UDDI objects, especially uddi:business and uddi:businessService,
a modified, UDDI-conformant uddi:keyedReferenceGroup approach provides
more flexibility. However, the document referencing semantics cannot be interpreted
by a standard UDDI client. Therefore, for Rich Text aributes a dedicated
uddi:keyedReferenceGroup is introduced:
<categoryBag> 
 <keyedReferenceGroup tModelKey="uddi:centrasite.com:attributes:richText"> 
  <keyedReference 
   tModelKey="uddi:uddi.org:categorization:general_keywords" 
   keyName="Detailed Description" 
   keyValue="http://... "/> 
 </keyedReferenceGroup> 
</categoryBag>

The uddi:tModelKey is pointing to
uddi:uddi.org:categorization:general_keyword, to make the uddi:keyName
meaningful. The uddi:keyValue points to the URL of the rich text. All
uddi:keyedReferences representing a rich text aribute are stored in a single
uddi:keyedReferenceGroup.

Document Attributes

CentraSite supports two different documents types:

reference: This is used for referencing documents that can be shared between
registry objects. These are also called supporting documents.

contains: This is used for documents that belong exclusively to the definition of a
registry object, such as WSDL and schema documents that define a Web service.

For tModels and instanceDetails, documents are represented in a uddi:overviewDoc
element as:
<overviewDoc> 
 <description> 
  sample category/Documentation 
 </description> 
 <overviewUrl useType="uddi:centrasite.com:attributes:document:reference"> 
  http://10.22.21.94:2020/... 
 </overviewUrl> 
</overviewDoc> 
<overviewDoc> 
 <description> 
  sample Asset File 
 </description> 
 <overviewUrl useType="uddi:centrasite.com:attributes:document:contains"> 
  http://10.22.21.94:2020/... 
 </overviewUrl> 
</overviewDoc>

For all other UDDI objects, a modified uddi:keyedReferenceGroup based approach is
used which conforms to the UDDI specification:



M
Even Header

Access Using UDDI

CentraSite Developer's Guide Version 10.2 (Innovation Release) 254

<categoryBag> 
 <keyedReferenceGroup    
  tModelKey="uddi:centrasite.com:attributes:document:reference"> 
  <keyedReference 
   tModelKey="uddi:uddi.org:categorization:general_keywords" 
   keyName="sample category/Documentation" 
   keyValue="http://10.22.21.94:2020/..."/> 
 </keyedReferenceGroup> 
 <keyedReferenceGorup 
  tModelKey="uddi:centrasite.com:attributes:document:contains" 
  <keyedReference 
   tModelKey="uddi:uddi.org:categorization:general_keywords" 
   keyName="Asset File" keyValue="http://10.22.21.94:2020/..."/> 
 </keyedReferenceGroup> 
</categoryBag>

For both document types (reference and contains), a separate
uddi:keyedReferenceGroup is required. The uddi:tModelKey of the
uddi:keyedReferenceGroup specifies the document type. For each document
type, a separate uddi:tModel is defined. Each udddi:keydReference
represents a single document. The uddi:tModelKey points to
uddi:uddi.org:categorization:general_keywords, to add meaning to
the uddi:keyName. The uddi:keyName specifies the location of the file and the
uddi:keyValue holds the URL of the document. All uddi:keyedReference
representing documents of one type are stored in a single uddi:keyedReferenceGroup.

Relationship Attributes

Relationships are represented in a uddi:keyedReferenceGroup, as follows:
<categoryBag> 
 <keyedReferenceGroup 
  tModelKey="uddi:centrasite.com:attributes:relationShip"> 
  <keyedReference 
   tModelKey="uddi:uddi.org:categorization:general_keywords" 
   keyValue="uddi:3447…" 
   keyName="Invokes"/> 
  <keyedReference 
   tModelKey="uddi:uddi.org:categorization:general_keywords" 
   keyValue="uddi:3447…" 
   keyName="RelatedTo"/> 
 </keyedReferenceGroup> 
</categoryBag>

The uddi:tModelKey indicates that a relationship is represented. Another
uddi:tModelKey uses uddi:uddi.org:categorization:general_keywords to
add meaning to the uddi:keyName. The uddi:keyValue points to the reference
registry object, and the uddi:keyName specifies the type of the relationship.
The available relationship types are determined by the aribute meta data.
All uddi:keyedReferences representing relationships are stored in a single
uddi:keyedReferenceGroup.

Metrics Definition

Following the approach proposed by the Governance Interoperability Framework,
saving metrics information for service objects is accomplished by publishing a
uddi:tModel. This means that a uddi:tModel holding the metrics information is
published and aached to the given uddi:businessService.
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Following is a simple uddi:tModel the metrics information:
<tModel tModelKey="uddi:3d32ac10-5dd1-11da-88b8-51d47e6188b2" deleted="false" 
                            xmlns="urn:uddiorg:api_v3"> 
 <name>Metrics</name> 
 <description>Metrics of EchoAccessPoint</description> 
 <categoryBag> 
  <keyedReference 
   tModelKey="…(key of object type taxonomy)" 
   keyName="Metrics" 
   keyValue="Metrics"/> 
  <keyedReference 
   tModelKey="uddi:centrasite.com:management:metrics:total.request.count" 
   keyName="Count of hits" 
   keyValue="14"/> 
  </categoryBag> 
</tModel>

The uddi:keyedReference of the uddi:categoryBag hold the metrics information. The
metrics that are supported are:

Total Request Count

Success Request Count

Fault Count

Average Response Time

Minimum Response Time

Maximum Response Time

Availability

Service Liveliness

For each of the supported metrics an according taxonomy is defined that represents the
according value set.

For aaching a metrics uddi:tModel to a given uddi:service, a uddi:keyedReference is
used, which references the metrics-reference taxonomy. Following is an example of a
uddi:businessService that references a metrics uddi:tModel:
<businessService serviceKey="uddi:1d233560-5dc8-11da-88b7-51d47e6188b2" 
                        businessKey="uddi:a2b32100-5ac0-11da-8540-e2406020853d" 
                              xmlns="urn:uddi-org:api_v3"> 
 <name>EchoHeadersService</name> 
 <description>wsdl:type representing service</description> 
 <bindingTemplates> 
  <bindingTemplate bindingKey="uddi:1d25a660-5dc8-11da-88b7-51d47e6188b2" 
   serviceKey="uddi:1d233560-5dc8-11da-88b7-51d47e6188b2"> 
   <description>wsdl:type representing port</description> 
   <accessPoint useType="http://schemas.xmlsoap.org/soap/http"> 
               http://tracy:4400/sst/runtime.asvc/com.actional.soapstation.Echo 
   </accessPoint> 
   <tModelInstanceDetails> 
    <tModelInstanceInfo 
     tModelKey="uddi:1cd8bee0-5dc8-11da-88b7-51d47e6188b2"> 
     <instanceDetails> 
      <instanceParms>EchoHeaders</instanceParms> 
     </instanceDetails> 
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    </tModelInstanceInfo> 
    <tModelInstanceInfo 
     tModelKey="uddi:1cafda20-5dc8-11da-88b7-51d47e6188b2"/> 
   </tModelInstanceDetails> 
   <categoryBag> 
    <keyedReference tModelKey="uddi:uddi.org:wsdl:types"     
                    keyName="uddi.org:wsdl:types" keyValue="port"/> 
   </categoryBag> 
 </bindingTemplate> 
 </bindingTemplates> 
   <categoryBag> 
    <keyedReference   
     tModelKey="uddi:centrasite.com:management:metrics:reference" 
     keyName="Metrics" 
     keyValue="uddi:3d32ac10-5dd1-11da-88b8-51d47e6188b2"/> 
    <keyedReference tModelKey="uddi:uddi.org:xml:namespace"    
     keyName="uddi.org:xml:namespace" 
     keyValue="http://sanity/test"/> 
    <keyedReference tModelKey="uddi:uddi.org:wsdl:types" 
     keyName="uddi.org:wsdl:types" keyValue="service"/> 
    <keyedReference tModelKey="uddi:uddi.org:xml:localName"  
     keyName="uddi.org:xml:localName" 
     keyValue="EchoHeadersService"/> 
 </categoryBag> 
</businessService>

Metrics Reference Taxonomy

The Metrics Reference taxonomy is for aaching metrics uddi:tModels to
uddi:businessService. The uddi:tModel for defining the taxonomy is:
<tModel tModelKey=
                 "uddi: centrasite.com:management:metrics:reference"> 
                 <name> centrasite -com:management:metrics:reference</name> 
 <description> 
  Reference to a tModel containing all metrics about the Service 
 </description> 
 <categoryBag> 
  <keyedReference 
   keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference 
   keyName="uddi-org:types:checked" 
   keyValue="checked" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference 
   keyName="entityKeyValues" 
   keyValue="tModelKey" 
   tModelKey="uddi:uddi.org:categorization:entitykeyvalues"/> 
 </categoryBag> 
</tModel>

Total Request Count Taxonomy

The following metrics tModel indicates the total number of requests:
<tModel tModelKey=
                "uddi:centrasite.com:management:metrics:total.request.count"> 
                <name>Total Request Count</name> 
 <description> Represents Metrics Total Request Count</description> 
 <categoryBag> 
  <keyedReference keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
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   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="uddi-org:types:unchecked" 
   keyValue="unchecked" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="Metric Type" 
   keyValue="Metrics Type" 
   tModelKey="uddi:centrasite.com:management:metrics:types"/> 
 </categoryBag> 
</tModel>

Success Request Count Taxonomy

The following metrics tModel indicates the number of successful requests:
<tModel tModelKey=
                "uddi:centrasite.com:management:metrics:success.request.count"> 
                <name>Success Request Count</name> 
 <description>Represents Metrics Success  Request Count</description> 
 <categoryBag> 
  <keyedReference keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="uddi-org:types:unchecked" 
   keyValue="unchecked" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="Metric Type" 
   keyValue="Metrics Type" 
   tModelKey="uddi:centrasite.com:management:metrics:types"/> 
 </categoryBag> 
</tModel>

Fault Request Count Taxonomy

The following metrics tModel indicates the number of faults:
<tModel tModelKey=
                "uddi:centrasite.com:management:metrics:fault.request.count"> 
                <name>Fault Request Count</name> 
 <description>Represents Metrics Fault Request Count</description> 
 <categoryBag> 
  <keyedReference keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="uddi-org:types:unchecked" 
   keyValue="unchecked" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="Metric Type" 
   keyValue="Metrics Type" 
   tModelKey="uddi:centrasite.com:management:metrics:types"/> 
 </categoryBag> 
</tModel>

Average Response Time Taxonomy

The following metrics tModel indicates the average response time of requests:
<tModel tModelKey=
                "uddi:centrasite.com:management:metrics:average.response.time"> 
                <name>Average Response Time</name> 
 <description>Represents Metrics Average Response Time</description> 
 <categoryBag> 
  <keyedReference keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="uddi-org:types:unchecked" 
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   keyValue="unchecked" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="Metric Type" 
   keyValue="Metrics Type" 
   tModelKey="uddi:centrasite.com:management:metrics:types"/> 
 </categoryBag> 
</tModel>

Minimum Response Time Taxonomy

The following metrics tModel indicates the minimum response time of requests:
<tModel tModelKey=
                "uddi:centrasite.com:management:metrics:minimum.response.time"> 
                <name>Minimum Response Time</name> 
 <description>Represents Metrics Minimum Response Time</description> 
 <categoryBag> 
   <keyedReference keyName="uddi-org:types:categorization" 
     keyValue="categorization" 
     tModelKey="uddi:uddi.org:categorization:types"/> 
   <keyedReference keyName="uddi-org:types:unchecked" 
     keyValue="unchecked" 
     tModelKey="uddi:uddi.org:categorization:types"/> 
   <keyedReference keyName="Metric Type" 
     keyValue="Metrics Type" 
     tModelKey="uddi:centrasite.com:management:metrics:types"/> 
 </categoryBag> 
</tModel>

Maximum Response Time Taxonomy

The following metrics tModel indicates the maximum response time of requests:
<tModel tModelKey=
                "uddi:centrasite.com:management:metrics:maximum.response.time"> 
                <name>Maximum Response Time</name> 
 <description>Represents Metrics Maximum Response Time</description> 
 <categoryBag> 
   <keyedReference keyName="uddi-org:types:categorization" 
     keyValue="categorization" 
     tModelKey="uddi:uddi.org:categorization:types"/> 
    
   <keyedReference keyName="uddi-org:types:unchecked" 
     keyValue="unchecked" 
     tModelKey="uddi:uddi.org:categorization:types"/> 
  
   <keyedReference keyName="Metric Type" 
     keyValue="Metrics Type" 
     tModelKey="uddi:centrasite.com:management:metrics:types"/> 
 </categoryBag> 
</tModel>

Availability Taxonomy

The following metrics tModel indicates the Virtual/Proxy service availability:
<tModel tModelKey=
                "uddi:centrasite.com:management:metrics:availability"> 
                <name>Availability</name> 
 <description>Represents Metrics Availability</description> 
 <categoryBag> 
  <keyedReference keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="uddi-org:types:unchecked" 



M
Odd Header

Access Using UDDI

CentraSite Developer's Guide Version 10.2 (Innovation Release) 259

   keyValue="unchecked" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="Metric Type" 
   keyValue="Metrics Type" 
   tModelKey="uddi:centrasite.com:management:metrics:types"/> 
 </categoryBag> 
</tModel>

Service Liveliness Taxonomy

The following metrics tModel indicates the uptime/downtime of Virtual/Proxy services:
<tModel tModelKey=
                "uddi:centrasite.com:management:metrics:service.liveliness"> 
                <name>Service Liveliness</name> 
 <description>Represents Metrics Service Liveliness</description> 
 <categoryBag> 
  <keyedReference keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="uddi-org:types:unchecked" 
   keyValue="unchecked" 
   tModelKey="uddi:uddi.org:categorization:types"/> 
  <keyedReference keyName="Metric Type" 
   keyValue="Metrics Type" 
   tModelKey="uddi:centrasite.com:management:metrics:types"/> 
 </categoryBag> 
</tModel>

Representing Targets and Target Types

CentraSite stores Targets and Target Types as taxonomies. Hence, a deployment of a
service to a target can be represented via a uddi:keyedReference.

Representing Status

Services that have a certain status are classified according to the LCM taxonomy.

Representing Version

Version information is represented by mapping the jaxr:Slot holding the version
information. A uddi:categoryBag holding version information appears as:
<categoryBag> 
 <keyedReference tModelKey="uddi:uddi.org:categorization:general_keywords" 
                   keyName="Version" keyValue="1.0.0"/> 
</categoryBag>

Mapping WS-PolicyAttachments

The mapping of WS-PolicyAachments follows the W3C specification Web Service
Policy Aachment version 1.5. This means that a tModel is created to represent the
reusable policy expression.

Configuring the UDDI Environment
This section describes the various configuration required for the UDDI environment.
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Configuration Properties
In CentraSite the UDDI registry reflects its behavior in terms of JAXR objects stored in
the CentraSite Registry or Repository. This representation can be used to parameterize
the behavior.

The behavior of the UDDI processing in CentraSite can be configured using global and
local properties.

UDDI in a Multi-CAST Environment

CentraSite supports a multi-CAST (CentraSite Application Server Tier) UDDI registry
environment. In this environment, multiple CASTs are running against a single
CentraSite Registry or Repository. Each CAST comes with its own UDDI Registry web
application. In addition, several pure JAXR-based clients interact with the Registry or
Repository.

In such an environment the Registry or Repository represents a single UDDI registry
node, albeit multiple UDDI Registries are involved. Each UDDI Registry provides its
own endpoints for the UDDI services. Due to the multi-CAST scenario, two different sets
of properties are needed:

Local properties, which specify the behavior of a single UDDI web application.
Local properties can be used to change the behavior of the web applications
independently.

Global properties, which specify the global behavior of the UDDI registry. Global
properties cannot be changed separately for each UDDI registry.

CAST Registration and Deregistration

You can manage CASTs through the CentraSite Command Line Interface. However, you
must have the CentraSite Administrator role.

Retrieving List of Available CASTs

Pre-requisites:

CentraSite provides a command tool named list CAST for this purpose.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd list CAST [-url <CENTRASITE-URL>] -user
<USER-ID> -password <PASSWORD>

The input parameters are:

Parameter Description

CENTRASITE-
URL

(Optional). The URL of the CentraSite registry. For example,
http://localhost:53307/CentraSite/CentraSite.
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Parameter Description

USER-ID The user ID of a registered CentraSite user who has the
CentraSite Administrator role. For example, Administrator.

PASSWORD The password for the registered CentraSite user identified by
the parameter USER-ID.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd list CAST -url
http://localhost:53307/CentraSite/CentraSite -user AdminUser -password
AdminPass

The response to this command could be:
Executing the command : list CAST 
Successfully executed the command : list CAST

Registering a CAST

Pre-requisites:

CentraSite provides a command tool named add CAST for this purpose.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd add CAST [-url <CENTRASITE-URL>] -user
<USER-ID> -password <PASSWORD>

The input parameters are:

Parameter Description

CENTRASITE-
URL

(Optional). The URL of the CentraSite registry. For example,
http://localhost:53307/CentraSite/CentraSite.

USER-ID The user ID of a registered CentraSite user who has the
CentraSite Administrator role. For example, Administrator.

PASSWORD The password for the registered CentraSite user identified by
the parameter USER-ID.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd add CAST -
url "http://localhost:53307/CentraSite/CentraSite" -user "AdminUser" -
password "AdminPass"

The response to this command could be:
Executing the command : add CAST 
Successfully executed the command : add CAST
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De-registering a CAST

Pre-requisites:

CentraSite provides a command tool named remove CAST for this purpose.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd remove CAST [-url <CENTRASITE-URL>] -
user <USER-ID> -password <PASSWORD>

The input parameters are:

Parameter Description

CENTRASITE-URL (Optional). The URL of the CentraSite registry. For example,
http://localhost:53307/CentraSite/CentraSite.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user identified
by the parameter USER-ID.

Example:

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd remove CAST
-url http://localhost:53307/CentraSite/CentraSite -user AdminUser -
password AdminPass

The response to this command could be:
Executing the command : remove CAST 
Successfully executed the command : remove CAST

Deployment Descriptors
In addition to the local and global properties that are stored in the registry, the web
application needs some information to contact the CentraSite Registry or Repository.
These parameters are:

com.centrasite.uddi.store.db

com.centrasite.uddi.store.dbUserId

com.centrasite.uddi.store.dbUserPasswordHandle

The credentials are for the unauthenticated read access. Usually the guest account is
used here.
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Changing the User ID or Password of the Web Application Login
Account
If you wish to change the password of the guest account, or if you wish to use another
user account instead of the guest account, proceed as follows:

To change the user ID/password of the web application login account

1. In the file <CentraSiteInstall_Directory> \cast\cswebapps
\UddiRegistry\WEB-INF\web.xml, specify the user ID and
password in com.centrasite.uddi.store.dbUserId and
com.centrasite.uddi.store.dbUserPasswordHandle.

If your configuration includes more than one CAST, you must make this change on
each CAST.

2. Update the corresponding user ID/password information that is stored in the
CentraSite Registry or Repository. For more information, see the CentraSite
Administrator’s Guide.

3. Restart Software AG Runtime.

Setting Global UDDI Properties
To set global properties

1. Create an XML configuration file that contains the following predefined UDDI
properties. This file should be in Java XML properties format.

For example:
<?xml version="1.0" encoding="UTF-8" ?> 
 <!DOCTYPE properties (View Source for full doctype...)> 
 <properties version="1.0"> 
  <comment>Test UDDI Global Configuration XML</comment> 
  <entry key="com.centrasite.uddi.UDDIOperatorName">CentraSite</entry> 
  <entry key="com.centrasite.uddi.UDDIDefaultLanguage">en-US</entry> 
  <entry key="com.centrasite.uddi.UDDIValueValidation">false</entry> 
  <entry key="com.centrasite.uddi.UDDIKeyGeneratorChecks">true</entry> 
  <entry key="com.centrasite.uddi.UDDIDiscoveryURLGeneration">false</entry> 
  <entry key="com.centrasite.uddi.UDDIEncoding">utf-8</entry> 
  <entry key="com.centrasite.uddi.UDDISubscriptionDuration">P1M</entry> 
  <entry key="com.centrasite.uddi.UDDIAuthTokenExpiration">P1D</entry> 
  <entry key="com.centrasite.uddi.UDDITransferTokenExpiration">P1D</entry> 
  <entry key="com.centrasite.uddi.UDDIV2Inquiry">true</entry> 
  <entry key="com.centrasite.uddi.UDDIV2Publish">true</entry> 
  <entry key="com.centrasite.uddi.UDDISendEmptyWebServiceNotifications"> 
             false</entry> 
  <entry key="com.centrasite.uddi.UDDISendEmptyEmailNotifications"> 
             true</entry> 
  <entry key="com.centrasite.uddi.UDDIMinimalNotificationInterval"> 
             P0Y0M0DT0H0M30S</entry> 
  <entry key="com.centrasite.uddi.UDDINumberOfRetries">3</entry> 
  <entry key="com.centrasite.uddi.UDDIMaxSubscriptionThreads">5</entry> 
 </properties>
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Descriptions of these properties are as follows:

Global Property Description

UDDIOperatorName Sets the operator aribute in UDDI
V2 replies. The default value is
CentraSite.

UDDIDefaultLanguage Sets the default language. All valid
language identifiers are allowed. The
default value is en-US.

UDDIValueValidation Activates or deactivates internal value
validation. Valid values: true or false
(default). For more information, see
Checked Value Set Validation.

UDDIKeyGeneratorChecks Activates or deactivates the
enforcement of keyGenerator tModels
for publisher assigned keys. Valid
values: true (default) or false.

UDDIDiscoveryURLGeneration Activates or deactivates the generation
of discoveryURL. Valid values: true or
false (default).

UDDIEncoding Specifies the XML encoding of the
UDDI responses. Valid values: utf-8
(default) or utf-16.

UDDISubscriptionDuration The duration of a registry subscription.
You can specify a default subscription
expiration period for each UDDI web
application separately.

The subscription duration is specified
using an xs:duration instance. It
specifies a duration in terms of years,
months, days, hours, minutes, and
seconds.

The default value is 1 month
(xs:duration(P1M)).

How a string holding an xs:duration
instance is generated is specified in the
XML Schema (Part 2) specification.
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Global Property Description

For example, to specify a duration
of 1 year, 2 months, 3 days, 10
hours, and 30 minutes, specify:
P1Y2M3DT10H30M. You can also
indicate a duration of minus 120
days as: -P120D. Reduced precision
and truncated representations of
this format are allowed provided
they conform to the following: If
the number of years, months, days,
hours, minutes, or seconds in any
expression equals zero, the number
and its corresponding designator may
be omied. However, at least one
number and its designator must be
present. The seconds part may have a
decimal fraction. The designator ‘T’
shall be absent if all of the time items
are absent. The designator ‘P’ must
always be present.

For example, P1347Y, P1347M, and
P1Y2MT2H are all allowed; P0Y1347M
and P0Y1347M0D are allowed.
P-1347M is not allowed although –
P1347M is allowed. P1Y2MT is not
allowed.

Note: An UDDI subscription survives an
application server restart.

UDDIAuthTokenExpiration The duration of an authorization
token.

This duration is specified using an
xs:duration instance. It specifies a
duration in terms of years (either 0 or
1), months, days, hours, minutes, and
seconds.

The default value is 1 day
(xs:duration(P1D)).

UDDITransferTokenExpiration The duration of a transfer token.

This duration is specified using an
xs:duration instance. It specifies a
duration in terms of years (either 0 or
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Global Property Description
1), months, days, hours, minutes, and
seconds.

The default value is 1 day
(xs:duration(P1D)).

UDDIV2Inquiry Enables UDDI V2 Inquiry support.
Valid values: true (default) or false.

UDDIV2Publish Enables UDDI V2 Publish support.
Valid values: true (default) or false.

UDDISendEmptyWebServiceNotifications Specifies whether to allow Web service
notifications to be sent even when no
changes have occurred. Valid values:
true (default) or false.

UDDISendEmptyEmailNotifications Specifies whether to allow email
notifications to be sent even when no
changes have occurred. Valid values:
true or false (default).

UDDIMinimalNotificationInterval The minimum time interval at which to
send notifications to subscribers.

This duration is specified using an
xs:duration instance. It specifies a
duration in terms of years (either 0 or
1), months, days, hours, minutes, and
seconds.

The default value is 30 seconds
(xs:duration(P30S)). The minimal
resolution is 10 seconds (as well as the
minimal possible value).

UDDINumberOfRetries The maximum number of times to try
to send Web service notifications to
subscribers. Valid values: 0 through 10.
Default: 3. The value 0 turns off this
property (that is, allows for unlimited
retries).

Note: This property applies only to Web
service notifications, not to email
notifications.
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Global Property Description

UDDIMaxSubscriptionThreads The maximum number of threads for
subscriptions. Default: 5.

2. To set the global UDDI properties in CentraSite, run the command set UDDI.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd set UDDI [-url <CENTRASITE-URL>] -
user <USER-ID> -password <PASSWORD> -file <CONFIG-FILE>

The input parameters are:

Parameter Description

CENTRASITE-
URL

(Optional). The URL of the CentraSite registry. For
example, http://localhost:53307/CentraSite/
CentraSite.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user identified
by the parameter USER-ID.

CONFIG-FILE The absolute or relative path to the XML configuration file.
If relative, the path should be relative to the location from
where the command is executed.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd set UDDI -
url http://localhost:53307/CentraSite/CentraSite -user AdminUser -
password AdminPass -file config.xml

The response to this command could be:
Executing the command : set UDDI 
Successfully executed the command : set UDDI

Setting Local UDDI Properties

Note: The UDDI representation of local properties is based on the general approach
of mapping jaxr:Slots to UDDI.
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To set local properties

1. Create an XML configuration file that contains the following predefined UDDI
properties. This file should be in Java XML properties format.

For example:
<?xml version="1.0" encoding="UTF-8" ?> 
 <!DOCTYPE properties (View Source for full doctype...)> 
 <properties version="1.0"> 
  <comment>Test UDDI Local Configuration XML</comment> 
  <entry key="com.centrasite.uddi.UDDIMaxResultSize">*</entry> 
  <entry key="com.centrasite.uddi.UDDIMaxSearchKeys">*</entry> 
  <entry key="com.centrasite.uddi.UDDIMaxSearchNames">*</entry> 
  <entry key="com.centrasite.uddi.UDDIHTTPGetServicesUrl"> 
              http://localhost:53307/UddiRegistry</entry> 
  <entry key="com.centrasite.uddi.UDDIResponseValidation">false</entry> 
  <entry key="com.centrasite.uddi.UDDIRequestValidation">false</entry> 
 </properties>

Descriptions of these properties are as follows:

Local Property Description

UDDIMaxResultSize Specifies the maximum inquiry result size. Default:
An unlimited size (denoted by *).

UDDIMaxSearchKeys Specifies the maximum number of search keys
returned by an inquiry. Default: An unlimited
number (denoted by *).

UDDIMaxSearchNames Specifies the maximum number of search names
returned by an inquiry. Default: An unlimited
number (denoted by *).

UDDIHTTPGetServicesUrl Holds the URI for the HTTP Get calls to retrieve
UDDI objects from the registry. Default value:
hp://localhost:53307/UddiRegistry.

UDDIResponseValidation Enables schema validation on UDDI V2 and V3
responses. Valid values: true or false (default).

Note: The appropriate schema file should be stored in
the CentraSite repository, in the /projects/uddi
folder.

UDDIRequestValidation Enables schema validation on incoming UDDI V2
and V3 requests. Valid values: true or false (default).
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Local Property Description

Note: The appropriate schema file should be stored in
the CentraSite repository, in the /projects/uddi
folder.

2. To set the local UDDI properties in CentraSite, run the command set UDDI.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd set UDDI [-url <CENTRASITE-URL>] -
user <USER-ID> -password <PASSWORD> -file <CONFIG-FILE>

If you start this command line tool with no parameters, you receive a help text
summarizing the required input parameters.

The input parameters are:

Parameter Description

CENTRASITE-
URL

(Optional). The URL of the CentraSite registry. For
example, http://localhost:53307/CentraSite/
CentraSite.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user identified
by the parameter USER-ID.

CONFIG-FILE The absolute or relative path to the XML configuration file.
If relative, the path should be relative to the location from
where the command is executed.

The parameters of the command are case-sensitive, so for example the parameter -
url must be specified as shown and not as -URL.

If you omit the passwords from the command, you are prompted to provide them.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd set UDDI -
url http://localhost:53307/CentraSite/CentraSite -user AdminUser -
password AdminPass -file config.xml

The response to this command could be:
Executing the command : set UDDI 
Successfully executed the command : set UDDI
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Getting Global and Local UDDI Properties
Pre-requisites:

To retrieve the global and local UDDI properties through the CentraSite Command Line
(.cmd) Interface, you must have the CentraSite Administrator role.

CentraSite provides a command tool named get UDDI for this purpose.

You execute this command tool in the CentraSite Command Line Interface:
CentraSiteCommand.cmd (Windows) or CentraSiteCommand.sh (UNIX). The tool is
located in the directory <CentraSiteInstallDir> \utilities.

The syntax is of the format: C:\SoftwareAG\CentraSite
\utilities>CentraSiteCommand.cmd get UDDI [-url <CENTRASITE-URL>] -user
<USER-ID> -password <PASSWORD>

If you start this command line tool with no parameters, you receive a help text
summarizing the required input parameters.

The input parameters are:

Parameter Description

CENTRASITE-
URL

Optional. The URL of the CentraSite registry. Default value is
http://localhost:53307.

USER-ID The user ID of a registered CentraSite user. For example, a
user who has the CentraSite Administrator role.

PASSWORD The password for the registered CentraSite user identified by
the parameter USER-ID.

The parameters of the command are case-sensitive, so for example the parameter -url
must be specified as shown and not as -URL.

If you omit the passwords from the command, you are prompted to provide them.

Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>CentraSiteCommand.cmd get UDDI -url
http://localhost:53307/CentraSite/CentraSite -user AdminUser -password
AdminPass

The response to this command could be:
Executing the command : get UDDI 
Successfully executed the command : get UDDI
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Schema Validation of UDDI Requests
All incoming UDDI V3 requests are validated against the XML schemas for UDDI
requests, as defined in the OASIS UDDI specification. Invalid requests are rejected. The
schema files are stored in the CentraSite repository in the folder /projects/uddi.

The validation can be activated or deactivated by the local configuration properties
Request Validation and Response Validation.

Checked Value Set Validation
CentraSite offers the internal validation of checked value sets. If a keyedReference
object is published that points to a checked value set, CentraSite checks if the keyValue
belongs to the value set. The UDDI 3.0.2 specifies checked value sets specified by
value set taxonomies and value sets that have a validation algorithm. All value sets are
represented in UDDI by a tModel. The validation of keyedReference objects can be
switched off. For this purpose, the global configuration property Internal Value Set
Validation can be used.

If the property is set to false, no checking is performed but keyedReference objects
pointing to an existing taxonomy are still mapped to a jaxr:internal classification.
Invalid references are mapped to external classifications. This means that even a
keyedReference object with an invalid value that points to a classificationScheme
with a concept taxonomy is not rejected but mapped to an external classification. If
the property is set to yes, keyedReference objects pointing to checked value sets are
checked. Invalid keyedReference objects are rejected with the error E_invalidValue.

Predefined Value Sets
CentraSite supports the following value sets from the UDDI specification:

Type category system

Relationships category system

Entity Key Values category system

NAICS 1997 Release

NAICS 2002 Release

UNSPSC Version 7.3

ISO 3166 Geographic Code System

UDDI v2 OwningBusiness category system

UDDI v2 IsReplacedBy identifier system

UDDI Entity Key Values category System
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UDDI Derived From category system

UDDI Nodes category system

General Keyword category system

Postal Address Structure

Predefined tModels
The following is a list of the predefined tModels in CentraSite:
AssociationType 
CentraSite 
CentraSiteFilterType 
ClassificationGroup 
ContentType 
Databases 
Interstage Business Process Manager 
Object 
ObjectType 
Origin 
PhoneType 
PostalAddressAttributes 
Products 
RepositoryObjectType 
URLType 
UseType 
crossvision Application Composer 
crossvision Information Integrator 
crossvision Legacy Integrator - ApplinX 
crossvision Legacy Integrator - EntireX 
crossvision Service Orchestrator 
dnb-com:D-U-N-S 
http://schemas.xmlsoap.org/ws/2003/03/localpolicyreference 
http://schemas.xmlsoap.org/ws/2003/03/policytypes 
http://schemas.xmlsoap.org/ws/2003/03/remotepolicyreference 
node-centrasite-com:keyGenerator 
ntis-gov:naics:1997 
ntis-gov:naics:2002 
ntis-gov:sic:1987 
thomasregister-com:supplierID 
ubr-uddi-org:iso-ch:3166-2003 
ubr-uddi-org:iso-ch:6523-1998:icd 
ubr-uddi-org:postalAddress 
uddi-org: protocol:keyGenerator 
uddi-org:UTS-10 
uddi-org:andAllKeys 
uddi-org:approximateMatch:SQL99 
uddi-org:binarySort 
uddi-org:bindingSubset 
uddi-org:caseInsensitiveMatch 
uddi-org:caseInsensitiveSort 
uddi-org:caseSensitiveMatch 
uddi-org:caseSensitiveSort 
uddi-org:categorization:keyGenerator 
uddi-org:combineCategoryBags 
uddi-org:derivedFrom 
uddi-org:diacriticsInsensitiveMatch 
uddi-org:diacriticsSensitiveMatch 
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uddi-org:entityKeyValues 
uddi-org:exactMatch 
uddi-org:fax 
uddi-org:ftp 
uddi-org:general_keywords 
uddi-org:homepage 
uddi-org:hostingRedirector 
uddi-org:http 
uddi-org:inquiry 
uddi-org:inquiry_v2 
uddi-org:inquiry_v3 
uddi-org:isReplacedBy 
uddi-org:keyGenerator 
uddi-org:mutualAuthenticatedSSL3 
uddi-org:node_custody_transfer_v3 
uddi-org:nodes 
uddi-org:orAllKeys 
uddi-org:orLikeKeys 
uddi-org:ownership_transfer_v3 
uddi-org:owningBusiness_v3 
uddi-org:protocol:http 
uddi-org:protocol:soap 
uddi-org:publication 
uddi-org:publication_v2 
uddi-org:publication_v3 
uddi-org:relationships 
uddi-org:replication_v3 
uddi-org:security_v3 
uddi-org:serverAuthenticatedSSL3 
uddi-org:serviceSubset 
uddi-org:signaturePresent 
uddi-org:smtp 
uddi-org:sortByDateAsc 
uddi-org:sortByDateDesc 
uddi-org:sortByNameAsc 
uddi-org:sortByNameDesc 
uddi-org:sortorder:keyGenerator 
uddi-org:suppressProjectedServices 
uddi-org:taxonomy 
uddi-org:taxonomy_v2 
uddi-org:telephone 
uddi-org:transport:keyGenerator 
uddi-org:types 
uddi-org:v3_policy 
uddi-org:validatedBy 
uddi-org:valueSetCaching_v3 
uddi-org:valueSetValidation_v3 
uddi-org:wsdl:address 
uddi-org:wsdl:categorization:protocol 
uddi-org:wsdl:categorization:transport 
uddi-org:wsdl:portTypeReference 
uddi-org:wsdl:types 
uddi-org:xml:localName 
uddi-org:xml:namespace 
uddi.org:bpel:types 
uddi:ebxml.org:collaborationprotocolagreement:v1.0:template 
uddi:ebxml.org:collaborationprotocolagreement:v2.0:template 
uddi:ebxml.org:collaborationprotocolprofile:v1.0 
uddi:ebxml.org:collaborationprotocolprofile:v2.0 
uddi:ebxml.org:messageservice:v1.0 
uddi:ebxml.org:messageservice:v2.0 
uddi:oasis-open.org:wsrp:v1_bindings 
uddi:oasis-open.org:wsrp:service_type 
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uddi:oasis-open.org:wsrp:v1_service_description_porttype 
uddi:oasis-open.org:wsrp:v1_markup_porttype 
uddi:oasis-open.org:wsrp:v1_registration_porttype 
uddi:oasis-open.org:wsrp:v1_portlet_management_porttype 
uddi:oasis-open.org:wsrp:v1_service_description_binding_soap 
uddi:oasis-open.org:wsrp:v1_markup_binding_soap 
uddi:oasis-open.org:wsrp:v1_registration_binding_soap 
uddi:oasis-open.org:wsrp:v1_portlet_management_binding_soap 
uddi:uddi.org:bpel:wsdlporttypereference 
uddi:uddi.org:propertyset 
uddi:uddi.org:update_entities_v2 
uddi:uddi.org:update_entities_v3 
uddi:w3.org:ws-policy:v1.5:attachment:policytypes 
uddi:w3.org:ws-policy:v1.5:attachment:remotepolicyreference 
uddi:w3.org:ws-policy:v1.5:attachment:localpolicyreference 
uddi:untmg.org:businessprocessspecificationschema:v1.10 
unspsc-org:unspsc 
unspsc-org:unspsc:3-1 
unspsc-org:unspsc:v6.0501

UDDI V3 APIs
The CentraSite Registry or Repository supports the Java API for XML Registries (JAXR).
It also supports UDDI V3- and V2. These APIs enable you to interact with the CentraSite
Registry or Repository directly from UDDI-compliant browsers and integration
development environment (IDE) tools. For more information about IDE tools, see “Using
Third-Party IDE Tools with CentraSite ” on page 280.

CentraSite provides Javadocs that you can use to create UDDI V3 clients. The Javadocs
provide the interfaces you need for implementing the Publish, Inquiry, Security, and
Taxonomy APIs in your clients.

<CentraSite_installation_root>\Documentation\en\jd\uddiv3ClientAPI

CentraSite supports the following APIs.

Use this API... To enable the client to...

Publish Execute any UDDI publishing API call. For example, you can
publish services to CentraSite and publish proxy endpoints for
services that already exist in CentraSite. You can publish the
following UDDI objects: Organization, Service, ServiceBinding,
and tModel.

Inquiry Interrogate CentraSite to retrieve service information. When
an active run-time policy’s virtual service executes, the Inquiry
API pulls the virtual service's information from CentraSite. You
can publish the following UDDI objects: Organization, Service,
ServiceBinding, and tModel.

Security Execute UDDI security API calls, using authorization tokens.
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Use this API... To enable the client to...

Taxonomy Fetch taxonomies and their immediate children nodes. The
taxonomies are represented in the tree structure. The Taxonomy
API is a custom API.

Classes and Interfaces

The major classes and interfaces available in the Javadocs are described as follows:

RegistryService

RegistryService is the core interface to communicate with the UDDI Registry
using the UDDI V3 API. This interface contains utility methods to get service stubs
for the Publish, Inquiry, Security, and Taxonomy APIs. The UDDI operations are
performed using their respective service stubs. It also contains a method to connect to
the CentraSite Registry or Repository, using authentication tokens.

RegistryConfiguration

RegistryConfiguration is a bean class that is used to connect to the CentraSite
Registry or Repository, based on the Registry or Repository’s configuration details, such
as its host, port, and URLs. The URLs include the Security URL, Inquiry URL, Publish
URL, and Taxonomy URL. This class also contains the user credentials of the Registry or
Repository.

RegistryFramework

RegistryFramework is a helper interface that can be used to get aribute
values, relationships and documents. This class contains the helper method
getServiceModifiedDate, which uses get_operationalInfo to get the modified date
of the service.

Note: Unlike the UDDI specification, serviceBinding is a contained element of a
businessService entity in CentraSite. Thus, when a service's bindingTemplate
entity is updated, then the service is updated as well. This means that when
you use the helper method getServiceModifiedDate, it returns the same
modification time for both the modified and modifiedIncludingChildren
aributes.

RegistryAgent

RegistryAgent is an interface that enables a policy enforcement point to query the
virtual services in the CentraSite Registry or Repository, and to publish run-time
performance metrics to the CentraSite Registry or Repository.

This interface contains the following helper methods:

findVirtualServices that finds the virtual services that are deployed to the
runtime target
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getVirtualServiceWSDLURL that returns the WSDL URL for the specified virtual
service

saveMetrics that saves the run-time performance metrics for the virtual services

UDDI_Security_SoapService

UDDI_Security_SoapService is an interface that can be used for all UDDI
Security operations. This interface contains the methods get_authToken
and discard_authToken. An instance of this interface can be obtained from
RegistryService.

UDDI_Inquiry_SoapService

UDDI_Inquiry_SoapService is an interface that contains methods for all Inquiry
operations. An instance of this interface can be obtained from RegistryService.

UDDI_Publication_SoapService

UDDI_Publication_SoapService is an interface that contains methods for all
UDDI Publish operations. An instance of this interface can be obtained from
RegistryService.

UDDI_Taxonomy_SoapService

UDDI_Taxonomy_SoapService is an interface that uses the method get_conceptDetail
to fetch taxonomies and their immediate children. The taxonomies are represented in the
tree structure. An instance of this interface can be obtained from RegistryService.

CentraSiteBusinessService

CentraSiteBusinessService is a wrapper class for the BusinessService class. This
class contains all methods contained in BusinessService, as well as these additional
methods:

getAttachedPolicyDocURL that returns the aached policy associated with the
service.

getAttachedPolicyTModelKey that returns the aached policy tModel key
associated with the service.

getAttributes that returns the aributes associated with the service in a Map.

getDocuments that returns the documents associated with the service in a Map.

getRelatedObjectKey that returns the UDDI key of the object that has the specified
relationship.

Examples

Getting the Value of an Attribute

The following example shows how to get the value of an aribute named Life Cycle
Status.
//Creating configuration object with host, port 
//and user credentials of the registry 
RegistryConfiguration regConfig = 
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  new RegistryConfiguration("localhost", "53307", 
  "DefaultUser", "PwdFor_CS21"); 
  
//Creating registry service instance using the RegistryConfiguration 
RegistryService regService = 
  RegistryService.Factory.newInstance(regConfig); 
  
//connection is made (get_authToken will be issued to registry) 
regService.connect(); 
  
//Inquiring the registry for the service using find_service call 
  
UDDI_Inquiry_SoapService inquirySoapService = 
  regService.getInquirySoapService(); 
FindService findService = new FindService(); 
Name name = new Name(); 
name.setValue("UDDI Security Service"); 
findService.setName(new Name[] {name}); 
findService.setAuthInfo(regService.getAuthToken()); 
System.out.println("Name....."+ findService); 
ServiceList serviceList = inquirySoapService.find_service(findService); 
ServiceInfos serviceInfos = serviceList.getServiceInfos(); 
  
//Getting the service Key for the first service 
ServiceInfo serviceInfo = serviceInfos.getServiceInfo(0); 
String serviceKey = serviceInfo.getServiceKey(); 
  
//Getting the service detail 
GetServiceDetail getServiceDetail = new GetServiceDetail(); 
getServiceDetail.setServiceKey(new String[] {serviceKey}); 
getServiceDetail.setAuthInfo(regService.getAuthToken()); 
ServiceDetail serviceDetail = 
  inquirySoapService.get_serviceDetail(getServiceDetail); 
BusinessService businessService = 
  serviceDetail.getBusinessService(0); 
  
//Creating instance of CentraSiteBusinessService 
CentraSiteBusinessService csBusinessService = new 
CentraSiteBusinessService(businessService); 
  
//Getting the value for the attribute "Life Cycle Status" 
String attributeValue = 
  csBusinessService.getAttributeValue("Life Cycle Status");

Getting the Proxy Services for a Specified Target

The following example shows how to get the proxy services for a specified target.
//Creating configuration object with host, port 
//and user credentials of the registry 
RegistryConfiguration regConfig = 
  new RegistryConfiguration("localhost", 
  "53307", "DefaultUser", "PwdFor_CS21"); 
  
//Creating registry service instance using the RegistryConfiguration 
RegistryService regService = 
  RegistryService.Factory.newInstance(regConfig); 
  
//connection is made (get_authToken will be issued to registry) 
regService.connect(); 
  
//Getting the RegistryAgent instance using RegistryService 
RegistryAgent registryAgent = regService.getRegistryAgent(); 
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//Getting the ServiceInfos which will contain 
//a list of the services deployed in the "Actional" target 
ServiceInfos proxyServices = 
  registryAgent.findProxyServices("Actional");

Inquiring about a Business Service

The following example shows how to fetch the details of a business service, using the
UDDI Inquiry API:
//RegistryConfiguration containing the host, port, userId and 
//password to connect to registry 
RegistryConfiguration regConfig = 
  new RegistryConfiguration("hostName", "port", "userId", "password"); 
  
//Creating the RegistryService using RegistryConfiguration 
RegistryService regService = 
  RegistryService.Factory.newInstance(regConfig); 
  
//connecting to registry. This method will fetch the AuthToken 
//using get_authTokenAPI 
regService.connect(); 
  
//Inquiring the registry for the service using find_service call 
UDDI_Inquiry_SoapService inquirySoapService = 
  regService.getInquirySoapService(); 
  
//Constructing the find_service inquiry call 
FindService findService = new FindService(); 
Name name = new Name(); 
name.setValue("UDDI Inquiry Service"); 
findService.setName(new Name[] {name}); 
  
//Issuing find_service inquiry call to 
//CentraSite registry using UDDI_Inquiry_SoapService 
ServiceList serviceList = inquirySoapService.find_service(findService); 
ServiceInfos serviceInfos = serviceList.getServiceInfos(); 
  
//Getting the service Key for the first service 
ServiceInfo serviceInfo = serviceInfos.getServiceInfo(0); 
String serviceKey = serviceInfo.getServiceKey(); 
  
//Getting the service detail 
GetServiceDetail getServiceDetail = new GetServiceDetail(); 
getServiceDetail.setServiceKey(new String[] {serviceKey}); 
getServiceDetail.setAuthInfo(regService.getAuthToken()); 
ServiceDetail serviceDetail = 
  inquirySoapService.get_serviceDetail(getServiceDetail); 
BusinessService businessService = 
  serviceDetail.getBusinessService(0); 
System.out.println("Fetched Service Name : " + 
  businessService.getName()[0].getValue());

Publishing a Business Service

The following example shows how to publish a business service, using the UDDI
Publish API:
//RegistryConfiguration containing the host, port, 
//userId and password to connect to registry 
RegistryConfiguration regConfig = 
  new RegistryConfiguration("hostName", "port", "userId", "password"); 
  
//Creating the RegistryService using RegistryConfiguration 
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RegistryService regService = 
  RegistryService.Factory.newInstance(regConfig); 
  
//connecting to registry. This method will fetch the 
//AuthToken using get_authTokenAPI 
regService.connect(); 
  
//Getting the UDDI_Publication_SoapService to publish the 
//sample business service 
UDDI_Publication_SoapService publishSoapService = 
  regService.getPublishSoapService(); 
  
//Constructing the save service call for sample business service 
SaveService saveService = new SaveService(); 
BusinessService businessService = new BusinessService(); 
Name name = new Name(); 
name.setValue("Sample Business Service"); 
businessService.setName(new Name[] {name}); 
  
//Setting the auth token using the registry service 
saveService.setAuthInfo(regService.getAuthToken()); 
saveService.setBusinessService(new BusinessService[] {businessService}); 
  
//Saving the business service using UDDI_Publication_SoapService 
publishSoapService.save_service(saveService);

Fetching Taxonomies

The following example shows how to fetch taxonomies, using the Taxonomy API:
//RegistryConfiguration containing the host, port, 
//userId and password to connect to registry 
RegistryConfiguration regConfig = 
  new RegistryConfiguration("hostName", "port", "userId", "password"); 
  
//Creating the RegistryService using RegistryConfiguration 
RegistryService regService = 
  RegistryService.Factory.newInstance(regConfig); 
  
//connecting to registry. This method will fetch the 
//AuthToken using get_authTokenAPI 
regService.connect(); 
  
//Getting the taxonomy soap service which is used fetch the taxonomies 
UDDI_Taxonomy_SoapService taxonomySoapService = 
  regService.getTaxonomySoapService(); 
  
//Constructing the get_conceptDetail request 
GetConceptDetail getConceptDetail = new GetConceptDetail(); 
  
//Fetching the NAICS taxonomy 
getConceptDetail.setConceptKey(new String[] 
  {"uddi:uddi.org:ubr:categorization:naics:1997"}); 
  
//Using UDDI_Taxonomy_SoapService we are fetching the 
//taxonomies from CentraSite registry 
ConceptDetail conceptDetail = 
  taxonomySoapService.get_conceptDetail(getConceptDetail);
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Using Third-Party IDE Tools with CentraSite

Overview
An Integrated Development Environment (IDE) tool for Web services is a user interface
provided by any vendor that enables you to publish (submit data) and inquire (search
data) in any UDDI registry. CentraSite supports any IDE tool that complies with
WSDL and UDDIV3 or UDDIV2 inquiry and publish semantics. Using IDE tools with
CentraSite, you can publish, inquire, and delete Web services.

Supported IDE Tools
The following IDE tools can be used with CentraSite version 9.8.

WTP Eclipse 1.5.2 plug-in

IBM Rational Application Developer 6.0

Parasoft JTest 7.5

PushToTest

UDDI4J

RUDDI

Specifying the Inquiry, Publish, and Security URLs
When using any IDE tool, you need to obtain a user account in CentraSite, and also
provide an inquiry URL for inquiring a Web service and a publish URL for publishing a
Web service. You also need to provide the security URL for those tools that require it (for
example, ALSB uses the security URL to get the AuthToken).

The UDDI Publish, Inquiry, and Security services are hosted at the following URLs on
the CentraSite host machine:

Inquiry URL:

http://<hostName>:<port>/UddiRegistry/inquiry

Publish URL:

http://<hostName>:<port>/UddiRegistry/publish

Security URL:

http://<hostName>:<port>/UddiRegistry/security

where <hostName> is the host name or IP address of the machine on which CentraSite is
installed and <port> is the port on which CentraSite is listening for hp requests.
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Note: The save_binding call in UDDI sends the access point but does not send the
WSDL URL. Therefore, the WSDL URL shows only the access point.

Downloading the WTP Eclipse 1.5.2 Plug-In
You can search for a business and publish a service from that business, using the WTP
Eclipse client.

To download the plug-in and access the Web Services Explorer

1. Download the Eclipse Web Tools version 1.5.2 from “hp://download.eclipse.org/
webtools/downloads/”. This version contains Eclipse 3.2.1.

2. Run your virus scan product to ensure the Eclipse Web Services Explorer opens
properly.

3. On the Eclipse SDK screen, click Window > Open Perspective.

4. On the Open Perspective dialog box, select J2EE and then click OK.

5. Click Run > Launch the Web Services Explorer.

The Web Services Explorer portlet displays.

6. In the Navigator pane, click UDDI Main.

7. On the Open Registry screen, type the following URL in the Inquiry URL box:

http://<hostName>:<port>/UddiRegistry/inquiry

where <hostName> is the host name or IP address of the machine on which
CentraSite is installed and <port> is the port on which CentraSite is listening for hp
requests.

8. Click Go.

If the registry is active, Eclipse displays its details. On this page, you can find and
publish services, businesses, and service interfaces (tModels).

9. Click Go.

IBM Rational Application Developer 6.0
For more information about the IBM Rational Application Developer 6.0, see the IBM
Developer website.

Connecting to CentraSite

To connect to CentraSite

1. From the Window menu of the tool, click Open Perspective > J2EE.

2. Click Run > Launch the Web Services Explorer.

http://download.eclipse.org/webtools/downloads/
http://download.eclipse.org/webtools/downloads/
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3. In the navigation window, click UDDI Main.

4. In the Registry Name box, type CentraSite.

5. In the Inquiry URL box, type http://<host>:<port>/UDDIRregistry/inquiry,
where <host> and <port> reflect the target CentraSite registry.

Publishing Entities

To publish entities

1. In the Publish URL box, type http://<host>:<port>/UDDIRegistry/publish,
where <host> and <port> reflect the target CentraSite registry.

2. Supply your user name and password.

3. Identify the registry to which you want to publish the entity.

4. Provide entity details.

When you aempt to find services and publish a new service, double authentication
is required. But when you aempt to publish a service directly, authentication is
required only once.

UDDI Extensions
Various extensions to the UDDI standard have been published by the standards bodies
OASIS and W3C. The extensions described below are implemented in CentraSite's UDDI
environment.

Using WSDL in a UDDI Registry

Since a UDDI registry houses information about web services and their providers, it is
essential that the information contained in a web service's WSDL document is accurately
mapped to the UDDI data model. This means that subsequent search operations to
discover a registered web service are possible, based on the information that is mapped
from the WSDL.

How CentraSite performs WSDL-to-UDDI mappings is based on the recommendations
that OASIS has published. The technical description of the OASIS recommendation for
WSDL-to-UDDI mapping can be found on the OASIS website.

Using WS-PolicyAttachment

An XML-based expression grammar for policies is described in the Web Services Policy
Framework (WS-Policy) specification, published by the W3C. The specification also
describes how a policy can be associated with a registry object.

The CentraSite UDDI registry supports WS-PolicyAachment version 1.2 and 1.5. Policy
aachments can be either WSDL-based or UDDI-based. Currently, CentraSite supports
UDDI-based policy aachments. With UDDI-based policy aachments, the policies are
modeled in the UDDI registry using UDDI elements.
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Version 1.2 Support

The CentraSite WS-PolicyAachment support for version 1.2 covers the following
aspects of the WS-PolicyAachment specification:

Supported Policy Subjects

CentraSite supports the UDDI-based policy aachments for the following policy
subjects:

Service Provider Policy Subject

Service Policy Subject

Endpoint Policy Subject

Referencing Remote Policy Expressions

An example for a remote policy reference is shown by the following
uddi:businessService that is taken from the WS-PolicyAachment specification:
<businessService serviceKey="…" > 
 <name>…</name> 
 <description>…</description> 
 <bindingTemplates>…</bindingTemplates> 
 <categoryBag> 
   <keyedReference 
      keyName="Policy Expression for example's Web services" 
      keyValue="http://www.example.com/myservice/policy" 
      tModelKey="uuid:a27078e4-fd38-320a-806f-6749e84f8005" /> 
 </categoryBag> 
</businessService>

The uddi:businessService is aached to a WS-Policy that accessible through the URL
hp://www.example.com/myservice/policy. The uddi:keyedReference represents
the aachment. It is referencing the remote policy reference category system via its
uddi:tModelKey and its value holds the URI of the policy document.

Registering Reusable Policy Expressions

A reusable policy expression is represented by a dedicated uddi:tModel in the UDDI
registry. The following uddi:tModel shows an example:
<tModel tModelKey="uuid:04cfa…"> 
 <name>…</name> 
 <description xml:lang="EN"> 
  Policy Expression for example's Web services 
 </description> 
 <overviewDoc> 
  <description xml:lang="EN">WS-Policy Expression</description> 
  <overviewURL>http://www.example.com/myservice/policy</overviewURL> 
 </overviewDoc> 
 <categoryBag> 
  <keyedReference 
   keyName="Reusable policy Expression" 
   keyValue="policy" 
   tModelKey="uuid:fa1d77dc-edf0-3a84-a99a-5972e434e993" /> 
  <keyedReference 
   keyName="Policy Expression for example's Web services" 
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   keyValue="http://www.example.com/myservice/policy" 
   tModelKey="uuid:a27078e4-fd38-320a-806f-6749e84f8005" /> 
 </categoryBag> 
</tModel>

The uddi:tModel comes with two uddi:keyedReferences. The first uddi:keyedReference
specifies the uddi:tModel to represent a reusable policy expression. The second
one points to the document holding the policy expression. An example that
shows the aachment of a reusable policy expression is given by the following
uddi:businessService:
<businessService serviceKey="…" > 
 <name>…</name> 
 <description>…</description> 
 <bindingTemplates>…</bindingTemplates> 
 <categoryBag> 
  <keyedReference 
   keyName="Policy Expression for example's Web services" 
   keyValue="uuid:04cfa…" 
   tModelKey="uuid:a27f7d45-ec90-31f7-a655-efe91433527c" /> 
 </categoryBag> 
</businessService>

The uddi:businessService holds a keyedReference pointing to the uddi:tModel holding
the reusable policy expression. The uddi:tModelKey of the uddi:keyedReference points
to the local policy reference uddi:tModel.

Registering Policies in UDDI Version 3

CentraSite supports UDDI-based policy aachments for UDDI version 2 and 3.

tModels to Support UDDI-Based WS-PolicyAttachments

CentraSite provides the tModels necessary to support UDDI-based WS-
PolicyAachments.

Remote Policy Reference Category System

This tModel is used to aach a policy to a UDDI entity by referencing the policy's URI.
<tModel tModelKey="uddi:schemas.xmlsoap.org:remotepolicyreference:2003_03" > 
 <name>http://schemas.xmlsoap.org/ws/2003/03/remotepolicyreference</name> 
 <description xml:lang="EN"> 
   Category system used for UDDI entities to point to an external 
   WS-PolicyAttachment Policy Expression that describes their 
   characteristics. See WS-PolicyAttachment specification for further details. 
 </description> 
 <categoryBag> 
  <keyedReference 
   keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uuid:c1acf26d-9672-4404-9d70-39b756e62ab4" /> 
 </categoryBag> 
</tModel>

WS-Policy Types Category System

This tModel is used to categorize tModels as representing Policy Expressions. There is
only one valid value, namely policy, that indicates this very fact. It is recommended that
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tModels categorized as representing Policy Expressions reference no more and no less
than this very Policy Expression using the Remote Policy Reference category system.
<tModel tModelKey=" uddi:schemas.xmlsoap.org:policytypes:2003_03" > 
 <name>http://schemas.xmlsoap.org/ws/2003/03/policytypes</name> 
 <description xml:lang="EN"> 
   WS-Policy Types category system used for UDDI tModels to characterize them 
   as WS-Policy – based Policy Expressions. 
 </description> 
 <categoryBag> 
  <keyedReference 
   keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uuid:c1acf26d-9672-4404-9d70-39b756e62ab4" /> 
 </categoryBag> 
</tModel>

Local Policy Reference Category System

This tModel is used to aach a Policy Expression to a UDDI entity by referencing the
UDDI entity that represents this Policy Expression. The Local Policy Reference category
system is based on tModelKeys. It is expected that referenced tModels are registered
with the same UDDI registry and are categorized as representing Policy Expressions
using the WS-Policy Types category system.
UDDI Key (V3): uddi:schemas.xmlsoap.org:remotepolicyreference:2003_03 
UDDI V1,V2 format key: uuid:a27f7d45-ec90-31f7-a655-efe91433527c 
Categorization: categorization 
Checked: Yes 
<tModel tModelKey="uddi:schemas.xmlsoap.org:localpolicyreference:2003_03" > 
 <name>http://schemas.xmlsoap.org/ws/2003/03/localpolicyreference</name> 
 <description xml:lang="en"> 
   Category system used for UDDI entities to point to a WS-Policy 
   Policy Expression tModel that describes their characteristics. 
   See WS-PolicyAttachment specification for further details. 
 </description> 
 <categoryBag> 
  <keyedReference 
   keyName="uddi-org:types:categorization" 
   keyValue="categorization" 
   tModelKey="uuid:c1acf26d-9672-4404-9d70-39b756e62aB4" /> 
  <keyedReference 
   keyName="uddi-org:entityKeyValues" 
   keyValue="tModelKey" 
   tModelKey="uuid:916b87bf-0756-3919-8eae-97dfa325e5a4" /> 
 </categoryBag> 
</tModel>

Version 1.5 Support

The CentraSite WS-PolicyAachment support for version 1.5 covers the same aspects
as for version 1.2. Additionally, CentraSite provides the following tModels necessary to
support UDDI-based WS-PolicyAachments:

uddi:w3.org:ws-policy:v1.5:aachment:localpolicyreference

uddi:w3.org:ws-policy:v1.5:aachment:policytypes

uddi:w3.org:ws-policy:v1.5:aachment:remotepolicyreference
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Extending UDDI Publisher API Set to Enable Physical Deletion of tModels

For the physical deletion of un-referenced tModels, CentraSite extends the UDDI
Publication API set. Appendix H of the UDDI V3 Specification describes how UDDI can
be extended. For removing a tModel from a registry, CentraSite introduces the request
purge_tModel. This extension is only supported for UDDI version 3.

Arguments

The purge_tModel request has the same arguments as the delete_tModel V3 request:

authInfo: This optional argument is an element that contains an authentication
token.

tModelKey: One or more required uddiKey values that represent specific instances of
known tModel data.

Behavior

The request removes a hidden tModel from the registry that is not referenced by any
other UDDI object.

Returns

On successful completion an empty message is returned.

Caveats

In the case of an error, a disposition report will be returned within a SOAP fault. In
addition to the errors which are common to all API calls, the following errors are
relevant here:

E_invalidKeyPassed: Signifies that one of the uddiKey values passed did not match
any known tModelKey values, or multiple instances of the same tModelKey values
were passed. The error is also returned if the referenced tModel is not hidden, or it
is still referenced. This means there are four conditions for this error. The different
conditions should be reflected in the errInfo element:

The specified tModel cannot be found

Multiple references to the same tModel

The specified tModel is not hidden

The specified tModel is still referenced

E_userMismatch: Signifies that one or more of the tModelKey values passed refers
to data that is not owned by the individual publisher who is represented by the
authentication token.
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Introduction to Application Framework
The CentraSite Application Framework (CSAF) provides a programming model for
developing custom extensions on top of CentraSite. It supports JAXR (Java API for
XML Registries) and extends the CentraSite JAXR-based API and the Pluggable UI - the
framework on which the CentraSite Control UI is built.

It contains two independent parts: the persistence framework and the validation
framework.

The persistence framework provides the ability to operate on registry data using
JavaBeans instead of the JAXR-based API. This is done in a fashion similar to object-
relational mapping tools such as Hibernate or Java Persistence API. It this case,
Java Beans are mapped to registry objects. All this is done declaratively using Java5
Annotations.

This framework was created with the intention of making it easier to work with
registries that support the JAXR-based interface, such as CentraSite. Its usage does not
require in general any specific or deep knowledge of this API.

A direct benefit of this is shortened application development time.

The validation framework provides an extensible mechanism for validating Java beans.
Multiple numbers of constraints can be aached to each bean. The notion of scopes is
also supported, that is, constraints apply only when specific conditions about the bean
are met.

The architecture of a common CentraSite application extension developed using CSAF:
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There are two major points that have to be clear in order to understand how the
persistence framework works, namely how the bean model is built based on the
RegistryBean interface and the BeanPool.

RegistryBean

The RegistryBean (com.softwareag.centrasite.appl.framework.beans.RegistryBean ) interface has to
stay on top of each bean model hierarchy.

It contains the properties that a registry object would have, namely a
key and a name. Implementing is the only restriction the framework
on the application bean model. The user can use DynamicRegistryBean
(com.softwareag.centrasite.appl.framework.beans.DynamicRegistryBean) for implementation of
RegistryBeans.

It implements RegistryBean and RevisionBean (
com.softwareag.centrasite.appl.framework.beans.RevisionBean), which is the revision-aware
extension of the RegistryBean interface.
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There is one more option here. If the registry bean needs to be lifecycle-aware, then the
user should use the com.softwareag.centrasite.appl.framework.lcm.beans.LifeCycleAware interface
instead of RegistryBean.

Its implementation is handled by
com.softwareag.centrasite.appl.framework.lcm.beans.LCAwareDynamicRegistryBean.

BeanPool

The BeanPool (com.softwareag.centrasite.appl.framework.persistence.BeanPool) is the main interface
with which the application interacts in order to use the persistence framework.

All CRUD (create, read, update, delete) operations search via this interface and registry
queries are done via this interface. The user must be aware that the BeanPool instances
are not thread safe. There can be only one beanPool per SessionContext. CSAF provides
the functionality to create beanPool instances by using SessionContext.createBeanPool();. The
beanPool can be accessed by SessionContext.getCurrentBeanPool();. This method returns the
BeanPool instance that is associated with the given context. The CurrentBeanPoolContext
interface defines the contract for implementations which knows how to scope the
notion of a current bean pool. An implementation of this interface is provided as
ThreadLocalCurrentBeanPoolContext, which maintains current bean pools for the given
execution thread. This functionality is extensible, so users can create their own context
by implementing CurrentBeanPoolContext.

StandaloneRegistryProvider

In order to obtain a connection to the repository, an instance of StandAloneRegistryProvider
must be created. This registry provider has several important parameters for its creation
that will affect the functionality of CSAF. CSAF supports several constructors which
exclude some of the properties and use their default values instead. The constructor with
full parameter list is:
StandaloneRegistryProvider(String registryUrl, String user, 
 String password, boolean browserBehaviour){}

registryUrl The URL of the CentraSite registry. For example, http://
localhost:53307/CentraSite/CentraSite.

user The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

password The password of the user identified by the parameter -
user.

browserBehaviour Sets the com.centrasite.jaxr.BrowserBehaviour
property of the connection factory. To enable type
management, this flag must be set to true; to enable
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RevisionManagement it must be false. Default value is
false.

Example for creating a BeanPool instance by using SessionContext and
StandaloneRegistryProvider
SessionContext context = null; 
RegistryProvider provider = null;try { 
   provider = new StandaloneRegistryProvider(registryUsername, 
                           registryPassword, true); 
  
 Configuration conf = new Configuration(); 
               conf.setRegistryProvider(provider); 
               conf.addBeanType(Item.class); 
               conf.addBeanType(Action.class); 
               conf.addBeanType(Entry.class); 
               conf.addBeanType(ExternalLink.class); 
               context = SessionContext.createInstance(conf); 
         } catch (CSAppFrameworkException e) { 
               // Do something with the exception 
         } 
  
BeanPool beanPool = context.getCurrentBeanPool();

Configuring Application Framework
You can configure the CentraSite Application Framework via the Configuration object
(com.softwareag.centrasite.appl.framework.Configuration).

The following can be configured here:

Bean types managed by CSAF

Persistence mode

Bean mode

Maximum concept cache size

Cache scope

Re-reading of outdated objects

Additionally, the configuration object supports a generic property: key/name pair. It can
used to configure any of the above mentioned properties generically.

After the Configuration object has been initialized, it can be passed to the
com.softwareag.centrasite.appl.framework.SessionContext.createInstance()
method, which creates a SessionContext instance.

This instance can then create
com.softwareag.centrasite.appl.framework.persistence.BeanPool instances
and can be used for the lifetime of the application.
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Bean Types Managed by CSAF

The framework keeps an internal data model for user-defined bean classes, for example,
bean classes that extend the com.softwareag.centrasite.appl.framework.beans.RegistryBean
interface.

After the bean interfaces have been defined as Java classes having the @RegistryObject
annotation, they must be registered by calling the Configuration.addBeanType(java.util.Class)
method.

In principle, calling Configuration.addBeanType(java.util.Class) for each bean class is not
mandatory, since CSAF tries to process this information (configuration) at runtime when
required. Nevertheless, it is still highly recommended because there are cases in which
it is not possible to obtain the mapping information at runtime, for example, when
performing a search in the registry.

Bean Modes

The framework supports two bean modes: BACKED and SIMPLE
(com.softwareag.centrasite.appl.framework.persistence.BeanMode). This mode specifies how the
beans interact with the underlying implementation of the API supporting JAXR.

When using the SIMPLE mode, data from the bean is transferred to the registry object
only when the user explicitly requests this by calling one of the BeanPool methods
(update(), flush(),delete()).

When using the BACKED mode, data from the bean is transferred to the registry object
immediately after it is set in the bean. The advantage of this is that extra features such as
locking and caching can be used.

Note: SIMPLE mode is deprecated; BACKED mode should always be preferred.

Persistence Modes

The framework supports two persistence modes: FULL and MAP_ONLY. This mode
specifies how and whether the data will be persisted in the registry.

When using the FULL mode, the data is entirely persisted in the registry. This is the
default mode.

When using the MAP_ONLY mode, the data is not persisted in the registry at all; it
is just mapped from the bean to the registry object. It is assumed that the persistence
is done outside of the framework. This is used, for example, in a Pluggable UI
environment, and applies to any custom extension of the CentraSite UI. In this, the
Pluggable UI takes care of storing the object in the registry.

Cache Configuration

Two properties of the caching can be configured: the maximum concept cache size
and the cache scope. Both parameters configure the concept mapping cache within the
framework.

The default value for the cache size is 1000.
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There are two available scopes for the cache:

APPLICATION: There is one cache for the whole application.

SESSION: Each session has its own cache.

Re-reading Outdated Objects

The framework provides support to re-read outdated registry beans automatically. This
is controlled by the Configuration.PROP_AUTO_REREAD_OUTDATED_OBJECTS property.
Possible values are true and false.

If the property value is set to true then when an outdated object is modified by the
system it is automatically re-read from the registry, that is, reverted to the latest state in
the database, before applying any changes. Otherwise the user receives the following
exception when performing the modification:
com.softwareag.centrasite.appl.framework.persistence.ObjectOutdatedException

Note: If this feature is turned on the current client of CSAF overrides any changes
made by another client.

Mapping Beans to Registry Objects with Annotations
The beans are mapped to registry objects using Java5 Annotations.

Each bean from the application bean model has to extend or implement the RegistryBean
(com.softwareag.centrasite.appl.framework.beans.RegistryBean) interface. If an interface extends
the RegistryBean interface, an implementation must be provided and specified using the
@Bean annotation:
@RegistryObject(objectTypeName="{http://namespaces.CentraSite.com/csaf}Item") 
@Bean(implementationClass = "...") 
public interface Item extends RegistryBean{ 
... 
}

The following table describes the annotations currently supported by the CentraSite
Application framework:

Annotations and Description Scope Properties

@RegistryObject

Maps a bean to a registry
object with a specific object
type.

Type objectTypeName (optional) – the
name of the object type of the
registry object.

objectTypeKey (optional) – the key
of the object type.

At least one of the properties must
be specified.
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Annotations and Description Scope Properties

@Property

Maps a bean property to
a registry object property.
The properties should
have the same type. The
mapper does not provide
type conversion, except for
JAXR InternationalString
to/from String.

Method target (optional) – the name of
the target property in the registry
object. The property must be a
standard property of a predefined
JAXR-based object type. If the
target property is not specified, it is
assumed that it matches the name of
the bean property.

@Slot

Maps a bean property
to a registry object slot.
Multivalue slots are
supported. Also provided
are type conversion slot
values which are string
to integer, Boolean, date,
timestamp, and Calendar.

Method Name (mandatory) – the name of
the slot to which this property is
to be mapped. The JAXR-based
property being mapped can be
custom defined, or the JAXR-based
object type that this property comes
from can be custom.

targetType (optional) – specifies
the type of the bean property. It
is used when the property is a
collection and thus the mapping
cannot guess the underlying
property.

type (optional) – the type of the
bean property. Supported types are
BOOLEAN, DATE, CALENDAR,
TIMESTAMP, INTEGER, LONG,
and AUTO. The laer allows the
mapper to guess the property type.

@Slots

Maps all slots of a registry
object to a bean property
(Collection).

Method targetType (mandatory) - the type
of bean that is to be mapped to a
single slot.

@SlotProperty

Used in conjunction with
the @Slots property. Maps
the properties of the bean
of the type specified as
target type with the @Slots
annotation. A slot has a

Method target (mandatory) – can
be one value from the enum
SlotPropertyName – NAME,
SLOT_TYPE, VALUES.
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Annotations and Description Scope Properties
name, slot type and values.
All these properties can
be mapped using this
annotation.

@TelephoneNumbers

Maps a bean property to
the TelephoneNumber
object from the JAXR-based
infomodel. Such objects
are used in the User JAXR
Object.

Method type (optional) – the type of the
telephone numbers.

@ExternalLink

Maps a bean property to a
ExternalLink JAXR-based
object or a collection of
them.

Method slotName (optional) – the name of a
slot inside the ExternalLink registry
object to be mapped that is checked
for having a specified value. This is
used to pick the proper ExternalLink
if the registry object has more than
one.

slotValue (optional) – the value of
the slot to be checked.

type (optional) – type of the bean
used for the mapping

@Association

Maps a property to an
association. It can be either
the association object
itself or the target of the
association.

Method key (optional) – the key of the
association type to be used. Either
type or key must be present.

type (optional) – the association
type to be used. Either type or key
must be present.

targetType (optional) – the type
of the bean to be mapped. It is
used when the bean property is a
collection and the type cannot be
guessed.

mappedTo (optional) – the property
can be mapped to either the
association registry object or the
target of the association.

cascadeStyle (optional) –
Supported cascade styles are
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Annotations and Description Scope Properties
ALL (Cascade on all operations),
UPDATE (Cascade on update
operations), DELETE (Cascade
on delete operations), NONE (no
cascading).

@AssociationTarget

Used in conjunction
with the @Association
annotation. Maps a
bean to a target of an
association. It is used when
a bean is mapped to an
association object using the
@Association annotation.
Then inside that bean a
property must be mapped
to the target.

Method None

@Classification

Maps a bean property
to a classification. Both
the classification object
and its concept can be
used. The mapping can be
simple – Bean property <-
> Classification(Concept)
or enumeration – Bean
property <-> Classification
(Concept) which concept
is under a specified parent
concept. The laer provides
a set of predefined possible
concepts, thus is similar to
the notion of enumeration.

Method classificationScheme
(optional) – the name of the
ClassificationScheme to be used.

parentConcept (optional) – the
path of the parent concept. Used
when mapping enumeration
classifications.

parentConceptKey (optional) – the
key of the parent concept. Either the
path or the key can be used.

conceptPath (optional) – the path
of the concept for this classification.

conceptKey (optional) – the key of
the concept for this classification.
Either the path or the key can be
used.

targetType (optional) – the type
of the bean used for the mapping.
Required when the property is a
collection and the type cannot be
guessed.
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Annotations and Description Scope Properties

mappedTo (optional) – the bean
can be mapped either to the
classification object or to its concept.

cascadeStyle (optional) – The
supported cascade styles are ALL,
UPDATE, DELETE, and NONE.

@ClassificationConcept

Used in conjunction
with the @Classification
annotation. Maps a bean
to the Concept of the
Classification specified
in the @Classification
annotation.

Method None

@ClassifiedInstances

Maps class hierarchy
to registry objects.
Classifications are used to
achieve this. Each registry
object that corresponds to
a bean from the hierarchy
is classified with a concept.
The laer belongs to a
taxonomy mirroring the
class hierarchy.

Type instances (mandatory) – the array
of the instances that this mapping
will address.

@ClassifiedInstance Sets the
information for a specific
mapping between a bean
from the hierarchy and a
registry object.

Type classificationScheme
(mandatory) – the classification
scheme to which the concept
belongs. Either the scheme name or
the key must be specified.

classificationSchemeKey
(mandatory) – the key of the
classification scheme. Either the
scheme name or the key must be
specified.

conceptKey (mandatory) – the key
of the concept used to classify this
instance.
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Annotations and Description Scope Properties

conceptPath (mandatory) – the
path of the concept used to classify
this instance.

beanType (mandatory) – the type
of the bean that corresponds to this
instance.

@ClassificationAribute

Annotation for mapping
the return value of a (geer)
method to the classification
aribute specified at type
level. The aribute name is
mandatory and is used to
identify the aribute. This
annotation is very similar
to the {@link Classification}
annotation in terms of
supported aributes and
underlying representation.
The difference is that the
taxonomy is obtained from
the aribute description.
In order to use this
annotation, a classification
aribute must be defined
at type level (the registry
object type must have a
classification aribute with
the same aribute name as
specified in the annotation).

Method attributeName (mandatory) – The
name of the aribute represented by
this annotation.

cascadeStype (optional) – The
cascading style for this mapping.

targetType (optional) – The type
of the mapped bean. The bean itself
must be of type Concept.

@FileAribute

Annotation for mapping
the return value of a
(geer) method to the
file aribute specified at
type level. The aribute
name is mandatory and
is used to identify the
aribute. This annotation
is very similar to the {@link
ExternalLink} annotation
in terms of supported

Method attributeName (mandatory) – The
name of the aribute represented by
this annotation.

cascadeStype (optional) – The
cascading style for this mapping.

targetType (optional) – The type
of the mapped bean. The bean itself
must be of type ExternalLink.
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Annotations and Description Scope Properties
aributes and underlying
representation. In order to
use this annotation, a file
aribute must be defined
at type level (the registry
object type must have a
file aribute with the same
aribute name as specified
in the annotation).

@Relationship

Annotation for mapping
the return value of a (geer)
method to the aribute
specified at type level.
The aribute name is
mandatory and is used to
identify the aribute. This
annotation is very similar
to the {@link Association}
annotation in terms of
supported aributes and
underlying representation.
The difference is that the
association and target types
are not specified but are
obtained from the aribute
description. In order to
use this annotation, a
relationship aribute must
be defined at type level (the
registry object type must
have a relationship aribute
with the same aribute
name as specified in the
annotation).

Method attributeName (mandatory) – The
name of the aribute represented by
this annotation.

cascadeStype (optional) – The
cascading style for this mapping.

targetType (optional) – The type
of the mapped bean. The bean itself
must be of type Concept.

Example
/** 
* Java bean interface representing JAXR-based registry objects 
* of type  ServiceInterfaceVersion. 
*/ 
@RegistryObject(objectTypeName = 
"{http://namespaces.CentraSite.com/csaf}ServiceInterfaceVersion") 
@Bean(implementationClass = 
"com.softwareag.centrasite.appl.framework.persistence.beanmodel.impl.ServiceIn 
terfaceVersionImpl") public interface ServiceInterfaceVersion extends 
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                                                                 RegistryBean{ 
  
   @Property(target = "name") 
   public String getName(); 
   public void setName(String name); 
  
   /** 
    * Returns the description 
    */ 
   @Property(target = "description") 
   public String getDescription(); 
  
   /** 
    * Sets the description 
    */ 
   public void setDescription(String description); 
  
   /** 
    * Returns the attachments 
    */ 
   @ExternalLink(type =  com.softwareag.centrasite.appl.framework.persistence. 
beanmodel.ExternalLink.class) public List<com.softwareag.centrasite.appl. 
framework.persistence.beanmodel.ExternalLink> getAttachments(); 
  
    /** 
     * Sets the attachments 
     */ 
    public void setAttachments(List<com.softwareag.centrasite.appl. 
framework.persistence.beanmodel.ExternalLink> attachments); 
  
     /** 
      * Returns the short name of the interface version. 
      * Maps to {http://namespaces.CentraSite.com/csaf}shortName slot. 
      */ 
      @Slot(name = "{http://namespaces.CentraSite.com/csaf}shortName") 
      String getShortName();   
  
     /** 
      * Sets the short name property of the interface version. 
      */ 
     void setShortName(String shortName);  
  
    /** 
     * Returns. 
     */ 
    @Association(type = "HasReviewRequest", 
                 targetType =  ReviewRequestOutcome.class, 
                 cascadeStype = CascadeStyle.DELETE) 
    List<ReviewRequestOutcome> getReviewRequestOutcomes(); 
  
    /** 
     * @param list 
     */ 
    public void setReviewRequestOutcomes(List<ReviewRequestOutcome> list);   
  
    /** 
     * Returns the findings, which are attached to the bean. 
     */ 
    @Classification(classificationScheme = "CSAF -Taxonomy", 
                    conceptPath = "/ClassificationInstances/Finding", 
                    targetType = Finding.class) 
    List<Finding> getFindings(); 
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    /** 
     * 
     * @param pFindings 
     */ 
    public void setFindings(List<Finding> pFindings); 
   
  
    @Slots(targetType = SlotBean.class) 
    public Collection<SlotBean> getSlots(); 
   
    public void setSlots(Collection<SlotBean> slots); 
} 
  
/** 
* Implementation of the {@link ServiceInterfaceVersion} bean interface. 
*/public class ServiceInterfaceVersionImpl extends DynamicRegistryBean 
implements ServiceInterfaceVersion { 
  
    private String _shortName; 
    private List<ReviewRequestOutcome> _reviewRequestOutcomes; 
    private Collection<SlotBean> slots; 
    private String _instanceSlotName; 
    private List<Finding> findings; 
    private List<ExternalLink> externalLinks; 
  
    /** 
     * {@inheritDoc} 
     */ 
    public String getShortName() { 
       return _shortName; 
    } 
  
    /** 
     * {@inheritDoc} 
     * 
     * The setter is annotated that modifies the object and it needs to be 
     * updated in the JAXR-based registry. 
     */ 
    public void setShortName(String shortName) { 
        _shortName = shortName; 
    } 
  
    public List<ReviewRequestOutcome> getReviewRequestOutcomes() { 
       return _reviewRequestOutcomes; 
    } 
  
    public 
    void setReviewRequestOutcomes(List<ReviewRequestOutcome> list) { 
       _reviewRequestOutcomes = list; 
     } 
  
    public Collection<SlotBean> getSlots() { 
       return slots; 
    }  
  
    public void setSlots(Collection<SlotBean> slots) { 
       this.slots = slots; 
    }    
  
    public String getInstanceSlotName() { 
       return _instanceSlotName; 
    } 
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    public void setInstanceSlotName(String slotName) { 
       _instanceSlotName = slotName; 
    } 
  
    public List<Finding> getFindings() { 
       return findings; 
    } 
  
    public void setFindings(List<Finding> findings) { 
       this.findings = findings; 
    } 
  
    public List<ExternalLink> getAttachments() { 
       return externalLinks; 
    } 
  
    public void setAttachments(List<ExternalLink> attachments) { 
       externalLinks = attachments; 
    } 
}

Standard Mappings

The Standard Mappings (com.softwareag.centrasite.appl.framework.beans.standard) are
RegistryBeans that represent all supported JAXR-based Registry Objects under the
package com.centrasite.jaxr.infomodel. They provide the functionality to operate and manage
JAXR-based RegistryObjects through the Application Framework with ease.

There are other kinds of objects that are included in this package although they are
not RegistryObjects (EmailAddress, PostalAddress, Slot … etc.). The Application
Framework provides a mapping for them as well. Standard Mapping instances are
created by the BeanPool's create(beanClass); standard non-registry object mappings
(EmailAddress, PostalAddress, Slot … etc.) are managed using the following:
com.softwareag.centrasite.appl.framework.beans.standard.StandardMappingManager

Standard Mappings Usage Sample
//Create a com.softwareag.centrasite.appl.framework.beans.standard.Organization 
com.softwareag.centrasite.appl.framework.beans.standard.Organization 
organization = beanPool.create(com.softwareag.centrasite.appl.framework.beans.s 
tandard.Organization.class); 
organization.setName("MyOrganization"); 
  
// Create StandardMappingManager for managing Standard non RegistryObjects 
// mappings 
StandardMappingManager smm = new StandardMappingManager(registryProvider); 
  
//Create a postal address 
com.softwareag.centrasite.appl.framework.beans.standard.PostalAddress pa = 
 smm.createPostalAddress("streetNumber", "street", "city", 
                         "stateOrProvince", "country", "postalCode","type"); 
organization.setPostalAddress(pa); 
  
// Get existing user and add it to the organization 
com.softwareag.centrasite.appl.framework.beans.standard.User user = 
beanPool.read( com.softwareag.centrasite.appl.framework.beans.standard.
User.class, 
USER_KEY); 
Collection<User> users = new ArrayList<User>(); 
users.add(user); 
organization.setUsers(users); 
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// save the changes 
beanPool.flush();

Generating Beans Through the Command Line

Pre-requisites:

CentraSite provides a command tool named GenerateCSAFBeans for this purpose.

The syntax is of the format:

C:\SoftwareAG\CentraSite\utilities>GenerateCSAFBeans.cmd <USERNAME>
<PASSWORD> <CENTRASITE-URL> <TYPENAME> <INTERFACEPACKAGE> <IMPLPACKAGE>
<DESTINATION>

The input parameters are:

Parameter Description

CENTRASITE-URL (Optional). The URL of the CentraSite registry. For
example, http://localhost:53307/CentraSite/
CentraSite.

USER-ID The user ID of a registered CentraSite user who has
the CentraSite Administrator role. For example,
Administrator.

PASSWORD The password for the registered CentraSite user
identified by the parameter USER-ID.

TYPENAME The namespace or name of the type to be generated.
Example: {hp://test}TestService.

Or, the name of the virtual type to be generated.
Example: "Virtual service" .

Note: The quotation marks are necessary, in order that
"Virtual service" is parsed as a single token.

INTERFACEPACKAGE The name of the package in which the
interfaces should be generated. For example:
com.sag.generated

IMPLPACKAGE The name of the package in which the
implementation should be generated. For example:
com.sag.generated.impl

DESTINATION The location where the generated bean will be stored.
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Example (all in one line):

C:\SoftwareAG\CentraSite\utilities>GenerateCSAFBeans.cmd Administrator
manage http://localhost:53307 "Virtual service" com.sag.generated
com.sag.generated.impl c:\tmp\

Querying the Registry
The Application Framework provides two search functionalities:

The Application Framework Simple Search uses only framework-specific data, so it
is simpler to use and supports all needed query operations. This search interface is
also the recommended one to use.

The Application Framework JAXR-Based Search combines framework and JAXR-
based data. The advantage of this search is that it can use the whole JAXR-based
functionality to query the registry. The disadvantage is that in order to use it, the
user must have considerable knowledge of JAXR.

Application Framework Simple Search
The Application Framework Simple Search uses framework-specific data only. To
perform a search, you:

1. Create a search object using a BeanPool instance.

2. Restrict search results by adding search predicates.

3. Define the order of the search results using one of the Order static methods.

4. Invoke the search using the result method.

Creating a Search Object
To search the registry, the user must create a search object using a BeanPool instance.
The BeanPool offers several methods for creating search objects:

Without arguments:
BeanPool.createSearch();

This creates a search object which, when executed, searches for objects in the registry
from all registered bean types. See “Bean Types Managed by CSAF” on page 292.

When a List of items is passed:
BeanPool.createSearch(List<Class<? extends RegistryBean>> beanClasses)

The created search object searches through all objects in the registry, from the
specified list of types.

When a single type is passed:
BeanPool.createSearch(Class<? extends RegistryBean bean> beanClass)
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The search object searches the registry only for items from the specified type.

The search object has a result() method that searches the registry and returns a list of all
RegistryBean objects that satisfy the search criteria.

Example:
BeanPool beanPool = sessionContext.getCurrentBeanPool();
Search search = beanPool.createSearch();

Restricting the Search Results by Adding Search Predicates
The predicate is an object representation of a query criterion used to restrict the
search results. Predicates can be created from a factory-like class called Predicates
(com.softwareag.centrasite.appl.framework.persistence.search.Predicates).

It provides two static methods for creating each specific predicate:

Without specifying Bean Type:
Predicates.eq(String propertyName, Object value)

By specifying a Bean Type:
Predicates.eq(String propertyName, Object value, 
Class<? extends RegistryBean> beanType)

where

The comparison operator:

and logical conjunction

eq equal

method name

ge greater than or equal to

 gt greater than

 le less than or equal to

 like matches a string that can include wildcards

 lt less than

 ne not equal

 or logical disjunction

property name The name of the property to be compared. This property
name is a string value representing the name of the Java
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property (getName() corresponds to “name”). The search
functionality supports adding a sequence of properties. This
is accomplished by knowing the searched RegistryBean
property hierarchy and by separating following properties
with a dot ..

Example:

Predicates.eq( "externalLink.uri ", value)

The predicate is created for the URI property of the
externalLinks of the searched RegistryBean, which should
be equal to the given value.

value The value to compare against. Most methods expect an
Object value because the search can handle a variety of
objects including String, Number, Date, Calendar, Key,
RegistryBean, and others. There are also methods that
expect a specific value type. An example is like (String
propertyName, String value), which supports wildcards
and therefore the expected value type is String. Other
object types that are worth mentioning are the so-called
support types (TelephoneNumbers, InternationalString,
LocalizedString, EmailAddress, PostalAddress). They can be
used for search criteria but not as a searched object because
they are not registry beans. For example, the following
search is valid:

Search search = beanPool.createSearch(User.class); 
Predicates.eq("telephoneNumbers.countryCode", 
"someCountryCode");

But the following search is not valid:

Search search = beanPool.createSearch(EmailAddress.class);

beanType The bean type for which the predicate is applied.

Important: If no beanType is specified then the predicate is
applied to the first bean type in the Search object's
list of bean types. Note that the first item of that list
must support the property passed to the predicate,
otherwise the search fails. In cases where the search
object is created for all supported bean types, the list
is filled randomly so the user must be aware of all
common properties supported by these RegistryBean
types.

Each predicate can be added to the search object by invoking the search method:
addPredicate(Predicate predicate);



M
Odd Header

Application Framework

CentraSite Developer's Guide Version 10.2 (Innovation Release) 307

A search object can add multiple predicates, which can be treated as predicates joined by
an and operator. For example:
Search search =  beanPool.createSearch(); 
search.addPredicate(predicate1); 
search.addPredicate(predicate2); 
search.addPredicate(predicate3);

is equal to predicate1 and predicate2 and predicate3 in the query to be executed.

There are two more methods in the Predicates class: and(Predicate p1, Predicate p2) and
or(Predicate p1, Predicate p2). These methods create a so-called combine predicate. They join
two predicates by logical conjunction or logical disjunction respectively. This predicate
can be added to the search object in the same way as the common predicates explained
above.

Supported predicates description

All supported predicates are created from methods in the Predicates class
(com.softwareag.centrasite.appl.framework.persistence.search.Predicates).

Like Predicate

A predicate that supports usage of wildcards. The value field of the creating methods:
like(String propertyName, String value) 
like(String propertyName, String value, Class<? extends 
RegistryBean> beanType)

is of Type String, so the user may add strings (possibly including wildcards).

Example:
like("name","%partOfExpectedName");

Wildcards

The like predicate supports wildcards in the manner of SQL and UDDI. The wildcard
characters are as follows:

Wildcard character Indicates

% Any value for any number of characters

_ Any value for a single character

The following special cases are supported:

To represent... use the character string...

% \%

_ \_
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To represent... use the character string...

\ \\

Greater Than Predicate

A predicate that compares Number, Date, or Calendar, returning true if the compared
object value is greater than the value given in the predicate's creating method “value”
field:
gt(String propertyName, Object value) 
gt(String propertyName, Object value, Class<? extends 
RegistryBean> beanType)

The value must be one of the following types: Number, Date, Calendar.

Example:
Calendar calendar = Calendar.getInstance(); 
Predicate predicate = Predicates.gt("requestDate",calendar);

Less Than Predicate

A predicate that compares Number, Date, or Calendar, returning true if the compared
object value is less than the value given in the predicate's creating method “value” field:
lt(String propertyName, Object value) 
lt(String propertyName, Object value, Class<? extends 
RegistryBean> beanType)

The value must be one of the following types: Number, Date, Calendar.

Example:
Predicate predicate = Predicates.lt("copyNumber",203);

Greater or Equal Predicate

A predicate that compares Number, Date or Calendar, returning true if the compared
object value is greater than or equal to the value given in the predicate's creating method
“value” field:
ge(String propertyName, Object value) 
ge(String propertyName, Object value, Class<? extends 
RegistryBean> beanType)

The value must be one of the following types: Number, Date, Calendar.

Example:
Predicate predicate = Predicates.ge("copyNumber",203);

Less or Equal Predicate

A predicate that compares Number, Date or Calendar, returning true if the compared
object value is less than or equal to the value given in the predicate's creating method
“value” field:
le(String propertyName, Object value) 
le(String propertyName, Object value, Class<? extends 
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RegistryBean> beanType)

The value must be one of the following types: Number, Date, Calendar.

Example:
Predicate predicate = Predicates.le("copyNumber",203);

Equal Predicate

A predicate that returns true if the compared object value is equal to the value given in
the predicate's creating method “value” field:
eq(String propertyName, Object value) 
eq (String propertyName, Object value, Class<? extends 
RegistryBean> beanType)

The value must be one of the following types: Number, Date, Calendar, String, Key,
RegistryBean.

If the value is of type RegistryBean then the comparison is made by the RegistryBean's
key.

Example:
Predicate predicate = Predicates.eq("name","somePropertyname");

Not Equal Predicate

A predicate that returns true if the compared object value is not equal to the value given
in the predicate's creating method “value” field:
ne(String propertyName, Object value) 
ne (String propertyName, Object value, Class<? extends 
RegistryBean> beanType)

The value must be one of the following types: Number, Date, Calendar, String, Key,
RegistryBean.

If the value is of type RegistryBean then the comparison is made by the RegistryBean's
key.

Example:
Predicate predicate = Predicates.ne("name","somePropertyname");

AND Predicate

A predicate that joins two predicates in a logical conjunction. The method that creates
this predicate:
public static Predicate and(Predicate p1, Predicate p2)

expects two predicates as arguments.

Example:
Predicate predicate1 = Predicates.eq("name","somePropertyname"); 
Predicate predicate2 = Predicates.eq("name","somePropertyname2"); 
Predicate andPredicate = Predicates.and(predicate1, predicate2);
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OR Predicate

A predicate that joins two predicates in a logical disjunction. The method that creates
this predicate:
public static Predicate or(Predicate p1, Predicate p2)

expects two predicates as arguments.

Example:
Predicate predicate1 = Predicates.eq("name","somePropertyname"); 
Predicate predicate2 = Predicates.eq("name","somePropertyname2"); 
Predicate orPredicate = Predicates.or(predicate1, predicate2);

Defining the Order of the Search Results
You can define the order using one of the following Order
(com.softwareag.centrasite.appl.framework.persistence.search.Order) static methods,
which create ascending or descending order for a given property:

asc(String propertyName) for ascending

desc(String propertyName) for descending

The rules for the property name when creating Order are the same as when creating
a Predicate. The user must know whether the bean types added to the search object
support the property passed to the Order asc(String propertyName) or desc(String
propertyName) methods. You can add multiple orders to the search object.

Example:
Order order = Order.asc("description");

Invoking the Search
After adding the necessary predicates and orders to the search object, the search can
be executed by invoking the result() method on the search object. It returns a list of all
RegistryBean objects in the registry that applied the predicate conditions in the specified
order. The result is lazy loading compatible.

Here is an example of a Search lifecycle:
List searchTypes = new ArrayList(); 
searchTypes.add(ReviewRequestOutcome.class); 
searchTypes.add(ServiceInterfaceVersion.class); 
   
Search search = beanPool.createSearch(searchTypes); 
  
Predicate predicate1 = Predicates.eq("ExternalLink.URI", 
"http://www.softwareag.com"); 
Predicate predicate2 = Predicates.eq("name","somePropertyname2"); 
Predicate orPredicate = Predicates.or(predicate1, predicate2); 
  
Search.addPredicate(orPredicate); 
  
search.addOrder("name"); 
  
List<RegistryBean> result = (List<RegistryBean>) search.result();
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This means that all ReviewRequestOutcomes and ServiceInterfaceVersions are searched
and the ones that have name equal to “somePropertyname2” or ExternalLink with URI
equal to “hp://www.softwareag.com” is returned in the resulting List of RegistryBean
objects ordered by name.

Extending the Application Framework
There are several points where the user can extend the existing Application Framework
functionality.

Properties

Each Java bean property is internally represented as a
com.softwareag.centrasite.appl.framework.mapping.Property instance.

The recommended way of creating a new property is by extending, directly or indirectly,
the BaseProperty class (com.softwareag.centrasite.appl.framework.mapping.BaseProperty).

To map the information from a given annotation to the new Property correctly,
a user-defined Property Processor that implements the PropertyAnnotationProcessor
(com.softwareag.centrasite.appl.framework.PropertyAnnotationProcessor) must be created.

Then the newly created PropertyProcessor must be added to the list of processors in the
BeanTypeAnnotationProcessor (com.softwareag.centrasite.appl.framework.BeanTypeAnnotationProcessor)
using the addAnnnotationProcessor(Class<?> annotationType, PropertyAnnotationProcessor
annotationProcessor) method.

Property Mapper

Each property value must be transferred to/from the
underlying registry object. For that purpose, CSAF provides the
(com.softwareag.centrasite.appl.framework.persistence.mapper.PropertyMapper) interface.

Users can provide their own implementation of the PropertyMapper interface by
hooking it to a given type of Property. Such a property mapper is registered using
the com.softwareag.centrasite.appl.framework.persistence.mapper.PropertyMapperFactory.addHandler
(PropertyMapperFactory.Handler) method.

Predicate

The preferred method of creating a custom-defined predicate is to extend the
DefaultPredicate (com.softwareag.centrasite.appl.framework.persistence.search.impl.DefaultPredicate)
class directly or indirectly. Another way is to directly implement the Predicate interface
(com.softwareag.centrasite.appl.framework.persistence.search.Predicate), although this is not
recommended because it does not offer default behavior.

To use this newly-created predicate, the user must create a custom defined
predicate handler, which must implement the PredicateHandler interface
(com.softwareag.centrasite.appl.framework.persistence.search.PredicateHandler).
This predicate handler must be added to the PredicateFactory
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(com.softwareag.centrasite.appl.framework.persistence.search.impl.PredicateFactory) list of predicate
handlers by calling addPredicateHandler(PredicateHandler handler).

Application Framework JAXR-Based Search
Whereas the BeanPool interface takes care of the standard CRUD operations
to the registry, the queries are performed using the Query interface
(com.softwareag.centrasite.appl.framework.persistence.Query):
package com.softwareag.centrasite.appl.framework.persistence; 
public interface Query<T extends RegistryBean> { 
  List<T> run(QueryContext pContext) throws JAXRException, 
     CSAppFrameworkException; 
}

In order to do a query, one should implement this interface and place the querying
routines in the run() method implementation. The query is then executed via
BeanPool.run():
<T extends RegistryBean> List<T> run(Query<T> pQuery) 
   throws CSAppFrameworkException;

The returned data is then in the form of beans.

This mechanism still requires knowledge of JAXR. The benefit is that JAXR is isolated in
this interface. Sample implementation of Query:
final Query<EntryCode> q = new Query<EntryCode>() { 
  public List<EntryCode> run(QueryContext context) throws JAXRException { 
        final RegistryAccessor regDAO = context.getRegistryAccessor(); 
        final Concept concept = regDAO.findConceptByPath("CSAF-Taxonomy", 
                        "/ClassificationInstances/EntryCodeType"); 
        final List<EntryCode> result = new ArrayList<EntryCode>(); 
      for (Concept c : (Collection<Concept>) concep.getChildrenConcepts()) { 
          try { 
              EntryCode ec = context.getCurrentBeanPool().read(EntryCode.class, 
                  c.getKey().getId()); 
              result.add(ec); 
          } catch (Exception e) { 
              throw new RuntimeException(e.getMessage(), e); 
          } 
      } 
      return result; 
  } 
}; 
List<RegistryBean> queryResult = getBeanPool().run(q);

In general, a Query would use the JAXR-based API to find and retrieve the data, and
then the keys of registry objects that were found are passed to the BeanPool to build the
beans. These beans are then returned as the result of the query execution.

Event Mechanism
The CSAF allows the user to register and receive notifications when certain events
occur. Currently, three persistence events are supported: objectDeleted, objectCreated,
objectUpdated. These events can be intercepted by implementing the interface
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com.softwareag.centrasite.appl.framework.persistence.PersistenceEventListener. Such listeners are
registered via the BeanPool, which has methods for adding, removing, and retrieving
listeners.

All of the supported events are post events, in other words, they are fired after an action
has been performed.

Using CSAF in pre-action events has some limitations. This is because the CSAF tries
to establish its own connection to the registry data. Under certain circumstances, it
may happen that a user searches the registry for a transient object (for example, an
object which is still not persisted into the database) and, on which a pre-action event is
executing, in such case the user may not be able to retrieve the transient object created
using another connection. As a best practice, we recommend that you use the JAXR-
based API connection for any pre-action events.

Asset Types
Type Management provides CRUD (create, read, update, and delete) operations for
custom object types. CSAF provides its own classes describing object (asset) types and
their aributes. Type Management supports operations on the following aributes:
file, classification, relationship and slot, where slot can be one of the
following types:

xs:boolean

xs:dateTime

xs:date

xs:time

xs:duration

xs:anySimpleType

xs:integer

xs:string

xs:anyURI

xs:double

xs:decimal

Type Management also provides CRUD operations for profiles, functionality to
associate aributes with profiles, and aach profiles to types. A manager interface
com.softwareag.centrasite.appl.framework.types.TypeManager is the entry point for the application
that uses CSAF.

Note: In order to use Type Management functionality, the StandaloneRegistryProvider
instance must be created with the browserBehaviour flag set to true.
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Usage Sample for Type Management
private String TYPE_LOCAL_NAME = "TypeLocalName"; 
  
private String TYPE_NAMESPACE = "http://test.namespace.test"; 
  
private String TYPE_NAME = "{" + TYPE_NAMESPACE + "}" 
                                  + TYPE_LOCAL_NAME; 
  
// Get a sessionContext instance 
SessionContext sessionContext = initSessionContext(); 
  
// Get a TypeManager instance from sessionContext 
TypeManager typeManager = sessionContext.getTypeManager(); 
  
// Create a custom object type 
TypeDescription typeDescription = typeManager.createType("TypeDisplayName", 
                    "TypeDescription",   TYPE_LOCAL_NAME, TYPE_NAMESPACE); 
  
// Create a Classification Attribute 
AttributeDescription attrClass = typeManager.createClassificationAttribute( 
       "ClassificationAttributeName","ClassificationAttributeDescription", 
        Constants.CLASSIFICATION_SCHEME_PRODUCTS); 
  
// Add attribute to custom type 
typeDescription.addAttribute(attrClass); 
  
// Create Profile 
Profile profile = typeManager.createProfile("ProfileName"); 
  
// Create a File Attribute 
AttributeDescription attrFile = typeManager.createFileAttribute( 
                "nameFileAttribute", "descriptionFileAttribute"); 
  
// Add attribute to profile 
profile.addAttribute(attrFile); 
  
// Add profile to custom type 
typeDescription.addProfile(profile); 
  
// Save custom type 
typeManager.saveType(typeDescription); 
  
// Get custom type by name 
TypeDescription type = typeManager.getType(TYPE_NAME); 
  
// Delete custom type 
typeManager.deleteType(type);

Association Types
In general, registry objects can be related to each other via associations. An association
belongs to a specified association type. CentraSite supports predefined association types,
such as HasParent and Uses; in addition, you can create custom association types.

In CentraSite, an association type is uniquely identified by its value (for example:
HasParent, Uses, etc.). The value is specified when the association type is created, it
cannot be subsequently modified.
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An association type can optionally have one or more locale-specific display names. If
no locale-specific display names are specified, the association type's value is used by
default.

Each association type has a forward label, this is shown, for example, when a
corresponding association is displayed by the impact analysis.

You can optionally specify a backward label. Multiple association types can share
forward and backward labels.

The CentraSite Application Framework type management feature provides methods for
creating, updating, deleting, and finding association types.

Usage Sample for Association Type Management
// Get a sessionContext instance 
SessionContext sessionContext = initSessionContext(); 
  
// Get a TypeManager instance from sessionContext 
TypeManager tm = sessionContext.getTypeManager(); 
  
AssociationType at = tm.createAssociationType( 
  "MyAssociationType", "MyDisplayName", "MyForwardLabel", 
  "MyBackwardLabel", Locale.EN); 
tm.saveAssociationType(at); 
  
// find an association type by its value 
AssociationType myAssociationType = tm.getAssociationType("MyAssociationType"); 
  
// find an association type by its display name 
myAssociationType = tm.getAssociationTypeByName("MyDisplayName"); 
  
// add a display name with a different locale 
myAssociationType.setName("MonNom", Locale.FRENCH); 
tm.saveAssociationType(myAssociationType); 
  
// delete an association type 
tm.deleteAsssociationType(myAssociationType);

Lifecycle Management
The Application Framework supports the Lifecycle Model (LCM) functionality. The
LCM provides the ability to define and track the life-cycle of a service and also provides
a way to define and enforce policies that govern the path of an asset through the
lifecycle. As a result, these policies can be automated or enforced consistently. Using
registry beans, we now support lifecycle-aware registry beans.

The definition of an LC Model starts with the definition of an LC Model taxonomy. The
state model of an LC Model is a standard state model (deterministic finite automaton,
DFA). The model itself is represented as the concepts of the LC Model taxonomy.
A taxonomy is not defined for this, so associations are used to represent the state
transitions. The states themselves are just concepts within the taxonomy.

In order to create a lifecycle-aware registry bean, the user must create a registry
bean that extends com.softwareag.centrasite.appl.framework.lcm.beans.LifeCycleAware.
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Also, the implementation of this registry bean must extend the
com.softwareag.centrasite.appl.framework.lcm.beans.LCAwareDynamicRegistryBean. This ensures that
the registry bean is lifecycle-aware and is ready to use for lifecycle operations.

In order to manage the lifecycle models and states, the LCM Manager must first be
initialized:
com.softwareag.centrasite.appl.framework.SessionContext 
sessionContext = initSessionContext(); 
com.softwareag.centrasite.appl.framework.lcm.LCMAdminManager 
lcmAdminManager = sessionContext.getLCMAdminManager();

The com.softwareag.centrasite.appl.framework.lcm.LCMAdminManager provides all operations for
creating, modifying and deleting LCModels. State models for Lifecycle Management
models can theoretically be complex and encompass multiple machines and LCStates.

LCModels are state machines for Lifecycle Management and the
state machines may not have any states that cannot be reached. The
com.softwareag.centrasite.appl.framework.lcm.LCModel provides methods for all operations that
can be performed on an LCModel. When the LCModel becomes active, no changes to
the LCModel are possible; instead, a new version of the LCModel can be created using
LCModel.createVersion().

The com.softwareag.centrasite.appl.framework.lcm.LCState provides access to the LCState and
state specific operations.

For more information about the methods and functionality supported by LCModel, check
the Javadoc of the framework.

Usage Sample for LCM
// initialize SessionContext 
SessionContext sessionContext = initSessionContext(); 
  
// get the LCMAdminManager 
LCMAdminManager lcmAdminManager = sessionContext.getLCMAdminManager(); 
  
// Create a LCModel 
LCModel lcModel = lcmAdminManager.createLCModel(); 
lcModel.setDisplayName("DisplayName"); 
lcModel.setDescription("Description"); 
  
// the LCModel must set a standard mapping Organization: 
//com.softwareag.centrasite.appl.framework.beans.standard.Organization 
lcModel.setOrganization((Organization)organization, false); 
  
// Create LCStates 
LCState lcStateA = lcModel.createLCState(); 
String stateAName = "State A"; 
lcStateA.setName(stateAName); 
lcStateA.setDescription("stateADesc"); 
Collection<LCState> states = new ArrayList<LCState>(); 
states.add(lcStateA); 
  
// add LCStates to lcModel 
lcModel.addStates(states); 
  
// lcModel must set an initial State 
lcModel.setInitialState(lcStateA); 
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// add the keys of all Types that should be enabled for LCM 
Collection<String> typesToBeEnabledForLCM = new ArrayList<String>(); 
typesToBeEnabledForLCM.add(typeToEnableForLCMKeys); 
lcModel.addEnabledTypes(typesToBeEnabledForLCM); 
  
// Save the lcModel using the LCMAdminManager 
lcmAdminManager.saveLCModel(lcModel); 
  
// Find existing LCModel. 
// The result will contain all LCModels (active and inactive) 
// that have the corresponding display name. 
List<LCModel> listOfModels = 
  lcmAdminManager.findLCModelByDisplayName("DisplayName",false);

Revision Management
CentraSite versioning capabilities make it possible to create a new version of an object
at any point in time. However, the new version is per definition a new object instance
which has to go through the whole lifecycle again, firing creation policies, and so on.
There is often a demand for versioning capabilities that allow a defined state of the same
object to be restored and referenced. Such a defined state is referred to as a checkpoint.

The CSAF interfaces related to versioning are
com.softwareag.centrasite.appl.framework.persistence.revision.RevisionManager and
com.softwareag.centrasite.appl.framework.beans.RevisionBean.

The CentraSite revisioning feature can be enabled system-wide, which means that every
object modification (create/update) of any instance of any type leads to the creation of a
checkpoint.

A checkpoint has the following identifying aributes: a minor version number, a label,
and a timestamp. The minor version number is incremented each time a checkpoint is
created. The label is an optional description that can be used to add information about
the change. Also a timestamp that reflects the date of the checkpoint creation is recorded
with the checkpoint. The creation of a new checkpoint is recorded in the audit log.

It is possible to reference one specific checkpoint of an object directly and retrieve all
of its data as it was at the point in time when the checkpoint was created. This implies
that changes made to the object after the checkpoint took place are not reflected in the
retrieved checkpoint. Note that the checkpoints provide read-only access to the data; any
aempt to update a checkpoint raises an exception. However the current object can be
updated.

Reading a bean instance from the registry using BeanPool.read() always returns the current
(latest) state of an object.

Deleting an object also deletes all of its checkpoints.

It is possible to purge a set of checkpoints to reduce the amount of data consumed by
keeping older states of the object.

Note that in order to use the Revision functionality, the StandaloneRegistryProvider instance
must be created with the browser Behaviour flag set to false.
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Usage Sample for Revision Management
package com.softwareag.centrasite.appl.framework.persistence.tests; 
  
import java.util.ArrayList; 
import java.util.Collection; 
  
import com.softwareag.centrasite.appl.framework.SessionContext; 
import com.softwareag.centrasite.appl.framework.beans.RevisionBean; 
import com.softwareag.centrasite.appl.framework.beans.standard.Service; 
import com.softwareag.centrasite.appl.framework.persistence.BeanPool; 
import 
com.softwareag.centrasite.appl.framework.persistence.revision.RevisionManager; 
  
public class Revisioning { 
  private static String checkpointName = "MyLabel"; 
  
  public void revisioning() throws Exception { 
      SessionContext sessionContext = initSessionContext(); 
      BeanPool beanPool = sessionContext.getCurrentBeanPool(); 
  
      RevisionManager revManager = sessionContext.getRevisionManager(); 
  
      //enable the feature if needed 
      if (!revManager.isRevisioningEnabled()) { 
          revManager.enableRevisioning(); 
      } 
  
      // create new checkpoint 
      Service bean = beanPool.read(Service.class, "uddikey"); 
      revManager.setCheckpoint(bean, checkpointName); 
  
      // get all checkpoints including the current state object 
      Collection<RevisionBean> checkpoints = revManager.getRevisionBeans(bean); 
  
      // restore to the only checkpoint 
      Collection<RevisionBean> restoreObjs = new ArrayList<RevisionBean>(); 
      for (RevisionBean rev : checkpoints) { 
          if (rev.isRevision()) { 
              restoreObjs.add(rev); 
              break; 
          } 
      } 
  
      revManager.restoreBeans(restoreObjs); 
  
      // delete checkpoints based on label 
      revManager.deleteBeans(checkpointName); 
  } 
  
  private SessionContext initSessionContext() { 
      //initialize CSAF 
        return null; 
  } 
  
}
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Multi-User Scenarios
In order to address multi-user scenarios successfully, several aspects of the framework
must be noted.

A SessionContext is an expensive-to-create, threadsafe object intended to be shared
by all application threads. It is created once, usually on application startup, from a
Configuration instance. A BeanPool is an inexpensive, non-threadsafe object that should
be used once, for a single request (single unit of work) and then discarded. The
CurrentBeanPoolContext interface defines the contract for implementations that know
how to scope the notion of a current bean pool. ThreadLocalCurrentBeanPoolContext, which
maintains current bean pools for the given execution thread, is provided as an example
implementation of this interface.

The specification of JAXR does not support transactions or locking. CSAF and
CentraSite's implementation extend the API with some locking and transaction
capabilities. Here are some points to note:

Transactions are handled internally and control over them (including
isolation, demarcation, and so on.) is not exposed through CSAF. There is only
support for bulk operations by using the BeanPool.delete(java.util.Collection) and
BeanPool.update(java.util.Collection) methods. These methods guarantee the atomicity
of the performed operation. There is also a BeanPool.flush() which performs one bulk
operation for the deleted beans and one for the created and updated beans.

Each modification to a registry bean (RegistryBean instance) leads to obtaining an
exclusive lock for writing on the whole registry object in the database. This is a
pessimistic locking strategy, as the lock is obtained when the object is modified and
not when it is actually persisted.

Whenever a lock on a registry object cannot be obtained (because it is taken by
another client), the following exception is thrown:
com.softwareag.centrasite.appl.framework.persistence.LockNotAvailableExcep 
tion

The notion of an outdated object denotes a registry object whose database
representation has been changed since it was read. This is usually caused by a
different client modifying the same instance. Trying to modify an outdated object
leads to the following exception:
com.softwareag.centrasite.appl.framework.persistence.ObjectOutdatedExcept 
ion

CSAF supports automatic re-reading of outdated objects; this forces a re-read of the
object from the database before applying the changes.

In general, the application must minimize the time a registry object is kept locked in the
database, that is, the time during which there are ongoing modifications on it.
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Setting the Classpath
In order to be able to use the CentraSite Application Framework features, the Java
classpath must include all the relevant class files. The easiest way to do this is to
include all the JAR files that are contained in the folder redist (including the subfolder
redist/csaf). The redist folder is typically located at C:\SoftwareAG\CentraSite\redist
(Microsoft Windows) or /opt/softwareag/CentraSite/redist (UNIX).

Examples
The CentraSite Application Framework SDK comes with two examples. One is for the
persistence functionality and the other is for the validation functionality.

CRUD Example

The CRUD example demonstrates the abilities of the persistence framework. It shows
how the BeanPool is initialized, configured, and connected to the registry. Also it shows
how CRUD (create, read, update, and delete) operations are performed and queries
implemented and executed. It also includes the bean model and sample mapping of the
most commonly used bean relationships and their JAXR-based representation.
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Introduction to Importing Objects Using API
CentraSite has a set of importers for importing various kinds of objects. They are used by
the Import function of CentraSite Control. However, they can also be invoked through
Java programs, SOAP API, batch commands (for example, shell scripts), or directly from
the command-line prompt. Import APIs available for importing are:

Web services

XML schemas

XML services

REST services

BPEL process files

XPDL files

All the importers have a few characteristics in common. Each import function is called
with an appropriate XML file (for example, the web service importer expects a WSDL
file as input). The XML file can be located in the file system or for some importers, it can
alternatively be specified by a URL (HTTP). The file is incorporated into the CentraSite
repository and there is a registry object (an ExternalLink) that will point to it. Each
importer typically creates one or more JAXR-based registry objects. The relationship is:

Invoking Importer from Java Program
The classes used by the importers are available in the CentraSiteUtils.jar file. The
CLASSPATH variable must refer to the JAR files that are used by CentraSite. It is
convenient to include all JAR files available in the redist folder of the CentraSite
installation.

After using an instance of the JAXRAccessor class to establish a valid connection (with
user and password) to CentraSite, one or more imports are possible. Finally, close the
session by calling the close() method of JAXRAccessor.
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Importing Web Service
The basic input when importing a web service is a WSDL file describing one or more
services. There are also some seer methods for additional parameters out of which the
organization (per object or per name) parameter must be set while other parameters are
optional. If a WSDL imports includes WSDLs or schemas, then the referenced files are
also imported and the according CentraSite objects will be created.

The following example illustrates how to register a web service to CentraSite:
import com.centrasite.jaxr.JAXRAccessor; 
import com.centrasite.jaxr.webservice.WebServiceRegistrator; 
  
String dbURL = "http://localhost:53307/CentraSite/CentraSite"; 
String organizationName = "MyOrganization"; 
String wsdlFile = "c:/temp/MyService.wsdl"; 
String user = ...; 
String password = ...; 
  
JAXRAccessor jaxr = new JAXRAccessor(dbURL, user, password); 
  
try 
{ 
    WebServiceRegistrator wsr = new WebServiceRegistrator(wsdlFile, jaxr); 
    wsr.setOrganization(organizationName); 
    wsr.register(); 
} 
catch (Exception e) 
{ 
   // handle error 
} 
finally 
{ 
   jaxr.close(); 
}

Setter Methods
The WebServiceRegistrator class provides the following seer methods. The seer methods
must be called before calling the register() method:

setDescription

Sets a description text that will appear with the imported Service object.

Syntax
public void setDescription(String description)

Parameters

String description
The description text.
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Usage Notes

Optional.

setOrganization

Sets the name of the organization under which the service must be registered.

Syntax
public void setOrganization(String organizationName)

Parameters

String organizationName
The name of the organization.

setOrganization

Sets the organization object under which the service must be registered.

Syntax
public void setOrganization(Organization organizationObject)

Parameters

Organization organizationObject
The organization object under which the service must be registered.

setPackageName

Sets the name of the registry package of which the service must be a member.

Syntax
public void setPackageName(String packageName)

Parameters

String packageName
The name of the registry package of which the service must be a member.

Usage Notes

Optional.

setPackageObject

Sets the registry package object of which the service must be a member.

Syntax
public void setPackageObject(RegistryPackage packageObject)
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Parameters

RegistryPackage packageObject
The registry package object of which the service must be a member.

Usage Notes

Optional.

setUsedObject

Sets a registry object that will point to the imported service with a Uses association. That
is, the imported service is used by the specified object.

Syntax
public void setUsedObject(RegistryObject usedObject)

Parameters

RegistryObject usedObject
The registry object that will point to the imported service.

Usage Notes

Optional.

setUsesObject

Sets a registry object that is pointed to by the imported service with a Uses association.
That is, the imported service uses the specified object.

Syntax
public void setUsesObject(RegistryObject usesObject)

Parameters

RegistryObject usesObject
The registry object that is pointed to by the imported service.

Usage Notes

Optional.

setWebDAVFolder

Changes the path of the folder where the WSDL file is stored in the CentraSite
repository.

Syntax
public void setWebDAVFolder(String folderPath)
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Parameters

String folderPath
The path of the folder where the WSDL file must be stored.
Default: /projects/WSDL.

Usage Notes

Optional.

setUserVersion

Sets a user-defined version number for the service and related registry objects.

Syntax
public void setUserVersion (String userVersion)

Parameters

String userVersion
The user-defined version identifier for the service objects.

Usage Notes

Optional.

setServiceName

Sets a user-defined display name for the service that must be registered.

Syntax
public void setServiceName (String serviceName)

Parameters

String serviceName
The display name of the service. The default name is the name of the element <service>
defined in the WSDL file.

Usage Notes

Optional.

Importing Web Service from URL
If a WSDL has to be accessed from a protected URL, you can specify its credentials by
using a separate constructor of WebServiceRegistrator.

Example:
WebServiceRegistrator wsr = new WebServiceRegistrator(wsdlURL, 
                      jaxr, null, wsdlAccessUser, wsdlAccessPassword);
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Updating Registered Web Service
To update a registered web service (for example, when the WSDL file has been modified
or if you want to change the registry package that contains the web service), call the
register() method with the modified WSDL file.

Note: The key associated with a registered service comprises its organization, its
name, and the WSDL file's targetNamespace. If you modify one or more of
these, the service is not updated, however, a new registry entry is created.

Attaching WSDL to Registered Web Service
You can aach a WSDL file to an existing web service. The code for aaching a WSDL
file is similar to the code for importing a WSDL file. An example code snippet is:
WebServiceRegistrator wr = new WebServiceRegistrator("attach.wsdl", jaxr); 
wr.setAttachServiceID("uddi..."); 
wr.register();

where, "uddi..." denotes the UDDI key of the service to which the WSDL file must be
aached.

Note: The service can be a manually-created service.

If the service has already been registered with a WSDL, then calling
setAttachServiceID updates the registered information.

If there are any services within the WSDL, they are registered as usual.

If the service has a ServiceBinding that is not in the new WSDL, it is
removed.

If the service has a ServiceBinding that is in the WSDL, it is updated.

Operations which are no longer present in the WSDL will be removed.

Using the setCreateVersion() method it is possible to create a new version
from the aached service rather than updating it.

The WebServiceRegistrator class provides the seer method (in addition to the seer
methods described under Importing a Web Service). The seer method must be called
before calling the register() method.

setAttachServiceID
Sets a Service ID (getKey().getId()) for a WSDL-service aachment.

Syntax
public final void setAttachServiceID(String attachServiceID)
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Parameters

String attachServiceID)
The ID of the service, in the form "uddi:...".

setCreateVersion
Indicates if a new version of the service has to be created rather than updating it. This
option has effect only if the service is already present.

Syntax
public void setCreateVersion (boolean createVersion)

Parameters

boolean createVersion
The boolean value of true indicates the creation of a new version.

Usage Notes

Optional.

Removing Registered Web Service
This section describes the functions to remove a registered web service, its resources,
associated registry objects, and the WSDL file in the CentraSite repository.

You must use an instance of the JAXRAccessor class to establish a CentraSite connection
before calling the removeService or removeServiceByID function. Close the session by calling
the close() method of JAXRAccessor.

Also before calling the removeService or removeServiceByID function, call the seer function.

This Example demonstrates how to remove a web service from CentraSite:
import com.centrasite.jaxr.JAXRAccessor; 
import com.centrasite.jaxr.webservice.WebServiceAdministrator; 
  
String dbURL = "http://localhost:53307/CentraSite/CentraSite"; 
String wsdlFile = "c:/temp/MyService.wsdl"; 
String user = ...; 
String password = ...; 
 JAXRAccessor jaxr = new JAXRAccessor(dbURL, user, password); 
  
try 
{ 
   WebServiceAdministrator wsa = new WebServiceAdministrator(jaxr); 
   int removeCount = wsa.removeServices(wsdlFile); 
} 
catch (Exception e) 
{  
   // handle error 
} 
finally 
{ 
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   jaxr.close(); 
}

removeService
Removes the service specified by the unique name and namespace.

Syntax
public boolean removeService(String serviceName, String namespace)

Parameters

String serviceName
The name of the service to be removed.

String namespace
The namespace of the service to be removed.

Return Codes

Value Meaning

true The specified service was successfully found and removed.

false The specified service was not found.

removeServices
Removes all services from CentraSite that are indicated by the specified WSDL file.

Syntax
public int removeServices(String wsdlFilename)

Parameters

String wsdlFilename
The name of the WSDL file that indicates the services to be removed.

Return Codes

Value Meaning

int The number of services that were removed.

removeServiceByID
Removes the service with the specified ID.
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Syntax
public boolean removeServiceByID(String serviceID)

Parameters

String serviceID
The ID of the service to be removed. The ID is the getKey().getID() value of the associated
service object.

Return Codes

Value Meaning

true The specified service was successfully found and removed.

false The specified service was not found.

setDeleteTargetAssocs
Specifies whether to delete associations to the service object, where the service object is
the target of the association. If the parameter is false and the service object is the target
of one or more associations, then the removal of the service object is inhibited.

Syntax
public void setDeleteTargetAssocs(boolean deleteTargetAssocs)

Parameters

boolean deleteTargetAssocs
true: Delete associations to the service object where the service object is the target of the
association.
Default: true

setRemoveReferencedImports
Specifies whether to remove the imported WSDL and schema files together with their
controlling ExternalLinks from the repository referenced .

Syntax
public void setRemoveReferencedImports(boolean removeReferencedImports)

Parameters

boolean removeReferencedImports
true: Remove the referenced imported WSDL and schema files.
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Finding Registered Web Service
The Web Service API provides functions with which you can find a registered web
service. For example:
import com.centrasite.jaxr.JAXRAccessor; 
import com.centrasite.jaxr.webservice.WebServiceAdministrator; 
  
String dbURL = "http://localhost:53307/CentraSite/CentraSite"; 
String wsdlFile = "c:/temp/MyService.wsdl"; 
String user = ...; 
String password = ...; 
  
JAXRAccessor jaxr = new JAXRAccessor(dbURL, user, password);   
  
try 
{ 
   WebServiceAdministrator wsa = new WebServiceAdministrator(jaxr); 
   Collection services = wsa.findWebServices("MyOrganization".wsdlFile); 
   . . . 
} 
catch (Exception e) 
{ 
   // handle error 
} 
finally 
{ 
   jaxr.close(); 
}

The WebServiceAdministrator class provides the following methods:

findWebServiceByNamespace
Finds the registered web service on the basis of its name and namespace.

Syntax
public Service findWebServiceByNamespace(String serviceName, String namespace)

Parameters

String serviceName
The name of the registered web service.

String namespace
The namespace of the registered web service.

findWebServices
Finds a collection of web service objects that are registered with the specified
organization in the specified WSDL file.

Syntax
public Collection findWebServices(String organizationName, String wsdlFile)
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Parameters

String organizationName
The name of the organization. Null if all organizations are to be discovered.

String wsdlFile
The file path to the WSDL file.

Importing Schema
The schema importer works closely with the web service importer. Since a WSDL file
of a web service may import or include schema files, CentraSite enables you to design
and store a schema before referencing the WSDL files. Similarly, if a schema file is
imported by more than one WSDL file, it could be beneficial to register the schema
first, before registering the WSDL files. When a schema is imported, the file is copied
into the CentraSite repository and an ExternalLink that controls the resource is created.
If a schema imports (includes) further schemas, then the referenced schemas are also
imported. The referenced relations are established by means of a Uses association in the
registry. This figure illustrates the relationship:

This example demonstrates how to import a schema file into CentraSite:
import com.centrasite.jaxr.JAXRAccessor; 
import com.centrasite.jaxr.schema.SchemaImporter; 
  
String dbURL = "http://localhost:53307/CentraSite/CentraSite"; 
String xsdFile = "c:/temp/MySchema.xsd"; 
String user = ...; 
String password = ...; 
  
JAXRAccessor jaxr = new JAXRAccessor(dbURL, user, password); 
  
try 
{ 
   SchemaImporter si = new SchemaImporter(xsdFile, jaxr); 
   si.add(); 
} 
catch (Exception e) 
{ 
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   // handle error 
} 
finally 
{ 
   jaxr.close(); 
}

Removing Schema
You can remove a schema from CentraSite. This function deletes the XML Schema object,
the ExternalLink, and the resource in the repository.

Note: If a schema is referenced by another object, for example, if it is referenced by
the ExternalLink of a WSDL object, then it cannot be deleted.

This example demonstrates how to remove a schema from CentraSite:
import com.centrasite.jaxr.JAXRAccessor; 
import com.centrasite.jaxr.schema.SchemaAdministrator; 
import javax.xml.registry.infomodel.ExternalLink; 
  
String dbURL = "http://localhost:53307/CentraSite/CentraSite"; 
String user = ...; 
String password = ...; 
  
JAXRAccessor jaxr = new JAXRAccessor(dbURL, user, password); 
  
try 
{ 
   SchemaAdministrator sa = new SchemaAdministrator(jaxr); 
   sa.removeByName(“MySchema.xsd”, true); 
} 
catch (Exception e) 
{ 
   // handle error 
} 
finally 
{ 
   jaxr.close(); 
}

The SchemaAdministrator class provides the following methods for removing a schema:

removeByName
Removes the schema specified by name.

Syntax
public int removeByName (String schemaName, boolean cascading)

Parameters

String schemaName
The name of the schema registry object.
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boolean cascading
true: The specified schema and all its descendant schema objects will be removed.
false: The specified schema will be removed.

Return Codes

The number of schema objects removed.

Value Meaning

true The specified schema was found and removed.

remove
Removes the schema specified by its XML schema object.

Syntax
public boolean remove(RegistryObject schemaObject)

Parameters

RegistryObject schemaObject
The XML schema object or the external link of the schema.

Return Codes

Value Meaning

true The specified schema was found and removed.

removeCascading
Removes the specified schema and all schemas that are related to it by import and
include. The initial schema is specified by its location in the CentraSite repository, which
may be relative or absolute.

Syntax
public boolean removeCascading(String schemaLocation)

Parameters

String schemaLocation
The repository location, which may be relative or absolute.
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Return Codes

Value Meaning

true The specified schema and all related schemas were found and
removed.

removeCascading
Removes the specified schema and all schemas that are related to it by import and
include. The initial schema is specified by its XML schema object or by its external link.

Syntax
public boolean removeCascading(RegistryObject schemaObject)

Parameters

RegistryObject schemaObject
The XML schema object or the external link of the schema.

Return Codes

Value Meaning

true The specified schema and all related schemas were found and
removed.

Importing BPEL Process File
The BPEL importer imports objects of a Business Process Execution Language file. In
CentraSite there are various specific predefined BPEL-ObjectTypes. A BPEL process
flow usually references certain web services. Note that those web services should be
registered prior to the BPEL registration otherwise the references to the services cannot
be established. The top-level controlling object is a BPELProcess object.

This example demonstrates how to import a BPEL file:
import com.centrasite.jaxr.JAXRAccessor; 
import com.centrasite.jaxr.bpel.BPELRegistrator; 
  
String dbURL = "http://localhost:53307/CentraSite/CentraSite"; 
String bpelFile = "c:/temp/MyBPEL.bpel"; 
String user = ...; 
String password = ...; 
  
JAXRAccessor jaxr = new JAXRAccessor(dbURL, user, password); 
   
try 
{ 
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   BPELRegistrator br = new BPELRegistrator(bpelFile, jaxr); 
   br.register(); 
   int warnings = br.getWarningCount();    
   // are there unreferenced services? 
} 
catch (Exception e) 
{ 
   // handle error 
} 
finally 
{ 
   jaxr.close(); 
}

The BPELRegistrator class provides the following optional seer methods. If you want to
use them, they must be called before calling the register() method:

setProjectName
Specifies a project name such as an internal RegistryPackage. The named project will
receive the created top-level object (a BPELProcess) as a member.

Syntax
public void setProjectName(String projectName)

Parameters

String projectName
The desired name of the project.

setWarningIfPLTNotFound
Specifies how CentraSite should react if a service that has not yet been registered in
CentraSite is encountered.

Syntax
public void setWarningIfPLTNotFound(boolean warningIfPLTNotFound)

Parameters

boolean warningIfPLTNotFound

true Each time a service that has not yet been registered in CentraSite
is encountered, a counter is incremented. Use the getWarningCount()
method to get the current value of the counter.

false If a service that has not yet been registered in CentraSite is
encountered, an exception occurs.
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Usage Notes

The default value of the parameter is true.

Removing Registered BPEL Object
You can remove a registered BPEL process object. The BPEL file is removed from the
repository and all associated registry objects are also removed. Like the import class, you
must first establish a CentraSite connection with an instance of the JAXRAccessor class
before calling the remove or removeProcess method. The BPELAdministrator class provides the
following methods:

remove
Removes the BPEL objects of the process flow indicated in the specified BPEL file.

Syntax
public boolean remove (String bpelFile)

Parameters

String bpelFile
Specifies the BPEL file whose objects are to be removed from the CentraSite repository.

Return Codes

Value Meaning

true The BPEL objects were successfully removed.

false The BPEL objects could not be removed.

RemoveProcess
Removes the BPEL objects of the process flow indicated by the BPELProcess name and
its namespace.

Syntax
public boolean removeProcess(String bpelProcessName, String bpelNamespace)

Parameters

String bpelProcessName
The process name of the BPEL objects to be removed.



M
Even Header

Importing Objects Using API

CentraSite Developer's Guide Version 10.2 (Innovation Release) 338

String bpelNamespace
The namespace of the BPEL objects to be removed.

Return Codes

Value Meaning

true The BPEL objects were successfully removed.

false The BPEL objects could not be removed.

Importing XPDL File
The XPDL importer imports a process definition from an XPDL file and from the XPDL
file, the importer produces a Process object and related components (for example,
Process Steps, Process Pools and Process Swimlanes). If the XPDL process references a
web service, the importer adds the web service to the registry if it is not already present
and associate it with the Process object.

This example demonstrates how to import an XPDL file into CentraSite using the
CentraSite Java API:
import com.centrasite.jaxr.JAXRAccessor; 
import com.centrasite.jaxr.xpdl.ImportXPDL; 
  
// Set URL for CentraSite registry or repository 
String dbURL = "http://localhost:53307/CentraSite/CentraSite"; 
  
// Specify the location of the XPDL file. 
String xpdlFile = "c:/temp/MyXPDL.xpdl";  
  
// Specify the user account and password that the importer uses to 
// log on to CentraSite                      
String user = "";                                       
String password = "";  
  
// Build the connection to CentraSite 
JAXRAccessor jaxr = new JAXRAccessor(dbURL, user, password);    
  
try 
{ 
// Instantiate XPDL importer object with specified XPDL file and 
// connection info and then execute the import method. 
  
   ImportXPDL xpdl = new ImportXPDL(xpdlFile, jaxr); 
   xpdl.doImport(); 
} 
catch (Exception e) 
{ 
// Handle error 
   ... 
} 
finally 
{ 
// Close connection to CentraSite registry or repository 
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   jaxr.close();                                               
}

The ImportXPDL class provides the following optional seer methods that you can use to
specify certain properties in the Process object. If you want to use these seer methods,
you must call them before you call the doImport() method.

setOrganization
Specifies the organization to which the Process object is to be added.

Syntax
public void setOrganization (Organization org)

Parameters

Organization org
The organization to which the importer will add the Process object. This method takes
an Organization object as input. You can obtain the Organization object for a specified
organization using the BusinessQueryManager.getRegistryObject() method.

Usage Notes

Optional. If you do not set the organization parameter, the importer adds the Process
object to the organization that the user specified in the JAXRAccessor belongs.

SetOriginalFilename
Specifies the filename to be assigned to the XPDL file in CentraSite's repository.

Syntax
public void setOriginalFilename (String originalFilename)

Parameters

String originalFilename
The filename that is to be given to the XPDL file in the CentraSite repository.

Note: A valid filename can consist of leers, numbers, and the underscore
character. It must not contain spaces or any other special characters.

Usage Notes

Optional

setProductConcept
Specifies the category from the Product taxonomy by which the Process object is to be
classified.
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Syntax
public void setProductConcept(Concept product)

Parameters

Concept product
The Product category (concept) that is to be assigned to the Process object. This
classification is generally used to identify the product from which the Process was
published.
The following are some of the predefined categories in the Product taxonomy in
CentraSite. (For other categories, examine the Product taxonomy on the instance of
CentraSite to which you are importing the XPDL file.)

CentraSite

webMethods ApplinX

webMethods EntireX

webMethods Product Suite, with the subcategories that include:

webMethods BPM

webMethodsComposite Application Framework

webMethods Trading Networks

Usage Notes

Optional

setVersion
Specifies the version identifier that is to be assigned to the Process object that the
importer adds to the registry. This methods specifies the user-defined version identifier.
The Process object will also have a version number, which is automatically assigned and
maintained by CentraSite.

Syntax
public void setVersion(String version)

Parameters

String version
The version identifier to be assigned to the Process object.

Usage Notes

Optional
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Invoking Importer through Command Line
Each importer includes a main() method, which allows it to be called from a Windows
batch file or from a UNIX shell script.

To invoke an importer from the command line, you must perform the following high-
level steps:

1. Create a script file.

2. Execute the script file with the appropriate input parameters.

Note that there are usable scripts available for most of the importers. You can find the
script files in the utilities folder in the <CentraSiteInstall_Directory>. For example, you
could import a Web Service asset using the command tool named ImportWSDL.[cmd|
sh].

Creating Script File to Invoke an Importer
The importers are Java classes whose main() method executes when you run the importer
class from the command line. To ensure that the CLASSPATH and other environment
variables are set properly when you run the importer class, you must create a script file.

Creating Script File for Windows (a .bat File)
Create a script file if CentraSite is running under Windows. Example of script file:
@echo off 
set JAVAEXE=fullPathToJava.exe
set REDIST=CentraSiteHomeDirectory \redist 
set BASEDIR=%~dp0 
cd /d %REDIST% 
  
REM build CLASSPATH with all files from jar directory 
set LOCAL_CLASSPATH= 
for %%I in (".\*.jar") do call "CentraSiteHomeDirectory \bin\cfg\lcp.cmd" %%I 
  
%JAVAEXE% -cp %LOCAL_CLASSPATH% importerClassName  %* 
cd /d %BASEDIR%

Where importerClassName  is the name of the Importer class that you want to run. For a
list of the importer class names, see “Importer Class Names” on page 342.

Example

The following is an example of a script file that calls the XML Schema importer:
@echo off 
REM 
REM Run XML Schema Importer 
REM 
set JAVAEXE=D:\software\java\jdk1.5.0_12\bin\java 
set REDIST=C:\SoftwareAG\CentraSite\redist 
set BASEDIR=%~dp0 
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cd /d %REDIST% 
  
REM build CLASSPATH with all files from jar directory 
set LOCAL_CLASSPATH= 
for %%I in (".\*.jar") do call "C:\SoftwareAG\CentraSite\bin\cfg\lcp.cmd" %%I 
  
%JAVAEXE% -cp %LOCAL_CLASSPATH% com.centrasite.jaxr.schema.SchemaImporter %* 
cd /d %BASEDIR%

Creating Script File for UNIX (Bourne-Shell Script)
Create a script file that looks as follows if CentraSite is running under UNIX.
#!/bin/sh
CENTRASITE_HOME=/opt/softwareag/CentraSite
export CENTRASITE_HOME
. ${CENTRASITE_HOME}/bin/centrasite_setenv.sh
# set CLASSPATH
REDIST=${CENTRASITE_HOME}/redist
CLASSPATH="$REDIST:$REDIST/*"
export CLASSPATH
# execute utility
EXECUTABLE="${CS_JAVA_EXE} -cp ${CLASSPATH} importerClassName "
$EXECUTABLE "$@"
RC=$?
exit $RC

Where importerClassName  is the name of the Importer class that you want to run. For a
list of the importer class names, see “Importer Class Names” on page 342.

Example

This is an example of a script file that calls the XML Schema importer:
#!/bin/sh
CENTRASITE_HOME=/opt/softwareag/CentraSite
export CENTRASITE_HOME
. ${CENTRASITE_HOME}/bin/centrasite_setenv.sh
# set CLASSPATH
REDIST=${CENTRASITE_HOME}/redist
CLASSPATH="$REDIST:$REDIST/*"
export CLASSPATH
# execute utility
EXECUTABLE="${CS_JAVA_EXE} -cp ${CLASSPATH} 
com.centrasite.jaxr.schema.SchemaImporter"
$EXECUTABLE "$@"
RC=$?
exit $RC

Importer Class Names
The table lists the importer class names.

Note: Some importers have an import class which you use to import the asset and an
admin utility class, which you can use to delete or replace the asset after it has
been imported.
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Importer or Admin Utility that You
Want to Use

Class Name

Web Service (Importer) com.centrasite.jaxr.webservice.WebServiceRegistrator

Web Service (Admin utility) com.centrasite.jaxr.webservice.WebServiceAdministrator

REST Service (Importer)

OData Service (Importer)

com.centrasite.jaxr.xmlservice.XMLServiceManager

XML Service (Importer) com.centrasite.jaxr.xmlservice.XMLServiceManager

XML Schema (Importer) com.centrasite.jaxr.schema.SchemaImporter

XML Schema (Admin utility) com.centrasite.jaxr.schema.SchemaAdministrator

BPEL Process Definition
(Importer)

com.centrasite.jaxr.bpel.BPELRegistrator

BPEL Process Definition
(Admin utility)

com.centrasite.jaxr.bpel.BPELAdministrator

XPDL File (Importer) com.centrasite.jaxr.xpdl.ImportXPDL

Executing Script File to Invoke Importer
To invoke the importer, you must run the importer script file with the required set of
input parameters. The input parameters that are required to run the script file varies
depending on the importer your script file invokes.

Note: You can also obtain the complete list of input parameters by invoking the
importer with no input parameters.

Importing Web Service

To import a Web Service from the command line

Run your importer script file or use the delivered ImportWSDL script.

The syntax is of the format: yourScriptFile -dburl centrasiteurl -w
wsdlFile -user yourCSUserID -password yourPassword
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To get an overview of all available parameters, call the script without any option.
Use the -help option to get a detailed description of the parameters.

Example:

ImportWSDL -w d:\myDirectory\myWSDLFile.wsdl -o "MyOrganization" -
user myUser -password myPassword

Invoking the Web Service Administrator from Command Line

You can invoke the Web Service Administrator utility to delete a web service that has
been imported into CentraSite. To obtain the input parameters used by this utility,
run the script file without any option.

Importing REST Service

To import a REST Service from the command line

Run your importer script file or use the delivered import Service script.

The syntax is of the format: yourScriptFile -s xmlFileURI -n serviceName -e
endpointURL -m httpMethods -user yourCSUserID -password yourPassword

To get an overview of all available parameters, call the script without any option.
Use the -help option to get a detailed description of the parameters.

Example:

import Service -s http://fs02hq/xml/myService.xsd -n myXMLService -
e http://appsvr02:53307/myService -m GET PUT -user myUser -password
myPassword

Importing XML Schema

To import an XML Schema from the command line

Run your importer script file or use the delivered ImportSchema script.

The syntax is of the format: yourScriptFile -s xsdFile -user yourCSUserID -
password yourPassword

To get an overview of all available parameters, call the script without any option.
Use the -help option to get a detailed description of the parameters.

Example:

ImportSchema -s d:\myDirectory\myXSDFile.xsd -user myUser -password
myPassword

Invoking the XML Schema Administrator from Command Line

You can invoke the XML Schema Administrator utility to delete an XML Schema
that has been imported into CentraSite. To obtain the input parameters used by this
utility, run the script file without any option.
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Importing BPEL Process

To import a BPEL process from the command line

Run your importer script file or use the delivered ImportBPEL script.

The syntax is of the format: yourScriptFile -file bpelFile -user
yourCSUserID -password yourPassword

To get an overview of all available parameters, call the script without any option.
Use the -help option to get a detailed description of the parameters.

Example:

ImportBPEL -file d:\myDirectory\myBPELFile.bpel -user myUser -
password myPassword

Invoking the BPEL Administrator from the Command Line

You can invoke the BPEL Administrator utility to delete or display a BPEL process
that has been imported into CentraSite. To obtain the input parameters used by this
utility, run the script file without any option.

Importing XPDL File
The XPDL importer imports a process definition from an XPDL file and from the XPDL
file, the importer produces a Process object and related components (for example,
Process Steps, Process Pools and Process Swimlanes). If the XPDL process references a
web service, the importer adds the web service to the registry if it is not already present
and associate it with the Process object.

This example demonstrates how to import an XPDL file into CentraSite using the
CentraSite Java API:
import com.centrasite.jaxr.JAXRAccessor; 
import com.centrasite.jaxr.xpdl.ImportXPDL; 
  
// Set URL for CentraSite registry or repository 
String dbURL = "http://localhost:53307/CentraSite/CentraSite"; 
  
// Specify the location of the XPDL file. 
String xpdlFile = "c:/temp/MyXPDL.xpdl";  
  
// Specify the user account and password that the importer uses to 
// log on to CentraSite                      
String user = "";                                       
String password = "";  
  
// Build the connection to CentraSite 
JAXRAccessor jaxr = new JAXRAccessor(dbURL, user, password);    
  
try 
{ 
// Instantiate XPDL importer object with specified XPDL file and 
// connection info and then execute the import method. 
  
   ImportXPDL xpdl = new ImportXPDL(xpdlFile, jaxr); 
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   xpdl.doImport(); 
} 
catch (Exception e) 
{ 
// Handle error 
   ... 
} 
finally 
{ 
// Close connection to CentraSite registry or repository 
   jaxr.close();                                               
}

The ImportXPDL class provides the following optional seer methods that you can use to
specify certain properties in the Process object. If you want to use these seer methods,
you must call them before you call the doImport() method.

Invoking Importer Using SOAP API
CentraSite provides a web service for each of the predefined importers. Descriptions of
these services are available here:
http://server :port /wsstack/services/listServices

where server  is the machine on which the Software AG Runtime is running and port  is
the port on which Tomcat is listening (port 53307 if CentraSite is configured to use the
default Software AG Runtime port number).

Example
http://myServer:53307/wsstack/services/listServices

Software AG recommends using MTOM, when using the CentraSite web services with
aachments of 1 megabyte or more.

Viewing the WSDL for the Importers

To view the WSDL for an importer service, click the service name on the listServices
page.
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Writing Your Own Importer
You can write your own plug-in for CentraSite Control to incorporate your own
importer. The prepared plug-in is a collection of files in a specific directory structure.
After implementing the plug-in, the files must be copied into the CentraSite
Controlwebapps folder under:
<RuntimeWebAppsDir> /PluggableUI/<MyPluginFolder>

The location of the <RuntimeWebAppsDir>  folder is <RuntimeDir> /workspace/webapps .

The folder <MyPluginFolder > must contain the following files and folders:

Name of File or Folder Description

plugin.xml Top plug-in description file

*.html Files generated for the GUI

*_SWT.xml Files generated for the GUI

images Directory for icons (GIF files)

lib Directory for JAR files provided by the plug-in

accesspath Directory created by HTML generation
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The ImportMyFile framework illustrates how an import plug-in may be set up. The
example extends the import selection list and presents a screen that prompts for the file
to be imported. After confirming the file, the appropriate adapter classes are called.

The Build Environment
This topic explains the build environment for generating the HTML files that are used
for the GUI and for compiling the necessary Java source files. It assumes the use of Ant,
the Java-based build tool.

Example of the file system structure under the plug-in directory:

Name of File or Folder Description

src The directory that holds the Java source files

xml The directory that holds the XML file that specifies your
import window

plugin.xml Top plugin description file that specifies the extension
point and the command class

build.xml The Ant input file for building the destination files

The Ant file named build.xml, can be used to establish an import plug-in. Look for the
properties with the following names:

plugin.name

plugin.provider

tomcat.dir

tomcat.ver.dir

and modify them as required to suit your installation.

This is build.xml:
<?xml version="1.0"?> 
<?xml-stylesheet type="text/xsl" href="./ant2html.xsl"?> 
<!-- 
Build an Import plugin 
--> 
  
<project name="Import Plugin Example" default="all" basedir="."> 
  <description> Build file for an Importer plugin </description> 
  
  <!-- environment --> 
  <property environment="env"/> 
  
  <property name="plugin.name" value="ImportMyFile" /> 
  <property name="plugin.provider" value="Software AG" /> 
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  <!-- tomcat home directory --> 
  <!-- <property name="tomcat.dir" 
              value="tomcat directory of installation" />   --> 
  <property name="tomcat.dir" value="C:/SoftwareAG/profiles/CTP" /> 
  <property name="tomcat.ver.dir" value="${tomcat.dir}/workspace"/> 
  
  <!-- point to the root of the pluggableUI to get the cis environment --> 
  <property name="pluggable.ui.root" 
           value="${tomcat.ver.dir}/webapps/PluggableUI"/> 
  
  <!-- the directory containing source code --> 
  <property name="plugin.dir" value="../${plugin.name}" /> 
  <property name="src.dir"    value="${plugin.dir}/src" /> 
  <property name="xml.dir"    value="${plugin.dir}/xml" /> 
  <property name="classes"    value="${plugin.dir}/classes" /> 
  <property name="lib"        value="${plugin.dir}/lib" /> 
  
  <!-- classpath --> 
  <path id="plugin.class.path"> 
   <fileset dir="${pluggable.ui.root}/CentraSiteControl/lib"> 
    <include name="*.jar"/> 
   </fileset> 
   <fileset dir="${pluggable.ui.root}/WEB-INF/lib"> 
    <include name="*.jar"/> 
   </fileset> 
  </path> 
  
  <!-- default target, build all --> 
  <target name="all" description="all" depends="jar, zip"/> 
  
  <!-- establish jar file of plugin --> 
  <target name="jar" depends="compile" description="jar"> 
   <mkdir dir="${lib}" /> 
   <jar destfile="${lib}/${plugin.name}.jar"> 
    <fileset dir="${classes}"/> 
    <fileset dir="${src.dir}" includes="**/*.properties"/> 
     <manifest> 
     <section name="com/centrasite/control"> 
      <attribute name="Implementation-Title" value="${plugin.name}"/> 
      <attribute name="Implementation-Version" value="1.0.0.0"/> 
      <attribute name="Implementation-Vendor" 
                value="${plugin.provider}"/> 
     </section> 
     </manifest> 
   </jar> 
  </target> 
  
  <!-- compile java sources --> 
  <target name="compile" description="compile" depends=""> 
   <mkdir dir="${plugin.dir}/accesspath" /> 
   <mkdir dir="${classes}" /> 
   <javac srcdir="${src.dir}" destdir="${classes}" debug="on" 
         classpathref="plugin.class.path" /> 
  </target> 
  
  <!-- Create plugin archive --> 
  <target name="zip" description="package the plugin" depends=""> 
   <zip destfile="${plugin.name}.zip" basedir="${plugin.dir}/.." 
                                     includes="${plugin.name}/lib/**, 
                 ${plugin.name}/accesspath/**, ${plugin.name}/plugin.xml, 
                                               ${plugin.name}/*_SWT.xml, 
                 ${plugin.name}/xml/** ${plugin.name}/*.html" /> 
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  </target> 
  
  <!-- Install plugin zip to PluggableUI --> 
  <target name="install" description="Install plugin zip to PluggableUI"> 
   <java classname= 
         "com.softwareag.cis.plugin.ext.plugins.command.InstallPlugInCommand" 
     fork="true"> 
     <arg value="-t" /> 
     <arg value="${pluggable.ui.root}" /> 
     <arg value="-z" /> 
     <arg value="${plugin.name}.zip" />      
     <classpath> 
      <fileset dir="${pluggable.ui.root}/WEB-INF/lib"> 
       <include name="*.jar"/> 
      </fileset> 
     </classpath> 
   </java> 
  </target> 
  
  <!-- Uninstall plugin zip from PluggableUI --> 
  <target name="uninstall" description="Uninstall plugin zip from PluggableUI"> 
   <delete dir="${pluggable.ui.root}/${plugin.name}" /> 
  </target> 
  
  <!-- Cleanup objects --> 
  <target name="clean" description="clean classes lib and generated files"> 
   <delete dir="${classes}" /> 
   <delete dir="${plugin.dir}/accesspath" /> 
   <delete dir="${lib}" /> 
   <delete file="${plugin.name}.zip" /> 
 </target> 
</project>

The classpath for the build step must comprise all JAR files used by the UI. Add these
JAR files to the build path of your java project also.

In order to present a user-defined screen when the plug-in's import buon is clicked, an
XML file that describes the GUI must be located in the subdirectory xml. The example
XML file (xml/ImportMyFile.xml) simply prompts for a filename:
<?xml version="1.0" encoding="UTF-8"?> 
<page model="com.importer.myfile.control.ImportMyFileAdapter"> 
  <pagebody> 
   <rowarea withleftborder="false" withtopborder="false" 
           withrightborder="false" withbottomborder="false" 
            withtoppadding="false" 
               paddingleft="10" paddingright="10"> 
    <vdist height="30"></vdist> 
    <itr> 
     <label name="File:" width="100" asplaintext="true"></label> 
     <fileupload2 width="100%" cfileprop="fileClientUrl" 
               fileprop="fileServerUrl" 
                 method="fileLoaded"></fileupload2> 
    </itr> 
    <vdist height="30"></vdist> 
   </rowarea> 
  </pagebody> 
  <statusbar></statusbar> 
</page>
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The Plug-In Environment
The master file of the plug-in is plugin.xml:
<plugin id="com.importer.myfile" order="101"> 
  <requiredPlugin id="com.centrasite.control" /> 
  <requiredPlugin id="com.softwareag.cis.plugin" /> 
  
  <!-- Import extension (point to command execution class) --> 
  <extension point="com.centrasite.control.import" 
            id="importMyFileCommand" 
            class="com.importer.myfile.control.ImportMyFileCommand"> 
  </extension> 
</plugin>

This file specifies the command class, which is used to select the user's import function.
It must be derived from com.centrasite.control.extpt.AbstractImport.

Note: This topic does not explain all the details of the Java source file, its purpose is
to indicate the code that must be modified to suit your environment.

Here is src/com/importer/myfile/control/ImportMyFileCommand.java:
package com.importer.myfile.control; 
  
import com.centrasite.control.extpt.AbstractImport; 
import com.centrasite.control.ActionContext; 
public class ImportMyFileCommand extends AbstractImport 
{ 
  static final String 
     IMPORT_NAME     = "Import MyFile";  // Appears in the import list 
  static final String 
     HTML_PAGE       = "/ImportMyFile/ImportMyFile.html"; 
  static final String 
     MY_IMAGE        = "../ImportMyFile/images/importMyFile.gif"; 
  static final String 
     CALLING_ADAPTER = "com.importer.myfile.control.ImportMyFileAdapter"; 
                         // point to the adapter class 
  
  public ImportMyFileCommand() { 
  } 
  
  public String getName() { 
    return IMPORT_NAME; 
  } 
  
  public String getImageURL() { 
    return MY_IMAGE; 
  } 
  
  public String getLayout() { 
    return HTML_PAGE; 
  } 
  
  public String getPageDescription() { 
    return "XPDL v.1 Importer"; 
  } 
  
  public void execute(ActionContext actionContext) { 
    actionContext.showPage(HTML_PAGE, getName(), CALLING_ADAPTER); 
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  } 
}

This class defines the paths of the image file for your private icon, the HTML file used
and the class of the import adapter.

Here is the frame of an import adapter (this is src/com/importer/myfile/control/
ImportMyFileAdapter.java):
package com.importer.myfile.control; 
  
import java.util.Collection; 
import javax.xml.registry.JAXRException; 
import com.centrasite.control.AbstractBrowseCommand; 
import com.centrasite.control.ActionContext; 
import com.centrasite.control.Connector; 
import com.centrasite.control.adapters.BaseAdapter; 
import com.centrasite.control.adapters.util.ImportAdapter; 
import com.centrasite.control.discovery.PromptYesNoHandler; 
import com.centrasite.control.logged.action.LoggedExecutor; 
import com.centrasite.control.logged.action.LoggedSchemaImport; 
import com.centrasite.control.interfaces.Initializable; 
import com.centrasite.jaxr.JAXRAccessor; 
import com.softwareag.cis.plugin.interfaces.RunnableDeferred; 
  
/** 
   *  Import adapter 
   */ 
public class ImportMyFileAdapter extends BaseAdapter 
             implements Initializable,ImportAdapter 
{ 
   private static final String TITLE = "Import MyFile"; 
  
   private String fileTmpUrl; 
   private String fileAtServer; 
   private String fileAtClient; 
  
   public ImportMyFileAdapter() { 
       fileAtServer = fileAtClient = fileTmpUrl = null; 
   } 
   public void initialize(Collection<Object> objs){} 
  
   public void setOrganization(String org){} 
  
   public boolean execute() { 
       callFinish(); 
       return true; 
   } 
  
   public String getFileClientUrl() { 
       return fileAtClient; 
   } 
  
   public void setFileClientUrl(String value) { 
       fileAtClient = value; 
   } 
  
   public String getFileServerUrl() { 
       return fileTmpUrl; 
   } 
  
   public void setFileServerUrl(String value) { 
       fileTmpUrl = value; 
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   } 
  
   public void fileLoaded() { 
     fileAtServer = fileTmpUrl; 
   } 
  
   public void callCancel() { 
     super.endProcess(); 
   } 
  
   private static boolean isWhiteSpace(String s) 
   { 
       if (s == null || s.length() == 0) return true; 
       for (int i=0 ; i < s.length() ; ++i) { 
           if (!Character.isWhitespace(s.charAt(i))) return false; 
       } 
       return true; 
   }  
       
   /** 
    * Called if "OK" button has been pressed 
    */ 
   public void callFinish() { 
       if (isWhiteSpace(fileAtServer)) 
       { 
           outputMessage(MT_ERROR, "no file entered"); 
       } 
       else 
       { 
          ImportMyFile ie = new ImportMyFile(getConnector(), 
                                fileAtServer, fileAtClient); 
          ie.doImport(); 
       } 
   } 
  
   /** 
    * Class for importing specific files 
    */ 
   private class ImportMyFile extends AbstractBrowseCommand 
                 implements RunnableDeferred, PromptYesNoHandler 
   { 
       private Connector connector; 
       private JAXRAccessor jaxr; 
  
       public ImportMyFile(Connector connector, String fileAtServer, 
                           String fileAtClient){ 
          // fileAtClient is the filename you can access 
          this.connector = connector; 
          this.jaxr = null; 
       } 
  
       public void doImport() { 
          JAXRAccessor jaxr = null; 
          try { 
             LoggedSchemaImport lsi = 
                 new LoggedSchemaImport(getActionContext()); 
             jaxr = getJAXR(); 
             // write here your import code to registry and repository 
             //setEventCallback( lsi.getEventCallback() );  
                  // for event logging 
  
             // your import code can use the methods 
             // accept(javax.xml.registry.infomodel.RegistryObject ro) 
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             // warning(javax.xml.registry.infomodel.RegistryObject ro) 
             // reject(javax.xml.registry.infomodel.RegistryObject ro) 
             // of the LoggedEventCallback class, 
             // to log the status of your import 
  
             new LoggedExecutor(lsi).execute();           
          } 
          catch (Exception e) { 
             throw new RuntimeException(e); 
          } 
          finally { 
             if (jaxr != null) 
                jaxr.close(); 
          } 
       } 
  
       private JAXRAccessor getJAXR() throws JAXRException { 
           if (jaxr == null)  { 
               jaxr = new JAXRAccessor(connector.getRegistryUrl(), 
                          connector.getUserName(), 
                          connector.getPassword()); 
           } 
           return jaxr; 
       } 
       public void run() throws Exception { 
           doImport(); 
       } 
  
       public void handleYes(ActionContext actionContext) { 
           doImport(); 
       } 
  
       public void handleNo(ActionContext actionContext) {} 
  
       public void executeCommand(ActionContext actionContext, 
                              String clientPath) {} 
  
       public void executeCommand(ActionContext actionContext, 
            String clientPath, String serverPath) { 
            actionContext.executeDeferred(this); 
       } 
  
       public int getCategory() { 
           return CATEGORY_MISC; 
       } 
  
       public String getImageURL() { 
           return null; 
       } 
  
       public String getTitle() { 
           return TITLE; 
       } 
  
       public String getName() { 
           return ""; 
       } 
  
       public String getLabel() { 
           return ""; 
       } 
   } 
}
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Assuming that you have set up all the Java files correctly in the directory src, you should
be able to build with the build.xml command.

The syntax for the command is:
ant -f build.xml jar all

This creates the plug-in-specific JAR file in the subdirectory lib and archives the
necessary plugin files into the file ImportMyFile.zip.

Propagating the Plug-In
Having generated the plugin files, they must be propagated into the directory
<RuntimeWebAppsDir> /PluggableUI/ of the installed CentraSite Control. Thus, for
example, ImportMyFile must have the following directory/file structure:
.../PluggableUI/ImportMyFile / 
  accesspath / 
      ImportMyFile.access 
  images / 
      ImportMyFile.gif 
  lib / 
      ImportMyFile.jar 
  ImportMyFile.html 
  ImportMyFile_JLIBS.html 
  ImportMyFile_SWT.xml 
  plugin.xml

You can do this by executing the build.xml command, which installs ImportMyFile.zip
into the <RuntimeWebAppsDir> /PluggableUI/ folder.

The syntax for the command is:
ant -f build.xml install

Generating Additional Files
You need this step only if you are not able to install the necessary files directly in the
<RuntimeWebAppsDir> /PluggableUI/ directory. In this case, you have to build the
structure shown in “Propagating the Plug-In” on page 355 by yourself. You can
automatically generate the .html files as well as the _SWT.xml and the .accesspath file
using the Software AG Application Designer.

To generate additional files

1. Edit the file stored in the following directory: <RuntimeWebAppsDir> /PluggableUI/
cis/config/cisconfig.xml

2. Insert the statement: plugindevelopment="true" in the following part:
designtimeclassloader= 
                             "com.softwareag.cis.plugin.registry.loader.
                              AdapterPluginClassLoader" 
   enableadapterpreload="true" 
   framebuffersize="3" 
   plugindevelopment="true" 
   loglevel="" 
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   logtoscreen="false" 
   maxitemsinfieldcombo="100"

3. Restart the Software AG Runtime. Now you can start the Application Designer with
the following URL: http://localhost:53307/PluggableUI/HTMLBasedGUI/
workplace/ide.html

4. Navigate to Tools & Documentation > Layout Manager and select the ImportMyFile
Plugin as Application Project. It appears in the Layout Definitions List.

5. Generate the required files using the Operations buon on multiple Items >
(Re)Generate HTML pages.

Activating the Plug-In
1. Restart Software AG Runtime.

2. Start CentraSite Control.

3. Select the Import function.

4. Select the name of the plug-in and click Next.

5. Type the name of the file to be imported.

6. Click Finish.

Deactivating the Plug-In
1. Run the command:

ant -f build.xml uninstall

2. Restart Software AG Runtime.

3. Start CentraSite Control.
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Installing CentraSite Plug-ins in Your Own Eclipse
Environment

To install the CentraSite plug-ins in your own Eclipse Environment

1. CentraSite plug-ins require the Eclipse SDK. If you want to use CentraSite Reporting,
download the Eclipse IDE for Java and Report Developers and select an integrated
package that contains both the required Eclipse software and BIRT.

If you do not want to use CentraSite Reporting, you can download the Eclipse IDE
for Java Developers. Software AG recommends using the same Eclipse version that
Software AG Designer uses.

2. Install a supported JRE as listed in System Requirements for Software AG Products.

3. Start Eclipse.

4. Go to the menu entry Help and click the option to install software.

5. In the Available Software dialog, select Add or Add Site.

6. In the Add Repository dialog, click Archive.

7. Go to the <Software AG_directory >/Designer/updates directory, select
com.softwareag.common.zip, click Open and then click OK.

If you need a language pack, install it using the same method.

8. On the Add Repository dialog, click Archive.

9. Go to the <Software AG_directory >/Designer/updates directory, select
CentraSiteUpdateSite.zip, click Open and then click OK.

If you need a language pack, install it using the same method.

10. The Available Software dialog lists the CentraSite plug-ins under SOA Governance.
Click Select All and then click Next.

11. Accept the terms of the license agreements and click Finish.

12. Restart Eclipse.

13. Test the installation as follows:

a. Go to File > New > Project > Business Intelligence and Reporting Tools > Report Project
and create a report project.

b. Go to File > New > Report and open the Report Design perspective.

c. Open the view Report Design > Data Explorer. Right-click Data Sources and then
click New Data Source. The dialog box lists the CentraSite data sources you can use
to create the XQuery for generating CentraSite reports (that is, CentraSite and
CentraSite XQuery).
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d. Select CentraSiteXQuery. Use the default data source name and click Next.
Connection information about the CentraSite data source appears.

14. Install fixes in your Eclipse environment as follows:

Note: Before installing fixes in your Eclipse environment, you have to install all
the fixes in your existing Software AG Designer installation.

a. Go to File > Import > Install > From Existing Installation and click Next.

b. In the Import from Application dialog box, browse to the Eclipse plug-ins in your
Software AG Designer installation that contains the latest fixes and click Next.
The Eclipse plug-ins are located at <Software AG_directory >/Designer/eclipse.

c. Select CentraSite Eclipse Plug-Ins and CentraSite Reporting Tools from the list
displayed and install them.

Connecting Eclipse to CentraSite

To connect Eclipse to CentraSite

1. Go to the Window menu entry and click Preferences.

2. Expand the CentraSite node and click Connections.

3. Click Add and provide the following information:

Unique name to appear in your list of connections.

Host and port for the Software AG Runtime. The default port is 53307.

ID of a user who has permission to access the CentraSite Registry Repository,
and password for that user.

4. Click OK.

5. Check that a connection to CentraSite is possible by clicking Test. If you experience
problems, go to Window > Preferences > General > Network Connections and check the
network connection seings. The proxy seings should be the same as for the
Software AG Runtime.

6. Go to Window > Open Perspective > Other in the main menu of the Eclipse Workbench
and select the CentraSite perspective.

Using CentraSite Online Documentation
The CentraSite Eclipse plug-ins are integrated in the help system of the Eclipse
Workbench. To access the help you need an Internet browser that supports JavaScript,
Java applets, and Cascading Style Sheets. The documentation has been successfully
tested with the Sun JVM 1.8.0 browser plug-in.
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If you are using Internet Explorer, when you try to display CentraSite help pages that
use active content, you might receive warning messages (for example, To help protect
your security, Internet Explorer has restricted this webpage from
running scripts or ActiveX controls that could access your computer).
Change the browser options to allow active content to run in files on your computer.
Then restart Internet Explorer, click the information bar, and click Allow Blocked Content...
for each affected help page.

To see CentraSite Eclipse UI Help, go to Help > Help Contents.

To see context-sensitive help for a CentraSite Eclipse plug-in view, menu option,
dialog, property page or wizard, press F1.
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